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1 Getting Started
1.1 Introduction

Welcome to Perception, the latest addition in a range of sophisticated software
for data acquisition control, display, analysis and reporting. This software
platform which capitalizes on more than 30 years design experience was
designed from the ground up using state-of-the-art tools that leave competitors
standing.

Designed as the software platform of the future, Perception software will
support most current and future HBM Genesis HighSpeed hardware as well as
selected legacy data acquisition systems. Secure your future… the most
complete range of data acquisition systems all supported by a single software
suite and a team of engineers committed to continuous improvement and
expansion.

Perception allows control of a variety of hardware, ranging from straightforward,
continuous data streaming of a few channels to multi-rack based DAQ
instruments providing millions of data points per second. Perception software
is equally comfortable with fast update scope type displays, streaming strip
chart displays and transient recording.

To support this range of instruments, each offering different acquisition
capabilities and their corresponding signal conditioners, Perception uses a
spreadsheet-style setup. This setup offers ease of use and enables instant
overview of all relevant parameters. An additional acquisition control dialog
gives you interactive control of one or multiple acquisition units. In the case of
the GEN2i, a unique platform called the Instrument Panel was developed.
Powered by the Perception engine, made specifically for the touch screen
environment and tailored toward simplicity and ease of use.

The unique displays let you visualize real-time waveforms instantly. Review
historical data while acquiring and displaying current data. Compare with
reference curves or zoom in to see the finest details with our free-style zooming
and panning. The alternate zoom feature gives you two zoom areas
simultaneously within the same waveform.

Dedicated hardware support allows for live and accurate display updates even
when working on multiple channels through an Ethernet interface.
StatStream® display technology enables even high resolution files to be viewed
instantly regardless of acquisition size or network speed.

Perception

26 A02689_09_E00_00   HBK: UNRESTRICTED



In addition the Perception software includes a variety of numerical displays and
“VU-meters” with alarm levels that are configurable and scalable to suit various
requirements and conditions.

With true multi-monitor support you can create a work space that goes beyond
conventional software capabilities. View different sets of data on multiple high-
resolution monitors for real power and control of your application.

Perception provides the measurement functionality you need to work with ease
and efficiency. The cursor measurements with horizontal, vertical and slope
cursors with a swiftly updated result table allows for fast and easy access to
points of interest.

A variety of built-in meters can be connected directly to parameters like max,
min and mean value as well as Peak-to-Peak, RMS, etc. These values are
generated by the acquisition hardware and displayed in real-time on your
computer screen.

The data navigator lets you easily find your way between the various data
sources such as live waveforms, files, strings, numerical values or calculated
results. These data sources can be located anywhere: on your data acquisition
system, on your hard disk or somewhere on the intranet. Configure the
information structure to your preferred viewing options. All detailed properties
of a selected source are instantly available making searching through a myriad
of data sources a breeze.

When you find an event of interest you can print your traces with a single menu
command on high-resolution printers in full-color. Or simply copy the display of
interest and paste it into any document for more advanced reporting. In addition
you can create quick or advanced (option) reports using Microsoft® Word.

For off-line analysis using third-party software packages, Perception can offer
a variety of export formats for many popular programs. Extensive set-up options
let you export the data of interest the way you want, and nothing more.

Perception’s thoughtful workbench concept allows for arrangement of a variety
of graphical objects into logical groups for easy reference. You can freely
customize the work space to suit your control and analysis needs: create an
environment by selecting the required windows, displays and components, size
and position them and save this as a Virtual WorkBench (*.pvwb) file for later
use. You can easily switch between saved work spaces for different
requirements, and at start-up you can choose between auto-configuration and
a saved work space.
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A variety of options is available to tailor the Perception application to your needs
including, but not limited to:

l Multiple workbooks that allow you to create multiple ‘instances’ of your
work environment and effectively use multi-monitor systems.

l Export plus for additional export formats.
l Control plus for acquisition control of multiple mainframes.
l Remote control with SOAP and RPC.
l Video playback that enables synchronized playback of video and time

domain data with tracking cursors.
l Analysis that allows entry of formulas to calculate math channels and

channel parameters.
l Advanced reporting: a DTP-alike tool for the creation of stunning reports

with displays, tables, results, etc.
l Information: a tool to include a variety of information in your experiment.
l Spectral display: provides basic FFT and Spectral Analysis functionality".

Other options include Custom Software Interface programming CSI, STL
formulas,  BE256/Multipro Control, and HPHV Automated Analysis.

Each option is described in it's own separate manual.

Note Not all features and functions mentioned in this manual are included as
standard.
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1.2 Requirements
The following section lists the hardware requirements.

l Intel® Core™ Duo (or compatible)
l For Perception

Windows Vista™ Business or Ultimate (32-bit and 64-bit, Service pack 2
or higher) Window 7 Professional (32-bit or 64-bit, Service Pack 1 or higher)
Windows 8 Pro, Windows 8.1 Pro

l For Perception Enterprise 64-bit
Windows Vista™ Business or Ultimate (64-bit, Service pack 2 or higher)
Window 7 Professional or Ultimate (64-bit, Service Pack 1 or higher)
Windows 8 Pro, Windows 8.1 Pro

l Microsoft DirectX® 9 or higher (included on media)
l Microsoft®.NET 4.0 (Included in Perception install)
l 512 MB of RAM memory - 2 GB recommended, and required when working

with more than one data acquisition mainframe.
l 1 GB of available hard-disk space for installation
l At least 1% of free hard-disk capacity for storage of acquired data
l TrueColor (24-bit) video display adapter with 64 MB on-board video

memory and hardware DirectX 9 and Microsoft Direct3D® support using a
screen size of at least 1024 x 768 pixels

l CD-ROM drive for installation of the software (DVD-drive required for
supplemental content)

l A free USB port for the HASP®HL USB Token
l 100 Mbit Ethernet interface (1 Gbit recommended) when combined with

GEN DAQ products

Note Please refer to Perception release notes for detailed information on specific
versions of Perception.

Note The Perception software is tested on video displays with a screen resolution of
96 dpi. Other resolutions may work, but are currently not advised.

1.2.1 Supported acquisition hardware
l GEN series Modular Data Acquisition System
l Vision XP (review and analysis)
l BE256 / MultiPro (requires BE256/MP Control option)
l ISOBE5600m
l QuantumX MX1609KB
l QuantumX MX1609TB
l QuantumX MX471B
l BE3200

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 29



1.2.2 System performance tests
After a new (clean) installation of the software, Perception will run a system
performance test at the first run of the software. This test verifies part of the
above mentioned system requirements and also advises on configurations for
best performance. Tests include:

l Available internal memory
l Operating system
l Processor type
l Swap file usage
l Continuous Data Rate

You can run this test any time from the menu: Help ► Performance Tests

In addition there is a test for the video display. You can access this test from
the menu: File ► Preferences... ► Perception ► Video.

There is also a test for Storage Speeds which is done at first launch of
Perception. You can access this from the menu: Window ►Continuous Data
Rate. This will show the Continuous Date Rate palette.

Figure 1.1: Continuous Data Rate dialog

Click on Details, when available, to show the details of this test. For more info
please see section "Set and Test current storage location" on page 348.
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1.3 Installing the software
When you install the Perception program files from the CD, note that you cannot
run Perception from the CD; you must install the components onto your hard
drive and run the software from that drive.

1.3.1 Install Perception
To install Perception in Microsoft® Windows®

1 Insert the Perception CD into your CD-ROM drive.
2 Click Next in the Perception AutoPlay dialog box. If the AutoPlay dialog box

doesn't appear, choose Start ► Run, enter d:setup.exe (where “d” is the
letter of your CD-ROM drive), and click OK.

3 Click Perception, read the information in the Setup dialog box, and click
Next.

4 Read the end user license agreement, select I accept... and click Next.
5 Enter the User Name and Organization. Click Next.
6 Choose which type of Perception installation you would like, there are three

choices:
Full install This installs a full version of perception with no limited
functionality. Also installs Offline and Freeview mode.
Offline install This installs Perception for offline use; prepare all
measurements as normal without connected hardware, you cannot record
when offline.
Free viewer install The Free viewer enables you to open, view, measure,
export and print Perception recordings.

7 Specify the type of installation you want:
l To use the standard installation, choose Typical.
l To use the complete installation, choose Complete.
l To install only particular components, or when you want to modify the

default installation location, choose Custom Install and select the
components and / or modify the installation location.

Note For a description of any component - and disk space required - that can be
installed, choose Custom Install to see a list of the components, and select
the component you want in the list. A description of the component appears in
the dialog box. In the Custom Install you can also verify the installation location.
To change the installation location, click Change, and specify a destination
folder.

8 Click Next, and follow the on-screen instructions to complete the
installation. When the process is complete, a message tells you that
Perception is installed. Click Finish.
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1.3.2 Conventions
Throughout this manual the software is described and depicted using
Windows 7. When required for Windows XP or Windows Vista, differences will
be explicitly stated.

When the wording “click Start....” is used, this refers to the Windows XP Start
button. In Windows Vista and Windows 7, the Start Menu has undergone some
significant changes, with the taskbar icon no longer labeled "Start" but simply
the pearl icon (of the window-frame in an orb).
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1.4 Starting Perception
To start Perception proceed as described in the following section.

1.4.1 Start Perception
The Perception software requires a HASP key. HASP (Hardware Against
Software Piracy) is a hardware-based (hardware key) software copy protection
system that prevents unauthorized use of software applications. You must have
the HASP®4 USB Token installed in a USB port before you can run the
software.

Figure 1.2: HASP USB Key example

To start Perception
l Choose Start ► All Programs ► HBM ► Perception ► Perception

When Perception is installed on a Dimension 4i or GEN5i, no external HASP
key is required. These instruments are equipped with a built-in HASP key.

1.4.2 Perception user modes
Perception allows for a number of different user modes. These user modes
pre-configure the Perception user interface to a layout that best suits the
selected situation.

When Perception has fully started you can navigate to the File menu then
Select User Mode, this is described in more detail in the chapter "Switch to
Instrument Panel" on page 45. From this menu you can select between all
Perception modes.

Commonly selected User modes are Single Sweep for transient applications
and Continuous for recorder applications.
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1.5 What's new in Perception
For detailed information of the new features of Perception please refer to:
www.hbm.com/perception

Note When you are using Perception Version 8, some of the information in this
manual may be outdated. Especially the acquisition modes described in chapter
"5 Acquisition Control and Status" on page 113 and appendix
"A Acquisition and Storage" on page 483 have been updated in Perception
Version 8. For more information on new acquisition modes, please visit the
Perception product page for the document “Perception V8 Acquisition Modes
Quick Start”.
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2 Perception Concepts
2.1 Introduction

Within the Perception application some concepts and terms are used that may
need an introduction. Knowledge of these concepts and terms is vital when you
want to gain maximum profit from Perception. It will also ease the operation of
the software.

When you do measurements, analysis and reporting there are a number of
procedures that you want to use more than once. Within these procedures there
are also a number of settings that you might want to save and recall.

Typical procedures / settings that you can save and recall in Perception are:

l Recorded data
l Hardware settings
l When options are installed:

l Report layout
l Formulas
l Settings from custom CSI projects
l And any other

These are the settings that you can store individually as well as combined.
Other settings can only be stored as part of a larger concept. In the following
sections we will describe the various possibilities.

Note Various file formats for storage are expanded over the years to include more
information. HBM, however, always strives for backwards compatibility as much
as possible. Therefore reading older files should always be possible although
they may not contain all the latest settings. In these situations warnings are
generated, but you can always use these older files and save them for upwards
compatibility.
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2.2 Virtual Workbench
A "workbench" is a way to save the way you arrange your tools and components
in a configuration that best suits your requirements.

l The Virtual WorkBench can be recalled whenever you like.
l Multiple workbenches can be created for various tasks.

The Virtual Workbench comprises the following components:

l Active display settings
l Hardware settings
l Information
l Formulas (option)
l Reports (option)
l User sheets
l As an option sheets can be organized in workbooks

The workbench defines your complete test environment without recorded data.
Some of the components can be saved individually.

2.2.1 Active display
The active display holds recorded or loaded data.

l The data can be referenced by display as well as by data source.

This allows you to perform operations on the currently active recording as well
as a fixed named recording. For example you can create a formula in the
formula database that references the “active” recording, regardless of the
physical location or file name. When new data flows in the active display, the
formula result is updated automatically.

The active display settings can not be stored independently, but are stored
when a virtual workbench is saved or with a recording.

When a virtual workbench is loaded, the active display settings are loaded as
well.For example when you connect the active display to a recorder and save
the workbench, reloading the workbench will recreate the active display with
the traces connected to that recorder.

2.2.2 User sheet
When you load the saved data into a new user sheet, the active display settings
are used to create the settings for the display in the new user sheet.
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User sheets are sheets created by the user in addition to the predefined sheets
as explained later on in this document. User sheets are not saved
independently, but are part of a virtual workbench.
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2.3 Individual storage of settings
Various settings can be stored individually in a separate file. These files can
easily be transferred between various uses of the application and/or computers.
For example when you have created a “standard” report for your company you
can save this and load it later on as a template for a specific test.

2.3.1 Hardware settings
The settings that define the hardware setup can be saved / loaded
independently from other settings. For example you might want to load a
workbench with the same test environment but alternative hardware settings
for a different test.

The hardware settings:

l define the complete hardware setup as specified in the settings sheet,
l can be stored in a separate file with the file extension .pset,
l are stored automatically when a workbench is saved and as part of a

recording,
l are loaded automatically as part of a complete workbench,
l can be extracted / loaded out of a workbench or recording as separate

settings,
l can be saved into a workbench or recording as separate settings.

2.3.2 Formulas
When the formula database is available (as part of the Advanced Analysis
option), the complete formula database with all functions can be saved and
reloaded.

The formula database settings:

l comprises all formulas/functions as specified in the formulas sheet,
l can be stored in a separate file with the file extension .pFormulas,
l are stored automatically when a workbench is saved and as part of a

recording,
l are loaded automatically as part of a complete workbench,
l can be extracted / loaded out of a workbench or recording as separate

settings,
l can be saved into a workbench or recording as separate settings.

2.3.3 Report layouts
When the Reporter is available (as part of the Report option), complete report
layouts can be saved and reloaded. This is the layout without the actual data
that might be in there.
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The report layout settings:

l comprise all settings of a multi-page report as specified in the report sheet,
l can be stored in a separate file with the file extension .pReportLayout,
l are stored automatically when a workbench is saved and as part of a

recording,
l are loaded automatically as part of a complete workbench,
l can be extracted / loaded out of a workbench or recording as separate

settings,
l can be saved into a workbench or recording as separate settings.

2.3.4 Information
By default a standard two-line information sheet is available. This can be
expanded by the Information option to create a freely configured information
tool.

The information settings:

l comprise all settings, fields and field values as set in the information sheet,
l can be stored in a separate file with the file extension .pInfo,
l are stored automatically when a workbench is saved and as part of a

recording,
l are loaded automatically as part of a complete workbench,
l can be extracted / loaded out of a workbench or recording as separate

settings,
l can be saved into a workbench or recording as separate settings.

2.3.5 Other optional software components
For details on settings of other optional software components refer to their
respective manuals.
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2.4 Experiment
As from version 4.0 the complete test environment including the recorded data
is stored in an experiment database file. The highest amount of data storage
space is used by the experiment.

Before version 4.0 recorded data and the test environment were two separate
files: a data file and a virtual workbench file.

l Data file The data file contains the actual data (or ‘waveforms’ or ‘traces’).
This data is automatically stored when a recording has been made. The
data files had an extension like .nrf or .dnrf or .pnrf.

l Virtual workbench The workbench defines your complete test
environment without recorded data.

As from version 4.0 the experiment concept is introduced: save and load the
recorded data complete with the test environment, i.e. the data file and the
workbench are combined into one file.

This file has the extension .pnrf like the classic data files. As from version 6.0
the file extension is .pnrf.

The load experiment command is the default operation to load data using the
Open... command.

To load the data only use the Load Recording... command with the ‘classic’
options As active, As reference or Using filename.

Note Various file formats for storage are expanded over the years to include more
information. HBM, however, always strives for backwards compatibility as much
as possible. Therefore reading older files should always be possible although
they may not contain all the latest settings. In these situations warnings are
generated, but you can always use these older files. Save them for upwards
compatibility.
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2.5 User interface modes
The Perception software is very sophisticated, has a variety of functions and
features and supports multiple hardware platforms with almost unlimited
capabilities.

To support all this the user interface is very extensive and may provide
information that you will never use or want to see.

To add a basic form of customization, Perception provides options to tailor the
user interface to your specific requirements: user modes for the complete
Perception application and a basic / advanced option for the settings sheet.

2.5.1 User modes
User modes are related to the type of application. You may be a typical transient
recorder user or a data logger user or somewhere in between or beyond.
Depending on the selection, sheets, functions or options may be not available.

In the application the following user/usage profiles are identified:

l Review The software is used to review data, maybe in combination with
analysis and reporting. No acquisition control or hardware settings are
required.

l Single sweep Typical transient recording usage. By definition each
recording comprises a single sweep (shot). No multi sweep settings or
multi-time base settings are required.

l Multi sweep Equals single sweep usage. Only now a recording can
comprise of multiple - triggered - sweeps.

l Slow-Fast sweeps Equals the multi sweep usage. Within a sweep time
base changes are possible (slow-fast-slow, also known as A-B-A).

l Continuous Typical recorder or data logger usage. The acquisition is a
single continuous recording on a single time base.

l Dual Continuous acquisition combined with one or more sweeps within a
single recording.
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When Perception has been started, navigate to the File menu and to Select
User Mode.

Figure 2.1: File menu with Select User Mode option

A Select User Mode

You will be presented with a submenu of options. Select one of these options
to change user mode in Perception without the need to exit the application.

2.5.2 Perception Start-up
You may turn on the user mode selection dialog, which is now off by default,
during Perception start-up.

Navigate to File ► Preferences: Perception ► Start up and select Show User
Mode selection dialog, which appears at start-up. When Perception starts,
you will be presented with the following dialog:
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42 A02689_09_E00_00   HBK: UNRESTRICTED



Figure 2.2: Perception User Mode dialog

Select your user mode in this dialog. Use the question mark buttons to get more
information about a specific mode. When you've made your selection, click
OK.

By default, the dialog above (Figure 2.2) does not appear at start-up. Select the
Remember my selection if you want your selection to be the default at start-up.
If you want to omit this dialog at start-up, select the Don’t show this dialog
again option.

Offline mode start-up has now moved to a separate application. Please see
chapter “Offline Setup & Configuration Manager” on page 522 for further details.

To change the default start-up behaviour, you can define a Quick Start: each
time you start up Perception, your personal configuration will be loaded
immediately.
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Quick Start
Use Quick Start to intialize the software without the User Mode and Start
selection dialogs.
Use the Create command to use the current work environment as the preferred
start-up state.

To set up your Quick Start:
1 Start the software
2 Set up your work environment
3 On the File menu and click Preferences
4 In the Preferences dialog, select Start up
5 Under Quick Start, select the Use Quick Start check box
6 To create a new Quick Start configuration, click Create
7 Click Apply or OK to confirm

Figure 2.3: Preferences dialog with Quick Start area

A Quick start area
B Start-up: Click Start up in the tree view to open the Quick Start area.
C Use Quick Start: Select the Use Quick Start check box to enable the

Create button.
D Create: Click the Create button to create a new Quick Start file using your

current configuration.
E Information on the quickstart file currently being used.
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To disable Quick Start:

1 On the File menu, click Preferences
2 In the Preferences dialog, select Start up
3 Under Quick Start, click to clear the Use Quick Start check box
4 Click Apply or OK to confirm

Start Perception in a specific mode
Perception can also be started in other modes. To start Perception in a specific
mode:

1 On the File menu, click Preferences
2 In the Preferences dialog, select Start up
3 Under User Mode, select your preferred Default User Mode
4 Click Apply or OK to confirm

2.5.3 Switch to Instrument Panel
To switch to the Instrument Panel, navigate to the File menu and then select
Switch to Instrument Panel.

Note Switching to Instrument Panel mode menu item is only visible if Instrument
Panel mode is available.

Figure 2.4: Switch to Instrument Panel option

A Switch to the Instrument Panel
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To start Perception in the Instrument Panel mode:

1 Click Preferences... in the File menu.
2 Select Start up in the tree view of the Preferences dialog.
3 In the User Interface Mode, drop down list box select the Instrument

Panel mode.

A Instrument Panel mode

2.5.4 Settings sheet layout modes
The hardware controlled by Perception can have numerous settings. Already
the settings are grouped into logical units to allow for a better overview of related
settings.

Apart from this logical grouping it is also possible to show or hide settings within
a group that are not relevant for basic operation of the instruments.

When the settings sheet is visible you can switch between the basic and
advanced mode.

To set or switch the settings sheet layout modes:

1 In the main menu select Settings.
2 In the Settings menu select Show Settings ► .
3 In the submenu select:

l Basic: this will show only the relevant settings
l Advanced: this will show all settings

4 Or, when visible, use the toolbar icon to set the mode:
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2.6 Data sources

Introduction
One of the central concepts of Perception is the data source. Data sources are
the generic mechanism that allows data visualization components to access
data and all kinds of different hardware to deliver it.

Figure 2.5: Data sources
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2.6.1 Data source types
In general there are four different kinds of data can be supplied by a data
sources:

l Waveform data:
A collection of values in which each value on the Y-axis can be projected
against one specific value on the X-axis.

 l If the values on the X-axis are placed at equal distances (equidistant),
this is typically synchronous data.

l If the values on the X-axis are not placed at equal distance, this is
asynchronous data.

l Digital waveform data:
Same as standard waveform data. Values are restricted to High or Low.

l Numerical data:
Single numerical value. The source of the data may represent a single point
in time but may also be the result of an operation that combines multiple
values into a single result, for example formulas and user variables.

Note May be integer or floating point data.

 l String data:
Textual information
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2.6.2 Where are data sources used
Data sources can be used as input for further operations, or can be visualized.
See the tables below how different types of datasources can be visualized in
Perception.
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Time display(2) YES YES YES YES NO NO

XY-display(2) YES YES YES YES NO NO

Spectral display(2) YES YES YES YES NO NO

User table NO NO NO NO YES YES
Meter NO NO NO NO YES YES

Report(3) YES YES YES YES YES YES

Image NO NO NO NO NO NO

(1) A-synchronous data may be synchronized in case an operation only
supports synchronous data. In this case the operation may take more time
as expected.

(2) These components have both live and review operational modes. Not all
mainframes support live data, or live data for spectral/XY displays.

(3) The report allows visual representation of all data types. However special
containers are required to show specific data source types. For more
information, refer to the report option manual.
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Data source can also be used as input for further processing, the following table
shows which data sources can be used for which operations.
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Export YES YES YES YES YES(2) YES(2)

Automation(2) YES YES YES YES YES YES

Formula
database(2)

YES YES YES YES YES YES

User actions(2) YES YES YES YES YES YES

Display markers NO NO NO NO YES YES
Logging NO NO NO NO YES YES
Applications YES YES YES YES YES YES

(1) A-synchronous data may be synchronized in case an operation only
supports synchronous data. In this case the operation may take more time
as expected.

(2) Depending on which specific part of the feature that is used these certain
data sources may or may not be available.
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2.6.3 Data source naming
Data sources are uniquely identified in the system by their path. This path
typically also indicates where the data from the data source originates from.
Some examples of this are:

Raw samples:
Active.<GroupName>.<RecorderName>.<ChannelName>

Live parameters:
Active.<GroupName>.<RecorderName>.<ChannelName>.
<ParameterName>

Formula database:
Formula.<FormulaName>

Information sheet:
Active.Information.<PartOfInformationSheet>

Display related:
Display.<DisplayName>.<PartOfDisplay>.<IndividualValue>

System:
System.<SystemConstantName>

Hardware diagnostics:
Hardware.<MainframeName>.<HardwareComponentPath>

Application sheet:
<ApplicationPrefix>.<DatasourceName>

User defined:
<Any>

By using fixed prefixes for different types of data sources, duplicate names are
less likely; however there are still a number of operations that may cause
duplicate names:

l Renaming a channel.
l Renaming a recorder.
l Renaming a mainframe in case of multiple mainframes.
l Adding a recorder to a group

(happens automatically upon connecting to a mainframe).
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In these cases Perception will not deny a renaming request, but will ensure that
no duplicate names exist. As the rename request is always accepted, the
existing duplicate name is always renamed. Typically this is achieved by adding
an “$1” or other sequence number at part of the path that was duplicated. For
example:

Consider a recorder (Recorder A) in group 1 with two channels:

l Channel A with user name: Current
l Channel B with user name: Channel A2

These two channels will have the following data sources exposing their data:

l Datasource 1: Active.Group1.Recorder A.Current
l Datasource 2: Active.Group1.Recorder A.Channel A2

Now if the second channel is renamed into Current as well, this will be the end
result:

l Channel A with user name: Current$1
l Channel B with user name: Current

With the following datasources:

l Datasource 1: Active.Group1.Recorder A.Current$1
l Datasource 2: Active.Group1.Recorder A.Current
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Within the formula database another mechanism is used to prevent
datasources with duplicate names. The formula database will deny a formula
from being created if another formula with that name already exists, instead it
will automatically create a new name that does not exist yet and show the new
name.

Figure 2.6: Automatically renaming

Note In case a custom application is running inside Perception, that application is
responsible for not introducing duplicate names. A recommended way of
working is to introduce a unique prefix for the application.

2.6.4 Restricted characters
When (re)naming channels and other elements that publish data through data
sources most characters are allowed. There are a number of characters that
are not allowed because they are reserved for specific operations within the
application.

Restricted characters:
! Exclamation point
. Full stop
 Space
, Comma
+ Plus sign
– Minus sign
* Asterisk
/ Slash mark
< Less than sign
> Greater than sign
@ At sign
; Semicolon
[ Left square bracket
] Right square bracket
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Restricted characters:
{ Left curly bracket
} Right curly bracket
( Left parenthesis
) Right parenthesis
” Quotation mark

In case any of these characters is used in a name, it will typically be replaced
by and underscore character (‘_’).
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3 The Work Area and Generic Procedures
3.1 Introduction

The Perception work area can be arranged to help you focus on your
measurement task. It uses the concept of a "workbench" where you arrange
your tools and components in a configuration that best suits your requirements.
This Virtual WorkBench can then be saved and recalled whenever you like.
Multiple workbenches can be created for various tasks. For more details on
virtual workbenches refer to "Virtual Workbench" on page 36.

3.1.1 Start dialog options

1 Connect the GEN series system to the Perception PC and start Perception.

Note Perception can be adapted to meet personal wishes. The Getting started
sequence is described using the default installed selections.

2 The user mode selection dialog appears (see Figure 3.1):

Figure 3.1: Perception User Mode dialog
 User modes are explained in the Perception Data Acquisition Software

manual. For this section about getting started, the system defaults are
used.
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 Click OK to continue.
3 Perception will continue to start. To continue, Perception will ask which job

it should perform (see Figure 3.2):

Figure 3.2: Perception job dialog

A Set up an auto-configured Experiment
 In the dialog select:

Set up an auto-configured Experiment Let Perception search for
connected acquisition hardware and create a default layout. Optionally you
can select and reset hardware. When this option is selected, Perception
resets the hardware and restores the factory default settings in the
mainframe.
Click Continue. This will show a selection of mainframes (see Figure 3.3)
or automatically make a selection if only one mainframe is available.
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Figure 3.3: Mainframe selection

From the list of available mainframes, select the mainframe(s) required for
the experiment. Click OK to continue.

 When using the mainframe for the first time, the IP address should have
been dynamically assigned. This ensures that the IP address matches the
PC if the PC network settings are also configured dynamically. However,
if the mainframe or PC is configured to a static IP-address, the two
networks may not match. The list of available mainframes shows every
HBM mainframe supported by Perception, even if network settings do not
match.

Start dialog options summary
Summarized the Start dialog provides the following experiment options:

Load VWB
environment

Load hardware
and connect

Load data

New blank
Auto default search and select
Auto + reset default search, select and

reset
Redo √ √
Redo + data √ √ √
Review √ √
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3.2 Getting familiar with your work environment

3.2.1 About the work area
The Perception work area is arranged to help you focus on your work. The work
area consists of the following components:

Figure 3.4: The Perception work area

A Menu bar

B Toolbar

C Palette

D Hidden palettes

E Status bar

F Sheet area

G Tabbed sheet

H Dynamic toolbar

I Dynamic menu
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A Menus The menus in the menu bar contain commands for performing
tasks.

B Toolbar The icons in the toolbar provide quick access to commonly
used commands.

C - D Palette A number of palettes are available. Palettes are auto-hide and
pinnable floating windows that can be docked on various positions.
These windows provide access to commands and operations that
constitute your typical work environment.

E Status bar The status bar is used to provide additional information.
F- G Sheet area The main part of the work area is occupied by sheets.

Sheets provide an interface to a variety of functions, for example
display of data, modification of settings, analysis, reporting, etc.
l Sheets are now managed with the Sheet Menu item Sheet

Manager. Sheet Manager gives you complete flexibility on what
sheets are loaded on start-up and what sheets you want to be
active or not. For more information please see "Sheet
management feature" on page 72.

H Dynamic menu Each sheet has its own proprietary menu that contains
commands related to the visible sheet.

I Dynamic toolbar Each sheet has its proprietary toolbar that contains
commands that are applicable to the visible sheet.

3.2.2 Notifications
A notification informs you of system events that are not related to the current
user activity. It can also provide you with useful and relevant but typically not
critical information. The notification could result from a user action or significant
system event, or could offer potentially useful information from the Perception
application.

The notification is made through a window briefly displayed from the notification
icon in the status bar. Notifications are displayed for a fixed duration of 9
seconds. After that they disappear.

 The notification icon is highlighted when a notification has occurred. When
the icon is dimmed there is no notification active.

When using sheets and automation it is increasingly common for tasks to run
in the background. Using notifications for such tasks (for example analysis)
leaves you, the user, in control.
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Figure 3.5: Notification warning

In this example, Perception notifies the user that the connection to fiber channel
Ch F1 is present.

When you click on the notification icon, a dialog comes up with the latest
(unread) notifications. This will also clear the notification icon.

When you close the dialog, this list of latest notifications is cleared.

Figure 3.6: Recent Notifications

A history of all notifications are available through an xml file called
“Notifications.xml”. You can open and read this file with an xml viewer or use
the Perception Diagnostics Viewer.

To read the history of notifications using the Perception Diagnostics
Viewer:
1 If not already available, add the Diagnostics Viewer sheet: In the Sheets

menu point to Diagnostics Viewer, if the sheet isn't available click Manage
Sheets and Load the Diagnostics viewer.

2 On the Diagnostics Viewer menu click Open Diagnostics.
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3 In the Open dialog box select Notifications.xml and click Open.
Now you see the notification history.

4 Use the chevrons (arrows) to slide open a surface to show remaining items
in hidden content.

To read the history of notifications using an external application:
1 On the Help menu click Open Perception Diagnostics Folder.
2 In Windows® Explorer double-click the Notifications.xml file.
3 Your xml viewer will open the xml file.

3.2.3 Choosing commands
Commands let you perform a wide variety of tasks. Perception provides several
ways to choose commands:

l The menus at the top of the work area provide access to commands. If a
command is dimmed in a menu, it isn’t applicable to the current operation.
For instance, a command may only work on a selected object, or a particular
kind of object.

l Shortcut menus drop-down when you right-click on an object or window
region that supports a shortcut menu. They display a small set of
commands and options related to the current context. Therefore they are
also referred to as context menus.

l Keyboard access keys also provide access to commands. However, don’t
confuse access keys with shortcut keys. While both access keys and
shortcut keys provide keyboard access to user interface, they are different.
Access keys have the following main characteristics:
l They use the Alt key plus an alphanumeric key.
l They are assigned to all menus and most dialog box controls.
l They aren’t intended to be memorized, so they are documented directly

in the user interface by underlining the corresponding control label
character.

l They have effect only in the current window, and navigate to the
corresponding menu item or control.

l Keyboard shortcuts let you quickly execute commands without using a
menu. When available, the keyboard shortcut appears to the right of the
command name in the menu.

l A toolbar is a graphical presentation of commands optimized for efficient
access. When available they let you quickly execute commands without
using a menu.
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3.2.4 Modifying color
In various locations you can modify the color of objects. The following diagram
shows the various controls used to modify a color.

Figure 3.7: Color selection

A Color drop-down box

B Summary of available colors

C Color dialog box

D Color pointer

E Color matrix

F Luminosity slider

To modify a color:

The following procedure describes the general line for modifying colors:

1 Click on the color drop-down box A.
2 In the summary of available colors B:

l Click on a color to select it, or
l Click on More... to select another color
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3 When you want to select another color in the Color dialog box C, click on
a color from the list of Basic colors, or click anywhere in the color matrix
E on the right and:
l Drag the color pointer D in the color matrix to the right or left to change

the hue.
l Drag the color pointer in the color matrix up or down to change the color

saturation.
l Drag the slider F at the right of the matrix to change the luminosity.
l Once you have defined the color you want, click Add to Custom

Colors.
4 Click OK.
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3.2.5 Insert and format a data source
In various locations of Perception, for example the User Tables, you can insert
and format a data source in a single operation. This option is available if the
data source that you want to insert is a numerical value or a text string, not a
waveform. These data sources are also referred to as variables. You can enter
variables in various text areas. Variables can be combined with plain text.

To insert and format a data source/variable
1 If applicable, position the text cursor on the insertion point in the text area

where you want to enter the variable, for example an empty cell in the User
Table.

2 Click Insert Data Source. The Insert Data Source dialog box will come up.
3 Make your selections and click OK when ready.

A Data source selection area

B Insert parameter

C Value properties

D Output string and sample

A Data source Select the data source in the tree view that you want to
insert.
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B Insert You can choose which information of the data source you want to
insert.

l Value Actual value of the data source.
l Name Name of the data source as it is shown in the tree view.
l Units Units in which the data source is measured.

If you do not select any of the three options the value will be used as
default.

C Value properties Select from multiple output formats:

l Integer: Number with no decimals.
l Floating Point: Number with decimals, without fixed “layout”.
l Fixed Point: Number with decimals, fixed number of places before

and after the decimal separator.
l Scientific Notation: Shorthand way of writing very large or very small

numbers. A number expressed in scientific notation is expressed as
a decimal number between 1 and 10 multiplied by a power of 10.

l Engineering Notation: Scientific notation in which the power of ten is
a multiple of three. The power of ten is represented by SI prefixes
such as Mega (M), Kilo (k) or Milli (m).

D Output In this area you see an example of the actual output as well as
the internal format string of the placeholder.

For each selection you make in the Insert Data Source dialog an example
of the output and the corresponding placeholder is given, using the
selected data source.

When you close the dialog, the text area will be updated with the
information provided. Depending on the situation you may also need to
close a properties dialog of the selected text area. If no actual data is
available, for example because a recording has not been made yet, the
placeholder will be shown. After the recording, the actual data will be filled
in.
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3.3 Using palettes
Palettes are floating windows that can be docked (pinned) in various positions
and provide auto-hide functionality. These windows provide access to
commands and operations that constitute your typical work environment.
Examples of palettes are:

l Control All - Acquisition Control
l Battery Status
l Recordings
l Hardware

Palettes can be shown, hidden, moved, docked, etc.

3.3.1 Showing and hiding palettes
You can display and hide palettes as you work.

To show or hide a palette:

Do one of the following:

l In the menu bar choose Window ► [palette name]. A check mark appears
next to the palette that is currently visible - either open or auto-hidden.

l When open click the top right button to close it.

l To auto-hide a palette it must be open and docked. Click the auto-hide
button. The palette will auto-hide when the mouse pointer leaves the palette
area.

l Click on a tab of the ‘hidden’ palette to let the palette slide open.
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3.3.2 Moving, docking and sizing palettes
You can move palettes to any position on the screen where they can stay as
floating windows, or you can dock a palette to a fixed location.

To move a palette:

1 Make sure the palette can be moved: clear the auto-hide feature.
2 Click on the title bar of the palette and drag the palette to a new location.

To dock a palette:

1 Make sure the palette can be moved: clear the auto-hide feature.
2 Click on the title bar of the palette and drag the palette. While dragging a

transparent docking context (B) will shade the area that the docking palette
can occupy. Docking stickers (A) will visually display where the docking
palette can be docked by displaying stickers that point to the appropriate
locations.

Figure 3.8: Palette position main area
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3 Position the mouse pointer on one of the stickers and release the mouse
button to dock the palette. You can either dock in the main area (see
Figure 3.8 on page 67) or relative (see Figure 3.9) to an already docked
palette.

Figure 3.9: Palette position relative

The inner arrowed docking icons will place the palette on the inside of the
main window/selected area and the outer arrowed docking icons place the
palette on the outside of the main window/selected area.

When a palette is floating you can control the size of a palette as well as how
many options appear in it.

To change the palette size:

l To change the size of the palette, drag the lower right corner of the palette,
or one of the sides.
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3.3.3 Tabbed grouping
You can group palettes in a tab style arrangement and display them in any
arrangement docked to any side of the work area. The docking palettes can be
grouped together or docked inside one another to make the best use of the
work space.

When grouped, the group behaves as a single palette.

To group palettes:

1 Click on the title bar of a palette and drag it to another palette.
2 A tabbed icon sticker will be displayed in the center of the docking stickers.

A transparent docking context (B) will change into a tabbed style palette
when you can group it.

3 Release the mouse button on the central icon (A) and the palettes will be
grouped together with tabs (C) on the bottom.

To switch between palettes in a group:

l Click on the tabs to switch between the palettes.

To remove a palette from a group:

l Grab a palettes tab and drag the palette outside the group.
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3.4 Using toolbars
A toolbar contains (buttons with) images that provide quick access to commonly
used commands and operations. Perception includes various built-in toolbars
that you can show and hide as needed. By default, all built-in toolbars are
docked side by side below the menu bar.

Some information (buttons) in the toolbar depends on the selected sheet. This
is the dynamic toolbar.

Figure 3.10: Perception toolbar (example)

A Toolbar grip (handle)
B Toolbar area
C File toolbar
D Acquisition control toolbar
E Zero Balance toolbar
F Logfile toolbar
G Dynamic toolbar/Information sheet including:

H Display/setup
I Cursor control
J Marker control

Toolbars can be repositioned:

l Below or above the menu bar.
l In a multi-line arrangement to save horizontal space.

To show or hide a specific toolbar: 

To show or hide a specific toolbar do one of the following:

l Using the toolbar area:
1 Right-click the toolbar area.
2 In the context menu that comes up click the toolbar that you want to

show or hide.
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l Using the Window menu:
l In the menu bar choose Window ► Toolbars ► [toolbar]. A check mark

appears before a toolbar that is currently visible.

To move a toolbar to another position: 

l Click on the grip (handle) of the toolbar, and then drag the toolbar to a
different location.
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3.5 Working with sheets
The main part of the work area is occupied by sheets. Sheets provide an
interface to a variety of functions, for example display of data, modification of
settings, analysis, reporting, etc.

3.5.1 Introduction
Sheets can be divided into the following categories:

l System sheets These sheets provide specific user interfacing for
Perception standard and optional features.

l User Sheets You can add as many user sheets as you want. These sheets
can be deleted.

l CSI Sheets With the Custom Software Interface (CSI) option you can
create your own plug-in for the Perception software. The graphical user
interface of this plug-in is based on sheets. In your application you define
the behaviour of the sheet.

3.5.2 Sheet management feature
The following feature is a management tool that allows the user complete
freedom to organize and display the sheets in Perception.

For improved management of the Perception work space, the Sheet
management feature will help personalize Perception quickly and easily.

A menu bar Item “Sheets” is now available; it contains all of the functions and
commands related to sheet selection and also the Sheet Manager.

The Sheet menu provides the ability to:

l Load and Unload sheets from the Perception Engine at any time
l Set the default value for all sheets on start-up
l Show or hide loaded sheets
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Sheets that have a check-mark beside them are loaded and showing in
Perception, sheets that do not have a check-mark are loaded but hidden. The
New User Sheet command is now also available in this menu.

Figure 3.11: Sheets menu

1 In the menu bar click Sheets
2 Select Manage sheets to open the Sheet manager interface.
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Figure 3.12: Sheet manager

1 Click to highlight the sheet to be changed
2 On the left you will see a short description of the sheet, and above are two

buttons:

Loads a sheet into the Perception engine. When a sheet
is loaded, you can select whether or not it shows as an
active sheet.
Remove will unload the sheet from the Perception
engine immediately. It will not be visible until reloaded
with Load.

Startup default  includes a drop down selection box in which you can select
the Startup default of the selected sheet.

When Perception starts a sheet can be started in either of the following modes:
Hidden, shown or unloaded.
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3.5.3 Sheet commands and options
Sheets by themselves can have various commands and options. These can be
generic or pertinent to a specific sheet.

To access the sheet commands and options do one of the following:

l Select a command from the dynamic menu or a sub menu.
l The toolbar provides a selection of commonly used commands. Click the

command to execute.
l Right-click the sheet tab. In the context menu that comes up select your

command or option.

3.5.4 Active and user sheets
For display of data the active and user sheets are used.

The active sheet is always available and cannot be deleted. It is a special sheet
that by default has a single display that shows the active recording. The active
recording is usually the recording that is being acquired or reviewed. If new data
comes in (from the hardware), it shows up in the display that is on the active
sheet automatically. You can re-arrange the layout of the active sheet when
required.

Figure 3.13: Active sheet default layout (example)

For additional flexibility user sheets are provided. On a user sheet you place
various objects like waveform displays, meters, images, etc. You can add
multiple sheets, each with their own layout and content. This allows you to
define various layouts for various parts of a measurement task and quickly
switch between them.
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To add a user sheet:

To add a user sheet do one of the following:

l In the menu bar choose Sheets ► New User Sheet.
l When visible, in the file toolbar click the New Sheet button  . In the drop

down list select User Sheet.
l Right-click a sheet tab or in the sheet tab area. In the context menu that

comes up select New Sheet ► User Sheet

Layout and splitters
By default a user/active sheet is a single area in which you can place a single
object: display, meter array, picture or video. To add more objects to a single
sheet you can modify the layout of a sheet to include up to 4 sections. Each
section can contain one object. Sections are separated by splitters. The splitters
can be moved to resize the sections.

To modify the layout of a sheet:

To divide a sheet into two or more sections do one of the following:

l In the menu bar choose [dynamic menu] ► Sheet Layout and select one
of the presented options in the submenus.

l When visible, in the dynamic toolbar click the Sheet Layout button  . In
the drop down list select one of the presented options in the submenus.

l Right-click in an empty sheet area. In the context menu that comes up
select Sheet Layout and select one of the presented options in the
submenus.

Note When you modify the number of sections within a sheet, layout options may be
lost.
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Figure 3.14: Sheet layout select example

Once a layout is selected for a sheet, splitters appear that divide the sheet into
sections. These splitters can be freely moved. When you hover the mouse over
a splitter, the mouse pointer will change into a pointer with arrows. The arrows
point in the direction that you can move the splitter. Click and drag the splitter
in the required direction.

The following cursor icons are used:

When this cursor shape is visible you can move the splitter that divides
the sheet area horizontally.

When this cursor shape is visible you can move the splitter that divides
the sheet area vertically.

Four way splitter icon: this icon appears when you are in the vicinity of an
intersection of a horizontal and vertical splitter. You can now freely move

both splitters at the same time.

3.5.5 Sheets and workbooks
As standard Perception has one workbook that contains all the sheets that are
available. As an option Perception allows you to create multiple workbooks.
When this option is installed you can create new workbooks, delete, copy and
paste workbooks. Workbooks can be placed anywhere on your screen or
secondary monitor(s). You can move sheets from one workbook to another
workbook.
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To move a sheet:

To move a sheet to another workbook do one of the following:

l In the menu bar choose [dynamic menu] ► Move sheet [sheet name] to
► and select one of the presented options in the submenu.

l Right-click the sheet tab. In the context menu that comes up select Move
sheet [sheet name] to ► and select one of the presented options in the
submenu.
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4 Navigator Panels
4.1 Introduction

Navigators within Perception are used to easily find your way through the
various data originators. A navigator resembles Windows® Explorer with paths
and folders to the various data sources. While Windows® Explorer only deals
with files, the Perception navigators allow you to browse files, hardware,
variables, etc. Navigators are organized as palettes. For details on palettes
refer to "Using palettes" on page 66.

For ease of use the Navigators are split into three classes:

l Hardware The hardware navigator lists all available hardware within a
network. This includes all mainframes that you use, that are in use by
somebody else or are not in use at all. This is also the place where you can
select (connect to) the hardware that you want to use for a specific
experiment. A tree structure provides the possibility to go down to the
channel level for detailed information.

l Recordings The recordings navigator lists all available recordings.
Recordings can be physically stored in archives on your PC or network,
cached in acquisition hardware, or referenced by Perception.

l Data Sources The data sources navigator allows you to browse and
access all data that is available within Perception. This can be referenced/
opened recordings, (system) variables, formula results, etc.

l Sensors The sensors navigator lists all available HBM sensors and User
sensors (optional). You can browse and access all sensors within the
Perception Sensor Database.

Figure 4.1: Perception navigators

In addition a Properties window is available that shows details - when available
- of the selected item within a navigator.
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4.2 Hardware navigation
Data acquisition hardware within Perception is based on the concept of a
recorder. A recorder consists of a number of acquisition channels that share
the same basic recording parameters sample rate, sweep length and pre- and
posttrigger length. Usually a single recorder is physically identical to a single
acquisition card.

Multiple recorders can be placed in a single mainframe. The mainframe is the
housing for the recorders, provides the power and includes the interface for the
local area network. A mainframe has its own network address (IP address).

Within the Perception software recorders can be combined into logical groups
for easy reference. Recorders within a group are not bound by physical
mainframes.

The navigator uses a Tree View to display the various items as an indented
outline based on their logical hierarchical relationship. The Hardware section
displays the acquisition unit(s) currently visible to Perception . All recognized
systems on your network are automatically displayed. The list is divided into
two categories: Used Hardware and Unused Hardware.

The Used Hardware entry displays the acquisition units currently connected to
Perception for data acquisition.
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The Unused Hardware entry shows mainframes that are available on the local
area network to be connected to the Perception software. Mainframes that are
found on the network but are already in use are greyed out.

Figure 4.2: Hardware tree with mainframes (detail)

A Unused hardware

B Used hardware

C Wake-on-LAN hardware

D Manually added hardware

E Detected hardware with a potential problem

A Unused hardware available for connection.
B Used hardware used by another user (user name in brackets). It is not

possible to connect to this hardware until the other user has disconnected
from it. Perception will be automatically updated when this occurs.

C Wake-on-LAN hardware; this hardware was previously detected with
Wake-on-LAN, but is now no longer detected on the network. Connecting
to this device will first attempt to power it on via Wake-on-LAN. If successful
it will connect normally, if the device does not startup the connection will
fail. Connecting to this type of mainframe will typically take longer than
connecting to hardware that is already running.
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D Manually added hardware, it is possible to add manual GEN series
mainframe configurations. Mainframes added manually will be shown like
this. For more information, please refer to "Add an unlisted system" on
page 87

E Detected hardware with a potential connection and/or configuration
problem. When connecting to the hardware you will be shown a dialog to
resolve the detected issue. For more information, please refer to "Network
conflict" on page 84.

You can select to show or hide the unused hardware section.

To show or hide the unused hardware:

1 Right-click anywhere in the hardware navigator.
2 In the context menu that comes up select Show Unused Hardware.

Figure 4.3: Hardware navigator menu

4.2.1 Add and remove a data acquisition system
When the Unused Hardware section is visible you can add data acquisition
systems to be used with your test. When you add a system you will also
automatically connect to that system and communication is started.

To add a data acquisition system:
To add a data acquisition system do one of the following:

l Click on a mainframe listed in the Unused Hardware section and drag it
onto the Used Hardware section.

l Select a mainframe listed in the Unused Hardware section. Double-click on
this selected mainframe.

l Select a mainframe listed in the Unused Hardware section. With a right
mouse click call up the context menu. In this menu select the Connect
command.
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l The mainframe will be added to the Used Hardware section. Recorders will
be grouped together, based on their time-base settings. So all 1 MS/s
boards will be placed into a single group, and all 250 kS/s boards will be
placed in another group. If a group with the same time-base setting already
exists, the recorder will be added to it, even if it contains recorders from
another mainframe.
 

Note When using multiple mainframes, recorders maybe automatically renamed
when placed in the same group to avoid naming conflicts.

To see individual recorders expand the mainframe tree by clicking on the
+ sign to the left of the mainframe or group entry.

When the mainframe is transferred to the Used Hardware section, a connection
dialog will come up, showing the progress in establishing the connection.

Figure 4.4: Hardware connection status dialog

In the Connecting Hardware dialog: 

l Click Close when connection has finished successfully.
l Click Show Diagnostics when you want to see an overview of the

connection procedure. This may be useful when connection failed.
Selecting this command will open the Diagnostics Viewer sheet.

l Select Automatically close this dialog when connection has finished
successfully when you want this dialog to close automatically when
connection has finished successfully.
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Figure 4.5: Diagnostics Viewer sheet (example)

Network conflict
If a network setting conflict is detected, this conflict must be resolved before the
connection can continue. The Perception Connect dialog appears (see
Figure 4.6).

Initially, the dialog appears with the settings currently used by this mainframe,
i.e. the ones containing the conflict. Make the changes required to resolve the
conflict and click Continue to complete the connection process.

Note If the conflict has not been properly resolved, this is indicated in the diagnostics
overview. The hardware is still shown in Unused Hardware in this case. By
connecting to the hardware again, the Perception Connect dialog will appear
again.
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Figure 4.6: Perception Connect dialog

A Description of the connection and/or configuration problem encountered
by Perception.

B Mainframe name The name of the mainframe on which the problem was
encountered.

C DHCP To configure for dynamic addressing (recommended default), click
for the mainframe to obtain an IP address automatically, and then click
Continue.

D Fixed IP address To configure for static addressing, click Use the
following IP address, and in IP address and Subnet mask type the IP
address and subnet mask to match the settings of the network adapter
installed in the PC running Perception

E Network adapter information List of available network connections of the
PC running Perception. In Windows®, check the detailed settings of the
network adapter. Make sure that the network adapter settings in the
mainframe match the settings in the PC.

F Click Cancel to stop the connection process for this mainframe.
G Click Continue to apply the changes and to continue the connection.
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If a reboot of the system is required to apply the new network settings, this will
be done automatically. The progress window (see Figure 4.7) will close
automatically when the mainframe has been rebooted.

Figure 4.7: Perception progress indicator for mainframe reboot

To remove a data acquisition system:
To remove a data acquisition system from the list of used hardware do one of
the following:

l Click on a mainframe or group listed in the Used Hardware section and drag
it onto the Unused Hardware section.

l Select a mainframe or group listed in the Used Hardware section. With a
right mouse click call up the context menu. In this menu select
Disconnect (for mainframes) or Remove (for groups). The mainframe will
be moved to the Unused Hardware section.

When you are not sure:
When you are not sure if all systems are listed do the following:

1 Make sure the Unused Hardware entry is available.
2 Right-click the Unused Hardware entry.
3 In the context menu that comes up click Scan for Mainframes. 

Password protect a system
Control access to a mainframe can be password protected. Refer to the user
manual that came with your acquisition system for more information on this
topic. From Perception you can modify this password.

To modify a mainframe password:

1 Make sure you are in mainframe mode - right click in the Hardware palette
and select Mainframe view - and that your hardware is listed in the used
hardware section.

2 Right-click the mainframe that you want to modify.
3 In the context menu that comes up click Change Password...
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4 In the dialog that comes up enter the old password and the new password.
Type the new password also in the Retype password field.

Figure 4.8: Change Password dialog

5 Click OK to effectuate the changes or Cancel to close this dialog without
modifications.

Add an unlisted system
The Perception software can locate known acquisition systems that are on the
same network. When a system is located behind a network firewall it cannot be
found by automatic detection.

To add an unlisted system:

To connect to a system that is not shown in the Unused Hardware section
proceed as follows:

1 Make sure the Unused Hardware entry is available.
2 Right-click the Unused Hardware entry.
3 In the context menu that comes up click Add Configuration ...
4 In the dialog that comes up enter a name for the mainframe and the correct

IP-address.

Figure 4.9: Add Configuration dialog

5 Click OK when done or Cancel to quit without modifications.
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Enable and disable individual recorders
You can re-arrange the configuration of recorders within the Used Hardware
section as described later. You cannot move individual recorders from the Used
Hardware to the Unused Hardware. When you do not want to use a specific
recorder you can disable this recorder and enable it again when you want to
use it.

You can also access this setting through the Settings sheet.

Enabling and disabling individual recorders:

To enable and disable individual recorders proceed as follows:

1 Make sure you can see the individual recorder(s). If not so, expand the
group or mainframe tree by clicking on the + sign on the left side of the
group or mainframe entry.

2 When enabled select Disable to disable the recorder. The recorder will be
disabled and automatically removed from its current group and moved to
the disabled group. Another way to disable recorders is to drag and drop
them into the disabled group.
When disabled select Enable to enable the individual recorder. The
recorder will be added to a newly created group. Another way to enable a
recorder is to drag and drop it to an enabled group. The recorder icon will
reflect the state of the recorder.
 

Note A recorder can only be added to a group that is set to a sampling rate it
also supports. E.g. it is not possible to add a 1 MS/s recorder to a group
that is set to 100 MS/s. When adding a recorder to a group, its sampling
rate is automatically adjusted to the sampling rate of that group, also its
sweep/continuous settings are automatically adjusted.

Perception

88 A02689_09_E00_00   HBK: UNRESTRICTED



4.2.2 Firmware upgrade
If a new version of Perception has been installed, the Firmware will be
upgraded. See the following steps with an example of a GEN series mainframe
for further information.

1 Perception has detected that an update is required.

Figure 4.10: Firmware upgrade (Step 1)
 
Click OK to continue with the next step.

WARNING

DO NOT POWER OFF OR UNPLUG YOUR SYSTEM WHILE IT IS
UPDATING.
THE MAINFRAME CAN BE DAMAGED.
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2 The update is in progress. Please wait for the next step.

Figure 4.11: Firmware upgrade (Step 2)

WARNING

DO NOT POWER OFF OR UNPLUG YOUR SYSTEM WHILE IT IS
UPDATING.
THE MAINFRAME CAN BE DAMAGED.

3 The sytem is rebooting. Please wait untill this process is finished.

Figure 4.12: Firmware upgrade (Step 3)
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WARNING

DO NOT POWER OFF OR UNPLUG YOUR SYSTEM WHILE IT IS
UPDATING.
THE MAINFRAME CAN BE DAMAGED.

4.2.3 Arranging recorders and viewing options
Depending on your requirements you can select one of three viewing options
for the hardware navigator: group view, mainframe view or recorder view.

l Group View In group view recorders are arranged in the used hardware
section as being part of a group. A group is a “logical” arrangement of
recorders and has no relation to the physical hardware location of the
recorders. Recorders can be moved from one group to another.

l Mainframe View In mainframe view the recorders are listed as they are
located in the physical mainframes. You cannot move recorders around.

l Recorder View In recorder view the recorders are listed in a single branch
without any reference to groups or mainframes.

To select a view mode:

l Use a right mouse click anywhere in the Hardware navigator. In the context
menu that comes up select the view mode.

To add a group:

To add a group proceed as follows:

1 Select Group View.
2 Right-click the Used Hardware entry.
3 In the context menu that comes up select Add Group.

To delete a group:

1 Select Group View
2 Select the group you want to delete.
3 With a right mouse click access the context menu and choose Remove.

The recorders that are in this group will be disabled and moved to the
disabled group.
 

Note When removing the last recorder from a group, the group will automatically
be deleted.
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To rename a group:

1 Select Group View
2 Select the group you want to rename.
3 With a right mouse click access the context menu and choose Rename.

You can now rename the group. Other options are: click the group name
twice or press F2.

Note Groups should be uniquely named. If a duplicate name is used, the group that
previously had that name will be automatically renamed.

To move a recorder:

To move a recorder from one group to another group:

l In group view select the recorder and drag it to another group.

Note A recorder can only be added to a group that is set to a sampling rate it also
supports. E.g. it is not possible to add a 1 MS/s recorder to a group that is set
to 100 MS/s. When adding a recorder to a group, its sampling rate is
automatically adjusted to the sampling rate of that group, also its sweep/
continuous settings are automatically adjusted.

Note If a recorder with the same name already exists in the group, that recorder will
be automatically renamed to a unique name. Two recorders with the same
name cannot exist in the same group.

4.2.4 Data source selection for display
You can use the hardware navigator to directly select a data source for display
of data. Basically you connect a display to acquisition hardware as data source.

To select a data source:

To select data sources using the hardware navigator do one of the following:
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l Select a recorder or a number of channels and drag them onto an empty
sheet or sheet section. A new display will be created that fills the complete
sheet (section) with the selected channels displayed. When data is
available this will be shown.

Note The selected channels will be added as overlaid traces to the targeted pane.

HINT/TIP

Hold down the Shift-key while dragging the channels. This will create/add
meters instead of waveforms.
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4.3 Recordings navigation
Previously recorded data files are accessible through the Recordings
Navigator. This navigator uses a Tree View to display the various items as an
indented outline based on their hierarchical relationship. The Navigator enables
you to open data files into Perception for review, or to use selected waveforms
as a reference. In addition the navigator allows you to organize files by moving
and deleting files and the creation, deletion and assignment of storage folders.

Data files are divided into four groups, defining their fundamental origin.

Figure 4.13: Recordings Navigator panel

A Archives: data stored on PC or network

B Default archive for storage of streamed data

C Open Recordings: references to recordings open in Perception

D On-line storage devices of connected hardware

E Data files stored on a Vision data acquisition system
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A Archives The archives section contains all recorded data that is stored
on the control PC’s local disk(s) accessible network locations. In this
section you can add and remove additional storage locations to organize
the data. Here you also define where streamed data from the acquisition
hardware must be stored. Predefined storage locations cannot be
deleted.

B Default archive for storage This is the location where streamed data from
the acquisition hardware is stored.

C Open Recordings This folder does not hold actual data. It holds
references to recordings that are open in Perception .

D Mainframes Depending on the type of acquisition hardware and installed
options local storage on the connected hardware can be available. For
example an iSCSI storage location connected to a GEN series mainframe.
These storage locations are shown in this folder.

E Visions Data stored on a connected Vision data acquisition system is
shown here. As opposed to “mainframes”, Visions cannot be controlled
from within the Perception software.

4.3.1 Working with archives
The archives section holds all stored recordings that are available through your
PC’s environment. By default it has two folders that cannot be deleted:

l My Recordings Your personal folder: this folder contains recordings that
are available only to the current user of the PC. This is the person that is
logged in as user within the Windows® environment.

l Shared Recordings Perception also provides a Shared recordings folder
for files you want to share with other users.

You can add more folders to the Archives directory.

To add an archive folder:

To create a new archive folder proceed as follows:

1 Right-click the Archives entry and click Add Archive...
or
1a Navigate to the File menu and then to Archives ► Add New Folder...
2 In the Browse for Folder dialog that comes up do one of the following:
 • Browse to and select an existing folder. Click OK.
 • Click Make New Folder. A new folder is displayed with the default

name New Folder selected. Type a name for the new folder, and then
click OK.
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The folder will be added to the tree view of Archives. You can add and
manipulate subfolders through Windows® Explorer.

To gain access to Windows® Explorer:

l Right-click a folder in Archives and click Open in Windows Explorer.

Note You can also assign removable storage devices as archive folders. When you
remove such a device, for example a memory stick, the folder will still be
assigned as an archive folder. An exclamation mark on the folder icon indicates
that this folder is not valid. When you insert the device again it will be recognized
automatically and used as defined.

You can delete folders that you have created. The default folders cannot be
deleted.

To delete an archive folder:

To delete a created archive folder from the Archive list proceed as follows:

1 Select the folder that you want to delete.
2 Use a right mouse click to access the context menu.
3 In the context menu click Delete.

Current acquisition folder
Within Perception you designate a folder that is used for data capture: when an
acquisition system is acquiring data in a continuous mode and has no local
storage capability, the data will be spooled to the PC and stored in this
designated folder.

The following icons are used to identify the various folder options:

l The  icon is used to identify the “current” acquisition folder.
l The  icon indicates that the “current” acquisition folder is within the

selected folder.
l The  icon is for standard recording folders.
l The  icon is for temporarily unavailable folders.

By default the My Recordings folder is set as current acquisition folder. You
can select any other folder within Archives as current acquisition folder.
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To set a folder as current acquisition folder:
1 Select the folder that you want to assign as current acquisition folder.
2 Use a right mouse click to access the context menu.
3 In the context menu click Make Current.

Open Recordings
The Open Recordings section of the recordings navigator lists all recordings
that are open in Perception . This list provides quick access to open recordings
without going through file lists in folders and subfolders in the archives section.
An open recording is identified with the  file open icon.

File types
Within Perception you can encounter various recording/waveform file types.
Most of these file types have a distinct icon. Below is a list of file types and the
corresponding (large) icons.

Table 4.1: File types

ICON FILE TYPE
LRF file type. This is the standard file type for Dimension data
acquisition systems. Color coded with a magenta waveform and
header.

NRF file type. This is the standard file type for Odyssey and Vision
data acquisition systems. Color coded with a red waveform and
header.

PNRF file type. This is the standard file type for data acquisition
systems that are controlled by Perception. Color coded with a blue
waveform and header.

TEAM file type. This is the standard file type for data acquisition
systems controlled by the TEAM256/TeamPro/ProView software.
Color coded with a golden waveform and header.

WFT file type. This is the standard file type for data acquisition
systems controlled by the “Nicolet Windows” software. Color coded
with a purple waveform and header.

ASCII file type. ASCII* files having the extension *.txt or *.asc are
accessible through the Recordings Navigator.

Catman binary DAQ file. These files, with the .bin extension, are
accessible through the Recordings Navigator and the File menu.

* For more information about ASCII files please refer to appendix “ASCII
Recording Loader” on page 885.
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4.3.2 Remote access
The GEN DAQ series mainframes can be used in combination with Perception
and in unattended mode. If the GEN DAQ series mainframes are setup to store
recordings on the internal disk, these recordings can be accessed using
Perception or by using regular network file sharing (SMB/CIFS).

The Remote Access option is accessible via the Perception Mainframe
Settings dialog. Once connected you can select the menu item “Mainframe
Setup..” in the “Settings” menu.

Note The Remote access option is only available when Perception is connected to
a GEN DAQ system.

Figure 4.14: Remote access controlled by Mainframe Settings dialog

A GenDAQ API
Enable access to the mainframe using GenDAQ API
By granting access to the GenDAQ API, the mainframe can be controlled
from any device in the nework which runs a client application that
supports the GenDAQ API.

B The file sharing option can be enabled by checking the Enable access
to the internal storage of the mainframe checkbox.
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C/D Set up the Username and Password. Click Apply to confirm this action,
than the GEN DAQ series mainframe can be accessed through the
network share.

E Access mainframe storage using Windows® Explorer In order to
access the mainframe storage, click the link or enter the displayed path
in the adress bar of the Windows® Explorer.

Accessing the mainframe using Windows® Explorer:
1 Open Windows® Explorer and type the network share in one of the

following formats.
 l IP adress based: \\<IP adress>\Recordings (see Figure 4.15)

l Name based: \\<Mainframe name>\Recordings

Note When using mainframe names which exceed 16 characters the mainframe IP
address should be used to access the network share.

 

Figure 4.15: Windows® Explorer IP adress
2 Connecting to a network share is only possible with the right credentials

(username + password). When a new network connection is setup
Windows® security asks for the Username and Password, once these are
provided Windows® can setup the connection (see Figure 4.16).
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Figure 4.16: Windows Security dialog

A Prefix: GHS\
 Once the connection is established successfully Windows® caches the

credentials.

Note The username must be prefixed with GHS\ to specify the correct domain/
workgroup (see Figure 4.16).

Note When the password is changed after Windows® cached the credentials, the PC
should be rebooted before the network connection to the GEN DAQ can be
made using the changed password.

3 After the connection to the network share has been set up successfully the
recordings can be accessed directly using Windows® Explorer (see
Figure 4.17). The recordings of the internal disk can be copied and deleted.

 

Figure 4.17: Access to recordings via Windows® Explorer

Note Do not delete the active recording.
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4.3.3 Externally stored recordings
Apart from the stored recordings that are available through your PC’s
environment, there can also be data available that is stored directly onto a
storage device in a data acquisition system:

l iSCSI storage locations connected to a GEN DAQ product.
l External SCSI disk(s) connected to a GEN DAQ product.
l Hard Disk Drive in a Vision data acquisition system.

Recordings that are located on a GEN series data acquisition system need to
be transferred to the PC first before you can display them. Recordings located
on a Vision can be viewed directly; that is, you can connect to a recording on
a Vision without the need to copy that recording to the PC local storage.

Mainframes
The mainframes section lists connected mainframes that have on-board
storage for recordings. Currently the GEN series data acquisition systems are
supported. Recording files in a mainframe can be copied, moved and deleted
from within the recordings navigator. They can not be directly opened for
viewing.

To delete a recording in a mainframe:

1 Right-click the file you want to delete to access the context menu.
2 In the context menu click Delete.
3 In the Confirmation dialog that comes up click OK to delete the file.

To move or copy a recording from a mainframe:

To move or copy one or more recordings from a mainframe to the control PC
proceed as follows:

1 Select the file(s) you want to move or copy.
2 Right-click the selected file(s) to access the context menu.
3 In the context menu click Move to Archive [archive name] or Copy to

Archive [archive name].
4 A dialog comes up that shows the progress. The current folder is used to

create a subfolder to store the transferred data.

The move/copy progress dialog provides feedback on the transfer progress and
can also be used to interrupt the transfer of either a single recording or the
complete transfer process.
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Figure 4.18: Copy / Move progress dialog

A File in transfer: number, name and source

B Target location

C File in transfer status and control

D Total transfer status and control

E List of files with current status

A File in transfer In the Transfer section of the dialog information is
available on the current file in transfer. This includes the running
number, file name and source location. The Source Location identifies
the name of the mainframe.

B Target Location The Target Location identifies the storage folder on
the controlling computer. By default this is a subfolder of the current
acquisition folder. The name of the subfolder is the name of the
mainframe. To modify the location of the current acquisition folder refer
to "Current acquisition folder" on page 96.

C - D Progress The Progress section includes progress indicators for the
current file in transfer and the total transfer. When you click the Skip
button the current file transfer will be aborted and the next file transfer
will be started. Click the Stop button to abort the complete transfer
process.
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E File list The file list area shows all files included in the copy or move
process. In front of the file name an icon displays the current status of
the file.
Options are:

   Indicates a file that has to be transferred.

   Indicates the file currently in transfer.

   Indicates a file that has been transferred successfully.

  Indicates a file that has not been transferred correctly or has been
aborted.

In the progress dialog click OK when done. Select Close this dialog
when finished if you want to close the dialog automatically after data
transfer.

Visions
Although you can open a recording directly from a Vision disk, you cannot
delete, move or copy a recording from the Vision disk to the control PC. For file
transfer capabilities of a Vision refer to the User Manual that came with the
Vision.

When you are not sure:

When you are not sure if all Visions are listed do the following:

1 Right-click the Visions entry.
2 In the context menu that comes up click Scan for Visions.
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Add an unlisted system

The Perception software can locate known Vision systems that are on the same
network. When a system is located behind a network firewall it cannot be found
by automatic detection.

To add an unlisted system:

To connect to a Vision that is not shown in the Visions section proceed as
follows:

1 Right-click the Visions entry.
2 In the context menu that comes up click Add a Vision ...
3 In the dialog that comes up enter a name for the Vision and the correct IP-

address.
4 Click OK when done or Cancel to quit without modifications.

HINT/TIP

Please note Perception also offers file copy / move functionality through user
keys, these can also be used in combination with recording automation. For
details on how to use user keys, please refer to manual User keys and Macros
(A05025).

4.3.4 Data source selection for display
You can use the Recordings Navigator to select a recording as data source for
display. Perception provides various options to load/open a recording.

Figure 4.19: Recordings Navigator with shortcut menu
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To load / open a recording: 

To load or open a recording do one of the following:

l Double-click on a recording. This will open that recording as experiment.
l Select a recording and drag it onto an empty sheet or sheet area. A new

display will be automatically created that fills the entire sheet (area) with
the selected recording displayed with channels as stacked (separated)
traces.

l Select a recording and drag it onto an existing display. The selected
recording will be added as overlaid traces to the targeted pane.

l Select a recording and use a right mouse click to access the context menu
shown in Figure 4.19.

Figure 4.20: Load/open recording options

HINT/TIP

You can also load recordings through the File ► Load Recording... menu
command. The dialog used for this operation offers also a variety of options
that are almost identical to the ones described in this section. Refer to "Load
Recording..." on page 354 for more information.

Review or Redo and experiment
As from version 4.0 the experiment concept is introduced in the Perception
software: save and load the recorded data complete with the test environment,
i.e. the data file and the workbench are combined into one file. This file has the
extension .pnrf like the classic data files.

For more information on the experiment concept refer to "Experiment" on
page 40.

See also the section "Start dialog options" on page 55.
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Load as Active
By default the active display on the active sheet is connected to the actual
hardware. The last made recording is on this display by definition. You can load
any other recording as active. This will load the selected recording into the
active display on the active sheet, and therefore becomes the active recording.
When a new recording is made in hardware, this will again replace the currently
connected recording in the active display.

For more information refer to "Active display" on page 36.

Load as Reference
While there can only be one active recording there can be multiple reference
recordings. When you click Load as Reference... a dialog comes up that allows
you to give the recording a meaningful name.

The reference recording entry now is not an actual recording, but a pointer
(reference) to a recording. You can assign a reference recording to a display.
You can also modify the actual recording that is referenced by the reference
recording. By doing so the display that shows the reference recording will be
updated to reflect the new recording.

To modify the source a reference recording:

To modify the source of an existing reference recording proceed as follows:

1 Select a recording and use a right mouse click to access the context menu.
2 In the context menu click Load as Reference...
3 In the dialog that comes up enter the name of the existing reference to

replace the source.

Load Using Filename 
This option makes the recording available in the system without creating a
display or replacing any other data. The recording is available with its own file
name through the Open Recordings section in the Recordings Navigator and
in the Data Sources Navigator.

Open in new User Sheet
This option creates a new user sheet. A new display will be automatically
created that fills the entire sheet with the selected recording displayed with
channels as stacked (separated) traces.
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Close an open recording
To close an open recording:

1 Select an open recording and use a right mouse click to access the context
menu.

2 In the context menu that comes up click Close.
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4.4 Data Sources navigation
The Data Sources Navigator provides a comprehensive list of all available data
sources within the Perception environment. These data sources are connected
hardware, opened files, system generated constants and variables, formula
results, etc.

Figure 4.21: Data Sources Navigator and expanded Active branch

A Active: active recording in active display/sheet

B Display: information and parameters of displays

C Formula: results of formulas

D Hardware: various information about connected hardware

E Loaded/opened recordings

F System: a variety of system information
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A Active The Active section provides data from the current active recorder/
recording. For a recorder this will be the data of all channels and extracted
parameters like maximum, minimum, etc. Depending on the originating
system more or less parameters are available. You can drag data from
this location into a display.

B Display The display section provides information and data of the available
displays. information includes relevant values of all cursors, markers,
active sweep and active trace; and start and end time.

C Formula The formula section holds the results of the formulas as defined
in the formula database. These results can be numbers, strings and
waveforms. You can drag data from this location into a display.

D Hardware The hardware section list information and status of the
connected hardware. Depending on the connected hardware this may
include battery and system power status, fan speeds, and temperatures
of amplifiers and processors. Note that the actual data channels are not
listed here. To add data from the acquisition channels use the Hardware
Navigator.

E Loaded and opened recordings Each open recording is listed. For each
recording the actual recorded data is available as well as information like
company and user name as well as recording times and title.

F System The system section provides a variety of information ranging from
numerical constants, to acquisition status and data/time information.

You can use any of these data sources. Depending on the type of data source
you can use them in formulas, displays or meters.

4.4.1 Data source selection for display and meters
From the Data Sources Navigator you can select a data source to show data
in a meter or display, depending on the type of data.

To use data:

To use data from one or more of the listed data sources do one of the following:

l Select a recorder (recording) or a (number of) channels and drag them onto
an empty sheet or sheet area. A new display will be automatically created
that fills the entire sheet (area) with the selected data displayed with
channels as stacked (separated) traces.

l Select a recorder (recording) or a (number of) channels and drag them onto
an existing display. The selected data will be added as overlaid traces to
the targeted pane.

l Select a parameter/value or a number of parameters/values and drag them
on an empty sheet or sheet area. New meters will be automatically created
that fill the entire sheet (area) displaying the selected parameters/values.
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l Select a parameter/value or a number of parameters/values and drag them
on an existing meter array. New meters will be added to the existing array
displaying the selected parameters/values.

HINT/TIP

You can also drag data sources directly into a formula in the formula database.
This allows you to quickly insert constants and variables into a function without
the need to know the complete path of that variable. E.g simply drag a cursor
X-position into your formula without typing the complete path like:
Display.Display1.Cursor1.XPosition.

Search Similar
When you right-click a data source, the context menu has a single entry: Search
Similar.

You can search within the Data Sources Navigator for sources that are similar
to the selected one. For example when you select a maximum of a channel,
Search Similar... will search for all maximum values within the data sources and
list them. This list can then be dragged onto a sheet.

To use Search Similar:

1 Select a data source and use a right mouse click to access the context
menu. Click Search Similar...

2 In the Search Results window that comes up:
l select the required data sources and drag them onto the applicable

location. Click Close when done.
l select a data source and click Goto. The indicator in the Data Sources

Navigator will jump to the selected data source. When required the tree
will be expanded to show the selected data source.
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Figure 4.22: Search Similar
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4.5 Properties window
The Properties window displays the properties of a selected item in one of the
navigators. Therefore it will be generally used in combination with one or more
of the navigators.

Figure 4.23: Various Properties windows

Depending on the type of object you have selected various properties will be
shown.
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5 Acquisition Control and Status
5.1 Introduction

Note When you are using Perception Version 8, some of the information in this
manual may be outdated. Especially the acquisition modes described in chapter
"5 Acquisition Control and Status" on page 113 and appendix
"A Acquisition and Storage" on page 483 have been updated in Perception
Version 8. For more information on new acquisition modes, please visit the
Perception product page for the document “Perception V8 Acquisition Modes
Quick Start”.

Within Perception all hardware related settings are accessible through the
Settings sheet, with the exception of the acquisition control commands Start,
Stop, Single Shot, Pause and (manual) Trigger. These commands are
accessible through the Control menu, the control toolbar and the Acquisition
Control palette.

The Settings sheet gives access to all hardware settings and may thus not be
preferable for day-to-day operation.

Therefore Perception provides three additional palettes for acquisition control
and status feedback:

l Acquisition Control  The Acquisition Control palette has a user interface
tailored towards daily operation. The palette can be docked and resized for
optimal usage. It provides acquisition control as well as quick setup of the
main acquisition parameters like recording length/time, sample rate, etc.

l Status The Status palette can be used to provide feedback on the
acquisition, automation and battery status at a glance. Full-size indicators
are used for easy readout even at a larger distance.

More detailed and background information on acquisition modes and storage
can be found in appendix “Acquisition and Storage” on page 483.
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5.2 Acquisition control
The Acquisition Control palette is used for quick access to the main parameters
of an acquisition. It is also used to control the actual acquisition and to give
feedback on the acquisition status of the controlled system(s).

To show or hide the Acquisition Control palette:

Do one of the following:

l In the menu bar choose Window ► Acquisition Control. If an acquisition
control palette is currently visible it will have a check mark on its left hand
side.

l When open click the top right button to close it.

l To auto-hide a control palette it must be open and docked. Click the auto-
hide button. The palette will auto-hide when the mouse pointer leaves the
palette area.

l Click on a tab of the ‘hidden’ control palette to let the palette slide open.
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In general you will select Control All to control all groups at the same time. To
control individual groups select a group. By default groups will be combined into
one palette.

For more information on palette grouping refer to "Tabbed grouping" on
page 69.

For more information on acquisition groups refer to "Arranging recorders and
viewing options" on page 91.

For more information on the usage of palettes in general refer to "Using
palettes" on page 66.

Before you can actually use an Acquisition Control palette you must be
connected to acquisition hardware. Refer to "Add and remove a data acquisition
system" on page 82 for details on how to connect to a data acquisition system.
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Figure 5.1: Full blown Acquisition Control palette

A Recording name: See chapter "Name" on page 117.

B Acquisition control: See chapter "Acquistion" on page 118.

C Acquisition status, including storage capacity / usage: See chapter "Status"
on page 120.

D User Mode (Slow sweep settings): See chapter "Slow Sweep" on
page 121.

E User Mode (Fast sweep settings): See chapter "Fast Sweeps" on
page 122.

F User Mode (Continuous recording settings): See chapter "Continuous" on
page 123.

The actual layout/options that are available in the Acquisition Control palette
depend on the connected hardware and the selected User Mode. See "Switch
to Instrument Panel" on page 45 for more information.

You can show or hide various blocks of information and control in the palette.
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To show or hide options in the Acquisition Control palette:

l Click the triangle in front of the group name. Example:

The Acquisition Control palette provides the functions as described in the
following sections.

5.2.1 Name
The experiment name defines the name of the recording in progress. The
experiment name uses autonumbering. When a recording starts, the
experiment number is incremented.

Figure 5.2: Recording name

1 Experiment name: the name of the experiment in progress. When a
recording starts, the recording number is incremented.

2 Click the Set button to change the name and/or number of the experiment.

To change the name of an experiment:

To change the name and/or number of the experiments proceed as follows:

1 Click Set (...) in the Name section of the Acquisition Control palette.
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2 In the dialog that comes up:

Figure 5.3: Set Experiment Name dialog

l Enter a name in the Name field. This will be the ‘prefix’ of the recording
name.

l Enter a number in the Serial number start field. The serial number is
the ‘suffix’ of the recording name (the part that is added to the end of
the name). Here you define where to start.

3 Click OK when done.

5.2.2 Acquistion
This section provides the fundamental acquisition control.

Figure 5.4: Acquisition control

1 Status display Shows the current status of the acquisition.
2 Acquisition control The following controls are available:
    
 ● Preview  This button serves two purposes:
  ● When no acquisition is active it will place the recorder in the pause

or stand-by mode. Although the recorder is digitizing, no data is
stored is memory or disk. This is useful for monitoring purposes.
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  ● When a an acquisition is active, the button will update to Pause
once Record is selected (see Figure 5.5). Using the control now it
will place the recorder in a hold mode: although the recorder is
digitizing, no data is stored in memory or disk. At this point the
Record button will change into Resume (see Figure 5.6), when
Resume is selected, the current recording continues, when Stop
is selected, the recording is finished.

   

Figure 5.5: Acquisition control - Record selected
   

Figure 5.6: Acquisition control - no data in memory or disk
    
  ● Record

The Record command starts acquisition of data.
  ● Stop

To stop an acquisition, select this button. This stops the current
recording. When in a sweep acquisition mode, the current sweep
will be aborted immediately.

  ● Trigger
The button is used to send a “manual” trigger command to the
recorder(s) under control.

More acquisition
Apart from the basic acquisition controls as provided in this palette, the same
controls are also available on other places:

l Control menu: refer to "Control menu" on page 393 for details.
l Accelerator (shortcut) keys: function keys F4 through F8
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l Toolbar: see Figure 5.7 below.

Figure 5.7: Acquisition control toolbar

1 Start F4

2 Stop F5

3 Single Shot F6

4 Pause F7

5 Manual Trigger F8

6 Voicemark F9

Note Voicemark is only enabled when making a recording with PC storage.

5.2.3 Status
While the acquisition section is used to control - and return information about
- the selected acquisition mode, the Status section is used to control - and return
information about - the state or progress of the actual storage: armed, triggered
or archiving.

Figure 5.8: Acquisition control - status

1 Elapsed time The elapsed time from start of recording. Format is days -
hours : minutes : seconds.

2 Memory gauge The memory gauge gives visual feedback on the amount
of local volatile memory of the acquisition system.

3 Disk gauge The disk gauge gives visual feedback on the amount of disk
space used on the PC.
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4 Data rate gauge The data rate gauge gives visual feedback on the amount
of data that will be stored to disk per second, the maximum amount is
determined by the device the data is stored to. For more information please
refer to "Continuous data rate gauge" on page 351.

Note When you hover with the mouse pointer over a gauge, the amount of storage
in use is displayed. A red indicator on the right hand side of the gauges is lit
when storage requirements exceeded the available space.

5.2.4 Groups
When data is stored, this data is organized in recordings. A recording (noun) is
defined as all the data that has been stored between the start of acquisition
(START command) and the end of acquisition. The end can be defined in
various ways. A recording can have one or multiple sweeps, a continuous data
stream or a combination of both.

These settings can be applied to each group of recorders independently.
Recorders within a group will always have the same storage settings. If a subset
of these recorders should be configured differently, they should be moved to
their own group.

Note The storage mode defines how data that is digitized and acquired is saved.
Perception offers a variety of storage modes, each with various options. Each
storage mode is related to a user mode, refer to section "User modes" on
page 41 for more information on the available user modes.

Slow Sweep
When in Slow-Fast Sweep mode, the slow sweep parameters are set here.

Figure 5.9: Slow Sweep parameters

1 Sample rate Here you set the slow-time base or sample rate of the group:
the rate at which the analog signals are sampled and digitized. Depending
on the connected hardware and the User Mode, this option is available.
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 You can set the sample rate by selecting the desired value from the list of
available sample rates, only values that are supported by all recorders in
the group are listed.

Note The maximum selectable sample rate of a group is determined by the slowest
card in the group. E.g. a group containing a 1 MS/s recorder and a 100 MS/s
recorder will have a maximum selectable sample rate of 1 MS/s. Moving the
100 MS/s to a new group will allow a selection up to 100 MS/s.

 Values may be shown using standard characters as technical multiplier
prefixes. For example selecting a value as “10 k” will set the the time base
to 10000.
Valid multipliers are: u (micro = 10-6), m (milli = 10-3), k (kilo = 10+3) and
M (mega = 10+6).

2 Length Defines the total length of the slow sweep.
3 Trig. Pos the trigger position defines the location of the trigger point within

the slow sweep: the part before the trigger (t=0) is negative time (history)
and termed pre-trigger. The part after the trigger is posttrigger. Set this
value as follows:

 ● 0% ≤ position ≤ 100%: trigger position is within the sweep
 ● position < 0%: trigger position is in front of the sweep (delayed trigger)
4 Units Select between samples, seconds or percentage (position only).

Fast Sweeps
These settings are used when storage mode is sweeps, dual or slow-fast.

Figure 5.10: Fast Sweeps parameters

1 Sample rate Here you set the fast-time base or sample rate of the group:
the rate at which the analog signals are sampled and digitized. Depending
on the connected hardware and the User Mode, this option is available.
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 You can set the sample rate by selecting the desired value from the list of
available sample rates, only values that are supported by all recorders in
the group are listed.

Note The maximum selectable sample rate of a group is determined by the slowest
card in the group. E.g. a group containing a 1 MS/s recorder and a 100 MS/s
recorder will have a maximum selectable sample rate of 1 MS/s. Moving the
100 MS/s to a new group will allow a selection up to 100 MS/s.

 Values may be shown using standard characters as technical multiplier
prefixes. For example selecting a value as “10 k” will set the the time base
to 10000.
Valid multipliers are: u (micro = 10-6), m (milli = 10-3), k (kilo = 10+3) and
M (mega = 10+6).

2 Count Defines the number of sweeps you want to acquire. This setting is
disabled when infinite is selected.

3 Length Defines the total length of the fast sweeps.
4 Trig. Pos the trigger position defines the location of the trigger point within

a fast sweep: the part before the trigger (t=0) is negative time (history) and
termed pre-trigger. The part after the trigger is posttrigger. Set this value
as follows:

 ● 0% ≤ position ≤ 100%: trigger position is within the sweep
 ● position < 0%: trigger position is in front of the sweep (delayed trigger)
5 Infinite Select this option for unlimited sweeps.
6 Units Select between samples, seconds or percentage (position only).

Continuous
Use this section to set the parameters of the continuous mode.

Figure 5.11: Continuous parameters
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1 Sample rate  Here you set the continuous-time base or sample rate of the
group: the rate at which the analog signals are sampled and digitized.
Depending on the connected hardware and the User Mode, this option is
available.

  
 You can set the sample rate by selecting the desired value from the list of

available sample rates, only values that are supported by all recorders in
the group are listed.

Note The maximum selectable sample rate of a group is determined by the slowest
card in the group. E.g. a group containing a 1 MS/s recorder and a 100 MS/s
recorder will have a maximum selectable sample rate of 1 MS/s. Moving the
100 MS/s to a new group will allow a selection up to 100 MS/s.

 Values may be shown using standard characters as technical multiplier
prefixes. For example selecting a value as “10 k” will set the the time base
to 10000.
Valid multipliers are: u (micro = 10-6), m (milli = 10-3), k (kilo = 10+3) and
M (mega = 10+6).

2 Acq. mode Defines the acquisition mode: when to stop this continuous
acquisition. Possibilities are:

 ● Standard  Continuous acquisition without a specific stop condition.
Click the Stop button to stop recording.

 ● Circular  Data is acquired in a circular buffer of specified length. Click
the Stop button to stop recording

 ● Stop on trigger  Stop when a trigger occurs. Basically this is a sweep
with pre- and posttrigger: pre-trigger = Total time - Posttrigger.

 ● Specified time Stop after specified total time is acquired. The Total
time field is now also available when the acquisition mode is Specified
time.

3 Total time Defines the total time in seconds of the acquisition when the
acquisition mode is circular or stop-on-trigger.

4 Posttrigger the trigger position defines the location of the trigger point
within a fast sweep: the part before the trigger (t=0) is negative time
(history) and termed pre-trigger. The part after the trigger is posttrigger.
Here you set the posttrigger value in seconds.

Perception

124 A02689_09_E00_00   HBK: UNRESTRICTED



5.3 Status
The Status palette is used for a quick overview of vital system parameters. A
large font is used to allow visibility at larger distances.

To show or hide the Status palette:

Do one of the following:

l In the menu bar choose Window ► Status. A check mark appears in front
of the status palette entry when it is visible.

l When open click the top right button to close it.

l To auto-hide a control palette it must be open and docked. Click the auto-
hide button. The palette will auto-hide when the mouse pointer leaves the
palette area.

l Click on a tab of the ‘hidden’ control palette to let the palette slide open.

For more information on the usage of palettes in general refer to "Using
palettes" on page 66.
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Depending on the connected hardware not all parameters listed below may be
available.

Figure 5.12: Status palette example

A Fiber: refers to the status of Fiber Optic isolated Digitizer front-ends

B RTC: Real-Time Clock

C Acquisition: acquisition status as in acquisition control palette

D Trigger status: trigger status as in acquisition control palette

E Automation: automation as defined in the automation menu

F Timer: status of the Timer for Conditional Start Stop (Control menu)

G Sensor: status of connected sensors

H RT Formulas: displays RT-FDB deployment case status

Note that various status notifications are a combination of individual systems,
recorders or channels. When no information is available the message “---” is
displayed.

A Fiber   The GEN series data acquisition system can be equipped with
Fiber Optic Isolated Digitizers. These front-ends are sometimes battery
operated. This field can display one of the following messages:
l Power OK: system is ready
l Power Off: system is not ready
l Low Battery: low on battery
l No Signal: cannot communicate with front-end
l Warming Up: amplifier is warming up
l Thermal Shutdown: internal temperature high
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B RTC (Real-Time Clock)    The real-time clock can be internal,
synchronized to an IRIG or GPS receiver, synchronized to a PTP master
or a Master within a Master/Slave configuration. This field shows the
status as follows:
l Synchronized: all is OK
l Synchronizing: almost OK
l Out of Sync: the RTC lost synchronization with the synchronization

source
l No Signal: the RTC has no signal from the synchronization source

When you hover with the mouse over this field a tooltip displays the
synchronization source.

C Acquisition   Displays the acquisition status as shown also in the
acquisition control palette. For details refer to "Acquisition control" on
page 114. Messages are:
l Idle: waiting for a start command
l Running: acquisition is active
l Pause: the acquisition is temporarily suspended
l Single Shot: the acquisition is in single shot mode

D Trigger   Displays the trigger status. Messages are:
l Idle: no trigger detection active
l Armed: ready and waiting for a trigger
l Triggered: triggered and recording is still active. Otherwise stated: the

recording is in the posttrigger segment
E Automation   Informs about the status of one of the automation options.

Messages are:
l Off: no automation is active
l Busy: automation is active
l Waiting: automation is active and waiting for new data to process

F Timer   Returns the status of the timer for conditional start-stop. Messages
are:
l Idle: no timer active
l Off: timer is off
l Wait for start: timer is waiting for a start of acquisition
l Wait for automatic start: timer is waiting for an automatic start of

acquisition (tooltip text only)
l Wait for stop: timer is waiting for a stop of an acquisition
l Wait for automatic stop: timer is waiting for an automatic stop of

acquisition (tooltip text only)
l Wait for automatic restart <time>: automatic restart after time (tooltip

text only)
l Wait for automatic restart <n> out of <m>: counted restart (tooltip text

only)
l Time to next Start: <time>: time to next start (tooltip text only)
l Time to next Stop: <time>: time to next stop (tooltip text only)
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G Sensor Shows the status of sensors connected to acquisition cards that
support this feature. In case none of the channels support sensor status
it will be displayed as None. Messages are:
l None: none of the channels in the acquisition system support sensor

information retrieval. In case of a problem, the tooltip for this status
field will identify the first channel this issue was found for.

l No Sensor: no sensor is attached to one of the channels
l Connected: a sensor is connected to all channels
l Short circuit: one of the sensors connected has a short circuit
l TEDS connected: a TEDS able sensor was detected
l Overflow: a value exceeding the sensor range was detected on one

of the connected sensors
H RT Formulas GEN DAQ mainframes can include real-time formulas. This

field displays the worst case status of deployment of real-time formulas
to any connected mainframe. Messages are:
l Error: one or more of the mainframes contain an RT-FDB setup that

cannot be deployed
l OK: no problems with deployment of RT-FDB formulas
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6 Data Visualization
6.1 Introduction

One of the most important tasks within data acquisition is the visualization of
data. The Perception software provides a variety of features for fast and
accurate display of waveforms. The unique displays let you visualize real-time
waveforms instantly. Review historical data while acquiring and displaying
current data. Compare with reference curves or zoom in to see the finest details
with free-style zooming and panning. The alternate zoom feature gives you two
zoom areas simultaneously within the same waveform.

Two vertical cursors are used for interactive measurements. Combined with a
cursor values table and sample snap you can have accurate results up to the
sample level. In addition horizontal cursors and slope cursors are available for
even more interactive interpretation of recorded data. Extensive replay facilities
let you jog/shuttle through the data with ease.

For documentation purposes you can annotate points of interest on the display
with a variety of display markers. These markers can be set manually or
automatic at the end of an acquisition.
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6.2 Waveform display fundamentals
On the active sheet and user sheets one or more waveform displays can be
positioned. Each waveform display can have multiple pages. Each page of the
display can then have multiple panes and each pane in the display can have
any number of overlapped traces.

Pages 
A page is a part of a display, just like a page that is part of a book. Each display
has at least one page, but can have multiple pages. Multiple pages are used
to display a large number of traces with the same X-axis parameters like
start- and stop time, cursor position, etc.

Only one page per display can be shown at a time. The other pages are
positioned virtually ‘behind each other’. You can switch to other pages easily
using the page control. Within a page one or more panes can be displayed.

Panes 
A pane is a part of a page: the page is divided into panes. Panes are used to
display data in separated - individual - areas. Panes can have individual heights
and might contain one or more traces. By definition traces can be overlapped
in a single pane. Overlapping can range from full (100%) to none (0%). Also
the position of individual traces within a pane can be set freely.

Traces 
A trace is the fundamental graphical representation of a digitized real-world
analog signal, or the result of a formula/calculation on such a signal.

Views
In addition to the standard arrangement possibilities a display page can divided
furthermore into views.  A view is a display-in-a-display and is used to represent
the same data in a different way, for example as a zoomed part of the original
trace(s).
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Figure 6.1: Display components - part 1

A Display

B Pane @ 25% height with single trace. No scaling.

C Pane @ 44% height with two traces, partially overlapped. Scaled.

D Pane @ 17% height with one trace. No scaling.

E Pane @ 14% height with two traces, fully overlapped. No scaling.

F Pages 1 through 4

G A trace

View types 
Within a display page there can be a maximum of 4 (four) views. Depending on
the settings these are:

l Main view: review in either sweep or recording mode.
l Zoom: a detail of the review view.
l Alternate zoom: another detail of the review view.
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l Live: live streaming data

Figure 6.2: Display components - part 2

A Review

B Zoom

C Alternate zoom

D Live

Each view is laid out as an individual display. However, due to the nature of
views, they are ‘connected’ to each other.

The display view area in detail

Note In the display view area the cursor values in the Y-annotation area are the
values of the primary vertical measurement cursors. There are also horizontal
and slope cursors  that are discussed in "Horizontal cursors" on page 169 and
"Slope cursors" on page 170.

The display view area provides a wealth of functions and information.
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Figure 6.3: Display components - part 3

The display view area can be divided into four main regions:

1 Y-annotation area
2 X-annotation area
3 Control area
4 Trace area

Other items include:

A View type
B Upper display limit
C Cursor values
D Lower display limit
E Range indicator
F Trace name (active trace)
G Sweep index
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H Page control
I Time control
J Replay control
K Cursor values
L Time scale
M Active cursor
N Trigger symbol
O Passive cursor
P Event bar

A View type Here you see and select the type of this view. The following
basic types are available:

l Review
l Zoom
l Alternate zoom
l Live

Depending on the selected basic type various options are available. The
view type indicator is highlighted when the view is selected. When
selected it is the “active view”.

B, D Upper and lower display limits These values indicate the display
range. By default this range is equal to the analog input range.

C Cursor values  You can select if you want to see cursor values here:

l Active cursor value. 
l Both cursor values.
l Difference between the two cursor values.

E Range indicator When the upper and lower limit are not equal to the
input range, the range indicator shows the display range relative to the
actual input range.

F Trace name The trace name is highlighted when selected. When
selected it is the “active trace”.

G Sweep index   This index is available when the review is in sweep
mode. It shows the number of the sweep that is reviewed.

H Page control   Use this control to go to other pages.
I Time control  You can use this control to jog/shuttle through time and

to set the X-axis zoom factor.
J Replay control   You can use this control to replay the data. When in

sweep review mode you can use this control to step through the sweeps
K Cursor values  X- and Y-value of the active cursor and the difference

of these values with the passive cursor.
L Time scale X-annotation area
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M Active cursor The active cursor is the cursor that is currently selected.
It is color-coded red.

N Trigger marker This marker indicates where a trigger occurred.
O Passive cursor  The other cursor, color-coded blue.
P Event bar There are various events. Their markers are placed here, for

example the trigger marker.

6.2.1 The Y-annotation area  
On the left-hand side of the display there is the Y-annotation area. A view within
a display and its Y-annotation area are divided into panes. Each pane can
support one or more traces.

Figure 6.4: Y-annotation area of a pane

A Upper display limit

B Trace name

C Display range indicator

D Cursor values

E Lower display limit

Traces and annotation are color coded. Depending on the available space the
Y-annotation area of a single pane can comprise one or more of the following
options. The width of the Y-annotation area can be set in the Display Setup
dialog.

To set the width of the Y-annotation area:

You can set the width of the Y-annotation area as follows:

1 Using a right mouse click in the display area access the context menu.
2 In the context menu select Display Setup...
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3 In the Display Setup dialog select the Annotation & Grid page.
4 In the Y-Annotation section set the Width of the area.
5 Click OK when done.

A, E Upper and lower display limits These values indicate the display range.
By default this range is equal to the analog input range. The values are
in technical units. Depending on the zoom range the display area can be
either equal to, larger than or smaller than the actual input range of the
signal.

B Trace name The trace name is the name given to the channel at recording
time. The trace name is highlighted when selected. When selected it is
the “active trace”.

C Display range indicator When the upper and lower limit are not equal to
the input range, the range indicator shows the display range relative to
the actual input range.

Figure 6.5: Display range indicator

A The display range is smaller than the input range

B The display range is larger than the input range
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D Cursor values  Depending on the selected option, one or more cursor
values are shown here. A blue square indicates the value at the passive
cursor position, a red square indicates the value at the active cursor
position.

To select the cursor values readout:

You can select which value(s) to show in the Y-annotation area. To do so:

1 Using a right mouse click in the display area access the context menu.
2 In the context menu select Display Setup...
3 In the Display Setup dialog select the Annotation & Grid page.
4 Make sure that in the Show area the Y-Annotation check box is

selected and select in the Y-annotation area under Show values
one of the following options:
l Display Y-range only Do not show cursor values.
l Active cursor value Show the Y-value of the active cursor.
l Values of both measurement cursors Show the Y-values of

both cursors.
l Difference between Y-values of cursors Show the difference

between the Y-values of both cursors.
5 Click OK when done.

Figure 6.6: Y-annotation options

A Display Y-range only

B Active cursor value

C Values of both measurement cursors

D Difference between Y-values of cursors
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6.2.2 Y-annotation per tick
To show the Y-annotation:

1 Use a right mouse click in the display area to access the context menu.
2 In the context menu select Display Setup...
3 In the Display Setup dialog select the Annotation & Grid page.
4 In the Y-annotation area select the check box Show annotation per

tick.

Figure 6.7: Y-annotation per tick

A Show annotation per tick
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Figure 6.8 shows the Y-annotation in detail:

Figure 6.8: Y-annotation area of a pane

A Enabled Y-annotation

6.2.3 The X-annotation area
The X-annotation area is used to display a time or position scale. The scale
supports internal (time-based) and external (position-based) acquisition time
bases. When time is used, the x-axis scale can be relative or absolute. When
position is used the position can be translated to linear or rotational
displacement. For ease of reference the X-annotation scale will be named time
scale although it can also refer to a position.

When the time scale is relative time, the time is referenced to the start of the
recording. With relative time the start of the recording is considered the start of
the time line, i.e. t=0.

When the time scale is absolute time, the actual time of day at the start of
recording is used as reference without correction.

To select the time scale:

1 Right-click anywhere in the display area
2 On the context menu click Display Setup…
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3 In the Display Setup dialog box select the Annotation & Grid page
4 Make sure that in the Show area the X-Annotation check box is selected

and select in the X-annotation area under Scaling one of the following
options:
l In time: Relative to start of recording Use the relative time scale 
l In time:Absolute local time Use the absolute time scale with respect

to local time 
l In time: Absolute UTC Use the absolute time scale with respect to

Coordinated Universal Time (UTC)    
l In position: Linear The time scale displays external “clocks”
l In position: Rotational, 360 degrees per cycle The time scale displays

cycles, each cycle represents 360 external “clocks”
l In position: Rotational, 720 degrees per cycle The time scale displays

cycles, each cycle represents 720 external “clocks”
5 Click OK when ready

HINT/TIP

Coordinated Universal Time (UTC) - is a high-precision atomic time standard.
UTC has uniform seconds with leap seconds announced at irregular intervals
to compensate for the earth’s slowing rotation, and other discrepancies. The
leap seconds allow UTC to closely track Universal Time (UT), which is a time
standard based on the earth’s angular rotation, rather than a uniform passage
of seconds.

The complete absolute time format is date HH:MM:SS.T-T, the relative time
format is DD HH:MM:SS:T-T with:

l date Actual date
l DD Number of days
l HH Hours in range 0 through 23
l MM Minutes in range 0 through 59
l SS Seconds in range 0 through 59
l T-T Depending on available resolution a number of decimals in range 0

through 9

Example: the absolute time 20-09-2006 21:53:16.879 reflects September 20,
2006 at 9:53:16 pm and 879 milliseconds.
The relative time 01 11:23:16.2365 reflects 1 day, 11 hours, 23 minutes, 16
seconds and 236500 microseconds.

Time annotation in the display by default shows three values: the start time (or
position) and the end time (or position) of the data as shown in the display as
well as the time (or clocks,cycles) per division. You can set this to show a time
value at every division: annotation per tick.
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To set the time annotation: 

To set the number of time values displayed in the X-annotation area proceed
as follows:

1 Using a right mouse click in the display area access the context menu.
2 In the context menu select Display Setup...
3 In the Display Setup dialog select the Annotation & Grid page.
4 Make sure that in the Show area the X-Annotation check box is selected

and select in the X-annotation area Show annotation per tick.
5 In the Grid area set the number of Horizontal divisions you want to use.
6 Click OK when done.

Figure 6.9: X-axis annotation

A Default annotation: begin, end and time/division

B Annotation per tick

You can set the time interval that you see on the display. Use the various Time
Scale options to fit (a part of) the waveform in the display area.
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To set the Time Scale proceed as follows:

1 Using a right mouse click in the display area access the context menu.
2 In the context menu point to Time Scale ►

3 In the sub menu that comes up select one of the following options:
l Auto The complete recording (all available data) from start to end is

shown in the display area. This function can also be accessed through
the auto scale button in the time control as explained in
Figure 6.19 "Time control" on page 159.

l Time per Division ► In the sub menu that comes up select a value.
The displayed data will be the number of divisions times the time per
division.

l Select... In the dialog that comes up use the Start and End fields to
define a segment of the complete waveform to be shown in the display.

6.2.4 Control area
The control area is a part of the display that contains one or more controls. The
control area can be hidden as well as individual controls. The control area can
hold the following controls:
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l Page control Manage pages
l Time control Scroll through the waveform data
l Replay control Replay waveform data
l Cursor values Show the values of the active and passive cursor

To show or hide control items:

You can select to show or hide individual control items as well as the complete
control area. To do so proceed as follows:

1 On the dynamic menu, click Setup Display, or right-click in the display area
to see the shortcut menu and select Display Setup.

2 In the Display Setup dialog select the Display Setup page.
3 In the Control area select the items you want to include in the control area.
4 Under Icon size sub section select an icon size.
5 Click OK when done.

Page control 
You use the page control primarily to step through the available pages. In
addition the page control allows you to modify a page name directly in the
control.

To step through the pages click the Next Page button and Previous Page
button. In addition you can use the following keyboard accelerators:

l Ctrl+Page Up to go to the previous page
l Ctrl+Page Down to go to the next page
l Ctrl+1 ... 9 to go directly to the indexed page
l Ctrl+Home to go to the first page
l Ctrl+End to go to the last page
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Figure 6.10: Page control functionality

A Default view

B Rename page

C List view

D Previous page

E Next page

In the text field of the page control you can do:

l Click: A drop down list shows all available pages. The currently active page
is marked. Click on a page name in the list to jump directly to that page.
Note that numbering used by the default naming continues to increase even
if previous pages have been deleted. The number is not an index

l Double-click: When you double-click the text field, the name of the page
is highlighted. Now you can modify the name. Press Enter to accept or
Escape to cancel.

l Right-click: A context menu will come up. Refer to "Page commands" on
page 188 for details.

Time control
The time control is explained in full detail in "Using the keyboard and time
control to zoom" on page 159.

Replay control
The replay control is explained in full detail in "Replay data" on page 161.

Cursor values 
In the control area you can select to show the cursor values. Depending on the
available screen area not all of the information may be visible. A tooltip provides
the same information.

Perception

144 A02689_09_E00_00   HBK: UNRESTRICTED



Figure 6.11: Cursor values in display control area

A X-value of active cursor

B X-difference of active and passive cursor

C Y-value of active cursor

D Y-difference of active and passive cursor

E Tooltip

6.2.5 Event/digital traces 
Event (or digital) traces are different from ‘normal’ waveforms with respect of
their possible values. Possible values are binary: either one (1) or zero (0) or
low/high, on/off, open/close, etc.

These traces are displayed differently as shown in the following diagram.
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Figure 6.12: Event traces

A Low

B Low + High

C High

A A low value is displayed as a one-pixel line.
B When within a certain time interval the values are low and high, but these

values cannot be displayed separately due to time scaling constraints, a
full height bar is displayed.

C A high value is indicated by a half-height bar from the top

You can set the size of the event traces.

To set the size of the event traces:

1 Using a right mouse click in the display area access the context menu.
2 In the context menu select Display Setup...
3 In the Display Setup dialog select the Annotation & Grid page.
4 In the Sizes area under Event traces select the size you want.
5 Click OK when done.
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6.2.6 The waveform display event bar 
The event bar in the waveform display is used to hold the vertical measurement
cursor handles and to hold markers that reflect a specific event. The markers
are placed on the event bar at the time position on which the event took place.
When you hover over an event marker a tooltip gives additional information
when available.

Figure 6.13: Event bar markers

A Active cursor handle (red). In addition each cursor handle has a fixed
number (1 or 2) for static reference.

B Passive cursor handle (blue). In addition each cursor handle has a fixed
number (1 or 2) for static reference.

C Video marker: a video stream is available, starting at this point. Double-
click the marker to start the video.

D Bookmark: a text is available at this point. Double-click the marker to read
it.

E Audio marker: an audio stream is available, starting at this point. Double-
click the marker to start the audio.

F Alarm: an alarm event occurred at this point.
G Trigger: a trigger occurred at this point.
H Start of recording. Multiple start-of-recording markers can be present in a

display.
I End of recording. Multiple end-of-recording markers can be present in a

display.
J Cold trigger: a trigger condition has been met. However it did not trigger

the acquisition, i.e. it did not start the posttrigger segment.
K Communication restored (OK): the communication with a remote front-end

has been restored (is OK). This typically happens after a communication
failure.

L Communication failure: there is no communication possible anymore with
a remote front-end. A typical cause is cabling malfunction.

M Poor quality communication: there is communication possible with the
remote front-end, but communication is poor. Loss of data and
misinterpretation of commands is possible.

N Clock synchronized: the internal clock of a mainframe is now synchronized
with the selected synchronization source. This can be in Master/Sync
mode, PTP, or using an IRIG/GPS synchronization source. This situation
also occurs when you switch from one source to another.

O Clock not synchronized: the internal clock of a mainframe has lost the
synchronization with the selected clock source. Typical causes are cabling
malfunction or no GPS signal.
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P Recording paused: the recording was paused. No data will be recorded
from this point until the recording is resumed. A tooltip displays details, as
shown in Figure 6.14.

Figure 6.14: Event marker - toolptip

Q Recording suspended: the internal memory of the mainframe is full. The
recording will first be stored in the experiment and then it will resume
automatically. A tooltip shows details.

R Frequency too high: the cycle source input signal frequency is too high;
multiple cycles will be used to calculate results.

S Frequency too low: the cycle source input signal stayed between the two
hysteresis levels longer than the can be handled through the available
computation memory. This typically occurs if the frequency is too low, but
there are other possibilities. Please refer to the cycle detection description
for more information.

T Cycle detect normal: cycle detection on the input signal is operating
normally again after detecting an earlier problem.

U Invalid calculation result: no cycles have been detected on the input signal
for a prolonged period. Possible causes:
l No cycle source input signal.
l The cycle source input signal range is outside the cycle source

hysteresis/levels settings, for example because of a DC offset.
l The input signal stays between the two hysteresis levels too long (also

indicated by the frequency too low marker, but now for such a long
period that no more calculations can be done based on the cycle
source).

V Calculated trigger: a calculated channel generated a trigger at this position,
but the hardware has triggered at a later point in time.

W Cycle detector overload: the cycle detector has lost track of its input signal
due to high frequency components in the signal.

X PTP master information: When using a PTP sync source this marker is
present at start of a recording and upon each move to a different PTP
master. The tooltip of this marker contains more information about which
mainframe is using which PTP master.
If this happens during a recording it is always preceded by a “Sync Lost”.
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6.3 Waveform display operation
This section describes how to use a waveform display and how to benefit as
much as possible from its capabilities

6.3.1 Adding traces to a display
There are various ways to add traces to a display. Most of them are based on
drag-drop from one of the navigators.

Using the Hardware Navigator
For more details on how to use the Hardware Navigator for data source
selection refer to the Hardware Navigator section: "Data source selection for
display" on page 92.

To select a data source:
To select data sources using the hardware navigator do one of the following:

l Select a recorder or a (number of) channels and drag them onto an empty
sheet or sheet section. A new display will be created that fills the complete
sheet (section) with the selected channels displayed. When data is
available this will be shown.

l Select a recorder or a (number of) channels and drag them onto an existing
display. The selected channels will be added as overlaid traces to the
targeted pane.

Using the Recordings Navigator
For more details on how to use the Recordings Navigator for data source
selection refer to the Recordings Navigator section: "Data source selection for
display" on page 104.

To select a data source:
To select a data source for a display do one of the following:

l Select a recording and drag it onto an empty sheet or sheet area. A new
display will be automatically created that fills the entire sheet (area) with
the selected recording displayed with channels as stacked (separated)
traces.

l Select a recording and drag it onto an existing display. The selected
recording will be added as overlaid traces to the targeted pane.

Using the Data Source Navigator
For more details on how to use the Data Source Navigator for data source
selection refer to the Data Source Navigator section:"Data source selection for
display and meters" on page 109.
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To select a data source:
To select data sources using the data sources navigator do one of the following:

l Select a recorder or a (number of) channels and drag them onto an empty
sheet or sheet section. A new display will be created that fills the complete
sheet (section) with the selected channels displayed. When data is
available this will be shown.

l Select a recorder or a (number of) channels and drag them onto an existing
display. The selected channels will be added as overlaid traces to the
targeted pane.

Using Display Setup
You can create a complete display with panes and traces from scratch using
the Display Setup dialog.

To create a display setup from scratch:
Once a display is on a sheet proceed as follows:

1 Using a right mouse click in the display area access the context menu. You
can also access this dialog for the active display through the Setup
Display ... command on the dynamic menu.

2 In the context menu select Display Setup...
3 In the Display Setup dialog select the Display Setup page. In this page do

one of the following:
l Add or remove pages.
l Rename page(s).
l Configure the display and zoom behaviour.
l Configure the control area.

4 In the Display Setup dialog select the Annotation & Grid page. In this page
you define:
l The type and layout of X and Y-annotation.
l The various colors used in the display.
l The grid and separator settings.

5 In the Display Setup dialog select the Panes Setup page. In this page do:
a Add or remove panes as required.
b Select a pane and select the data sources that should go in it.
c Re-arrange traces when required.

6 In the Display Setup dialog select the Traces Setup page and modify the
trace properties as required.

7 Click OK when done.

6.3.2 Drag and drop traces
A summary of how to move and select traces.

l To select a trace you must click on a trace in the Y-annotation area.
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If there are more than one trace in a pane:
l Cycle through traces with a single click in the panes Y-annotation area.
l Click on a trace name to specifically select that trace.
 
Drag and drop a selected trace to compare traces:
l Select a trace.
l Drag it over another trace and drop.
 
The two traces are now combined and overlapped. More traces can be added
this way.

Separate combined traces

You can separate combined traces by opening another trace from the context
menu or with drag and drop.
To separate combined traces by opening another trace from the context
menu:
l Open another trace from the context menu (for more information see

"Waveform display miscellaneous context commands" on page 186).
l Drag the required trace back into an empty trace.
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To separate combined traces with drag and drop:
1 Select a trace.
2 Drag it over a pane separator as shown in Figure 6.15.
3 The pane separator will be highlighted and the cursor icon will change into

a “drag to new pane” icon.

Figure 6.15: Drag trace over pane separator

A Drag icon

4 Drop the drag icon to create a new pane between the existing panes or at
the top or bottom of the display area.

For more information on organizing traces refer to "Traces Setup" on
page 201.
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Move a trace to a different or new page 

To move a trace to a different or new page:
1 Select a trace.
2 Drag it to the page selection area.

Figure 6.16: Drag trace to different or new page

A Page selection area

3 The page selection area shows all existing pages and a new page.
4 Drop the drag icon in the desired page.

6.3.3 Modifying the display layout
Various options are available to adapt the layout of any individual waveform
display to suit your requirements. These options include, but are not limited to,
general layout, number of pages, numbers of panes and pane size, colors, grid,
etc.
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Modifying the view arrangement and view type 
The arrangement of views in a display as well as their size is controlled by split
modes and splitters. For details on the usage of these controls refer to "Layout
and splitters" on page 76. You can modify the current layout. You cannot add
or delete views using the Split settings.

To gain access to the split settings:

To gain access to the split settings within the display proceed as follows:

1 With a right mouse click in the display area call up the context menu.
2 In the context menu point to Split ►

3 In the sub lists make your choice.
What you see in a view is defined by the sources that are connected to a view
and the view type. There are four basic types:

l Review in either sweep or recording mode.
l Zoom: a detail of the review view.
l Alternate zoom: another detail of the review view.
l Live: live streaming data.
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Review A view is in review mode when stored data is shown. This can be either
from a recording on disk, data stored locally in the data acquisition system, or
a partially stored recording that is still active. This last option is the so-called
“review while recording” feature.

When in review mode you can select between Recording and Sweep:

l Recording: what you see is the complete recording, or the recording as
far as it has been stored when recording is still active.

l Sweep: what you see is a selected sweep or the last recorded sweep when
recording is still active.

Zoom A zoomed area of a review view is displayed.

Alternate zoom Another zoomed area of a review view is displayed.

Live The view is in live mode when you are looking to live data coming from an
acquisition system. Within a display there can only be one Live view. When you
switch a view from review to live while another view is already in live mode, this
view will be switched automatically to review mode.

Live mode is only available when an acquisition system is connected to the
display and the system is in Pause or Acquire mode.

To switch between view types:

To switch between the various view types proceed as follows:

1 Right-click the view mode indicator of a view.

2 In the context menu that comes up click the view mode and option(s).
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When you apply the above procedure to the live view a modified list of
possibilities comes up:

l Sweep Triggered Each sweep is displayed as-is.
l Display Triggered Each sweep is displayed with a display trigger as

reference point.
l Scoping Provides a stable picture like an oscilloscope.
l Scrolling Provides a scrolling display.
l Display Trigger Sets the position of the trigger point as percentage of the

sweep length.

Modifying the pane size 
You can modify the (vertical) size of a pane in a Review view at any time. When
you hover the mouse over a pane separator in the Y-annotation area, the mouse
pointer will change into a pointer with arrows. The arrows point in the direction
that you can move the separator. While dragging the affected pane separators
are displayed as dotted lines. You can also modify the pane size through the
Display Setup dialog.

To modify pane size(s) do one of the following:

l Click and drag the splitter in the required direction. This will modify the
height of the pane above, and the height of the pane below the selected
pane separator.

l Shift+drag the splitter in the required direction. This will modify the height
of all panes below the selected pane separator. You must press and hold
down the SHIFT key before pressing the mouse button.

l Ctrl+drag the splitter in the required direction. This will modify the height
of all panes above the selected pane separator. You must press and hold
down the CTRL key before pressing the mouse button.
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l Using a right mouse click in the display area access the context menu, and
proceed as follows:
1 In the context menu select Display Setup...
2 In the Display Setup dialog select the Panes Setup page. In this page

select a pane and set its height.
3 Click OK when done.

6.3.4 Zooming and panning     
A powerful feature of the display is the ability to zoom in on a segment of interest
of the waveform. Perception supports fully free-style zooming and panning in
two areas of the waveform data. The second zoom area is called the alternate
zoom. All zoom functions on the alternate zoom are performed exactly the same
as on a normal zoom but with the ALT key pressed.

Figure 6.17: Zoom areas

To zoom in:
l Click and drag the mouse. A bounding box with a semi-transparent fill will

appear indicating the zoom area. When you release the mouse, a zoom
view will be created filled with the zoomed portion of the original view. The
zoom area is shown as a raised semitransparent bounding box in the review
view. The alternate zoom area is shown as a sunken semi-transparent
bounding box in the review view. When zooming you can press the CTRL
or SHIFT key to constrain the zoom area in the X or Y direction respectively.
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Figure 6.18: Zoom area indicator and cursor shapes

A Resize vertically

B Resize horizontally

C Move entire zoom area

D Resize both horizontally and vertically

To resize a zoom area:

You can resize a zoom area by dragging a side or a corner of the bounding box
to another location as follows:

l With the mouse hover over a border or corner. When an arrow cursor
appears click and drag in the required direction.

To move the zoom area:

You can move the zoom area by dragging it to another location as follows:

l With the mouse hover over the zoom area. When the four-way cursor shape
appears click and drag the zoom area to another location.

To unzoom:

l Right-click a view. In the context menu that comes up click Unzoom. The
zoom area will disappear.
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Using the keyboard and time control to zoom
You can also zoom with keys on the keyboard. This allows you to zoom without
creating a zoom display. You can also use the time control.

To zoom using the keyboard do one of the following: 

l To compress and expand in the x-direction (time scale) press the - (minus),
+ (plus), * (asterisk) or / (slash) on the numeric key pad.

l To compress and expand in the y-direction (trace scale) press the - (minus),
+ (plus), * (asterisk) or / (slash) on the numeric key pad while pressing at
the same time the CTRL-key.

These options are also accessible through the display context menu: right-click
the display area. In the context menu that comes up point to Time Scale or
Trace Scale to access these commands.

HINT/TIP

Right-click in the display area, go to Time Scale, then click Select... To see the
shortcut menu, right-click on the actual time scale and then click Select...

To zoom using the display time control:

l Make sure the time control is visible. If not:
1 Right-click in the display area to see the shortcut menu. In the shortcut

menu that comes up click Display Setup...
2 In the Display Setup page select Show timescale indicator in the

Control Area section.
l Click the Compress, Expand or Autoscale button.

Figure 6.19: Time control

A Compress time scale

B Scroll arrows

C Scroll box, a.k.a. thumb, slider or elevator

D Scroll bar shaft
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E Expand time scale

F Autoscale time scale

Scrolling waveforms on the X-axis 
Once you have zoomed in the review area, i.e. you can only see part of the
recording in the review area, you can move this area along the x-axis (time
scale) only. This is called scrolling. Scrolling is supported in various ways as
described below.

Keyboard You can use the Page Up and Page Down keys to scroll one screen
to the left and right respectively. Use the Home key to jump immediately to the
beginning of the waveform and the End key to jump to the end of the waveform.

Mouse wheel When you are using a mouse with integrated wheel button, you
can use the wheel (plus optional Shift key) to scroll the waveform to the left and
to the right.

Time control scroll bar You can use the display time control scroll bar to scroll
through the waveform. When you click a scroll arrow, the data in the display
moves, revealing data in the direction of the arrow. The scroll box moves along
the scroll bar to indicate how far the visible portion of the waveform is from the
edge. The size of the scroll box reflects the difference between what is visible
in the display and the entire contents of the waveform (file). Refer to
Figure 6.19 "Time control" on page 159 for graphical details.

To scroll using the display time control:

l Make sure the time control is visible. If not:
1 Right-click the display area. In the context menu that comes up click

Display Setup...
2 In the Display Setup page select Show timescale indicator in the

Control Area section.
l Click on the scroll arrows and drag the scroll box.

Mouse wheel support 
The waveform displays include support for computer mice that have a wheel
button.

l Use the wheel to scroll the waveform to the left and to the right.
l Hold down the SHIFT key and use the wheel to scroll the waveform to the

left and to the right in larger steps.
l Hold down the CTRL key and use the wheel to zoom in and out on the X-

axis.
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l Hold down the CTRL+ALT key combination and use the wheel to move the
selected trace up and down.

l Hold down the CTRL+SHIFT key combination and use the wheel to zoom
in and out on the Yaxis of the selected trace.

6.3.5 Replay data  
Recorded data can be replayed within a Review view of the waveform display.
The data can be either from a stored recording, or it can be part of the current
acquisition. When the data to replay is part of the current recording then the
feature is called “review while recording”.

The replay functionality is controlled by the replay control that is located in the
control bar of the display. The layout and functions of the replay control depend
on the review mode: continuous or sweep.

Replay continuous data

Figure 6.20: Replay control for continuous data

A Jump to begin of data

B Play backward

C Stop

D Play forward

E Jump to end of data

To replay continuous data:

To replay continuous data proceed as follows:

1 Make sure the view is in continuous mode. If not:
a Right-click the view mode indicator of a view.
b In the context menu that comes up select the Review and

Continuous option.
2 Make sure the replay control is visible. If not:

a Right-click the display area. In the context menu that comes up click
Display Setup...

b In the Display Setup page select Show replay control in the Control
Area section.
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3 Do one of the following:
l Click one of the jump buttons to go quickly to the start or the end of the

recording.
l Click one of the play buttons to start replay of data.
l To increase the replay speed click the play button again.
l When the replay speed is increased you can decrease the replay

speed by clicking the opposite play button.
l To stop replay click the Stop button.

Replay sweep data

Figure 6.21: Replay control for sweep data

A Jump to begin of data

B Previous sweep

C Next sweep

D Jump to end of data

To replay sweep data:

To replay sweep data proceed as follows:

1 Make sure the view is in sweep mode. If not:
a Right-click the view mode indicator of a view.
b In the context menu that comes up select the Review and Sweep

option.
2 Make sure the replay control is visible. If not:

a Right-click the display area. In the context menu that comes up click
Display Setup...

b In the Display Setup page select Show replay control in the Control
Area section.

3 Do one of the following:
l Click one of the jump buttons to go quickly to the start or the end of the

recording, first and last sweep respectively.
l Click the previous button to show the previous sweep.
l Click the next button to show the next sweep.

You can see the sweep index in the lower left hand corner of the display. The
sweep index is labelled item G in Figure 6-3 .
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6.4 Cursors and basic measurements
Within the Review or Zoom view of a Perception display there are three types
of cursors:

l The vertical  measurement cursors. These are the primary cursors for a
variety of measurements. They also serve as boundaries for calculations.

l The horizontal  cursors. These are additional cursors that provide
amplitude information.

l The slope  cursors. These are free moveable cursors (line segments) that
provide slope/angle information.

Figure 6.22: Cursor types

A Vertical cursors

B Horizontal cursors

C Slope cursors

All three cursor types can be visible or hidden on a per display basis. They can
also be ‘locked’: when cursors of a specific type are locked or grouped, they
move simultaneously.

The various cursor commands are accessible through the toolbar, the dynamic
sheet menu and the display context menu.
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Figure 6.23: Cursor toolbar

A Vertical cursors visibility

B Vertical cursors grouping

C Horizontal cursors visibility

D Horizontal cursors grouping

E Slope cursors visibility

F Slope cursors grouping

G Slope cursors select

To show or hide cursors:

To show or hide specific cursors do one of the following:

l Click on the corresponding visibility button in the toolbar.
l Using the dynamic sheet menu:

1 Point to Cursors ►.
2 Point to the required cursor type.
3 Click Visible.

l Using the context menu:
1 Right-click the display area.
2 In the context menu that comes up, point to the required cursor type.
3 Click Visible.

When cursor visibility is switched to visible, the cursors may come up
‘docked’, i.e. the cursors themselves are not visible, but the handles are
displayed. These handles can appear in a corner or on a side of the waveform
display area. Click and drag these handles to reveal the complete cursors.

Cursors are moved by clicking on the handle or on the cursor line using the
mouse and dragging the cursor to the new location. When you hover the mouse
pointer over the cursor the mouse pointer changes to indicate that you can drag
the cursor or the cursor handle.

You can also drag corresponding cursors as a group, i.e. moving one cursor
automatically moves the other cursor while they maintain their distance.
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To group or ungroup cursors:

To group or ungroup specific cursors do one of the following:

l Click on the corresponding group button in the toolbar.
l Using the dynamic sheet menu:

1 Point to Cursors ►.
2 Point to the required cursor type.
3 Click Group.

l Using the context menu:
1 Right-click the display area.
2 In the context menu that comes up, point to the required cursor type.
3 Click Group.

Figure 6.24: Grouped cursors maintain distance when moved

6.4.1 Vertical cursors 
The event bar at the top of the display is used to place event markers and also
contains cursor “handles” used for moving the vertical cursors. By definition the
red cursor is the active cursor and the blue cursor is the passive (inactive)
cursor. A cursor becomes active when you click on it. Cursors are moved by
clicking on the handle or on the cursor line using the mouse and dragging it to
a new location. When you move the pointer over the cursor the mouse pointer
changes to indicate that you can drag the cursor.
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Figure 6.25: Vertical cursors

A Active cursor (red)

B Trigger event indicator

C Passive cursor (blue)

D Event bar

E Ready-to-drag mouse pointer

F Drag mouse pointer

The values of the vertical cursors can be displayed in the control area (refer to
Figure 6.9 "X-axis annotation" on page 141) and in the Y-annotation area (refer
to Figure 6.6 "Y-annotation options" on page 137).

In addition the cursors also have a number. This number is fixed for that specific
cursor, i.e. it does not change. This makes it easy to reference the cursors
without knowing which one is the active one.

Sample snap 
When you are zoomed in far enough to see the individual samples of a trace
(denoted by dots and connected by a linear interpolated line) you can easily
measure the exact value of each individual sample. To do so drag the vertical
cursor while holding down the CTRL-key. The cursor will snap to each individual
sample while dragging. When you position the cursor between two consecutive
samples, the displayed value is a linear interpolation between the two samples.
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Figure 6.26: Individual samples and sample snap

Auto placement
You can quickly position the active cursor on a trigger point:

l The keyboard combination Ctrl+T moves the active cursor to the next
available trigger to the right of the original position and re-centres the
display around the trigger.

l The keyboard combination Ctrl+Shift+T moves the active cursor to the
next available trigger to the left of the original position and re-centres the
display around the trigger.

Miscellaneous functions
More vertical cursor functions are available through the display context menu.

Set Cursor at Position

You can set the active cursor at the position where you clicked with the mouse
in the display. To do so proceed as follows:

1 Right-click the display area.
2 In the context menu that comes up, point to Vertical Cursors ►.
3 Click Set Cursor at Position

Change Active

You can swap the active and passive cursor: the active cursor becomes the
passive cursor and vice versa. Their position remains intact. To do so proceed
as follows:

1 Right-click the display area.
2 In the context menu that comes up, point to Vertical Cursors ►.
3 Click Change Active.
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Find and Go To
You can search for specific events in a waveform and jump to that location with
the active cursor. To search for a specific event and jump to it proceed as
follows:

1 Make sure that the waveform you want to inspect is active.
2 Right-click the trace area of the waveform you want to inspect.
3 In the context menu that comes up, point to Vertical Cursors ►.
4 Click Find and Go To.... The following dialog will come up:

Figure 6.27: Find and Go To dialog

A Display name

B Trace name

C Search parameters

D Go to next event

E Go to previous event

F Close dialog

G Center display around event

H List of search criteria

A Display name The dialog header shows the name of the display that is
selected.

B Trace name The name of the selected trace is shown. Make sure this is
the correct one.
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C Search parameters Depending on the selected search criterion one or
more parameters may be required to define the exact condition. Enter
values and/or make the correct selections here.

D-E Command and Buttons Select Next or Previous to jump between
successive events.

F Close Select when done.
G Center Display Select this option if you want to center the display around

the event.
H Search criteria List of criteria that you can use.

You can also gain access to this dialog as follows:

l Select [dynamic menu] ► Find and Go To...
l When available in the toolbar click the Find and Go To button 

6.4.2 Horizontal cursors 
Horizontal cursors are additional cursors that you can use for amplitude
measurements. By definition the red cursor is the active cursor and the blue
cursor is the passive (inactive) cursor. A cursor becomes active when you click
on it. Cursors are moved by clicking on the handle or on the cursor line using
the mouse and dragging it to a new location. When you move the pointer over
the cursor the mouse pointer changes to indicate that you can drag the cursor.

In addition the cursors also have a number. This number is fixed for that specific
cursor, i.e. it does not change. This makes it easy to reference the cursors
without knowing which one is the active one.

Figure 6.28: Horizontal cursors

A Active cursor (red)

B Passive cursor (blue)

C Ready-to-drag mouse pointer

D Drag mouse pointer
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Set Cursor at Position

You can set the active cursor at the position where you clicked with the mouse
in the display. To do so proceed as follows:

1 Right-click the display area.
2 In the context menu that comes up, point to Horizontal Cursors ►.
3 Click Set Cursor at Position.

6.4.3 Slope cursors 
While horizontal and vertical cursors can be moved only along a single axis,
the slope cursors offer you complete freedom of size and position.

Three slope cursors are provided. You can select to use one, two or all three
slope cursors. Each cursor can be freely positioned, and the end points can be
dragged to any location. This freedom allows you to create a tangent and
measure the slope of a curve

There is no active slope cursor. Each cursor is color coded and has a fixed
number.

Figure 6.29: Slope cursors

A Blue slope cursor (2)

B Red slope cursor (1)

C Green slope cursor (3)

D Ready to move mouse pointer

E Move mouse pointer
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F Ready to rotate mouse pointer

G Rotate mouse pointer

Set Cursor at Position

You can set the last activated slope cursor at the position where you clicked
with the mouse in the display. To do so proceed as follows:

1 Right-click the display area.
2 In the context menu that comes up, point to Slope Cursors ►.
3 Click Set Cursor at Position.

Select number of slope cursors

You can select the number of slope cursors you want to use in your display. To
select the number of slope cursors do one of the following:

l When available in the toolbar you can select the Number of Slope
Cursors  drop down list and select one, two or three cursors

l Using the dynamic sheet menu:
1 Point to Cursors ►.
2 Point to Slope Cursors ►.
3 In the sub menu that comes up, select one, two or three cursors.

l Using the context menu:
1 Right-click the display area.
2 In the context menu that comes up, point to Slope Cursors ►.
3 In the sub menu that comes up select one, two or three cursors.

6.4.4 Cursor measurements
The values of the vertical cursors can be displayed in the control area (refer to
Figure 6-9 "Cursor values" on page 144) and in the Y-annotation area (refer to
Figure 6-6 "The Y-annotation area" on page 135).

In addition a window can be displayed with all cursor values, including
horizontal and slope cursors. The Cursor Table shows the cursor values of the
active display.

This window also provides functionality to copy values to clipboard and post
values to Excel.

To show or hide the Cursor Table make sure a display is active and do
one of the following: 
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l When available in the toolbar you can click the Cursor Table button .
l With the display selected: press the space bar.
l Using the dynamic sheet menu:

1 Point to Cursors ►.
2 Click Cursor Table

l Through the context menu:
1 Right-click the display area.
2 In the context menu that comes up, click Cursor Table.

l In addition you can close the Cursor Table as follows:
l Click Close in the title bar of the window.
l Click Close in the Settings menu of the window.

Figure 6.30: Cursor Table

A Menu bar

B Vertical cursors area

C Horizontal cursors area

D Slope cursors area

E Crossing parameters cursor 1 / cursor 2

F Crossing parameters cursor 1 / cursor 3

G Crossing parameters cursor 2 / cursor 3

H Toolbar
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A Menu bar The menu bar has one menu: Settings. The settings
menu provides access to all additional features of the Cursor Table.

B Vertical cursors  The vertical cursors area has rows for each trace
and a bottom row to display the time information.

C Horizontal cursors  The horizontal cursors area has a single row.
This row displays the active trace.

D Slope cursors  The slope cursors area has two sections: one for
the slope of each cursor and one for the crossing of each cursor
with another cursor.

E, F, G Refer to Figure 6.30 "Cursor Table" on page 172, for the location
of the following details:
E The crossing of cursor 1 and cursor 2
F The crossing of cursor 1 and cursor 3
G The crossing of cursor 2 and cursor 3
Note
The crossing of the cursors is not visible by definition. The crossing
is calculated by the position and slope of the visible cursors. When
the crossing is outside the visible area, extrapolation is used to
calculate the virtual crossing of the two cursors.

a

b

Figure 6.31: Slope cursors crossing

a Actual crossing

b Virtual crossing
H Toolbar The toolbar provides quick access to the most commonly

used commands.
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A Menu bar in Detail:

Figure 6.32: Cursor table settings menu

Active Trace Values
Show only the values of the vertical cursors and the active trace.
When information on horizontal and/or slope cursors is available
these will be shown also.
 
All Traces Values
Show the values of the vertical cursors and all traces. When
information on horizontal and/or slope cursors is available these
will be shown also.
Values are displayed in technical units. For event traces technical
units typical are 1/0, high/ low, on/off, etc.
 
Engineering Format
Select this option when you want the displayed values to be in
engineering format. This format is a scientific notation in which the
power of ten is a multiple of three. The power of ten is represented
by prefixes like kilo or milli.
 
Scientific Format
Select this option when you want the displayed values to be in
scientific format. This format is a shorthand way of writing very
large or very small numbers. A number expressed in scientific
notation is expressed as a decimal number between 1 and 10
multiplied by a power of 10.
 
X-axis Format
Select this command to set the format used to display time.
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Figure 6.33: X-Axis Format dialog

By default the time is displayed as short as possible: only the
available information is displayed without leading zeros. In the x-
axis format dialog you can set the number of decimal places used
behind the seconds.
Select Use full notation when you always want the complete
format. The number of days is only displayed above 24 hours.
 
Static Cursor Table
Select this option when you want to use the fixed numbers of the
horizontal and vertical cursors as reference instead of the relative
‘left/right’ and ‘top/bottom’ naming. Use this option if you want the
values in the columns related to a cursor remain in the same
column. For example when you move one cursor to the other side
of the other cursor, the indication remains in the same column:
values from one cursor are always in the same column, regardless
of the position of the cursor.

Figure 6.34: Static and non-static cursor table

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 175



 In the figure above situation A and B depict the operation when the
table is non-static.

a Start situation: the red cursor (active) is on the left-hand side
of the blue (passive) cursor. You can verify this by looking at
the Time positions (750 ms vs 1.2 s). When we move the active
cursor to the other side of the passive cursor we get situation
b.

b End situation: the active cursor is on the right-hand side of the
passive cursor. You can verify this by looking at the Time
positions (1.2 s vs 1.6 s). The values that correspond to the
passive cursor have moved from the right-hand column to the
left-hand column, i.e. the columns are swapped.
In Figure 6.34 situation c and d depict the operation when the
table is static.

c Start situation: the red cursor (#1) is on the left-hand side of
the blue (#2) cursor. You can verify this by looking at the Time
positions (677 ms vs 1.3 s). When we move the active cursor
#1 to the other side of the passive cursor #2 we get situation
d.

d End situation: the red cursor (#1) is on the left-hand side of the
blue (#2) cursor. You can verify this by looking at the Time
positions (1.9 ms vs 1.3 s). The values that correspond to the
cursors remained in their respective columns however, i.e. the
columns are not swapped.

Copy to Clipboard
You can copy values to clipboard and paste these values in
another application. You can select to copy only the values of the
horizontal, vertical or slope cursors. The copy includes the column
headers.
 
Copy to Excel
You can copy the values directly to Microsoft® Excel with the
following options:
l Post To This will place the complete table into Excel on a sheet

called “ Perception - <display name>". When Excel is not
active it will be launched. When the sheet already exists data
will be overwritten.

l Append To The data will be appended to the data that is
already in the sheet called “ Perception - <display name>".

l Copy to Current Cell Data will be placed in the currently
active sheet with the upper lefthand cell of the cursor table in
the currently active cell of the sheet.

 Close
Close the Cursor Table.
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B Horizontal Cursors in Detail The columns provide the following
information:
l Name The name of the active trace.
l Left/Cursor 1 The Y-value of a trace at the named cursor

position. The cursor position in time is shown in the Time row.
A red and blue indicator is used to denote the active (red) and
passive (blue) cursor.

l Right/Cursor 2 The Y-value of a trace at the named cursor
position. The cursor position in time is shown in the Time row.
A red and blue indicator is used to denote the active (red) and
passive (blue) cursor.

l Delta The difference between the cursor values.
l Units The technical units.

C Vertical Cursors in Detail The columns provide the following
information:
l Name The name of the trace.
l Top/Cursor 1 The level of this cursor with respect to the active

trace. Depending on the location of the cursor this level may
be well above or below the actual levels of the active trace. A
red and blue indicator is used to denote the active (red) and
passive (blue) cursor.

l Bottom/Cursor 2 The level of this cursor with respect to the
active trace. Depending on the location of the cursor this level
may be well above or below the actual levels of the active
trace. A red and blue indicator is used to denote the active
(red) and passive (blue) cursor.

l Delta The difference between the cursor values.
l Units The technical units of each trace and the time.

D Slope Cursors in Detail
The slope section has a single row. This row displays the name
of the active trace. The slope values are related to the X- and Y-
axis of that trace. The columns provide the following information:
l Name The name of the active trace (reference trace)
l Cursor 1, 2, 3 The slope value of each cursor
l Units The slope in the units of the reference trace.

The crossing section provides information about the crossing of
each cursor with any other cursor. Units are with respect to the
reference trace.
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6.4.5 Cursor navigation
The cursor navigation keys are used to easily navigate the display cursors
through your displayed waveforms. The cursor navigation keys are available
via a Perception Cursor Navigation panel.

Figure 6.35: Cursor Navigation

The panel can be enabled or disabled via the Perception Window menu item
(see Figure 6.36): Cursor Navigation

Figure 6.36: Window menu with cursor navigation enabled

A Show/hide cursor navigation

B Cursor Navigation Properties
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The Cursor Navigation panel is always linked to the active display and operates
on the active trace in this display. The name of the active display and active
trace are shown at the top of the dialog. When there is no active display and/
or no active trace the keys are disabled.

The panel contains the following cursor navigation buttons:

Previous Relative Maximum

The active cursor steps to the previous relative (or local) maximum on the
active trace.
 

Next Relative Maximum

The active cursor steps to the next relative (or local) maximum on the active
trace.
 

Previous Relative Minimum

The active cursor steps to the previous relative (or local) minimum on the active
trace.
 

Next Relative Minimum

The active cursor steps to the next relative (or local) minimum on the active
trace.
 

Go to absolute Maximum

Set the active cursor at the absolute maximum of the active trace.
 

Go to absolute Minimum

Set the active cursor at the absolute minimum of the active trace.
 

Previous Level Crossing

The active cursor steps to the previous level crossing on the active trace. The
level can be specified via the Cursor Navigation Properties dialog. This
dialog can be opened by a right button click on this key or via the Windows
main menu item Cursor Navigation Properties…
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Next Level Crossing

The active cursor steps to the next level crossing on the active trace. The level
can be specified via the Cursor Navigation Properties dialog. This dialog can
be opened by a right button click on this key or via the Windows main menu
item Cursor Navigation Properties…
 

Previous Step

The active cursor steps back by the specified step value. The step value can
be specified via the Cursor Navigation Properties dialog. This dialog can be
opened by a right button click on this key or via the Windows main menu item
Cursor Navigation Properties…
 

Next Step

The active cursor steps ahead by the specified step value. The step value can
be specified via the Cursor Navigation Properties dialog. This dialog can be
opened by a right button click on this key or via the Windows main menu item
Cursor Navigation Properties…
 

Previous Trigger

The active cursor goes to the previous trigger position.
 

Next Trigger

The active cursor goes to the next trigger position.
 

Previous Voicemark

The active cursor goes to the previous voicemark position.
 

Next Voicemark

The active cursor goes to the next voicemark position.
 

Previous Marker

The active cursor goes to the previous marker mark position.
  

Next Marker

The active cursor goes to the next marker mark position.
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Swap Cursors

Exchange the positions of the two cursors. This has the effect of making the
inactive cursor the active one.
  

Set Cursor at Other Cursor

Set the inactive cursor at the position of the active cursor.
  

Slope between Cursors

Set a slope cursor on the active trace between the two vertical cursors.
  

Specific X-Position

Shows a dialog box (see Figure 6.37) to specify the new X-value for the active
cursor, requesting you to enter the new X-value for the active cursor.

Figure 6.37: Go to Specific X-position dialog

A Numerical value or selected data source

B Select data source
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The x value can either be a fixed numerical value (A), but can also be a data
source (B). A data source entry can be very usefull in case you are interested
to set the cursor at a calculated position, for example set the cursor to the time
where the trace has the steepest tangent.
The formulas can look like:

Figure 6.38: Formula example

Now you can use the calculated position to set your cursor there.

Figure 6.39: Example of specifying the new X-value with a formula

A X-value specified by a formula

Cursor navigation properties
The Cursor Navigation Properties dialog (see Figure 6.36) can be shown via
the Window menu or via a right mouse click on the level crossing or step keys.
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The Cursor Navigation Properties dialog looks like:

Figure 6.40: Cursor Navigation Properties dialog

A Level Define the level used to find the correct level crossings.
B Direction Define the direction used to find the correct level crossings.
C Step(s) Define the stepsize expressed in the same units as the X-axis, this

will be mostly seconds.

6.4.6 Statistical calculations
Within Perception a variety of statistical calculations and parameter extraction
can be performed easily on the waveform data shown as active trace in the
active display.

To show or hide the Calculations window make sure a display is active
and do one of the following:

l When available in the toolbar you can click the Calculator button  .
l Using the dynamic sheet menu:

1 Click Calculator.
l Through the context menu:

1 Right-click the display area.
2 In the context menu that comes up, point to Calculate.
3 Select one of the calculation options.
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l In addition you can close the Cursor Table as follows:
l Click the Close button in the title bar of the window.
l Click Close.

Figure 6.41: Calculations window

A Calculation selection

B Result area

C Progress bar

A Calculations  The Calculation window provides four categories of
calculations that you can use:
l Statistics   This category includes calculations for statistical values

such as mean value, standard deviation, signal root-mean-square
( RMS ) value, maximum and minimum value.

l Cycle   Various parameters related to repetitive signals is calculated
in this category. Included are frequency, period, number of cycles and
standard deviation.

l Pulse   This category comprises an extensive range of (single) pulse
parameters like: rise time, fall time, pulse width, top, base, duty cycle,
pre-shoot and overshoot.

l Area Energy and area under curve are calculated here.
B Results The results of the calculations are shown in the result area. The

following generic information is always displayed: channel name, begin
and end time of the calculation interval, i.e. the vertical cursor positions,
duration and the actual number of samples used for the calculations.

C Progress bar The progress bar shows the progress for calculations on
large data sets. You can click the Abort button to abort a calculation.
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To perform calculations:

To perform calculations make sure the window is open and proceed as follows:

1 Select the waveform display that you want to use. The name of the selected
waveform display is shown in the title bar of the calculation dialog.

2 Select the channel on which you want to perform the calculations. The
name of the selected channel is displayed in the result area of the
calculation dialog.

3 In the Calculation dialog select the calculation. The progress bar shows the
progress for calculations on long records. Click the Abort button to abort a
calculation.

You will need to repeat (steps of) the above procedure when you want to
perform a calculation on another display, channel or time interval.

HINT/TIP

For more information on transitions, pulse and pulse parameters refer to the
“IEEE Standard on Transitions, Pulses and Related Waveforms”, IEEE Std
181-2003.
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6.5 Waveform display miscellaneous context commands
A variety of functions and commands is directly accessible through the context
menu. The context menu gives you quick access to the most commonly used
functions. This section describes all display context menu commands that are
not covered elsewhere in this manual.

To gain access to the context menu:

l Right-click the display area.

6.5.1 Trace commands 
Trace commands let you add, modify and delete traces.

To gain access to the trace commands:

l In the display context menu point to Trace ►. The trace submenu comes
up.

New Trace
You can add a trace to the currently active pane. By definition the trace will be
positioned as the last (lowest) trace.

To add a new trace:

1 Click New Trace...
2 In the Select Data Source dialog that comes up select a trace.
3 Click OK when done or Cancel to quit without adding a new trace.

Insert Trace
You can add a trace to the currently active pane on a specific position.

To insert a new trace:

1 Point to Insert Trace ►
2 In the sub menu that comes up click Before Selected Trace... or After

Selected Trace...
3 In the Select Data Source dialog that comes up select a trace.
4 Click OK when done or Cancel to quit without adding a new trace.

Delete Trace
You can quickly delete a trace from a pane, either by using the context menu
command or the keyboard shortcut.
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To delete a trace do one of the following:

l Press the Del or Delete key on your keyboard.
l Select Delete Trace in the trace sub menu.

In the confirmation dialog that comes up click OK.

Trace Setup
Click Trace Setup... to access the Display Setup dialog with the Traces Setup
page selected. Here you can set a variety of trace related parameters and
modify the trace source.

6.5.2 Pane commands 
Pane commands let you add, modify and delete panes.

To gain access to the pane commands:

l In the display context menu point to Pane ►. The pane submenu comes
up.

New Pane
You can add a pane to the currently active display page. By definition the pane
will be positioned as the last (lowest) pane. 

To add a new pane:

l Click New Pane

Insert Pane
You can add a pane to the currently active display page on a specific position.

To insert a new pane:

1 Point to Insert Pane ►
2 In the sub menu that comes up click Before Selected Pane or After

Selected Pane.

Delete Pane
You can quickly delete a pane from a page, either by using the context menu
command or the keyboard shortcut.
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To delete a pane do one of the following:

l Press the Shift+Del or Shift+Delete key combination on your keyboard.
l Select Delete Pane in the trace sub menu.

In the confirmation dialog that comes up click OK.

Pane Setup
Click Pane Setup... to access the Display Setup dialog with the Panes Setup
page selected. Here you can set a variety of pane related parameters and
modify the pane contents, location, etc.

6.5.3 Page commands
Page commands let you add, modify and delete pages. You can also rename
pages and make a copy of the page for use in other programs.

To gain access to the page commands:

l In the display context menu point to Page ►. The page submenu comes
up.

New Page
You can add a page to the currently active display. By definition the page will
be positioned as the last page.

To add a new page:

l Click New Page

Insert Page
You can add a page to the currently active display on a specific position.

To insert a new page:

1 Point to Insert Page ►
2 In the sub menu that comes up click Before Selected Page or After

Selected Page.
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Delete Page
You can quickly delete a page from a display, either by using the context menu
command or the keyboard shortcut.

To delete a page do one of the following:

l Press the Alt+Del or Alt+Delete key combination on your keyboard.
l Select Delete Page in the page sub menu.

In the confirmation dialog that comes up click OK.

Rename Page
You can give a page another name.

To rename a page:

1 Do one of the following:
l Press the Alt+F2 key combination on your keyboard
l Select Rename Page in the page sub menu

2 The name of the page in the page control is highlighted. Now you can
modify the name. Press Enter to accept or Escape to cancel.

Copy Page as Picture
You can copy the page as bitmap and enhanced metafile to the clipboard. Use
the Paste (Special) command to place the image into other programs. Use the
context menu or the keyboard shortcut to access this command.

To copy a page as picture do one of the following:

l Press the Ctrl+Alt+C key combination on your keyboard.
l Select Copy Page as Picture in the page sub menu.

Page Setup
Click Page Setup... to access the Display Setup dialog with the Annotation &
Grid page selected. Here you can set a variety of page related parameters.
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Print Display
You can make a high resolution copy of the visible page of the display on your
printer.

To print a display page:

1 Do one of the following:
l Access the display context menu and click Print <display name>...
l When available in the toolbar you can click the Print button 

2 In the Print dialog that comes up set your (color) preferences and click
Print.
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6.6 Display Setup dialog
The Display Setup... command in the dynamic sheet menu and the display
context menu is the common starting point for accessing a variety of waveform
display properties. Specific properties are also available as (sub) entries in the
display context menu. These entries can give access to the Display Setup
dialog with the corresponding page selected.

The settings and properties are grouped for easy reference and to keep the
user interface as clear as possible. The following main groups are available:

l Display Setup: global display settings and behaviour
l Annotation & Grid: X- and Y-annotation settings as well as grid/separators

settings
l Panes Setup: manage panes and their content
l Traces Setup: define trace source, layout and parameters

6.6.1 Display Setup
The Display Setup page gives access to various properties that are relevant to
the display look and feel.
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Figure 6.42: Display Setup dialog - Display Setup

A Display name

B Control area settings

C Page management

D Add, delete and move pages

E Page name

F Overrange indication

G Dynamic display behaviour

H Zoom preference

A Display name    Each waveform display can be given a descriptive name.
Any name with up to 100 characters is allowed. When you deselect the
Show display name in title bar option, the display title bar will collapse.
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HINT/TIP

To show/hide the display title bar instantly you can click on the show/hide title
bar icon, the little arrow on top of the title bar. You can also double-click
anywhere in the title bar to toggle the title bar’s visibility.

B Control area   The control area is a part of the display that contains one
or more controls. The control area can be hidden as well as individual
controls. The control area can hold the following controls:

l Page control Manage pages.
l Time control Scroll through the waveform data.
l Replay control Replay waveform data.
l Cursor values Show the values of the active and passive cursor.

Here you can set which controls you want to see. For details refer to
"Control area" on page 142.

The Icon size sub section allows you to set the size of the controls

l Small Default, typically used for 96 DPI display resolution.
l Medium For higher display resolution, for example 120 DPI.
l Large For touch screens.

C Page management In this section you can add, delete and move pages.
You can also rename pages here. Each available page is displayed as a
large page icon. The highlighted page is the active page and also the page
on which you perform your actions.

To select (activate) a page:

l Click on the page icon of the page that you want to activate. The name
of the selected page appears in the Page Name text field.
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D Add, delete and move pages    There are four controls that allow you to
add, delete or move pages.

To add a page:

l  Click the Add page button. This will add a page. The page will be
appended to the end of the page list and activated.

To delete a page:

1 Select the page icon of the page you want to delete.
2  Click the Delete page button.

To move a page:

1 Select the page icon of the page you want to move.
2 To move the selected page do one of the following:

l  Click the Move page left button to move the selected page
one position to the left.

l  Click the Move page right button to move the selected page
one position to the right.

E Page name The name of the currently selected page. You can type new
name here.
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F Overrange   Overrange is physical phenomenon, based on the input
characteristics of the digitizing equipment.

In general digitizing equipment has 16-bit resolution. This resolution
equals 65536 levels. For various reasons only the middle 60000 levels
are used, leaving a 4.6% range on each side. This is called the overrange.
Depending on the recorded waveform data can be available within this
range. For example a sine wave with an amplitude of 8.5 volt acquired
with an 8 volt span of the input amplifier will fit in the complete ADC
measurement range (which is actually 8.7 volt), but the maximum values
will be within the overrange since the actual used range is 8.0 volt.

Figure 6.43: Overrange drawing

a Overrange information displayed

b Overrange information suppressed

Here you select if you want to see the data in the overrange yes or no.
G Dynamic display behaviour This option allows you to add a live view in

your display when acquiring data automatically:

l No change Select this option when you do not want an automatic
view replacement.

l Add live view Select this option to add a live view when acquisition
starts. When acquisition stops the original layout of the display is
restored.

l Replace view Select this option to replace a Review view with a live
view when acquisition starts. When acquisition stops the original
layout of the display is restored.

H Zoom style   Defines the default zoom style. Each zoom style is always
accessible by means of zoom+key(s) combination.
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6.6.2 Annotation & Grid
The Annotation & Grid page in the Display Setup dialog box gives access to all
settings related to the layout and functionality of the annotation of both the Y-
axis and the X-axis. Also general - style related - layout options can be found
here.

Figure 6.44: Display Setup dialog - Annotation & Grid

A X-Annotation: time and position axis

B Show: set visibility of components

C Colors: set colors of components

D Font: set font for annotation

E Y-Annotation: amplitude axis

F Grid: define grid settings

G Sizes: set separator and event traces thickness
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A The X-annotation area is used to display a time or position scale. The
scale supports internal (time-based) and external (position-based)
acquisition time bases. When time is used, the x-axis scale can be relative
or absolute. When position is used the position can be translated to linear
or rotational displacement. For ease of reference the X-annotation scale
will be named time scale although it can also refer to a position.

When the time scale is relative time, the time is referenced to the start of
the recording. With relative time the start of the recording is considered
the start of the time line, i.e. t=0.

When the time scale is absolute time, the actual time of day at the start
of recording is used as reference without correction. 

For full details refer to "The X-annotation area" on page 139.
B In the Show area you can set which items you want to be visible in the

display. Check all that apply.
C To set the Colors of the various objects and areas click on the

corresponding color drop down box. For details on changing colors refer
to "Modifying color" on page 62.

D Font You can set the font properties of the font used in the annotation of
your display. Click Select to call up the common Font dialog box. Make
your selections and click OK.  

E Y-Annotation On the left-hand side of the graphic display is the Y-
annotation area. The properties of this area can be set here: width and
cursor readouts. For full details on the Y-Annotation area refer to "The Y-
annotation area" on page 135.
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F Grid You can add grid lines to the display as a visual aid when inspecting
waveforms. The Grid section provides the various grid setup features.
Grid settings are for panes, for example a setting of 10 horizontal divisions
results in ten horizontal divisions per pane.  

You can have a horizontal as well as a vertical grid. A horizontal grid
places horizontal lines, that is, divides the Y-axis. A vertical grid places
vertical lines on the X-axis.

To set the grid lines:

1 In the Show area select the Grid check box
2 In the Grid area select the Horizontal and Vertical check box as

required. Enter the required number of divisions for each of these
selections. The Horizontal divisions are related to the horizontal grid
lines style, that is, the Y-axis is divided into the number of divisions
you enter here. The Vertical divisions are related to the vertical grid
lines style, that is, the X-axis is divided into the number of divisions
you enter here.

3 In the Colors area set the color of the grid lines.
G Sizes here you set the sizes of the Pane separators and the Event

traces.

Pane separators are the small horizontal lines that indicate the borders of
the panes. Panes are used to display data in separated - individual -
areas. Panes can have individual heights and might contain one or more
traces.

To modify the pane separators:

1 In the Show area select the Pane separators check box
2 In the Sizes area under Pane separators set the width of the

separator lines. This may improve visibility with high resolution
printing. Options include:
l Small: 1 pixel
l Medium: 3 pixels
l Large: 5 pixels

3 In the Colors area set the color of the pane separators.

For details on the Event traces height refer to the section on "Event/digital
traces" on page 145.
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6.6.3 Panes Setup  
The Panes Setup page in the Display Setup dialog provides all functionality for
pane management: add and remove panes, reposition and size panes, define
the contents of a pane.

Figure 6.45: Display Setup dialog - Panes Setup

A Page select

B Pane position and size

C Pane icon

D Pane separator

E Add/remove pane

F Pane size

G Move pane up/down

H Move trace up/down

I Traces in selected pane

J Navigator: available traces (data sources)

K Add/remove trace

L Pane layout section
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A Page select Use the page select scrollbar to select a page. The Panes
and Pane Layout section will change to reflect the corresponding setup.

B-G Pane position and size In this section you can add and delete panes,
reposition panes and set their size.

To select a pane:

To select a pane for manipulation:

l Click on the pane icon of the pane you want to select.
 To add a pane:

l  Click the Add pane button. This will add a pane. The pane will
be appended to the end of the pane list and activated.

 To delete a pane:

1 Select the pane icon of the pane you want to delete.
2  Click the Delete pane button.

 To move a pane:

1 Select the pane icon of the pane you want to move.
2 To move the selected pane do one of the following:

l  Click the Move pane up button to move the selected pane
one position up.

l  Click the Move pane down button to move the selected
pane one position down.

 To size a pane:

You can set the size of each pane individually. To do so proceed as
follows:

1 Select the pane icon of the pane you want to resize.
2 Do one of the following:

l In the Height box enter a value as percentage of the display
size.

l Click on a pane separator and drag it to the required position.
H-L Pane contents and layout In this section you define the traces that are

in the pane and their position: add and remove traces and position
traces.
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 To add a trace:

To add a trace you must select a data source and add this source to the
list of traces as follows:

1 In the list of Available Traces select one or more data sources.
2 Do one of the following:

l With the sources selected drag them into the list of Selected
Traces.

l  Click the Add trace button. This will add the selected trace.
The trace will be appended to the end of the trace list.

 To delete a trace:

1 Click the trace in the Selected Traces list you want to delete.
2  Click the Delete trace button.

 To move a trace:

1 Click the trace in the Selected Traces list you want to move.
2 To move the selected trace do one of the following:

l  Click the Move trace up button to move the selected trace
one position up.

l  Click the Move trace down button to move the selected
trace one position down.

6.6.4 Traces Setup  
The Traces Setup page in the Display Setup dialog provides a variety of
functionality for trace management: trace position and scaling, source
modification and layout. You cannot add or delete traces here. To do so go to
the Panes Setup page in this dialog or use one of the techniques described in
"Trace commands" on page 186.
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Figure 6.46: Display Setup dialog - Traces Setup

A Page and pane select

B Trace select, position and size

C List of available traces

D Settings of selected trace

E Source of selected trace

F Position

G Color replace

H Y-Scale settings

I Graphical representation of traces within pane

A Page and pane select Use the Page select scrollbar to select a page.
Use the Pane select scrollbar to select a pane within the selected page.
The list of available traces and the graphical representation will change
to reflect the equivalent setup.
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B Traces In this area you can select a trace for manipulation. Here you can
modify the vertical size and position of a trace within a pane.

To select a trace:

To select a trace for manipulation, do one of the following:

l Click on the trace in the list of available traces (C)
l Click on the graphical representation of the trace (I)

To scale a trace within a pane:

To scale a trace within a pane (without modifying the actual display range)
using the graphical area proceed as follows:

1 In the graphical area click the trace you want to modify.
2 Drag the top and/or bottom handle of the trace to the required position

and release the mouse. Note that the Top and Bottom indicators
under Position change accordingly while dragging.

Although you modify the scaling of the trace within the pane, you do not
scale the display range. You can modify the display range in the Y-scale
area.

To position a trace within a pane:

To position a trace within a pane using the graphical area proceed as
follows:

1 In the graphical area click the trace you want to modify.
2 Click and drag the trace indicator to the required position and release

the mouse. Note that the Top and Bottom indicators under Position
change accordingly while dragging.

C List of available traces  Use this list to select a trace.
D Settings This is the general section to set various properties of the

selected trace. Areas include:

l Source
l Position
l Y-Scale
l Zero-line and color
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E Source Typically you set the source of a trace in the Panes Setup page.
However, you can modify the source of a selected trace also in this page.

To modify the source of a trace:

To modify the source of trace do one of the following:

l When you know the actual path of the source you can type it directly
into the source select text box, or modify the contents.

l Browse for data source:
1 Click on the Data Source Navigator button at the right-hand side

of the source select text box.
2 In the Select Data Source dialog that comes up select the new

data source.

3 Click OK when done.

The Select Data Source dialog provides a list of data sources that is
filtered to show only the data sources that are applicable in a specific
situation.
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F Position Here you can scale and position a trace within a pane using
numeric entry. You can also set a zero line.

To scale and position a trace:

To scale and position a trace using numeric entry:

1 Select the trace you want to modify using one of the aforementioned
procedures.

2 Enter a value for Top and Bottom as a percentage of the pane height.
The graphical representation will change accordingly.

To set a zero line:

When you want to show a zero line for the selected trace in the display:

l Select the Show zero line check box
G Color replace You can modify the default color of a trace

To set the color of a trace:

1 Select the trace you want to modify using one of the aforementioned
procedures.

2 Select the Replace channel color with check box.
H Y-Scale Here you can set the Y-scale options for a selected trace. You

can set the Y-scale of a trace to one of the following options:

l Input Range The Y-scale display range is exactly the same as the
input range.

l Fixed When set to fixed, begin and end of the Y-scale display range
are user-defined.

l As trace This option allows you to set the Y-scale display range
exactly the same as a selected other trace. Once this option has been
set, the selected trace will “follow” the settings from the linked trace.

To modify the display range select the trace you want to modify using one
of the aforementioned procedures and do one of the following:

l Select Fixed and enter the From (upper limit) and To (lower limit)
values, or

l Select As trace and in the list select the trace you want to use.
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I Graphical representation This area provides an interactive approach for
modifying the trace position and size within a pane.

The following Figure 6.47 on page 206 is an example of a pane with various
trace settings.

Figure 6.47: Example of various trace settings
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6.7 Display markers

Marker terminology
Display Markers are used to accurately mark a position on your data in the
graph area or to label a defined point so that it stands out from the rest of the
data. There are several different types of markers available for different
purposes. This section outlines the Marker options available to you.

Below is an example of a type of display marker called a trace marker. In this
example the markers properties are noted. Markers use a combination of these
properties and depending on the user, may or may not include a label.

Figure 6.48: Example of a display marker

A Label

B Line

C Anchor

Within the Review, Zoom or Alt Zoom view there are eight marker types to add
annotations to your data:

l The Trace Marker can be added to a trace to annotate amplitude of a
waveform at a specified time.

l The X-Range Marker can be used to annotate time or position difference
between two points in a waveform.

l The Y-Range Marker can be used to annotate amplitude difference in a
waveform and can be placed at a specified time or position.

l The Slope Marker can be used to annotate the slope between two points
on a waveform.

l The Time Marker can be added to the display to annotate a position in the
recording.

l The Full Display Marker can be added to the display to annotate the width
of the view.
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l The Slope Cursor Marker can be used to annotate the slope at a time or
position of a waveform using the slope cursors as reference.

l The Free Float Label is a label only, can be positioned on the display and
remains at this position, independent of the waveform shown.

All eight marker types can be manipulated using the properties dialog, toolbar
and dynamic menu.

Figure 6.49: Markers sub-menus

A Marker commands

B Marker types
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Figure 6.50: Markers toolbar

A Show all markers

B Hide all markers

C Select and add markers

To show all display markers do one of the following:

l Click Show all Markers in the toolbar.
l Using the dynamic sheet menu:

1 Point to Markers  ►
2 Click Show all Markers

To hide all display markers do one of the following:

l Click Hide all Markers in the toolbar.
l Using the dynamic sheet menu:

1 Point to Markers ►
2 Click Hide all Markers

To place a display marker do one of the following:

l Position the cursor or cursors on the point(s) of interest in display.
l For trace-related markers (see each individual marker description for more

information) make sure the trace you want to add markers to is the active
trace.

l Make sure the view you want to add the marker to is active.
l Using the shortcut menu:

1 Right-click the appropriate cursor to access the shortcut menu.
2 In the shortcut menu select the marker type you want to add.
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l Using the dynamic sheet menu:
1 Point to Markers ►
2 Point to Add ►
3 Click on the marker type you want to add. The active view and active

cursor will be used for adding the marker.

To remove a marker do one of the following:

l Using the shortcut menu:
1 Right-click the marker.
2 Click the Remove icon.

l Using the dynamic sheet menu:
1 Point to Markers ►
2 Click the Remove icon.

To show the marker properties dialog take one of the following actions:

l Using the shortcut menu:
1 Right-click the marker.
2 Click the Properties of icon.

l Using the dynamic sheet menu:
l Point to Markers ►
l Click the Properties of icon.

To identify the active marker:

The active marker can be identified by the rectangle drawn around it. A marker
is automatically active after it is added. It can also be activated using a mouse
click.
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Figure 6.51: Active display markers

Display marker data sources

After a marker is created, new data sources are added that can be used
throughout Perception . Depending on the marker type, various data sources
will be added to the system.The data source for display markers are added in
the following location:

Display ► “DisplayName” ► “DisplayMarkers” ► “DisplayType” ► “MarkerName”

Display type refers to the area where the marker was added, for example the
zoom, alt zoom or review area.

6.7.1 Trace marker 
When adding a trace marker the anchor will be inserted at the crossing between
the active trace and active cursor. The label will be given a default offset but
can be repositioned freely to the desired position.

This marker is added to the active trace.

The data sources that are added for this marker are:

l LabelText: This is the text shown in the display marker.
l StartLevel: This is the amplitude of the marker anchor on the trace.
l StartTime: This is the time of the marker anchor on the trace. This time is

the time relative to the start time of the recording.
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6.7.2 X-range marker 
The X-Range marker is added at the amplitude of the active cursor and between
the times of the two vertical cursors. After adding the marker, its vertical position
can be changed by picking up the marker or dragging the label up and down.
It is also possible to move the label around the marker line and horizontally
between the start and end anchor of the display marker.

This marker is added to the active trace.

The data sources that are added for this marker are:

l LabelText: This is the text shown in the display marker.
l StartLevel: This is the amplitude of the marker start anchor on the trace.

The start anchor is the anchor at the active cursor.
l StartTime: This is the time of the marker start anchor on the trace. This

time is the time relative to the start time of the recording. The start anchor
is the anchor at the active cursor.

l EndLevel: This is the amplitude of the marker end anchor on the trace.
l EndTime: This is the time of the marker end anchor on the trace. This time

is the time relative to the start time of the recording.
l DeltaX: This is the difference between the start and end times of the

marker.

6.7.3 Y-range marker
The Y-range marker will be placed at the position of the active cursor. The start
anchor is placed at the crossing between the active cursor and the active trace.
The end anchor is placed at the same position as the start anchor, but its
amplitude is determined by taking the crossing between the passive cursor and
the active trace. It is possible to move the marker horizontally by dragging it
using the line or the label. You can position the label horizontally across the
marker line.

This marker is added to the active trace.

The data sources that are added for this marker are:

l LabelText: This is the text shown in the display marker.
l StartLevel: This is the amplitude of the marker start anchor on the trace.

The start anchor is the anchor at the active cursor.
l StartTime: This is the time of the marker start anchor on the trace. This

time is the time relative to the start time of the recording. The start anchor
is the anchor at the active cursor.

l EndLevel: This is the amplitude of the marker end anchor on the trace.
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l EndTime: This is the time of the marker end anchor on the trace. This time
is the time relative to the start time of the recording.

l DeltaY: This is the difference between the start and end amplitudes of the
marker.

6.7.4 Slope marker 
The slope marker is placed between the crossing of the active cursor with the
active trace and the passive cursor with the active trace. Once placed, this
marker cannot be moved anymore.

The label can be placed at any position on the marker line.

This marker is added to the active trace.

The data sources that are added for this marker are:

l LabelText: This is the text shown in the display marker.
l StartLevel: This is the amplitude of the marker start anchor on the trace.

The start anchor is the anchor at the active cursor.
l StartTime: This is the time of the marker start anchor on the trace. This

time is the time relative to the start time of the recording. The start anchor
is the anchor at the active cursor.

l EndLevel: This is the amplitude of the marker end anchor on the trace.
l EndTime: This is the time of the marker end anchor on the trace. This time

is the time relative to the start time of the recording.
l DeltaX: This is the difference between the start and end times of the

marker.
l DeltaY: This is the difference between the start and end amplitudes of the

marker.
l Slope: This is the slope between the start and end anchor points of the

marker.

6.7.5 Time marker 
The time marker is placed at a fixed position of the display. It is added at the
position of the active cursor and at least one valid trace is required for adding
a time marker because a point of reference is required to calculate a correct
position.

The marker is added to the page and runs from the top of the display to the
bottom of the display. This marker type does not have a start or end anchor.

The label can be moved vertically across the line. Limited horizontal movement
is also possible, the label can be positioned left or right of the marker line.
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The data sources that are added for this marker are:

l LabelText: This is the text shown in the display marker.
l StartTime: This is the time of the marker start anchor on the trace. This

time is the time relative to the start time of the recording.

6.7.6 Full display marker 
The full display marker must be added using the horizontal cursors. It is added
at the amplitude of the active horizontal cursor. Once added this marker runs
from the leftmost to the rightmost position of the view. The label is positioned
in the view and keeps its position relative to the view, even if the data is moved.

It is possible to move the label horizontally in the view, and the label can also
be moved vertically around the marker line. Because this marker runs from the
start of the view to the end of the view, it has no start or end anchor.

This marker type is added to the active trace.

The data sources that are added for this marker are:

l LabelText: This is the text shown in the display marker.
l StartLevel: This is the amplitude of the marker start anchor on the trace.

6.7.7 Slope cursor marker
This marker is very similar to the slope marker. The only difference is the
placement method. To place a slope cursor marker, use the slope cursors. The
slope cursor marker is added at the position of the active slope cursor.

Note After adding the slope cursor marker the slope cursor is hidden by the marker.
You can move the slope cursor normally to make it visible again.

The slope cursor marker is added to the active trace. It is not possible to move
the marker after placement.

The data sources that are added for this marker are:

l LabelText: This is the text shown in the display marker.
l StartLevel: This is the amplitude of the marker start anchor on the trace.

The start anchor is the anchor at the active cursor.
l StartTime: This is the time of the marker start anchor on the trace. This

time is the time relative to the start time of the recording. The start anchor
is the anchor at the active cursor.
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l EndLevel: This is the amplitude of the marker end anchor on the trace.
l EndTime: This is the time of the marker end anchor on the trace. This time

is the time relative to the start time of the recording.
l DeltaX: This is the difference between the start and end times of the

marker.
l DeltaY: This is the difference between the start and end amplitudes of the

marker.
l Slope: This is the slope between the start and end anchor points of the

marker.

6.7.8 Free float marker
The free float marker is a label only that is positioned on the display and always
stays in the same position, independant from time or amplitude changes of the
data shown in the display. When added, this marker is placed in the upper left
corner of the active view. It can then be moved to any position in the display.

This marker is added to a display page.

This marker has only one data source:

l LabelText: This is the text shown in the display marker.

6.7.9 Marker properties
To see the Marker properties option menu right-click on a marker and then
choose properties of <name>. You can also highlight a Marker and click
Active ► Markers ► properties of <name>.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 215



Figure 6.52: Marker Properties dialog

A Progressive disclosure

B Anchors; Type Size and Style

C Hide Label

D Marker name

E Automation

F Insert data source

G Label Text

H Marker type

A Progressive disclosure Expands or collapses the properties dialog.
B Anchors Select between, Type or shape, sizes and different styles.

l Anchor size Selects the required anchor size from the list.
l Anchor style Selects the appropriate style from the list. This may not

have any effect on anchors in small size.
C Hide label Hides the label. In case of the trace marker this will also hide

the line to the label.
D Marker name Changes the name of the marker. Changing the marker

name will also change the path of data sources created by the marker.
Note that double names are not allowed and will be automatically
replaced with unique names.
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E Automation Depending on the marker type one or more of the following
items may be available. For more information on automatic markers see
"Automatic markers" on page 217 in this manual.

F Insert data source Click to insert a data source in the label text. Refer
to "Insert and format a data source" on page 64 for more information.

G Label Text This is the text that will be displayed in the label of the marker.
Note that this text may contain placeholders which are indicated by
braces.

H Marker type This indicates the type of marker. It also indicates to which
page or trace the marker is added.

6.7.10 Automatic markers
You can automate marker placement. To do this you need to connect one or
more of the marker's anchor coordinates to a data source. To enable
automation select the check box in front of the coordinate that needs to be
automated. Then use the data source navigation button to attach the coordinate
to the appropriate data source. This can be any available numerical data
source.

Figure 6.53: Automatic markers with anchor check box (detail)

If only the position (X) of a marker is set to automatic, the corresponding
amplitude (if applicable) is determined using the level of the connected or active
trace at the resulting position.

An automatic display marker can be recognized in the display by a small
rectangle in the upper right corner of the label. This rectangle is not printed in
the report.

If an automatically placed marker is manually moved, it is set to a fixed position
and is no longer automatic.
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Figure 6.54: Select Data Source

Example:

To set up an auto marker we need a few things first. In this example we will set
up a “maximum value” position marker for Chanel A1.

1 Firstly we need to set up a formula in the formula sheet option. Click on the
Formula sheet tab and enter the following into a row of blank cells:
Name: “ ChA1_Max “
Formula: “ @MaxPos(Active.Group1.Recorder_A.Ch_A1) “
 
This will show the maximum for Channel 1 on any data channel that you
add the label.
 

2 In Active sheet display make sure you have data available in Chanel 1
and select an active Channel with data on which you want the marker to be
placed.

3 Position the cursor anywhere you like, right-click and add trace marker.
4 Once you have a trace marker available select it and right-click to edit it.

Click properties of <name> and in the displayed dialog click More.
5 Go to Automation and select the check box for Anchor 1 (x).
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6 Now you can click on the navigation button and another dialog box “Select
Data Source” will open (see Figure 6.55).

Figure 6.55: Active Sheet/Marker Properties dialog/Select Data Source
dialog (From left to right)

 
7 Double click or click the “plus” sign next to Formula and select the recently

made formula ChA1_Max from the list, double click or press OK and then
OK again in the Marker <name> properties dialog.
 
The cursor should now move to the correct position corresponding to the
chosen formula written in the formula sheet. The maximum amplitude value
should now equal the marker anchor value.

Save display markers

Display markers that are added to a display are also stored in a VWB and
experiment when they are saved.

Opening a VWB will already show all manually placed markers even if no data
is shown yet. After opening the VWB there are two options:

1 A previous recording is opened. This will show the data and not affect the
display markers. Once the data is loaded, all automatic markers that can
now be evaluated are also shown. Please note that the data should be
loaded the same way as it was saved, so used load as active or load using
filename where appropriate.

2 A new recording is created. The manually placed markers will now
disappear and the automatic markers will be shown when their automatic
coordinates can be evaluated.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 219



Opening an experiment that contains display markers will show both the data
and the display markers (manual and automatic) that were saved when the
experiment was saved.

In general: If you start a new recording, manually placed markers are removed
from the display. Automatic markers are temporarily hidden until their location
is determined.
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6.8 External clock support
When you select the external time base in the settings sheet, the clock used to
drive the ADC’s is the clock signal presented at the external clock input BNC
on the system. When you select this mode, the interval between two
consecutive samples may not be equidistant. This all depends on the accuracy
of the supplied clock signal. Refer to the user manual supplied with your
hardware for more details.

Note External clock is a system wide setting. If you are using multiple mainframes,
all connected mainframes will be set to external clock mode.

Note External clock is an advanced usage of your data acquisition system; therefore
you will have to show the advanced settings sheet settings.

Through the settings sheet, the external clock units, scaling, shift, Top Dead
Centre and delay can be set. See the settings sheet manual for a more detailed
explanation of the external clock options.

External clock is most commonly used for applications performing
measurements on rotational equipment. Others are most likely using the clock
as a movement indicator.

External clock in the display
By default the display will show the signals in seconds. The X-Annotation will
be scaled according to the time conventions, HH:MM:SS.dddd where HH is the
hours, MM the minutes, SS the seconds and dddd the second fraction. The
hours and minutes are automatically blanked for small time values. For external
clock this is most likely not the preferred format. Therefore the display can be
set into another mode.

To set the display in the external clock support mode:

1 Right-click in the display area to access the shortcut menu.
2 In the shortcut menu click Display Setup...
3 In the Display Setup dialog select the Annotations & Grid page.
4 In the X-Annotation section select the Position option as scaling unit (see

picture ”Property sheet of the display”).
5 Select one of the following options:

l Linear
l Rotational, 360 degrees per cycle
l Rotational, 720 degrees per cycle

6 Click OK when done.
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Figure 6.56: External clock settings

By default the display will now show the X-Annotation as external clock units
per division. Also the clock notation of the display status bar will be shown in
the external clock units.
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Figure 6.57: Display shows X-Annotation in external clock units with status bar
(detail)

Position options
When external clock is selected, the display shows the external clock values
relative to the start of the recording. Other options like Absolute local and
Absolute UTC are not available anymore.

The available selections are:

l Linear
l Rotational, 360 degrees per cycle
l Rotational, 720 degrees per cycle

Linear
When the Linear option is checked, the X-Annotation will be shown as the
number of external clock units after the start of the recording. For larger or
smaller units, an engineering prefix will be used. For example when the external
clock units are “Clocks” the time per division can be 100.0 mClocks/Div or 10
kClocks/Div. The options to expand and compress the X-Annotation scale will
be in decades of the 1, 2, 5 range.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 223



Rotational, 360 degrees per cycle
When the Rotational, 360 degrees per cycle option is selected, the X-
Annotation will be shown as the number of cycles and the number degrees per
cycle. As separator the colon “:” is used to separate the cycles and degrees
within the cycle. For example 10:013 is the external clock location where we
have 10 cycles and 13 degrees from the start of the recording. The cycles will
not contain engineering prefixes. The X-Annotation expand and compress
scale will be in the decade ranges 1, 2, 5 for values < 1 degree, and
1,2,5,10,30,60,180 for values > 1 degree and < 360 degrees. Larger values will
be scaled in the 1, 2, 5 ranges again.

Rotational, 720 degrees per cycle
When the Rotational, 720 degrees per cycle option is selected, the X-
Annotation will be shown as the number of cycles and the number degrees per
cycle. Each cycle now contains 720 degrees. The X-Annotation expand and
compress scale will now include also 360 degrees.
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7 Sheet Objects
7.1 Introduction

Most of the work area is occupied by sheets. A number of sheets have a fixed
user interface. The active sheet and user sheets do not have a fixed user
interface. Their layout and contents is free to configure. You can divide such a
sheet into one to four areas and in each area you can place an object.

In this chapter we will discuss the various objects that can make up an active
or user sheet. For information on the general usage of sheets refer to "Working
with sheets" on page 72 and following.

Currently the following objects can be placed on a sheet:

l Waveform display
l Spectral display (optional)
l XY-display
l Meter array
l User table
l Image
l Video (optional)

7.1.1 Adding and deleting objects 
Objects can be easily added to a sheet. Once a sheet is ‘full’ you cannot add
new objects. Nor can you replace an object. In such a case you must delete an
object first before you can add a new one.

Objects are placed in the area that you last clicked or in the last available area.

Figure 7.1: Add object shortcut menu
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To add an object:

To add an object to a sheet do one of the following:

l In the menu bar choose [dynamic menu] ► Add ►. Click an object in the
sub menu.

l When visible, in the toolbar select one of the object icons.
l With a right mouse click in the sheet area call the context menu. In the

context menu select Add ►. Click an object in the sub menu.

To delete an object:

1 Select the object that you want to delete.
2 Right-click the object to access the context menu.
3 In the context menu click Delete [object name].
4 In the confirmation dialog that comes up click OK.

To move an object into the Recycle Bin:

Note The Recycle Bin option is only available when there are multiple objects on the
Active/User sheet.

1 Select the separator of the sheet object (e.g. User Table) which you want
to delete.

Figure 7.2: Separator

A Separator

2 Move the seperator to the left or right sheet border.
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3 Release the separator when a Reycle Bin symbol appears.

Figure 7.3: Reycle Bin

A Reycle Bin

4 The sheet object which shows the Recycle Bin symbol will be deleted.
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7.2 Waveform display
The waveform display is described in full detail in the chapter “Data
Visualization” on page 129 and the following pages.
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7.3 Meters
Within Perception you have the possibility to add meters to a sheet. A meter
can be a numerical meter, but also an analog / VU or hybrid meter. Usually
there are a number of meters organized as an array. The array of meters has
a number of properties that resemble the waveform display, for example a title
bar and a page control.

Figure 7.4: Meter array example with numerical meters

A Show/hide title bar

B Object title bar

C Page control

D Parameter select

E Meter properties

F Units of displayed value

G Value

H Meter title bar

A Show/hide title bar To show/hide the meter title bar instantly you can
click on the show/hide title bar icon, the little arrow on top of the title bar.
You can also double-click anywhere in the title bar to toggle the title
bar’s visibility.

B Title bar You can set the name of the object that is displayed in the title
bar through the object’s properties.

C Page control This is a standard page control to browse through the
various pages.

D Parameter select Use this control to select quickly a parameter when
available.

E Meter properties This button calls up the meter properties dialog.
F Units Shows the technical units of the displayed value.
G Value The value of the selected parameter.
H Meter title bar Can show information on the data and data source.
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7.3.1 Meter flavors
As standard a variety of meter types is provided. Most meters are available in
multiple sizes to allow for a best fit of the available space. The actual size used
is determined automatically and is related to the available space for the array.

Figure 7.5: A variety of meters

7.3.2 Data sources for meters
Each meter can be connected to a data source. Data sources for meters can
be real-time parameters as provided by the data acquisition system or data
sources provided by the Perception environment. Summarized:

Data sources for meters can be either one of the following:

l Real-time parameters from connected acquisition hardware.
l Various system variables (or constants).

For each of these parameters also the highest and lowest value within the
current acquisition is calculated.

Real-time parameters
Depending on the type of acquisition hardware that is connected a variety of
real-time parameters can be available. A basic set of parameters includes:

l Maximum value
l Minimum value
l Mean value
l Peak-to-peak value
l Root Mean Square (RMS)
l Standard deviation

When available these values can be accessed through the data sources
navigator. The realtime parameters are available as a subset from the actual
channel data.
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Figure 7.6: Data sources for meters

System variables
Almost any system variable can be used as data source for a meter. These are
typical stringtype variables or numbers. They can be found in any section and
may range from User Name to Ventilator Speed.

7.3.3 Adding meters to a sheet
There are various ways to add one or more meters to a sheet. Refer also to
"Adding and deleting objects" on page 225.

Basically there are two options:
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1 Drag data sources to an empty area on a sheet. This will instantly create
an array of meters.

2 Add a placeholder to a sheet. You are presented an empty placeholder for
a meter array, still to be filled.

To add meters using drag-and-drop:

1 Make sure the Data Sources navigator is visible.
2 In the Data Sources navigator select one or more parameters / values and

drag them onto an empty sheet or sheet area. New meters will be
automatically created that fill the entire sheet (area) displaying the selected
parameter(s) / value(s). When selecting you can:
l select an individual parameter / value
l select all parameters/values of a channel: hold down the Shift-key while

dragging a channel. An array will be created that comprises all real-
time parameters of the selected channel.

l select all parameters/values of a channel: hold down the Shift-key while
dragging a recorder. A multi-page array will be created that comprises
all real-time parameters of the selected recorder.
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To add meters using a placeholder:

1 To add a meter placeholder to a sheet do one of the following:
l In the menu bar choose [dynamic menu] ► Add to sheet ► Meter.
l When visible, in the toolbar click the Add Meter button .
l Within the sheet area call the context menu. In the context menu select

New Meter(s)...

2 Make sure the Data Sources navigator is visible.
3 In the Data Sources navigator select one or more parameters / values and

drag them onto the meter placeholder. New meters will be automatically
created. When selecting you can:
l select an individual parameter / value
l select all parameters/values of a channel: hold down the Shift-key while

dragging a channel. An array will be created that comprises all real-
time parameters of the selected channel.

l select all parameters/values of a recorder: hold down the Shift-key
while dragging a recorder. A multi-page array will be created that
comprises all real-time parameters of the selected recorder.

Replacing meters
You can replace one or more meters by one other meter.

To replace meters: 

1 Select the meter(s) you want to replace.
2 Right-click the selected meter(s) to access the context menu.
3 In the context menu click Replace Meter(s)...
4 In the Select Data Source dialog that comes up select the new data source.
5 Click OK when done.
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7.3.4 Modifying the layout of a meter array
Just as you can divide a sheet into areas you can also divide a meter array into
areas.

To modify the layout of a meter array:

To divide a meter array into two or more sections do one of the following:

l Right-click the meter array.
In the context menu that comes up point to Split ► and select one of the
presented options in the submenus.

Once a layout is selected, splitters appear that divide the array into sections.
These splitters can be freely moved. When you hover the mouse over a splitter,
the mouse pointer will change into a pointer with arrows. The arrows point in
the direction that you can move the splitter. Click and drag the splitter in the
required direction.

The following cursor icons are used:

When this cursor shape is visible you can move the splitter that divides
the array area horizontally.

When this cursor shape is visible you can move the splitter that divides
the array area vertically.

Four way splitter icon: this icon appears when you are in the vicinity of an
intersection of a horizontal and vertical splitter. You can now freely move

both splitters at the same time.

7.3.5 Inserting, deleting and moving individual meters
Within the array of meters you can insert, delete and move (re-arrange)
individual meters.

To select one or more meters:

For many operations you must select one or more meters as follows:
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l To select a single meter: click on the meter.
l To select consecutive meters, click the first meter, press and hold down

SHIFT, and then click the last meter.
l To select nonconsecutive meters, press and hold down CTRL, and then

click each meter.
l To unselect a meter(s): press the Esc key.

To insert meters:

You can insert meters in an existing array by drag-and-drop of the
corresponding data sources as follows:

1 Select the required data source(s) as described earlier.
2 Drag them onto the meter array. You will see a red line between the meters

that indicates the insertion point.
3 Move the insertion point to the desired location.
4 Release the mouse button.

To delete meters:

1 Select the meter(s) that you want to delete.
2 Right-click the array to access the context menu.
3 In the context menu click Delete Meter(s).
4 In the confirmation dialog click OK.

To re-arrange meters:

You can modify the order in which the meters are shown.

To modify the order proceed as follows:

1 Select the meter(s) that you want to move.
2 Drag the selection to a new location. While dragging the mouse pointer

changes and transparent meters are shown. You will see a red line between
the meters that indicates the insertion point.

3 Move the insertion point to the desired location.
4 Release the mouse button.

7.3.6 Meter properties
The Properties... command in the meter context menu is the common starting
point for accessing a variety of meter properties.
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The settings and properties are grouped for easy reference and to keep the
user interface as clear as possible. The following main groups are available:

l General: global meter settings and meter select
l Value: value related settings including alarm levels
l Styles & Colors: image and font colors
l Auto Setup: define default setup settings
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General
The General page in the meters properties dialog gives access to various
properties that are relevant to the global look and feel of the array.

Figure 7.7: Meter Properties dialog - General

A Name of meter array

B Page select

C Show/hide channel name

D Meter array layout

E Previous meter type

F Selected meter type

G Next meter type

H Meter update rate

I Meter accuracy

J Page name
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A Name of meter array Each meter array can be given a descriptive name.
Any name with up to 100 characters is allowed. You can modify it here.

B Page select Use the page select scrollbar to scroll through the available
pages within a multipage array. The name of the selected page is shown
in the page name text box J.

C Show/hide channel name The title bar of the individual meters shows
the name of the data source / parameter that is displayed. By default also
the channel name is shown. Deselect this option to hide the channel
name.

D Meter array layout You can modify the layout of the meter array to create
more space. By default all options are set.

You can:

l Deselect Show meter title bar to create more horizontal space.
l Deselect Show page selector to create more vertical space.

HINT/TIP

To show/hide the meter array title bar instantly you can click on the show/hide
title bar icon, the little arrow on top of the title bar. You can also double-click
anywhere in the title bar to toggle the title bar’s visibility.

E-G Select / preview meter type Use the buttons on the left and right to
scroll through the available meter types. The preview gives an example
of the selected meter type. This preview is also used to give feedback
on certain selections you make in this and other pages of the Properties
dialog.

H Update rate When connected to a data acquisition system the meters
can provide real-time information. Here you can set the update rate. The
update rate for the meters can be set from 1 to 10 times per second.

I Accuracy Here you can set the display accuracy of meters with a digital
section. The number of decimals to show can be set from 0 to 9.

J Page name The name of the selected page is shown in the page name
text box. Any name with up to 100 characters is allowed. You can modify
it here.

Value
Each meter within an array of meters has an individual set of properties with
respect to alarm levels, colors and data source. The Value page in the Meter
Properties dialog allows you to modify these settings.
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Figure 7.8: Meter Properties dialog - Value

A Page select

B Meter select

C Enable alarm levels

D Font color and level settings

E Copy settings select

F Meter preview

G Additional meter settings

H Background color settings

I Data source select

J Page name

A Page select Use the page select scrollbar to scroll through the available
pages within a multipage array. The name of the selected page is shown
in the page name text box J.
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B Meter select Use the meter select scrollbar to scroll through the
available meters within a multi-meter array. The source of the selected
meter is shown in the data source select input field I.

C Enable levels As standard you can set the font color as well as the
background color of the meter readout. In addition you can set colors
that are used when certain levels are crossed, for example levels that
define an alarm situation.
To enable color change for level crossings:

l Select the Enable levels option
D, H Font color and level settings Here you define the font color and level

settings. These are combined with the background settings of the meter
readout.
To set level crossing indication:

l Select Enable levels. You can now set the high and low level and
corresponding colors.

l Set the High level value and the corresponding font and
background colors that you want to use. When the signal is equal
to or becomes larger than the set value, the high level colors will be
used for display instead of those specified for the normal level.

l Set the Low level value and the corresponding font and
background colors that you want to use. When the signal is equal
to or becomes smaller than the set value, the low level colors will
be used for display instead of those specified for the normal level.

For details on changing colors refer to "Modifying color" on page 62.

Use the Meter preview F to verify the effect of the various settings. When
you are satisfied with the results you can copy the settings to other
meters.

E Copy settings Use this control to copy the settings to other meters.
To copy settings:

1 Use the drop down list to make a selection. Typical options include:
l Selected meter
l Selected page
l All pages

2 Click Copy Now
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I Data source select Each meter is connected to a data source. You can
modify the selected data source here.
To modify the source of a meter:

To modify the source of meter do one of the following:

l When you know the actual path of the source you can type it directly
into the source select text box, or modify the contents.

l Browse for a data source:
1 Click on the Data Source button  at the right-hand side of

the source select text box.
2 In the Select Data Source dialog that comes up select the new

data source.

3 Click OK when done.

The Select Data Source dialog provides a list of data sources that is
filtered to show only the data sources that are applicable in a specific
situation.

G Settings This command gives access to settings that are pertinent to a
specific meter.
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Figure 7.9: Meter specific settings: LED indicator

Meter specific settings for the LED (on/off) indicator include a level setting and
a color select for each level.

Styles & Colors
The Styles & Colors page of the meter properties dialog defines the font and
background settings for the labels used in a meter.
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Figure 7.10: Meter Properties dialog - Styles & Colors

A Font and background color

B Font family and style

C Overrange indication

D Preview

A Font and background color Use the font and background color controls
to select a color.
To set the font or background color:

l To set the color of the font or background click on the corresponding
color drop down box.
For details on changing colors refer to "Modifying color" on page 62.
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B Font family and style You can set the font properties of the font used in
the meter labels.
To set the font properties do one of the following:

l Click the font you want to use in the drop-down list. The fonts listed
are all TrueType fonts.

l Click the style you want to use in the drop down list.
C Overrange You can use the overrange option to set a color for overrange

indication. A signal is in overrange when it is outside the display range.
D Preview Use the Meter preview to verify the effect of the various settings.

Auto Setup
The auto setup feature of meters defines how meters are placed in an empty
meter placeholder. This feature is especially useful when you drag multiple data
sources into an empty meter placeholder.

Figure 7.11: Meter Properties dialog - Auto Setup

A Number of meters

B Meter type
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C Sort select

D Preview

A Number of meters You can set the maximum number of meters per
page. When the total number of required meters exceeds this limit, one
or more new pages are created.

B Meter type Define the default meter type: click on a meter look in the drop
down list.

C Sort select You can set the preferred order in which the meter array is
filled.
To set the sort order:

1 Select Use sorting.
2 Select one of the Sort by options.

D Preview Shows the currently selected meter type and look.

7.3.7 Meter miscellaneous features and functions
This section describes the various meter possibilities that have not been
discussed in one of the previous sections.

Meters and the clipboard
Commands are provided for transferring meters using the Windows® Clipboard.
These commands are the standard Cut Meter(s), Copy Meter(s) and Paste
Meter(s) commands as well as the standard shortcut keys for these operations.

To transfer meter(s):

To transfer one or more meters do the following:

1 Select one or more meters.
2 Right-click the meter area to access the context menu.
3 In the context menu do one of the following:

l Click Copy Meter(s) to duplicate the meters to the clipboard.
l Click Cut Meter(s) to transfer the meters to the clipboard and delete

them from the meter array.
4 Navigate to the destination (and set the insertion location, if appropriate).

The destination can be another location on the same page, a location on
another page or a new - empty - page.

5 Right-click the meter area to access the context menu and click Paste
Meter(s).
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Page commands
Page commands let you add and delete pages. You can also rename and clear
pages and make a copy of the page for use in other programs.

To gain access to the page commands:

l In the meter array context menu point to Page ► 
The page submenu comes up.

l In the status bar or title bar context menu this submenu is directly available.

You can add a page to the currently active meter array. By definition the page
will be positioned as the last page.

To add a new page:

l Click on New Page

You can add a page to the currently active meter array on a specific position.

To insert a new page:

1 Go to a specific page.
2 In the context menu point to Insert Page ►
3 In the submenu that comes up click Before Selected Page or After

Selected Page.

You can quickly delete a page from a meter array, either by using the context
menu command or the keyboard shortcut.

To delete a page do one of the following:

l Press the Alt+Del or Alt+Delete key combination on your keyboard.
l Select Delete Page in the page submenu.
l In the confirmation dialog that comes up click OK.

You can give a page another name.
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To rename a page:

1 Do one of the following:
l Press the Alt+F2 key combination on your keyboard
l Select Rename Page in the page submenu

2 In the Page Name dialog that comes up enter a new name.
3 Click OK to accept.

You can copy the page as bitmap to the clipboard. Use the Paste (Special)
command to place the image into other programs. Use the context menu or the
keyboard shortcut to access this command.

To copy a page as picture do one of the following:

l Press the Ctrl+Alt+C key combination on your keyboard.
l Select Copy Page in the page submenu.

Click Page Properties... to access the Meter Properties dialog with the General
page selected.

You can make a copy of the visible page of the display on your printer.

To print a meter page: 

1 Access the context menu and click Print <meter name>...
2 In the Print dialog that comes up set your preferences and click Print.

To clear a meter page:

1 Access the context menu and click Clear Page.
2 In the confirmation dialog that comes up click OK.

Using the page control
You use the page control primarily to step through the available pages. In
addition the page control allows you to modify a page name directly in the
control.

To step through the pages click the Next Page button and Previous Page
button. In addition you can use the following keyboard accelerators:

l Ctrl+Page Up to go to the previous page
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l Ctrl+Page Down to go to the next page
l Ctrl+1 ... 9 to go directly to the indexed page
l Ctrl+Home to go to the first page
l Ctrl+End to go to the last page

Figure 7.12: Page control functionality

A Default view

B Rename page

C List view

D Previous page

E Next page

In the text field of the page control you can:

l Click: A drop down list shows all available pages. The currently active page
is marked. Click on a page name in the list to jump directly to that page.
Note that numbering used by the default naming continues to increase even
if previous pages have been deleted. The number is not an index.

l Double-click: When you double-click the text field, the name of the page
is highlighted. Now you can modify the name. Press Enter to accept or
Escape to cancel.

l Right-click: A context menu will come up. Refer to "Page commands" on
page 246 for details.
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7.4 Images
You can place and scale images, company logos, etc. on your sheet.

You place an image object as described in "Adding and deleting objects" on
page 225. A placeholder for the image is shown.

To actually load an image or modify the properties you must access the Image
Properties dialog.

To gain access to the Image Properties dialog:

l Right-click the area of the image object.
l In the context menu click Properties...

Figure 7.13: Image Properties dialog

A Image source

B Image object name

C Background color

D Fitting of image within area

E Link image

A Image source Currently bit mapped images are supported: gif, jpg and
bmp. Transparency is not supported.
To load an image:

1 In the Image Properties dialog click Browse...
2 In the Select picture dialog select the file that you want to use and click

Open.
3 Make the modifications as required in the properties dialog and click

OK when done.
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B Image object name You can give the object a different name for easy
reference when more images are available.

C Background Defines the background color of an image that does not
completely fill the sheet area.

D Fitting An image object is placed within a sheet (area). You can define
how the image will fit in the available space. 
Fitting options are:

l No fitting The image is placed with the original resolution/size. The
upper left-hand corner of the image is placed at the upper left-hand
corner of the sheet (area).

l Fit image to frame Resizes the image to complete fill the sheet (area)
and allows the content proportions to be changed. The content may
appear to be stretched if the content and the area have different
proportions.

l Center image Centers content with area. The proportions and size of
the image are preserved.

l Fit image proportionally Resizes the image to fit a frame while
preserving the content proportions. If the image and the area have
different proportions, some empty space will result.

Figure 7.14: Image fitting examples
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 1 No fitting
 2 Center image
 3 Fit image to frame
 4 Fit image proportionally

E Link image To link to the image select this option. Deselect this option if
you want to embed the image in the virtual workbench.
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7.5 User tables
An additional means of presenting information is the user table. The user table
is a user-configurable table that can be used to show any non-waveform data
source in a tabular form. Examples of non-waveform data sources are:

l (Intermediate) scalar results
l Texts
l System constants and variables
l User variables

Besides presenting them you can easily put the user table in a Perception
report, copy it to the clipboard or post the contents to Microsoft® Word and
Microsoft® Excel with a variety of options.

Figure 7.15: Example of a formatted user table

A Show/hide title bar

B Title bar

C Row header

D Grid

E Cell

A Show/hide title bar To show/hide the user table title bar instantly you can
click the show/hide title bar icon, the little arrow on top of the title bar. You
can also double-click anywhere in the title bar to toggle the title bar’s
visibility.

B Title bar You can set the name displayed in the title bar through the user
table's properties.

C Row header The header of the row can be in one of three modes: with
number, without number or off. This can be set in the user table’s
properties.
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D Grid The work area of the user table
E Cell Shows the actual value, or the placeholder when in edit mode.

User tables can be added to the Active sheet or User sheets.

7.5.1 Creating a user table
You can place a user table as described in "Adding and deleting objects" on
page 225. This will add an empty default user table to the sheet.

Figure 7.16: Empty default user table

Another method to add a user table is to drag data sources from the Data
Sources Navigator to an empty area on the sheet while pressing (and holding)
SHIFT + ALT. By doing this a user table is created using the predefined rows
and columns (as defined in the user table’s properties) and is filled with the
selected data sources.

7.5.2 Inserting data into the user table
You can enter data into a cell of the table as follows:

l Type directly into the cell.
l Drag and drop data from the Data Sources Navigator.
l Use the shortcut menu of the user table to access the Insert Data

Source dialog.

Typing into a cell
You can enter random text as well as data source placeholder(s) directly into
a cell. To do so, proceed as follows:
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1 Click the cell you want to use.
A small pencil in the row header indicates that you are now in edit mode:

2 Type your text or placeholder. For example, the placeholder
“{System.UTCTime!Value,#.###k}” will display the UTC time when not in
edit mode.

3 Press Tab, Enter or activate another cell with the mouse when done.

Note This will delete the text that was already in the cell.

Using the Data Sources Navigator
You can easily drag and drop one or more data sources directly from the Data
Sources Navigator into a cell or row header.

To add a single data source from the Data Sources Navigator:

1 In the Data Sources Navigator select the item you want to insert.
2 Drag the item to the cell you want to use and release the mouse. The

following dialog will come up:

3 Select which properties of the selected data source you want to use. If you
select multiple properties, you can also define how these properties will be
distributed. The possible ways of distribution are explained further on in this
chapter.

4 Make your selections and click Insert when done or Cancel to cancel the
operation.
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Inserting multiple data sources
You can also insert multiple data sources into the user table in one drag and
drop action. To do so:

1 In the Data Sources Navigator select the items you want to insert.
2 Drag the items to the cell that represents the upper left-hand corner of the

range of cells you want to use and release the mouse.
3 From here follow the procedure for a single data source.

Properties and cell distribution
Each data source has three attributes: name, value and units. Depending on
the data source not every attribute contains meaningful data. When using
multiple attributes in drag and drop mode, these can be distributed in the table
in various ways.

As an example have a look at the X-position of a cursor. Assume you want to
drop this item on the cell of the second row and the second column.

Figure 7.17: User table – Properties and cell distribution (Detail) 1

Select all three properties (attributes) and the option Each property in a single
cell, start in left-most column. The result will be:

Figure 7.18: User table – Properties and cell distribution (Detail) 2

If you select the option Each property in a single cell, start at current
column, the result will be:
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Figure 7.19: User table – Properties and cell distribution (Detail) 3

If you select the option Selected properties in one cell, in current column,
the result will be:

Figure 7.20: User table – Properties and cell distribution (Detail) 4

Dropping an item on a row header
In addition to dropping on a single cell, it is also possible to drop on a row
header. In this case the distribution is automatic. The name attribute of the data
source is inserted in the first column, the value attribute in the second column
and the unit attribute in the third column. If the table has more than three
columns, they will not be filled. If the table has two columns, only the name and
value attributes will be inserted. If there is only one column, only the value
attribute will be inserted.

If multiple items are dropped on a row header, this row will be used as top, and
all other items will be inserted in the rows below.

Overwriting existing data using drag and drop
If you drag and drop a data source onto a cell that is not empty, the following
dialog will come up:
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Make your selection and click Insert when done or Cancel to cancel the drag
and drop operation.

Using the Insert Data Source dialog
The third method to insert a data source in a cell is using the shortcut menu.
This will also give you direct access to various (string) formatting options. To
do so proceed as follows:

1 Right-click the cell you want to use. The shortcut menu will come up:

2 In the shortcut menu click Insert Data Source.
The Insert Data Source dialog will come up.

3 Choose and set up the data source you want to insert and click OK when
done or Cancel to cancel the insert operation.
For a full description of the Insert Data Source dialog refer to "Insert and
format a data source" on page 64.

7.5.3 Editing data in the user table
If the inserted data needs to be adjusted or the data source’s attributes need
to be changed, this can be done in different ways:
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l Type directly into the cell.
l Use the Data Source Properties dialog.

Typing into a cell
You can edit the text in a cell in two ways:

1 Type directly into the cell.
This will delete the text that was already in the cell.

2 Activate the cell and click in the cell to go to edit mode. Edit your text or
placeholder.
A small pencil in the row header indicates that you are now in edit mode.

Using the Data Source Properties dialog
Calling the Data Source Properties dialog to edit a data source that is already
in a cell can be done by using the shortcut menu. To do so:

1 Right-click in the cell or go to edit mode and right-click the data source
placeholder that needs editing.

2 Choose Data Source Properties.

3 Make the necessary changes and click OK to accept the changes or
Cancel to discard them.

Modifying the layout of the user table
The user table is initially made up of three columns and ten rows. Rows and
columns can easily be added, removed or cleared using the shortcut menu.

Adding rows
To add a row proceed as follows:

1 Select a cell in the row where the new row should be inserted above or
below.
Selecting multiple cells in different rows is allowed.
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2 Right-click the cell to call up the shortcut menu.
3 In the shortcut menu that comes up:

Choose Add – Row Above if you want to add a row above the selected
cell(s).
Choose Add – Row Below to add a row below the selected cell(s).

Adding columns
To add a column proceed as follows:

1 Select a cell in the column where the new column should be inserted to the
left or right.
Selecting multiple cells in different columns is allowed.

2 Right-click the cell to call up the shortcut menu.
3 In the shortcut menu that comes up:

Choose Add – Columns to the Left to add a column left of the selected
cell(s).
Choose Add – Columns to the Right to add a column right of the selected
cell(s).

Deleting rows
Deleting a row means removing (not emptying) the row which contains selected
cell. To delete a row proceed as follows:

1 Select the cell(s) in the row(s) which should be deleted.
2 Right-click one of the selected cells to call up the shortcut menu.
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3 In the shortcut menu that comes up:

Choose Delete – Row(s) to delete the row(s) containing the selected
cell(s).

Deleting columns
Deleting a column removes the column which contains the selected cell. To
delete a column proceed as follows:

1 Select the cell(s) in the columns(s) which should be deleted.
2 Right-click one of the selected cells to call up the shortcut menu.
3 In the shortcut menu that comes up:

Choose Delete – Row(s) to delete the row(s) containing the selected
cell(s).

Deleting the table
Use the shortcut menu if you want to delete the entire table:

1 Right-click somewhere on the user table object to call up the shortcut menu.
2 In the shortcut menu that comes up:

Choose Delete – Table  to delete the table.
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3 In the confirmation dialog click Yes to delete the user table or No to abort
the action.

Clearing cells
Clearing a cell means the text inside the cell is removed, not the cell itself. To
clear a cell proceed as follows:

1 Select the cells that need to be cleared.
2 Right-click a selected cell to call up the shortcut menu.
3 In the shortcut-menu that comes up:

Choose Clear – Cell(s) to clear the selected cells.
Choose Clear – Row(s) to clear the entire rows which contain the selected
cells.
Choose Clear – Column(s) to clear the entire columns which contain the
selected cells.
Choose Clear – Table to clear all cells in the table.

Cell alignment
The text in a cell is left-aligned by default. This can be changed for every cell.

1 Select the cells that need cell alignment.
Selecting multiple cells is allowed.

2 Right-click one of the selected cells to call up the shortcut menu.
3 In the shortcut menu click the desired alignment.

Font and font style
Every cell can have its own font and font style. The size of the row is adjusted
to fit the largest font in a row. To adjust the font or font style proceed as follows:
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1 Select the cells the font and/or font style of which needs to be changed.
2 Right-click one of the selected cells to call up the shortcut menu.

3 If you only want to change the style, choose the needed style. If the font
itself needs to be changed, click Choose Font…

4 The windows font dialog is shown. Set up the font as desired. Click OK to
accept the new font or Cancel to discard.

7.5.4 User table properties
In the properties of the user table it is possible to change:

l The name of the user table object
l The number of rows and columns
l The way the row header is set up
l If the user table is locked

To access these properties, right-click somewhere on the user table object and
click Table Properties.

Now the Properties of User Table dialog is shown. On this dialog you can
make the desired changes. Click OK to accept or Cancel to discard the
changes.

Perception

262 A02689_09_E00_00   HBK: UNRESTRICTED



Figure 7.21: Properties of User Table

The new settings can be set as default for all user tables added after the
change. To do this, check the Set as default for new user tables option.

With the Lock table option it is possible to protect the table from undesirable
key strokes, drag and drop operations or deletions. If the table is locked, this is
graphically visualized by a lock  in the title bar. This lock can only be turned
off in the properties.

7.5.5 User table toolbar
The user table has a toolbar. On this toolbar most of the previously mentioned
operations can be done. But this toolbar holds some extra features:

l Posting to Excel
l Posting to Word

Posting to Excel
Just like the cursor table the user can post the user table to Excel (2003 or
higher) with one click of a button. This can be done in three different ways:

1 Post to Excel: This will place the complete table into Excel on a sheet called
“ Perception - <user table name>” starting at cell A1. If Excel is not active
it will be launched. If the sheet already exists, the data will be overwritten.

2 Append to Excel: The data will be appended to the data that is already in
the sheet called “ Perception - < user table name>”. The data is then
appended on the first empty cell in column A. If Excel is not active it will be
launched, and the sheet will be created.
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3 Copy to Current Cell: The data will be placed in the currently active sheet
with the upper left-hand cell of the cursor table in the currently active cell
of the sheet. If Excel is not active it will be launched, but no sheet will be
created.

Setup Excel

Excel running

Start Excel

Workbooks

available

Add Workbook

Get first Workbook

Yes

Yes

No

No

Post to Excel

Sheet name 
exists

Create sheet name Create sheet name 

Clear sheet name

Start writing at A1

Yes

No

Setup Excel

exists

Start writing at that cell

Yes

No

Get first available cell

Setup Excel

Copy to current cell

Start writing at that cell

Get Active Sheet

Get Active cell

Setup Excel

Post to Excel

Sheet name 

Figure 7.22: Post to Excel

Posting to Word
In addition to the posting to Excel it is also possible to post the user table to
Word.

When selecting Post to Word a check is done if Word is already open and a
document is present. If this is not the case, Word will be started and a document
will be created.

At the position of the cursor a new (Word) table will be created were the values
of the user table are copied to. If this location is inside an existing table, the new
table will be created in there. Schematically this looks as shown below (see
Figure 7.23).
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Post to Word

Copy Values into

Table

Get Cursor Position

Create Table at that

position

Setup Word

Setup Word

Word running

Start Word

Document

available

Create Document

Get first Document

Yes

Yes

No

No

Figure 7.23: Post to Word

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 265



7.6 XY-display
An XY-display is a display that shows data from one or more channels as a
function of data from another channel, as opposed to a function of time (time
domain display).
A well-known result is a so-called Lissajous curve (see Figure 7.24), in which
signals with different frequencies and phase shifts are plotted against each
other:

Figure 7.24: Lissajous curves

   
 Frequency proportion Phase shift
A 1:1

B 1:1

C 1:1

D 2:1

E 3:2

F 4:3

One or more XY-displays can be positioned on the active sheet and on the user
sheets. Each XY-display can have multiple pages. Each page of the display
can then have any number of traces.
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7.6.1 XY-display concepts and components

Concept
By default, an XY-display is linked to a specific time-domain display. The
XY-display will apply all layout information from that time-domain display. The
active trace in the time-domain display from the time that the link was created
will become the X-source used in the XY-display. It will also “follow” the settings
of the time-domain display; modifications made in the time-domain will
automatically be reflected in the XY-display. You can also link to any other
time-domain display. When you link to another time-domain display, all settings
from the new time-domain display will be used.

Pages
A page is a part of a display, just like a page is part of a book. Each display has
at least one page, but a display can also have multiple pages. Multiple pages
are used to display a large number of traces with the same X-axis parameters.

Only one page per display can be shown at a time. The other pages are
positioned virtually “behind each other”. You can switch to other pages easily
by using the page control. One or more traces can be displayed within a page.

Traces
A trace is the fundamental graphical representation of data from a channel as
a function of data from the X-source channel.

Views
In addition to the standard arrangement options, a display page can divided
furthermore be divided into views. A view is a display-in-a-display and is used
to represent the same data in a different way, for example as a zoomed part of
the original trace(s).
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Figure 7.25: XY-display components - part 1

A XY-display title bar

B Trace area

C Y-annotation area

D X-annotation area

E Control area

A maximum of four views can be shown within a display page. Depending on
the settings, these are:

l Main review view
l Zoom: a detail of the review view.
l Alternate zoom: another detail of the review view.
l Live: live streaming data
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Figure 7.26: XY-display components - part 2

A X-Y Review

B X-Y Live

C X-Y Zoom

D X-Y Alt Zoom

Each view is shown as an individual display. However, due to the nature of
views, they are “connected” to each other.

The XY-display view area in detail
The display view area provides a wealth of functions and information.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 269



Figure 7.27: XY-display components - part 3

1 Y-annotation area
2 Trace area = the rest
3 X-annotation area
4 Control area
A View type
B XY-display title bar (contains the name of the XY-display)
C Cursor values
D Trace name (active trace)
E Y-range scale
F Page selector
G Frame cursor control
H Time frame
I X-range scale
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J Active horizontal cursor on the X-source
K Passive horizontal cursor on the X-source
L Passive vertical cursor on the Y-sources
M Active vertical cursor on the Y-sources
N Link to display

A View type You can see and select the type of view here. The following
basic types are available:
l Review
l Zoom
l Alternate zoom
l Live

 Depending on the basic type selected, various options are available. The
view type indicator is highlighted when the view is selected. When selected,
it is the “active view”.

B Trace name When highlighted, it denotes the “active” trace.
C Cursor values Here you can see the cursor values as:

l Active cursor value
l Both cursor values
l Difference between the two cursor values

 The selection follows the ‘linked’ time display.
D Display title bar
E Y-range scale Shows the Y-annotation scale. You can select how the Y-

range should be scaled.
F Page selection control Please refer to the Time Display description for

detailed information.
G Frame cursor control You can use this control to move the frame cursor

over the time-domain signal. The XY-data of the part covered by the frame
cursor will be used to draw the traces.

H Time frame The time frame of the data used to create the XY-display.
I X-range scale Shows the X-annotation scale. You can select how the

X-range should be scaled.
J Active horizontal cursor on the X-source This is the active cursor,

color-coded red. The cursor will follow the value of the X-source at the time
of the active horizontal time display cursor.

K Passive horizontal cursor on the X-source This is the in-active cursor,
color-coded blue. The cursor will follow the value of the X-source at the
time of the passive vertical time display cursor.

L Passive vertical cursor on the Y-sources  This is the in-active cursor,
color-coded blue. The cursor will follow the value of the in-active Y-trace
at the time of the passive vertical time display cursor.
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M Active vertical cursor on the Y-sources This is the active cursor, color-
coded red. The cursor will follow the value of the active Y-trace at the time
of the active vertical time display cursor.

N Link to display This will be shown if an XY-display is linked to a time
display. The name of time display is shown.

The Y-annotation area 
The Y-annotation area is on the left-hand side of the display. It is divided into
two sections. The first section is the annotation area. This shows the traces
currently available within the page. The second section shows the upper and
lower values of the active Y-trace. If the Y-annotation area allows it, all other
Y-traces values will be shown. If there is room to display additional values, these
will be shown.

Figure 7.28: Y-annotation area

1 Annotation area Names and cursor information
2 Scaling information Here you can see the cursor values as:
A Cursor values

l Active cursor value
l Both cursor values
l Difference between the two cursor values

 The selection follows the “linked” time display.
B Trace name The active trace is shown highlighted in the list.
C Y-scaling The values of the Y-grid can be seen here.
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The X-annotation area 
The X-annotation area is on the bottom of the display. It is divided into two
sections. The first section is the annotation area. This shows the current
X-source trace within the page. The second section shows the upper and lower
values of the X-source. If the X-annotation area allow intermediate values,
these will be shown.

1 Annotation area Names and cursor information
2 Scaling information
A X-source name The trace that is used as the X-source.
B Cursor values Here you can see the cursor values as:

l Active cursor value
l Both cursor values
l Difference between the two cursor values

 The selection follows the “linked” time display.
C X-Scaling The values of the X grid can be seen here.

Control area
The control area is the part of the XY-display that contains the various controls.

Figure 7.29: Control area

A Page selection control Please refer to the Time Display description for
detailed information.

B Frame cursor control You can use this control to move the frame cursor
over the time-domain signal. The XY-data of the part covered by the frame
cursor will be used to draw the traces.

C Time frame The time frame of the data used to create the XY-display.
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Frame cursor control
The frame cursor control enables the automatic movement of the frame cursor
for XY calculations. The frame cursor is the time area section displaying the
data which is used for calculation.

Figure 7.30: Frame cursor control (detail)

A Move frame cursor to the beginning of the time-domain signal.
B Automatically move the frame cursor in steps towards the beginning of the

recording.
C Move the frame cursor one step towards the beginning of the recording.
D Stop the automatic frame cursor movement.
E Move the frame cursor one step towards the end of the recording.
F Automatically move the frame cursor in steps towards the end of the

recording.
G Move frame cursor to the end of the time-domain signal.

7.6.2 XY-display operations

General
This section describes how to use the various display tools.
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Linked display
Within Perception, an XY-display is typically linked to a time-domain display.
Pages, colors and traces are all copied from the linked time-domain display.
When something changes in this area, the change is copied over to the
XY-display. Therefore, when you add a trace to a time-domain display, this
trace is also added to the XY-display.

Figure 7.31: Time-domain display

A Name of the time-domain display.
B Link indicator in the XY-display showing that it is linked to the time-domain

display “My Display”.

When an XY-display is linked to a time-domain display, the link indicator in the
XY-display shows which time-domain display it is linked to. When there is no
link, this icon is not shown at all.

For more Information, please refer to chapter "XY-display shortcut menu" on
page 290.

Note When you restore the link between a time-display and XY-display, the layout of
the XY-display will be updated to match the linked display. This will also happen
if you change the link from one display to another one. The active trace in the
time-domain display from the time that the link was created will become the
X-source used in the XY-display.
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Add or remove traces to or from an XY-display
You cannot add or remove traces directly to an XY-display. You need to have
a link between the XY-display and the time-domain display, and to configure
the time-domain display. Traces that are added to the time-domain display are
also added to the XY-display. Traces that are removed from the time-domain
display are also removed from the XY-display.

Modifying the display layout
The X-source can be changed within the XY-display. This can be done using
the “XY-display properties” dialog (refer to Figure 7.40) or using drag and drop.

To modify the display layout using drag & drop:

1 Click on the trace in the Y-annotation area which you want to have as
X-source

2 Drag the trace to the X-annotation area.

Perception

276 A02689_09_E00_00   HBK: UNRESTRICTED



3 The drop area will be highlighted. The hand cursor changes into a hand-
drop cursor and the Y-trace can be dropped here by releasing the mouse
button.

Figure 7.32: XY-display with highlighted drop area (detail)

A Hand-drop cursor

B Highlighted drop area

Colors and other layout behaviour are copied from the linked time-domain
display.

Zooming and panning in the XY-display
A powerful feature of the display is the ability to zoom in on a segment of interest
in the graph. The XY-display supports squared zooming and full free-style
zooming in two areas of the XY-data. The second zoom area is called the
alternate zoom. All zoom functions on the alternate zoom are performed exactly
the same as on a normal zoom, but with the Alt-key pressed down.
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Figure 7.33: Zoom areas

A X-Y Review

B X-Y Zoom

C X-Y Alt Zoom

To zoom in:
Click and drag the mouse. A bounding box with a semi-transparent fill will
appear, indicating the zoom area. When you release the mouse, a zoom view
will be created and filled with the zoomed portion of the original view. The zoom
area is shown as a raised semitransparent bounding box in the review view.
The alternate zoom area is shown as a sunken semitransparent bounding box
in the review view.

To resize a zoom area:
You can resize a zoom area by dragging a side or a corner of the bounding box
to another location as follows:

l With the mouse hovering over a border or corner. When an arrow cursor
 appears, click and drag in the required direction.

To move the zoom area:
You can move the zoom area by dragging it to another location as follows:
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l With the mouse hovering over the zoom area. When the four-way cursor
 shape appears, click and drag the zoom area to another location.

To unzoom:
l Right-click the view. Click the Unzoom command in the context menu that

comes up. The zoom area will disappear.

Replay data
Analyzed data can be replayed within a Review view of the XY-display.

The replay functionality is controlled by the frame cursor replay control that
is located in the control bar of the display. For more information about replay
data, please refer to Figure 7.30 "Frame cursor control (detail)" on page 274.

Interaction between the XY-display and the time display
When linked to a display, the entire layout of the time-domain display is copied
to the XY-display.

Frame cursor 
A frame cursor will now be shown in the time-domain display. This frame cursor
indicates which area of the waveform is included in the XY frame.

The frame cursor will dynamically show you the new area of the XY-display
when using the replay buttons. You can also use the frame cursor to look at the
XY-characteristics of a position you are interested in. The frame cursor is
displayed as a semitransparent orange area with two solid orange lines
annotating the start and end times of the frame.

You can move the frame cursor in the time-domain display manually. To do so:

1 Hover the mouse over a vertical edge of the frame until you see the bi-
directional arrow shaped cursor .

2 Click and drag the frame to the desired position.
3 Release the mouse button.
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Figure 7.34: Time-domain display with frame cursor

A1 This is the start time of the frame currently shown in the XY-display. The
numerical value of this time is annotated at C.

A2 This is the end time of the frame currently shown in the XY-display. The
numerical value of this time is annotated at D.

B The area that is being shown in the XY-display is shown in a transparent
red area.

C This is the start time of the frame currently shown in the XY-display.
D This is the end time of the frame currently shown in the XY-display.

You can change the size of the frame cursor in the time-domain display
manually. To do so:
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1 Hover the mouse over a vertical edge of the frame while pressing down the
ALT key until you see the bi-directional arrow-shaped cursor icon with two
vertical lines between them .

2 Click and drag the frame boundary to the desired position.
3 Release the mouse button.

A Bi-directional arrow shaped cursor

Linking
XY-displays may be added to the active sheet and all user sheets. If an
XY-display is added to a sheet that already contains a time-domain display, the
XY-display will automatically be linked to that display. The active trace in the
time-domain display from the time that the link was created will become the
X-source used in the XY-display.

If more than one time-domain display exists on the sheet, the active time-
domain display will be automatically linked to the new XY-display.

To change the linked time-domain display, do one of the following:

l Right-click in a view of the XY-display. On the shortcut menu that comes
up, point to Link With. In the submenu that comes up, select the display
you want to link to.

l If the XY-display is active, go to the dynamic menu. On the dynamic menu,
point to Link With. In the submenu that comes up, select the display you
want to link to.

l If the XY-display is not active, go to the dynamic menu. On the dynamic
menu, point to XY-display and than point to Link With. In the submenu
that comes up, select the display you want to link to.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 281



If no display existed at the moment you added the XY-display, there will be no
link. The XY-display will not be automatically linked to a time-domain display if
the time-domain display is added last. In these cases, you can setup the link
manually.

To link a time-domain display to an XY-display, do one of the following:

l Right-click in a view of the XY-display. On the shortcut menu that comes
up, point to Link With. In the submenu that comes up, select the display
you want to link to.

l If the XY-display is active, go to the dynamic menu. On the dynamic menu,
point to Link With. In the submenu that comes up, select the display you
want to link to.

l If the XY-display is not active, go to the dynamic menu. On the dynamic
menu, point to XY-display and than point to Link With. In the submenu
that comes up, select the display you want to link to.

7.6.3 Cursors and basic measurements
The XY-display shows the vertical cursors of the linked time-domain display.
They are only shown if they are in the requested frame.

The cursors are shown for the active y-trace and the x-source. The values in
the time axis of the vertical cursors are retrieved for the corresponding trace.
These are the points where the cursors are displayed in the XY-display.

You can use the toolbar, the dynamic sheet menu or the XY-display shortcut to
show/hide the cursors.

Figure 7.35: Dynamic menu with XY-display

A Grid Show/Hide
B Cursor table  Show/Hide
C Cursors Show/Hide
D Zero Lines  Show/Hide
E Set View to Y-t Display Period  Sets the frame cursor size to correspond

to the times of the view in the linked display.
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To show or hide cursors:

l Click on the corresponding visibility button in the toolbar.
l Using the dynamic sheet menu when the XY-display is active:

l Click on the Show cursors icon .
l Using the dynamic sheet menu when the XY-display is not active:

1 Point to the desired XY-display
2 Click on the Show cursors icon .

l Using the context menu:
1 Right-click in the XY-display area.
2 In the context menu that comes up, click on the required cursor type.

Cursor measurements 
The values of the vertical cursors can be displayed in the information window
and in the Y-annotation area.

In addition, a window containing all cursor values, including the horizontal ones,
can be displayed. The Cursor Table shows the cursor values of the active
XY-display.

This window also provides functionality to copy values to the clipboard and to
post values to Excel.

To show or hide the Cursor Table, make sure an XY-display is active and do
one of the following:

l When available in the toolbar, you can click the Cursor Table button.
l With the XY-display selected: press the space bar.
l Using the dynamic sheet menu when the XY-display is selected, click on

the Cursor Table command.
l Using the context menu:

1 Right click the XY-display area.
2 In the context menu that comes up click the Cursor Table command.

l In addition, you can close the Cursor Table as follows:
 l Click the Close button in the title bar of the window.

l Click the Close command in the Settings menu of the window.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 283



Figure 7.36: Cursor Table of XY-display

A Menu bar

B Toolbar

C Vertical cursors
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A Menu bar The menu bar has one menu: Settings. The settings menu
provides access to all additional features of the Cursor Table.

Figure 7.37: Cursor Table Settings menu

l Active Trace Values Show only the values of the vertical cursors and
the active trace. Information on the horizontal cursors will also be
shown, when available.

l All Traces Values Show the values of the vertical cursors and all
traces. Information on the horizontal cursors will also be shown, when
available.
Values are displayed in technical units.

l Engineering Format Select this option when you want the values to
be displayed in engineering format. This format is a scientific notation
in which the power of ten is a multiple of three.

l Scientific Format Select this option when you want the values to be
displayed in scientific format. This format is a shorthand way of writing
very large or very small numbers. A number expressed in scientific
notation is expressed as a decimal number between 1 and 10
multiplied by a power of 10.

l X-Axis Format Select this command to set the format used to display
X-axis labels.
By default, the labels are displayed as short of a format as possible;
only the available information is displayed without leading zeros. In
the format dialog, you can set the number of decimal places used
behind the integral part of the label.

l Static Cursor Table Select this option when you want to use the fixed
numbers of the horizontal and vertical cursors as references instead
of the relative “left/right” and “top/bottom” naming. Use this option if
you want the values in the columns related to a cursor to remain in the
same column. For example, when you move one cursor to the other
side of the other cursor, the indication remains in the same column;
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values from one cursor are always in the same column, regardless of
the position of the cursor.

Figure 7.38: Static and non-static cursor table
 l Copy to Clipboard You can copy values to the clipboard and paste

these values in another application. You can choose to copy only the
values of the horizontal, vertical or slope cursors. The copy includes
the column headers.

l Copy to Excel You can copy the values directly to Microsoft® Excel
with the following options:
l Post To This will place the complete table into Excel on a sheet

called “ Perception - display name". When Excel is not active, it
will be launched. When the sheet already exists, data will be
overwritten.

l Append To The data will be appended to the data that is already
in the sheet called “ Perception - display name".

l Copy to Current Cell Data will be placed in the sheet currently
active. The cell in the upper left-hand corner of the cursor table
will be placed in the cell that is currently active in the sheet.

l Close Close the cursor table.
B Toolbar The toolbar provides quick access to the most commonly used

commands.
C Vertical cursors The vertical cursors area has rows for each trace and a

bottom row to display the time information. The columns provide the
following information:

l Name The name of the trace.
l Left / Cursor 1 The Y-value of a trace at the named cursor position.

The cursor position in time is shown in the Time row. A red and blue
indicator is used to denote the active (red) and passive (blue) cursor.

l Right / Cursor 2 The Y-value of a trace at the named cursor position.
The cursor position in time is shown in the Time row. A red and blue
indicator is used to denote the active (red) and passive (blue) cursor.

l Delta The difference between the cursor values.
l Units The technical units of each trace.
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For more information about controlling the cursors of the linked time display,
please refer to "Cursors and basic measurements" on page 163.

7.6.4 XY-display properties
You have access to change the linked display, X-source, frame size setup and
the grid and scalings setting in the XY-display.

You can also set the name of the display in this dialog.

To gain access to the XY-display properties, do one of the following:

l When the XY-display is the active component on a sheet, select
Properties on the dynamic sheet menu.

Figure 7.39: XY-display properties

A XY-display properties

l When the XY-display is not the active component on a sheet, point to
XY-display on the dynamic sheet menu and select Properties in the
submenu.

l Right-click anywhere in the XY-display area and select Properties in the
shortcut menu that comes up.
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XY-display settings

Figure 7.40: XY-display properties dialog

A Display name

B Link to Y-time-domain display

C Source for X-axis

D Frame

E Always squared display

F Grid

A Display name Edit the name in the text box.
B Link to Y-time-domain display Select the desired Link to Y-time-

domain display from the drop down list.

Figure 7.41: Link to Y-time-domain display

1 Highlighted link to domain display
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C Source for X-axis Select the desired Source for X-axis from the drop
down list.

Figure 7.42: Source for X-axis

1 Highlighted Source for X-axis

D Frame  Select the desired Frame length settings Samples or Seconds.

Figure 7.43: Frame length

1 Highlighted setting for Frame length

l Edit the value in the Frame length field.
l Edit the percentage value in the Overlap field or click on the up/down

arrows.
E Always squared display Click the check box to get a squared

XY-display. This is useful to identify patterns more easily.
F Grid Edit the X/Y divisions field(s) of the Grid or click on the up/down

arrows.

Figure 7.44: Figure 7.13: Grid X/Y divisions
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7.6.5 XY-display shortcut menu
When you right-click in the XY-display, a shortcut menu comes up. This section
explains each shortcut in this menu.

Figure 7.45: XY-display shortcut menu

● Zoom Back Returns to the previous zoom.
● Unzoom Use this option to remove a zoom or Alt-zoom, if present.
● Link With
● Split Change the display layout
● Show Grid Show/Hide the grid
● Show Cursor Table Shows the cursor table
● Set Cursor at Position
 1 Select the desired point with the mouse in the XY-display.
 2 Press CTRL and click with the mouse. The cursor is now positioned at

the desired point.
 OR
 1 Select the desired point with the mouse in the XY-display.
 2 Right-click and select Set Cursor at position option. The cursor is

now positioned at the desired point.
● Show Cursors Shows/Hides cursors
● Show Zero Lines Shows/Hides Zero lines
● Set View to Y-t Display Period Sets the frame cursor size to correspond

to the times in the linked XY-display.
● Delete Deletes the selected XY-display from the sheet.
● Properties Shows the XY-display properties.
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Link With submenu
This submenu lists the names of the time-domain displays availabe within
Perception.

Figure 7.46: Link With submenu (detail)

Split submenu
Please refer to the “Display Operations” section "Zooming and panning in the
XY-display" on page 277 for more information.

7.6.6 Dynamic menu
Perception supports a dynamic menu, which is located on the menu bar. The
name of the menu is the same as the sheet that is currently active in Perception.

Figure 7.47: Perception menu bar

A Active menu

The dynamic menu contains commands that depend on the component that is
currently active on the sheet.

When a XY-display is the active component, the following menu will appear.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 291



A Operations on the layout of the sheet. For more information, please refer
to the chapter "Working with sheets" on page 72.

B Operations on other components that are not currently active on the sheet.
For more information, please refer to the corresponding component.

C Operations on the sheet within Perception workbooks. For more
information, please refer to the chapter "Workbook" on page 347.

D Operations on the component that is currently active on the sheet, in this
case the XY-display. For more information on the different menu items,
please refer to the shortcut menu items described in the chapter "XY-
display shortcut menu" on page 290.

7.6.7 Dynamic toolbar
When one of the components on a sheet becomes active, it will show extra
items on the toolbar that depend on the component. For an XY-display, the
toolbar items from the folllowing figure are added:
Figure 7.35 "Dynamic menu with XY-display" on page 282.
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8 More Sheets
8.1 Introduction

Apart from the sheets discussed so far there are more sheets that are always
available: Information, Settings, Diagnostics Viewer and Fiber Status.
Depending on the options installed or the hardware connected these sheets
can provide more or less functionality.
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8.2 Information sheet
By default a standard two-line information sheet is available. This can be
expanded by the Information option into a free to configure information tool.
Refer to the separately supplied documentation for details.

The Information sheet enables you to add additional information to be stored
permanently within a recording file as soon as an acquisition is done.

Figure 8.1: Information sheet - minimum configuration

8.2.1 Default information
By default the User name and Company are filled in. These cannot be changed.

8.2.2 Comment
The Comment field is editable. It can comprise literal text as well as variables.

To enter text in the comment field:

1 Enter the edit mode:
l In the Information menu click Edit Comment.
l When available in the toolbar click the Edit Comment button 

2 Type your text.
3 Exit the edit mode:

l In the Information menu click Edit Comment.
l When available in the toolbar click the Edit Comment button 
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Within the comment field you can also add placeholders for variables that are
updated automatically.

To enter variables in the comment field:

1 Enter the edit mode:
l In the Information menu click Edit Comment.
l When available in the toolbar click the Edit Comment button 

2 Position the cursor on the insertion point for the variable. Do one of the
following:
l In the Information menu click Add Data Source...
l When available in the toolbar click the Add Data Source... button

3 In the Select Data Source dialog that comes up select the data source.

Figure 8.2: Select Data Source dialog

4 The Select Data Source dialog provides a list of data sources that is filtered
to show only the data sources that are applicable in a specific situation.
Click OK when done.

5 Exit the edit mode:
l In the Information menu click Edit Comment.
l When available in the toolbar click the Edit Comment button 

8.2.3 Additional commands
The available commands are listed in the Information menu. Commonly used
commands are available also through the toolbar when visible.
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In the menu there are also possibilities to save the information in a separate
file. In general the information settings:

l comprise all settings, fields and field values as set in the information sheet,
l can be stored in a separate file with the file extension .pInfo,
l are stored automatically when a workbench is saved and as part of a

recording,
l are loaded automatically as part of a complete workbench,
l can be extracted / loaded out of a workbench or recording as separate

settings,
l can be saved into a workbench or recording as separate settings.

Figure 8.3: Information menu

A Information menu when not in edit mode

B Information menu when in edit mode

Load Information
You can load information from a variety of sources. Note that you can also load
information from files that provide more than the default values. All information
will be displayed. However, you cannot modify this additional information,
unless you have the Information option installed.

To load information:

To load information from an external source proceed as follows:

1 Do one of the following:
l In the Information menu click Load Information...
l When available in the toolbar click the Load Information... icon 

Perception

296 A02689_09_E00_00   HBK: UNRESTRICTED



2 In the Load Information dialog that comes up select your file type if required:
l Information file .pInfo
l Virtual Workbench .pvwb
l Experiment .pnrf

3 Select the file you want to load.
4 Click Open.

Save Information
Much in the same way as you can load information you can also save
information. You can also save into an existing virtual workbench or experiment.
By doing so you will replace the Information within that file. No other data will
be altered.

To save information:

To save information into an external source proceed as follows:

1 Do one of the following:
l In the Information menu click Save Information As...
l When available in the toolbar click the Save Information As... icon

2 In the Save Information As dialog that comes up select your file type if
required:
l Information file .pInfo
l Virtual Workbench .pvwb
l Experiment .pnrf

3 Select the file you want to save into/replace or type a name for a new file.
4 Click Save.

Refresh comment
When you have placeholders in your comment, you can refresh the actual
values.

To refresh the information:

l Do one of the following:
l In the Information menu click Refresh Comment.
l When available in the toolbar click the Refresh Comment icon 
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Print Information
You can make a copy on the printer of the information.

To print a copy of the information:

1 Do one of the following:
l In the Information menu click Print Information...
l When available in the toolbar click the Print Information... icon 

2 In the Print dialog that comes up enter your preferences.
3 Click Print.
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8.3 Settings sheet
The settings sheet provides a spreadsheet-style user interface combined with
graphical user interface elements to access all hardware related settings. When
a hardware setting cannot be found here it does not exist. All the individual
settings and their meaning are explained in full detail in appendix "Settings
Sheet Reference" on page 534.

8.3.1 Settings sheet layout
The layout of the settings sheet is designed to provide an efficient interface that
allows for quick modification of hardware settings of the connected acquisition
systems. Features are implemented to modify settings of large systems equally
simple as for smaller systems.

Figure 8.4: Settings sheet - example

A General settings

B Input settings

C Real-time calculations
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D Memory and time base settings

E Trigger settings

F Alarm settings

G Sensor operations

H Task pane

I Channel column

J A settings column

K A row on channel level

L A row on recorder level

M A row on group level

N Column headers

O Graphical feedback and interface

On the left-hand side of the sheet there is a task pane. In this pane the settings
are combined into logical groups for easy reference. Use this pane as a ‘table
of contents’ to select a specific settings section, for example the input settings
of all basic channels.

The actual settings matrix is based on channel/recorder/group rows and setting
columns:

l Each column gives access to a single setting.
l Each row represents a channel:

l Channels can be combined into a recorder.
l Recorders can be combined into groups.

Modifications made on a level are applied to all lower levels, for example a
settings change in a recorder row will affect all channels of that recorder. You
can select if you want to use the groups and recorders levels.

For many setting sections there is also a graphical user interface: a simplified
block diagram that shows the most relevant settings with respect to the actual
hardware. A number of settings can be changed directly in the diagram as well.
You can hide or show the block diagram.

Depending on your requirements you may want to show or hide certain parts
of the interface/matrix. Various commands are also accessible through the
sheet context menu.

You can switch between the basic and advanced mode.
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To set or switch the settings sheet layout modes:

1 In the main menu select Settings.
2 In the Settings menu select Show Settings ►.
3 In the submenu select:

l Basic: this will show only the relevant settings
l Advanced: this will show all settings

4 Or, when visible, use the toolbar icon to set the mode:

You can switch the column header layout.

To modify the column header layout:

1 In the main menu select Settings.
2 In the Settings menu select Show Header ►.
3 In the submenu select:

l Show Image Only: this will show icons.
l Show Text only: this will show text.
l Show Image and Text: this will show an icon with text.

4 Or, when visible, use the toolbar icon to set the mode:

You can set the width of each column.
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To modify the column width:

1 Hover with the mouse in the column header area over a column separator.
The mouse cursor will change into a double-side arrow.

2 Click and drag the column separator to a new location. While dragging a
dotted line is used as a visual guidance.

You may want to show or hide the block diagram (when available)

To show or hide the block diagram:

l Click on the grip that is located on top of the column header area.

When applicable you may want to show or hide groups or recorders (or
individual events when available).

To show or hide groups, recorders, events:

1 In the main menu select Settings.
2 In the Settings menu:

l Click Show Groups to show/hide the groups.
l Click Show Recorders to show/hide the recorders.
l Click Show Event Channels to show/hide the event channels.

3 Or click the corresponding button in the toolbar when available.

A Groups

B Recorders

C Events
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Within the settings sheet colors are used to denote the status of settings, for
example warning, conflict, updating, etc.

Figure 8.5: Settings sheet legend

You can see the list of available colors and indicators (legend) when applicable.

To show or hide the legend: 

1 In the main menu select Settings.
2 In the Settings menu click Show Legend to show/hide the legend.
3 Or click in the toolbar when available the Show Legend button 

You can modify the colors of various status indications.

To modify a status indication color:

l To set the color of a status indication click on the corresponding color drop
down box. For details on changing colors refer to "Modifying color" on
page 62.

8.3.2 Modifying settings
The Settings sheet let you enter values and settings in variety of ways. As a
result, you may encounter multiple ways of entering a value in a single text box
or entry field.

In general:

l You can use the dialog Tab key and the arrow keys to navigate through
the cells in the sheet.

l Once a cell has been modified you can use the Enter and Tab key to
effectuate the setting. Using the Tab key will also move you to the next cell
(i.e. the cell to the right of the current cell).

To open a cell for modification:

You will need to “open” a cell in a sheet to modify the content. To do so you
can:
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l double-click on it.
l click the cell twice.
l click once to select and use a right-mouse click to open.
l click once to select and press Enter.

To enter a value:

To enter a value do one of the following:

l Type a value in an open entry field.
l Choose a value from a drop-down list associated with the entry field.
l When a drop-down list is visible you can still type in another value, when

this is supported for that specific setting.
l When a drop-down list is visible you can use the up- and down-arrow key

to step though the options.

To modify an option:

l Click an option from the drop-down list. When a drop-down list is visible
you can use the up- and down-arrow key to step though the options.

To modify on/off settings:

l To toggle an on/off settings click on the field to select it and click again to
toggle the selection.

To modify a color:

l To modify a color click on the corresponding color drop down box. For
details on changing colors refer to "Modifying color" on page 62.

Mixed values
When using groups and recorders, the group and recorder row display the same
values as set in the lower level. For example when all channels have an input
span of 10 Volt, the input span of the corresponding recorder will also be 10
Volt. When not all channels have the same values, the upper level displays the
value of the first channel in the range below.

Modify multiple cells
You can modify the contents of multiple cells within a column in one go. There
are two fundamental options:
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l Use multi-select techniques.
l Use recorders and groups.

To modify multiple cells using multi-select techniques:

You can modify multiple cells in the same column at once. To select multiple
cells for editing do one of the following:

l Click on the header of a column. This will select all cells in a column. Press
and hold down SHIFT, and then click on a cell to edit the contents. Release
the Shift key and edit the field. Press Enter when done.

l To select consecutive cells, click the first cell, press and hold down SHIFT,
and then click the last cell. Click on a cell to edit the contents. Press Enter
when done.

l To select nonconsecutive cells, press and hold down CTRL, and then click
each cell. Click on a cell to edit the contents. Press Enter when done.

To modify multiple cells using recorders and groups:

1 Make sure groups and/or recorders layout is visible.
2 Click on a cell in the group or recorder row.
3 Edit the contents.
4 Press Enter when done.

8.3.3 Using the block diagram
In various sections a simplified block diagram is available. The function of this
block diagram is threefold:

l It gives a graphical representation of the object you want to control. This
makes it easier to identify the function of various settings.

l It gives feedback on (the impact of) settings made, for example you can
see the physical impact of modifying a switch setting.

l You can use it to control a variety of settings without the need to search
through a myriad of columns.
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Figure 8.6: Example of a settings sheet block diagram (bridge input)

A Channel select

B Activate bridge wizard

C Bridge representation – Mouse sensitive area

D Legend

E A switch – Mouse sensitive area

F Numeric value

G Enable/Disable connector pinning

H Physical input range

I Spin box

J A switch – Mouse sensitive area

A Channel select Use this control to step back and forth through the
available channels. This control also works on groups, recorders and
multiple selected channels.

B Activate bridge wizard Click the button to open the Bridge Setup.
C Bridge representation – Mouse sensitive area Click anywhere in the

area to modify the state of the option(s). Each click will put the option in
the next state (repeating).

D Legend Depending on the type of diagram a legend may be used to clarify
used symbols.

E Excitation – Mouse sensitive area On/Off switch for the excitation of the
Bridge. Click anywhere in the area to modify the state of the option(s).
Each click will put the option in the next state (repeating).
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F Numeric value You can modify numeric values using one of the following
methods:

l Double-click on the value: the value will change into an entry field or
drop down list. Type or select the required value and press Enter or
Tab when done.

l Place the mouse cursor over the value. The cursor will change into a
. Click on the value and drag the cursor left or right to change the

value. While dragging the cursor will change into  .
l Click on the value: the value is selected and the cursor will change

into a  . Turn the mouse wheel up or down to change the value.
G Enable/Disable connector pinning Show or hide the connector pinning.

In this example the connector pinning of a bridge input connector can be
displayed.

H Input range This indicator shows the actual physical input range in volts
and not in technical units.

I Spin box A spin box is a text box that allows you to move, or spin, through
a fixed set of values.

J A switch – Mouse sensitive area Click anywhere in the area to modify
the state of the option(s). Each click will put the option in the next state
(repeating).

8.3.4 Additional commands
The available commands are listed in the Settings menu. Commonly used
commands are available also through the toolbar when visible.

In the menu there are also possibilities to save the settings in a separate file.
In general the settings:

l define the complete hardware setup as specified in the settings sheet,
l can be stored in a separate file with the file extension .pset,
l are stored automatically when a workbench is saved and as part of a

recording,
l are loaded automatically as part of a complete workbench,
l can be extracted / loaded out of a workbench or recording as separate

settings,
l can be saved into a workbench or recording as separate settings.
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Load Default Settings
You can restore the hardware settings to their factory default.

To restore the settings to their factory defaults:

l In the Settings menu click Load Default Settings

Load Settings
You can load settings from a variety of sources.

To load settings:

To load settings from an external source proceed as follows:

1 Do one of the following:
l In the Settings menu click Load Settings...
l When available in the toolbar click the Load Settings... button  .

2 In the Load Settings dialog that comes up select your file type if required:
l Settings file .pset
l Virtual Workbench .pvwb
l Experiment .pnrf

3 Select the file you want to load.
4 Click Open.

Save Settings
Much in the same way as you can load settings you can also save settings. You
can also save into an existing virtual workbench or experiment. By doing so you
will replace the settings within that file. No other data will be altered.

To save settings:

To save settings into an external source proceed as follows:

1 Do one of the following:
l In the Settings menu click Save Settings As...
l When available in the toolbar click the Save Settings As... icon  .

2 In the Save Settings As dialog that comes up select your file type if required:
l Settings file .pset
l Virtual Workbench .pvwb
l Experiment .pnrf

3 Select the file you want to save into/replace or type a name for a new file.
4 Click Save.
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Resolve All Conflicts
Conflicts are generated when you make settings that prohibit a ‘correct’
recording. However, you may choose to start a recording. When you do so the
conflicting settings will be resolved before the actual acquisition starts. Conflicts
are color coded as defined in the settings sheet legend. You may choose to
resolve these conflicts before you start an acquisition.

To resolve all conflicts:

l Do one of the following:
l In the Settings menu click Resolve All Conflicts.
l When available in the toolbar click the Resolve All Conflicts icon

 .

Bridge Wizard
For bridge input channels a bridge wizard is available. The wizard allows you
to configure your bridge channels more easily. The outcome of the wizard is an
optimal match of the amplifier gain/span with your bridge configuration. In
addition, when you provide all the information, all settings for shunt calibration
are also calculated.

The bridge wizard allows you to configure the bridge amplifier by entering
typical known information, derived from specification sheets and/or physical
setup descriptions. You can easily enter information from a data sheet into the
bridge wizard.

The wizard allows you to set up multiple channels at one go and copy settings
from a channel with known correct parameters to other channels.

To set up one or more bridge channels:

1 Select no, one or multiple channels in the settings sheet
2 Do one of the following:

l On the Settings menu click Bridge Wizard.
l When available in the toolbar click Bridge Wizard  .
l When available in the graphical area of the settings sheet click the large

Activate bridge wizard icon in the upper right-hand corner.
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3 In the Bridge Wizard start-up page:

Figure 8.7: Bridge Setup Start-up

Select the channels that you want to use in the procedure. The channels
that were already selected in step 1 are selected here by default.
 

4 Click Next
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5 In Step 1 of 5 select the type of transducer that you are using.

Figure 8.8: Bridge Setup Step 1 of 5

6 Click Select if you want to copy settings from another channel.
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7 Click Next and follow the on-screen instructions to complete the procedure.
When the process is complete, a summary is displayed.

Figure 8.9: Bridge Setup Step 5 of 5

8 Click Auto balance bridges if you would like the bridge to be balanced
when you exit this dialog. If you select this option and click Apply and
close, a dialog box will appear asking if you would like to be taken to the
bridge balance screen to see the results, click yes or no.

Figure 8.10: Bridge Balance dialog

9 Click Apply and close.
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8.3.5 Print Report
Perception controls a large number of hardware-related settings. You can use
the Print Settings command to create a listing from these settings. You can
modify the content of the printout. You can send the print information to a printer,
post the information into a Word document or create a PDF file.

To access the Print Settings dialog do one of the following:

l In the File menu point to Print and click Settings…
l If available, in the Settings menu click Print Settings…
l If available, in the Settings toolbar click Print Settings…

Figure 8.11: Print Settings dialog

A Print items selection tree

B Command buttons

C Print settings options

A Print items selection tree

Use this tree view to select the items to be printed.
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B Command buttons

Load settings...

To load an “external” settings file:

1 In the File menu point to Print and click Settings from File...
2 In the File Open dialog select the file that contains the settings. By

default this is a *.pset file. However, it is also possible to select a
workbench file (*.pvwb) or a recording file (*.pnrf) and load the set-
tings that are in these files.

3 Click Open.
4 The top of the tree view shows the name of the selected file.

 
 Print Report

Click Preview to create a preview of the report. The first page gives an
overview of the selected items. If a selected item does not contain any
data, this item is not printed. Selected items which are not printed are
listed in the “Not Printed” column.

In the Print Preview dialog box do the following:

1 Click Close to close the Print Preview dialog box.
2 Click Print… to print the report. The standard print dialog will open.
3 In the Zoom list select a zoom factor.
4 Use the PageUp and PageDown keys to step through a multi-page

report.
 
 Post to Word

Click Post to Word to post the report to Microsoft® Word. This will open
Word and create a report.

 
 Create PDF

Click Create PDF to create a PDF file of the settings report. In the Save
As dialog select a folder and file name and click Save.
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C Print settings options

Use these options to modify the report layout.

If you do not want to print empty columns select the Don’t show empty
columns check box.

The input range of a channel can either be defined by a from and to value
or by a span and offset value. Select Show from / to for the first option
or else select Show span / offset.

Select the TU per Volt check box to display technical units per volt. Clear
this check box to display volt per technical units.

For external clock settings the scaling can be expressed in clock pulses
per unit or in units per clock pulse. Select the Clock Pulses per Unit
check box to display clock pulses per unit. Clear this check box to display
units per clock pulse.

8.3.6 Network and External storage setup

Network setup

Note The Mainframe network setup and the External storage setup features are only
available if the Settings Sheet is active.

TCP-IP based acquisition system can be re-configured through the settings
sheet, for example if a DNS server is put in use, if networks are reconfigured
or if connection to the device is desired through a specific network connection
on the acquisition system.
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To review/update the mainframe network settings:

l In the Settings menu click Mainframe Settings

Figure 8.12: Mainframe Settings dialog

Please refer to the GEN series user manual for detailed information on
configuring network settings.

Note It is only possible to review/update network settings of currently connected
mainframes!

Setup external storage
Depending on the setup of the acquisition system, three possible ways of
storing acquired data are available:

● PC Storage: On the PC control system.
● Mainframe Disk 1,

Mainframe Disk 2:
On a hard drive mounted in the acquisition system.

● iSCSI 1,
iSCSI 2:

On an external iSCSI hard drive, connected to the
acquisition system.
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The storage location setting in the settings sheet can be used to select which
way should be used for each mainframe in the system. If an external hard drive
(currently iSCSI only) is selected, this drive needs to be properly setup. In some
cases this can be done through the mainframe’s front panel menu, but another
way to do the setup is through the External Storage Setup dialog.

To setup connection to an external storage device:

l In the Settings menu click External Storage

Figure 8.13: Mainframe Settings - External Storage Setup dialog

Please refer to GEN series user manual for detailed information on the setup
of iSCSI storage.

8.3.7 Power on Setup
The GEN DAQ mainframe can start with the settings set to their default values
or reload the stored user settings values. The Power on Setup determines this
choice. The settings can be persisted on the GEN DAQ mainframe’s internal
storage. The stored settings are restored automatically at the next startup of
the GEN DAQ mainframe.
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The Power on Setup dialog provides access to the connected mainframe(s)
(see Figure 8.14).

Note The menu item is only enabled when Perception is connected to a GEN DAQ
mainframe which supports Power on Setup.

Figure 8.14: Mainframe Settings - Power on Setup

A Power on settings: In this column the Power on settings can be selected,
this can either be System defaults or User settings.

 l System defaults: The mainframe(s) use the factory system default
when starting.

l User settings: The mainframe(s) use the previously stored user
settings when starting. When this option is selected and no user
settings are stored, this setup cannot be applied.

B Status: Checking if a mainframe has a stored setup can be seen in the
Status field. Precondition: User settings is selected.

Note The stored setup needs to be created with the current mainframe configuration.
If the mainframe hardware configuration has changed (e.g.: Removing an
acquisition card), new user settings need to be stored.
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C Store: The settings are only stored on user request. This can be done for
all applicable mainframes at once by using the Store button, or for a single
mainframe by using the context menu.

D Reload: Stored settings are restored at GEN DAQ mainframe startup or
on user request. You can use the Reload button to reload setting for all
applicable mainframes at once, or use the context menu for a single
mainframe reload.

E Acquisition mode: This mode determines if the acquisition is active after
startup of the GEN DAQ mainframe.

 l Idle: The GEN DAQ mainframe restores the settings at startup. The
acquisition state remains idle.

l Preview: The GEN DAQ mainframe restores the settings at startup
and starts the acquisition in preview mode.

Note In Preview mode the RT-FDB (Real-time Formula Database) calculations are
performed and calculation results can be exported to the EtherCAT® bus, CAN
bus or the GENDAQ API.
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8.4 Fiber Status sheet
HBM offers a range of Fiber Optic isolated digitizers for use with the GEN series
data acquisition system. These digitizers are discrete units that are connected
to the GEN series data acquisition system through a fiber optic cable for
communication and data transfer.

Depending on the type and model these remote front-ends are battery
operated, mains operated or use another external power supply.

Because the units can be located on a large distance of the actual laboratory,
the units provide an extensive set of on-board diagnostics and status
information to verify proper operation. This information is available through the
Fiber Status sheet.

When this sheet is not readily available you must add it. To add the Fiber Status
sheet do one of the following:

1 On the File menu point to New Sheet and select Fiber Status in the
submenu.

2 Right-click in the tab area of the sheets. On the shortcut menu point to New
Sheet and select Fiber Status in the submenu.

3 When the toolbar is available click the Create new sheet icon and select
Fiber Status in the drop-down menu.

Depending on the model battery information may, or may not, be available.

8.4.1 Status information
The following is a list of all available status information in this sheet.

Note There are no settings here that you can modify.

Link status

Summary
Gives information about the communication status: OK, bad or no
communication

Description
When no errors are detected for more than 1.5 second, the connection is OK.
Otherwise the connection is bad. When no 'light' is detected, communication
is lost.
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Link quality (BER)

Summary
Gives the Bit Error Ratio

Description
The BER is an indication of the link quality. With a typical measurement time
the front-end firmware can determine a BER better than 10-11 with a
confidence level (CL) of > 99%. When a unit starts up, the unit can determine
within 10 seconds a BER of 10-10 with a CL of 85%; after 2.5 minutes a BER
of 10-11 with a CL of 95%.

Cable length

Summary
Cable length in meters

Description
Accuracy is ± 1 meter. For some fiber systems this can go up to 4000 meter
standard or even 12000 meter with low-loss cables.

Front-end temperature

Summary
Temperature inside the front-end cabinet

Description
Gives the temperature inside the front-end. Typical values are 15 °C to 25 °C
above ambient temperature, depending on the model.
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Front-end power level

Summary
Power level indication for the internal electronics

Description
This is a copy of the “power low” indication on the receiver front panel. When
not OK the power voltage has gone below 10.4 V (approximately). This
situation stays until 9.2 V (approximately) is reached. Below this level the
front-end will not function any more.

Front-end power source

Summary
Current power source on which the front-end operates: mains (external) or
battery

Description
Depending on the model the unit can operate on mains (external) or battery or
'both'.

Front-end external power status

Summary
Condition when an external power source is used

Description
The voltage level of an external power source: good, under-range (low) or
over-range (high).
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Total capacity remaining

Summary
Remaining total battery capacity of all installed batteries together

Description
Some front-ends include two batteries. When one battery has 100% and the
other one has 80% capacity, the total capacity remaining equals 90%.

Operating time remaining

Summary
Estimated remaining operation time of unit based on capacity and power
consumption

Description
Indicates the remaining operation time of the front-end based on total
remaining capacity and power consumption. This is an approximation.

Voltage

Summary
Voltage supplied by battery A/B

Description
Voltage supplied by the battery.
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Current

Summary
Current of battery A/B. A positive value indicates that the battery is loading

Description
Current of battery A or B. A positive value indicates that the battery is loading;
a negative value indicates that the battery is in use.

Capacity rating

Summary
The amount of electrical energy battery A/B can deliver over a certain period
of time, measured in Ampere-hours (Ah)

Description
The battery capacity rating provided by manufacturers is the product of 20
hours multiplied by the maximum constant current that a new battery can
supply for 20 hours at 20 °C (68 °F), down to a predetermined terminal voltage
per cell. It is therefore a theoretical value.

Capacity remaining

Summary
Remaining battery capacity of battery A/B

Description
Remaining battery capacity of battery A or B.
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Temperature

Summary
Temperature of battery A/B

Description
Internal temperature of battery A or B.

Charge status

Summary
Indication of the charge status of battery A/B. Can be charging, discharging or
idle

Description
Rechargeable batteries can be discharging, charging or idle when no current
is drawn.

Charge cycles

Summary
Number of battery charge cycles to date for battery A/B

Description
When a battery is discharged and then recharged it is said to have completed
a battery cycle. This is important because battery life is determined by the
number of cycles a battery can yield.
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Condition

Summary
Condition of the battery A/B

Description
The condition (health) of the battery is determined by the number of battery
cycles N. The condition is said to be good for N < 300 for a typical battery.

8.4.2 Additional commands
The available commands are listed in the dynamic Fiber Status menu.
Commonly used commands are also available through the toolbar when visible.

Figure 8.15: Fiber Status sheet menu

Show Battery Summary
When the front-end has on-board batteries you can select to show or hide the
Battery Summary columns Total capacity remaining and Operating time
remaining.

Show battery details
When the front-end has on-board batteries you can select to show or hide the
batteries details columns. These columns provide information on a per battery
basis.

Temperature unit
Temperature can be displayed in degrees Celsius (°C), degrees Fahrenheit
(°F) or in Kelvin (K).
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8.5 Diagnostic Viewer sheet
During operation Perception keeps track of a variety of diagnostic information.
This information is related to the Perception application itself, communication
with acquisition hardware and various notifications. This information is stored
on the computer in XML-based files. For easy access to this information a
Diagnostics Viewer sheet is provided

When this sheet is not readily available you must add it. To add the Diagnostics
Viewer sheet do one of the following:

l On the Sheet menu point to Manage Sheets... and select Diagnostics
Viewer in the table and Load.

l Right-click in the tab area of the sheets. On the shortcut menu point to New
Sheet and select Diagnostics Viewer in the submenu.

l When the toolbar is available click the Create new sheet  icon and select
Diagnostics Viewer in the drop-down menu.

8.5.1 Operation
Initially the Diagnostics Viewer sheet comes up empty. Now you need to open
a diagnostics file.

To open a diagnostics file:

l On the Diagnostics Viewer menu click Open Diagnostics. In the file Open
dialog select the diagnostics file that you want to see and click Open.
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Figure 8.16: Diagnostic Viewer sheet

The information is a list of events, grouped in sessions. By default the most
recent session is displayed in full. Chevrons are used to show or hide remaining
items in hidden content:

l Click on a chevron pointing downwards to open a session.
l Click on the same chevron now pointing upwards to close a session.

Each event has an icon in front to indicate the type of event:

Information: the event has no consequences

Warning: a condition that might cause a problem in the future

Error: a problem that has already occurred and may prohibit correct
operation

8.5.2 Commands
The available commands are listed in the dynamic Diagnostics Viewer menu.
Commonly used commands are also available through the toolbar when visible.
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Figure 8.17: Diagnostic Viewer menu

Open Diagnostics
Use this command to open one of the available diagnostics files.

To open a diagnostics file:

l On the Diagnostics Viewer menu click Open Diagnostics. In the file Open
dialog select the diagnostics file that you want to see and click Open.

Filter Diagnostics

You can set a filter on the diagnostics to view only the events of interest for you.

To filter diagnostics:

1 On the Diagnostics Viewer menu click Filter Diagnostics. The following
dialog comes up:

Figure 8.18: Filter Diagnostics dialog

2 In this dialog select the type of events that you want to see. By default all
types are selected.

3 For a more detailed filter you can specify a (part of a) text string in the
Category or Description fields of the event entry.
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4 You may want to apply this filter as default for each time you open a
Diagnostics Viewer sheet.

5 Click OK when done.

Auto Refresh
Select this option if you want to refresh the Diagnostics viewer automatically
when new events arrive. As standard this option is cleared.

Print Diagnostics
Select this command when you want to print the diagnostics. The print is laid
out as displayed on the screen: open and closed sessions.
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9 Menus Walkthrough
9.1 Introduction

The Perception work area includes the command menus at the top of your
screen. The menu bar provides a number of fixed menus: menus that always
are on the same location, do not change their name and provide always the
same basic functions, regardless of the state of the software. Apart from these
static menus their is also a dynamic menu: a menu related to the context of the
selected sheet. These dynamic menus are described in the corresponding
sheet section.
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9.2 File menu
The file menu is primarily used to open, close and save files related to the work
environment.

Figure 9.1: File menu

9.2.1 New...
Select New... to start a new work environment based on an experiment or virtual
workbench. You can select to start from scratch or use an existing environment.
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Start a new work environment
The start dialog automatically appears when you start Perception, or when you
select New in the File menu. You can use this dialog to create a new
experiment, redo an existing experiment using actual hardware or review an
experiment with data only.

Figure 9.2: Perception Start dialog

Start dialog options:

1 If the dialog is not already open do one of the following
l Choose File ► New
l If available in the toolbar click the New experiment button
l Press CTRL+N

2 In the dialog select one of the following options:

Start dialog options summary

Load VWB Envi-
ronment

Load Hardware
and connect

Load Data

New Default (1)

New and Auto Default (2) Search and select
(2+)

Redo x (3)
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Load VWB Envi-
ronment

Load Hardware
and connect

Load Data

Redo and Data x (3+) x (3+) x (3+)

Review x (4) x (4)

Set up new blank experiment (1)

Start from the beginning. This creates a new blank experiment based on a
default layout. For details of experiments refer to "Experiment" on page 40.

Set up an auto-configured Experiment (2)

This will create and experiment based on available acquisition hardware. If you
want factory defaults to be restored select the and reset hardware option.
Choosing this option will bring up a dialog from which to choose available
hardware to connect to.

When you select the auto configure command a dialog comes up that you use
to choose the hardware.

Figure 9.3: Hardware select dialog

Select one or more of the available mainframes. Hardware that is dimmed in
already in use with the name of the user is shown between parentheses.

Click Rescan to rescan the network, click OK when done.

Perception will now automatically connect to the selected hardware and create
a work environment for you. The connected hardware will be set in Pause mode.
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When you select a mainframe, the last used password for that mainframe is
used for authorization. When there is no last used password, a default
password is used to connect to the mainframe. When this verification fails, you
will need to enter the mainframe’s password.

Figure 9.4: Enter Password dialog

When entered correctly this password will be saved for later use.

Redo an existing Experiment (3)

If you have already performed an experiment and saved it with the correct
layout, you can select this option to revert back to the saved workbench, data
and hardware set up.

To open from Perception:

1 Do one of the following:
l Select File ► New... ► Redo an existing Experiment ► OK
l Select File ► Open...
l If available click the toolbar icon  Open Experiment.

 
You can optionally select and load existing experiment data to
include the data from the experiment file.

2 In the Open Virtual workbench dialog select the file you want to load and
click Open.

While the Virtual Workbench is being loaded, a progress dialog is shown. It lists
all relevant actions and their success or failure.
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Figure 9.5: Load Experiment Progress dialog

Clear the “Automatically close this dialog when finished successfully” option if
you want to review the results.

For more information on user modes refer to "Switch to Instrument Panel" on
page 45.

Review a stored experiment (4)

Select a previously stored experiment and load the associated Virtual
Workbench and data, but do not connect the hardware.

Hardware not found
Typically an experiment/VWB contains information about connected hardware.
If you load an experiment/VWB and the hardware is not available or modified,
you will be notified of this situation and will be given the option to connect to
other hardware as a substitute.

In this case, during loading you are given the opportunity to load the setup of
the registered instrument(s) into new ones that are currently available.
Whenever a VWB or experiment is loaded and the referenced hardware is not
found, the following dialog will be shown:

Perception

336 A02689_09_E00_00   HBK: UNRESTRICTED



Figure 9.6: Virtual Workbench Load dialog

A Replace option

B Skip option

C Mainframe name

D Adress of mainframe

E Mainframe name

F Refresh

G List of mainframes

H Continue

A Replace option Select this option if you want to replace the mainframe
with another mainframe from the selection list.

B Skip mainframe Click this option if the original mainframe should not be
replaced.
If this option is selected, an attempt to connect to the original mainframe
is made during the actual connection process. You can use this if you do
not want to replace the mainframe. You can also use this if the original
mainframe has not been powered up or completely booted yet. In this
case switch on your hardware and wait for the mainframe to be
completely booted and then click Continue.

C Mainframe name The name of the mainframe in the VWB that cannot be
found.

D Address of mainframe The IP-address of the mainframe in the VWB
that cannot be found.
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E Mainframe name The name of the mainframe in the VWB that cannot be
found.

F Refresh The refresh button can be used to refresh the content of the
mainframes list. New mainframes can appear in the list or the “in use”
status can change.

G Mainframe selection list The list of mainframes that are found. Note that
this list only contains mainframes of the same type as the original
mainframe. It is not possible to load settings of a mainframe type into a
different mainframe type.

H Continue with the connection process using the selected option.
This dialog is shown once for each mainframe that was stored in the VWB
or experiment you are loading and that could not be found. A mainframe
can only be selected once and if it is not in use by another user. If a
mainframe is not selectable, it will still be shown in the list.

Units in use are greyed and the name of the user is displayed. If the
available mainframe was previously selected to load into a referenced
mainframe, or if it is matched to another mainframe that was in the VWB
or experiment, this will be indicated by the term Loaded instead of a user
name.

Loading settings into a different mainframe

When loading settings into a different mainframe, the configuration of the
mainframe may differ from the original mainframe. If this happens, the following
rule is used to load the recorders of the mainframe:

When a recorder is loaded, the type of the recorder and it's settings are
compared with the stored settings for this recorder. If the recorders are of
compatible types and in the correct slots, the settings are loaded. The
configuration of the recorder is also compared, only the recorder settings that
match exactly are loaded. This is done for all recorders in the VWB or
experiment.

Once a load attempt is made for all recorders in the VWB or experiment, the
hardware recorders and settings that did not match will not be loaded and are
disabled.

Perception

338 A02689_09_E00_00   HBK: UNRESTRICTED



Open an existing workbench
If you want to start with an existing workbench select this option. For more
information on workbenches refer to "Virtual Workbench" on page 36.

To open an existing workbench:

1 Do one of the following:
l Select File ► New... ► Open an existing virtual workbench ► OK
l Select File ► Open Virtual Workbench...
l When available in the toolbar click the Open Virtual Workbench

button 
2 In the Load Virtual Workbench dialog that comes up select your file type if

required:
l Virtual Workbench .pvwb
l Experiment .pnrf

3 Select the file you want to load.
4 Click Open.

When you open an experiment the Perception application by itself will be
closed. After loading all new information the Perception application is started
with the new experiment settings. While loading the virtual workbench a
progress dialog is shown. For details see the remarks for this dialog in
"Hardware not found" on page 336.

9.2.2 Open...
This command brings you directly to the Open Experiment for Review dialog.

To open an experiment using the Open command:

1 Select File ► Open...
2 In the Open Experiment for Review dialog select the file you want to load.
3 Click Open. Refer to Figure 9.1 "File menu" on page 332 for details.

9.2.3 Save
Lets you save your experiment.

To save your experiment:

l Select File ► Save. This will save the experiment to its current file.
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Note When a recording is made, the data is automatically saved on the PC in your
archive directory with the current recording name, including all workbench
settings. When you click Save, you save (overwrite) the workbench settings
within the experiment. The data (recording) that is part of the experiment cannot
(and will not) be modified.

9.2.4 Save a Copy As…
The “Save a Copy As...” option stores a copy of the current active experiment.

Note “Save a Copy As...” is only enabled if a new active recording or an experiment
is open.

The experiment data will be taken over in the newly created PNRF file. At the
end of the save process, the active workbench will be saved into the newly
created PNRF file. For more information about Perception storage formats refer
to "Export Recording..." on page 356.

1 In the File menu point to Save a Copy As… to open the context menu.

Figure 9.7: File menu with Save a Copy As... option

A Save a copy as
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2 In the following dialog (see Figure 9.8) navigate to the new path to save the
file as a copy. If needed click the Advanced button to get the dialog with
the advanced settings.

Figure 9.8: Save a Copy As dialog

A File name Note that “_Copy.pnrf” will automatically be added to the
existing filename.

B Advanced Click the Advanced button to open the Configure Save a
Copy as dialog (see Figure 9.9).
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3 Click the option button(s) in the Save what area and/or the check boxes in
the File area for the settings of the copied file.

Figure 9.9: Configure Save a Copy As dialog

A Save what settings

B File settings

C Full path example

D File name extension

E File name

A Save what  Click the desired option button:
l Complete recording
l Between cursors
l Displayed area
l Zoomed segment
l Alternate zoomed segment

Note that you can select either one of these options or the Sweeps
option button.
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 l Sweeps

Choose the desired sweeps setting for the file to be copied.
  
B File The options below allow for building up a more complex filename,

which can include:
l Recording name The recording name, as set in the Acquisition

Control palette.
l Recording date
l Recording time
l Autonumber A number that increases automatically by 1 for every

new file, starting at the specified number and consisting of the specified
total number of digits.

l Trigger The number of the triggered segment that contains the data
to be saved.

l Overwrite When this option is selected, only one file is created each
time the action is initiated.

 Placeholders
In addition to the options described above, you can also manually edit the
filename. Insert placeholders to the filename box (E). The placeholder is
inserted on the cursor position within the text box when you select the
option. You can cut and paste text to your preference in the filename box
(C), in order to set the placeholders and eventual fixed file name text in the
desired order. A placeholder is a text identifier between percent (“%”)
symbols, which is automatically replaced by another text when its value is
calculated (for example %date% will be replaced by the current date).
These placeholders are documented in the Export Formats User’s Guide.
 
Typical placeholders are:
l %recname%
l %date%
l %time%
l %autonumber%
l %trigger%

C Full path example Shows what the final file name(s) will look like. When
satisfied with the result, click OK to save the configuration.
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D Extension Supported file format
  
E File name  In this text box you can enter a name for the output file. Note

that this might only be part of the whole file name, depending on the rest
of the options in the dialog.

9.2.5 Close
Closes the current experiment. However the current Virtual Workbench remains
intact.

9.2.6 Open Virtual Workbench...
This command brings you directly to the Open Virtual Workbench dialog.

To open a Virtual Workbench using the Open Virtual Workbench
command:

1 Select File ► Open Virtual Workbench...
2 In the Load Virtual Workbench dialog that comes up select your file type if

required:
l Virtual Workbench .pvwb
l Experiment .pnrf

3 Select the file you want to load.
4 Click Open.

When you open a Virtual Workbench the Perception application by itself will be
closed. After loading all new information the Perception application is started
with the new workbench settings.

While loading the virtual workbench a progress dialog is shown, identical to the
one when loading an experiment. For details see the remarks for this dialog in
"Hardware not found" on page 336.

9.2.7 Save Virtual Workbench
Lets you save your current virtual workbench.

To save your current virtual workbench:

l Select File ► Save Virtual Workbench. This will save the workbench to its
current file. If you haven’t previously saved your workbench, the Save
Virtual Workbench command functions in the same way as the Save Virtual
Workbench As... command.

Perception

344 A02689_09_E00_00   HBK: UNRESTRICTED



l When available in the toolbar click the Save Virtual Workbench icon 

9.2.8 Save Virtual Workbench As...
Choose this command to save your workbench to a different file.

To save your virtual workbench with a different name:

1 Do one of the following:
l Select File ► Save Virtual Workbench As...
l When available in the toolbar click the Save Virtual Workbench

As... button 
2 In the Load Virtual Workbench dialog that comes up select your file type if

required:
l Virtual Workbench .pvwb
l Experiment .pnrf

3 Select the file you want to save into/replace or type a name for a new file.
4 Click Save.

9.2.9 Revert to Last Opened Setup
This command allows you to return to the initial state of your work environment.
This can be the state of the environment after start-up, or the state of the most
recent opened VWB.

With this feature you can experiment freely with your setup, without losing the
original information. Even after an accidental overwrite of your loaded VWB you
can easily restore your workbench and undo the accidental save operation.

When you revert, the original settings file (*.pvwb) will be restored.

To revert to your initial state:

1 Select File > Revert to Last Opened Setup…
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2 Click Revert in the confirmation dialog that comes up:

Figure 9.10: Confirm Revert dialog

The original workbench will be loaded.

9.2.10 Save Configuration for Offline Use...
Use this command when you intent to use the Configuration Manager as
described in the appendix “Offline Setup & Configuration Manager”on
page 522.

To save the configuration for offline use:

1 Select File ► Save Configuration for Offline Use...
2 In the Save Offline Configuration dialog that comes up select the file you

want to save into/replace or type a name for a new file.
3 Click Save.

9.2.11 New Sheet
You can add sheets to the default layout. Depending on the options installed
(including CSI) one or more type of sheets may be available.

To add a new sheet:

1 Do one of the following:
l Point to File ► New Sheet ►
l When available in the toolbar click the New Sheet button 

2 In the submenu that comes up select the sheet you want to add.
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9.2.12 Workbook
As standard Perception has one workbook that contains all the sheets you
create. As an option Perception allows you to create multiple workbooks. When
this option is installed you can create new workbooks, duplicate and delete
workbooks. Commands for these operations are available through the
Workbook command.

New
To create an additional workbook from scratch use the New command. This will
create a new blank workbook that is positioned on top of the current workbook,
slightly offset.

To create a new workbook: 

l Using the file menu:
1 Point to File ► Workbook ►
2 In the submenu click New .

l When available in the toolbar click the New Workbook button 

Duplicate
To create an additional workbook based on a current one use the Duplicate
command. This will create a copy workbook that is positioned on top of the
current workbook, slightly offset.

To duplicate a workbook:

1 Point to File ► Workbook ►
2 In the submenu click Duplicate.

Delete
To remove a workbook use the Delete command.

To delete a workbook:

1 Point to File ► Workbook ►
2 In the submenu click Delete.

9.2.13 Archives
The archives section in the Recordings Navigator holds all stored recordings
that are available through your PC’s environment.
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You can add more folders to the Archives directory, or set the current archive
folder. For details refer to "Working with archives" on page 95.

Add new folder ...
To add an archive:

1 Point to File ► Archives ►
2 In the submenu click Add new folder ...
3 In the Browse for Folder dialog that comes up do one of the following:

l Browse to and select an existing folder. Click OK.
l Click Make New Folder. A new folder is displayed with the default

name New Folder selected. Type a name for the new folder, and then
click OK.

To set the current archive folder:

1 Point to File ► Archives ►
2 In the submenu click Set Current...
3 In the Browse for Folder dialog that comes up do one of the following:

l Browse to and select an existing folder. Click OK.
l Click Make New Folder. A new folder is displayed with the default

name New Folder selected. Type a name for the new folder, and then
click OK.

9.2.14 Set and Test current storage location
Also within the archives menu is the Continuous data rate feature which you
can use to test the current storage location.

Continuous data rate feature
The Continuous data rate feature is used to test the ability of the available hard
disc drives to manage and record data. It is used for measuring the speed at
which a disc drive can absorb data and to calculate space requirements.

The required data transfer throughput is determined by the addition of all active
sample channels and their respective data rates.

This feature will carry out the following automatically:

l When Perception starts for the first time a characterization of the default
storage location will be done.

l If any parameter change leads to a data transfer load change, the feedback
will be updated accordingly.
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l Optional: If hardware permits there is a continuous “real-time” feedback
when continuous acquisition and storage is active.

To see the storage display window, click window in the file menu and then click
Continuous data rate. The menu puts a check mark by the side of this
command and closes the menu. Continuous data rate pane is now showing
in the side panel.

Figure 9.11: Continuous Data Rate panel

Clicking on Details will bring up the window in Figure 9.12. It shows the amount
of data per recorder per unit time that is being used.

Figure 9.12: Continuous Data Rate Details
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To select a new storage path open the data storage location preferences by
navigating to File ► Archives ► Set and test current storage location. You
should now see Figure 9.13 appear.

Figure 9.13: Storage Location dialog

To see an overview of storage locations available, click the icon  Available
storage locations . This expands a list of locations in your network you can
save data to.

Click Browse…  and navigate to your new path and click OK. After doing this
you may want to measure the performance again, do this by clicking Measure
now. You will now see the following Figure 9.14.

Figure 9.14: Speed test progress indicator
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The Speed Test indicator will appear briefly and then disappear, momentarily
after this the Performance rating will be updated with a new figure and date of
test, see Performance in Figure 9.14 above.

9.2.15 Continuous data rate gauge
To understand the continuous data rate gauge you must use your own rule of
thumb to decide whether or not gaps may appear in your recordings.

Whether or not this might happen will depend on your specific system and your
test setup.

Figure 9.15: Continuous data rate - 80/100 MB/s

For example is the data rate gauge is at 80% maximum then it's highly likely,
unless you are performing very short recordings, that gaps may appear in your
recordings.

Figure 9.16: Continuous data rate - 50/100 MB/s

A warning will appear if the continuous data rate gauge is above 40% for a
specific storage drive.
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Figure 9.17: Storage location warning dialog

This warning is shown because some test setups call for very long continuous
recordings at high data rates, the longer a recording runs for the higher the
internal memory buffer may become.

Figure 9.18: Continuous Data rate - Buffer warning

A Continuous data rate indicator

B Warning lights

If the internal memory buffer reaches it's maximum a warning light will be
triggered and remain on for the remainder of the recording. This warning light
shows that during recording the internal memory buffer exceeded it's maximum
and therefore the recording contains data gaps.

Perception

352 A02689_09_E00_00   HBK: UNRESTRICTED



If more than one channel (n channels) is recording data, the data rate will
increase by n channels times the data rate. Therefore the maximum data rate
will be reached n times faster than recording only 1 channel.

Figure 9.19: Data rate and multiple channels

A Warning: When this light is on, gaps have appeared in the data stream.

l The Y-Axis represents the Continuous data rate indicator in Figure 9.19.
l The X-Axis represents the percentage of the maximum available Data rate.

Figure 9.19 shows that if four channels of data are being recorded the
Continuous data rate will go into the red four times faster at 25% of the
maximum data rate where only 1 channel is recording.

When warning light (A) on the continuous data rate or the buffer is lit, it stays
on, this acts as a warning to inform the user that data gaps exist somewhere in
the recording.

Note Data gaps do not stop the recording process, the recording will continue as
normal when the buffer is below its maximum.
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9.2.16 Load Recording...
Perception provides various options to load a recording. Refer also to "Data
source selection for display" on page 104.

To load a recording:

1 Do one of the following:
l Select File ► Load Recording...
l When available in the toolbar click the Load Recording... button 

2 In the Load Recording dialog select the file you want to load.
3 Select your options in the Load recording and Action section.
4 Click Open.

Figure 9.20: Load Recording dialog

The Load Recording dialog provides the following options:

l Select how the recording is loaded.
l Select where the recording is displayed.
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Load Recording
You can load a recording:

l As active By default the active display on the active sheet is connected to
the actual hardware. The last made recording is on this display by definition.
You can load any other recording as active. This will load the selected
recording into the active display on the active sheet, and therefore becomes
the active recording. When a new recording is made in hardware, this will
again overwrite the currently connected recording in the active display.

l As reference While there can only be one active recording there can be
multiple reference recordings. The list box allows you to give the recording
a meaningful name.

l Using filename This option makes the recording available in the system
with its own name.

Action
Defines what you want to do with the recording:

l Clear the Display data option to add the recording to the list of data sources
without creating a display.

l Add the recording to the currently active display.
l Create a new display:

l In the currently active sheet
l In a new sheet

File Formats
Perception supports various file formats.

To load a specific file format:

1 Do one of the following:
l Select File ► Load Recording...
l When available in the toolbar, click the Load Recording... button 
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2 Load Recording dialog: Files of type drop down list shows all available file
formats.

Figure 9.21: Files of type list (detail)

A Available file formats

For more information about text file formats, please refer to appendices: “ASCII
Recording Loader” on page 885, “CSV Recoding Loader” on page 898 and
“UFF58 File Format” on page 903.

9.2.17 Export Recording...
Perception can save data directly in a variety of popular formats so you can
easily use the recorded data in your preferred analysis programs. Data can only
be exported when (part of) the recording is shown in a waveform display. The
Perception standard software package comprises three export formats (ASCII,
FlexPro and TEAM Data). With the Multiple export option you add over 20
export formats for many popular programs (Excel, CDF AIRBUS, DATS and
more…).

To export data:

To export data proceed as follows:

1 Select a waveform display: click on the title bar of a display to make it the
active display. The title bar will be highlighted.

2 Choose File ► Export Recording... to open the Export Recording dialog.
3 Make the required settings:

l Select the format.
l Select the region of interest that you want to export in the “Part of

recording to export” section.
l Set resampling options.
l Select the channels that you want to export.

4 Click the Settings... button to modify the settings related to the export and
export format.
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5 Click OK to start the export. An estimated time remaining and file size are
displayed.

Figure 9.22: Export dialog

A Export format

B Part of recording to export

C Resample options

D Export statistics

E Channels to export

F Export format related settings

A The Export format list box allows you to select one of the available
formats. Each format has an individual set of settings pertinent to that
format.
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B You can set the region of interest in the Part of recording to export
section. These settings refer to the following options are available.
Depending of the display and the recording not all options may be
enabled.
l Complete recording Since a display can contain data from various

recordings this option defines the area between the first Start of
Recording marker and the last End of Recording marker.

l Between cursors This time interval is limited to the area defined by
the position of the two vertical measurement cursors. When the two
cursors are at their home position, the number of samples to export
will be one (1).

l Zoomed segment With this option the time interval of the export will
be set to the start and stop time of the Zoom view. When no Zoom
view is available, this option is disabled.

l Alternate zoomed segment With this option the time interval of the
export will be set to the start and stop time of the Alternate Zoom view.
When no Alternate Zoom view is available, this option is disabled.

l Active triggered segment When data is available with triggered
segments you can export a specific triggered segment. For this the
active cursor must be positioned within the triggered segment that
you want to export. When no triggered segments are available or
when the active cursor is positioned outside a triggered segment, this
option is disabled.
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Figure 9.23: Examples of Part of recording to export

1 Zoomed segment

2 Alternate zoomed segment

3 Between cursors

4 Complete recording

5 Active triggered segment
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C Resample Most HBM Genesis HighSpeed data acquisition systems
include the ability to sample different channels at different rates. Some
HBM Genesis HighSpeed systems also have a unique feature where
channels can be sampled at a slow rate until a trigger occurs, then sample
at a higher rate while the trigger condition is true. These powerful features
allow you the flexibility to make the best choices for your individual
applications. However most analysis programs require uniformly sampled
data and cannot accommodate different rates in a single file. For this
reason most of the export formats must resample data to a single constant
rate during the export. In these cases, the check box for Resample
waveform is forced on and cannot be unchecked. You may select between
High rate, Low rate and Custom rate.

l High rate All selected channels are exported at the highest rate in
the recording, which is displayed in the dialog for your information.
The fastest channels are unaltered. All slower channels have
additional samples inserted by linear interpolation. This option
preserves all information in the recording but can produce large file
sizes due to the additional samples.

l Low rate All selected channels are exported at the lowest rate in the
recording, which is displayed in the dialog for your information. The
low rate channels are unaltered. All higher rate channels are
decimated to the low rate by discarding samples. This option
produces smaller files that are useful for an overview, but discards
high rate information.

l Custom rate All selected channels are exported at any arbitrary rate
you define, either higher or lower than the original sample rate(s). This
feature is useful for adjusting the sample rate to special rates required
by your post-processing, such as 1024 Hz and other power-of-two
rates for FFT analysis, or 44.1 kHz and 48 kHz for audio WAV files.
Linear interpolation is performed between the nearest original
samples and newly computed samples are placed in the output file.

When multi-rate export is supported for an export format, resample is
turned off by default and the export file will contain all selected channels
at their original sample rate(s) including slow/ fast/slow triggered
segments. If desired, resample can still be selected to force all channels
to an identical single rate for a uniform matrix.

D The Export statistics section provides information on the final file size.
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E Apart from the region of interest to export you can also select which
Channels to export. The following options are available:

l Active channel The channel that is currently selected will be
exported. The name of the selected channel is highlighted in the
waveform display.

l Displayed channels All channels that are currently visible in the
display will be exported.

l All channels All channels within the waveform display, visible or not,
will be exported, i.e. all traces on all pages of the waveform display.
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F Export format related export Settings are available to fine-tune your
export. This option comprises both generic and specific settings. The
dialog may have different settings for different export formats.

Figure 9.24: Specific export settings

A Title of the file

B Storage folder

C Storage folder naming options

D File name

E File name options

F Path and file name example

G Format specific options

H Browse for folder

A You can give a file a descriptive title. This is not the file name.
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C, H, F Each file is exported to a folder. You can enter a name for the folder
or browse for a folder.

Using the storage folder naming options you can modify the path
name to include relevant settings:

l Recording date
l Recording time

The result is displayed in the file name example section.
D-F Define the file name and file name extension.

Using the file name options you can modify the file name to include
relevant settings:

l Sequence number
l Recording name

The result is displayed in the file name example section.
G The options section provides options that are pertinent to the selected

export format.

9.2.18 Print
You can select Display, Settings, Information, Formula (if available) or Report
(if available) for printing.
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Figure 9.25: File menu with Print options

To print:

1 Point to File ► Print ►
2 In the submenu click the required option.
3 In the Print dialog select your preferences:

l Color options for display printing
l Page range options for all others

4 Select the basic print options and click Print. Settings: refer to
Figure 8.11 "Print Settings dialog" on page 313 for more details.

Color options for display printing include:

l Black on white background The complete waveform display is printed in
black and white, with the background set to white. All color preferences as
set in the display properties are ignored.

l Color on white background All display parts (traces, annotation, etc.) are
printed in the colors as defined in the display properties except for the
background. The background is set to white.
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l What You See Is What You Get (WYSIWYG) When selected, the printout
colors are exactly the same as on the screen, including the background.

9.2.19 Preferences...
Various program settings are stored in the Perception Preferences. These
settings include, but are not limited to, start-up options, options for updates,
video information, display settings, etc.

Figure 9.26: Preferences dialog

To open the Preferences dialog:
l Click Preferences... in the File menu.
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User Interface Mode startup options

To startup Perception in a specific User Interface Mode:

1 Click Preferences... in the File menu.
2 Select Start up in the tree view of the Preferences dialog.
3 In the User Interface Mode drop down list box you have the following three

choices:

Figure 9.27: User Interface Mode area (detail)

A Auto The software detects the system it is running on and starts in the
corresponding mode.

B Perception Standard The standard Perception GUI. This is default on
PCs and the GEN5i

C GEN2i Instrument Panel The Instrument Panel GUI which is default for
a GEN2i. For more information refer to Figure 2.4 on page 46.

Perception will start in the defined User Interface mode.

9.2.20 Exit
Select this command to exit Perception.

9.2.21 Definer Mode menu

Introduction to the Definer Mode concept
There are situations in which it is useful that some users are allowed to access
or change everything and other users have restricted access to the Perception
functionality and are allowed to change only some items or even nothing. To
achieve this Perception has a so called Definer Mode. In this mode a Definer
is able to disable operations in a Workbench so that other non-Definer users
are denied access to these operations. For example, the Definer might disable
the File/New menu item so that the non-Definer user is not allowed to create a
new Workbench. In the rest of this section the term Definer will be used to
describe the Perception user who is working in Definer Mode and the term user
will be used to describe the user who is using Perception in the non-Definer
Mode.

Perception

366 A02689_09_E00_00   HBK: UNRESTRICTED



A Definer is in addition to all other Perception operations able to:

l Create and change Workbenches with restrictions.
l Define a restricted set of operations in a Workbench which a user is allowed

to perform.
l Protect the restrictions with a password.

When not in Definer Mode a user who uses a restricted Workbench is able to:

l Open the Workbench and use the unrestricted functionality.

Access to or use of the following items can be made restricted:

l The main menu items
l The main menu sub items
l Toolbars
l Controls
l Sheets

If the restricted Workbench is properly set up a user of this restricted Workbench
has only access to the functionality needed to perform the required tasks.
Therefore a user can concentrate on the accessible functionality only and does
not need to pay attention to all other non-accessible functionality.

This restricted access has several benefits because a user is better guided in
the tasks which must be performed.
Some of these benefits are:

l A user is likely to make fewer errors because not needed functionality is
not accessible.

l Faster measurements are possible because setup of Perception is faster.
l The Perception software is easier to use because the user can concentrate

on only a subset of the Perception functionality.
l Higher safety because a user is guided in his work.
l Higher productivity because a user is guided in his work.
l A user needs less education.
l A user is likely to feel less stress when involved in experiments at which a

lot is at stake.

Note The Definer Mode is available in the Professional and Enterprise Perception
versions 6.60 and higher. When using a Workbench which contains restrictions
these restrictions are applied in all Perception versions 6.60 and higher. They
are ignored in all earlier Perception versions.
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Note Restrictions in a Workbench are not applied when Perception is in Instrument
Panel mode.

How to create a restricted Workbench
To create a Workbench with restrictions first a Workbench must be setup like
normal. After creating this Workbench restrictions can be applied to it.
The following steps describe how to create a restricted Workbench:

1 Start Perception normally.
2 Setup the Workbench layout for the user to work with.
3 Enter the Definer Mode (see paragraph “Enter the Definer Mode” on

page 369).
4 Optionally set up Menu restrictions (see paragraph “Set up Menu

restrictions” on page 372).
5 Optionally set up Control restrictions (see paragraph “Set up Control

restrictions” on page 375).
6 Optionally set the read-only state of sheets (see paragraph “ Set the

Read-Only state of Sheets” on page 377).
7 Optionally set a Restrictions Password (see paragraph “Set a Restrictions

Password” on page 380).
8 Save the Workbench. When saving the Workbench the selected

restrictions are also saved in this Workbench.
9 Exit the Definer Mode (see paragraph “Exit the Definer Mode” on

page 383).

In chapter "Detailed description of Definer Mode functionality" on page 369
these steps are described in detail.

How to change a restricted Workbench
It is possible to change the restrictions in an existing Workbench. The following
steps describe how to change the restrictions in an existing Workbench.

1 Start Perception normally.
2 Load the Workbench containing restrictions (see paragraph ”Load a

Workbench” on page 385).
3 Enter the Definer Mode (see paragraph “Enter the Definer Mode when a

restricted Workbench is loaded” on page 371).
4 Optionally set up Menu restrictions (see paragraph “Set up Menu

restrictions” on page 372).
5 Optionally set up Control restrictions (see paragraph “Set up Control

restrictions” on page 375).
6 Optionally set or remove the read-only state of sheets (see paragraph “Set

the Read-Only state of Sheets” on page 377 and “Remove the Read-Only
state of Sheets” on page 379).
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7 Optionally set, change or clear a Restrictions Password (see paragraph
“Set a Restrictions Password” on page 380, “Change a Restrictions
Password “ on page 381 and “Clear a Restrictions Password” on
page 382).

8 Save the Workbench. When saving the Workbench the selected
restrictions are also saved in this Workbench.

9 Exit the Definer Mode (see paragraph “Exit the Definer Mode” on
page 383).

In chapter "Detailed description of Definer Mode functionality" on page 369
these steps are described in detail.

Detailed description of Definer Mode functionality
This chapter contains a detailed description of the functionality which is
available when the Definer Mode is entered.

A Enter the Definer Mode
B Enter the Definer Mode when a restricted Workbench is loaded
C Set up Menu restrictions
D Set up Control restriction
E Set the Read-Only state of Sheets
F Remove the Read-Only state of Sheets
G Set a Restrictions Password
H Change a Restrictions Password
I Clear a Restrictions Password
J Exit the Definer Mode
K Load a Workbench

A Enter the Definer Mode

To enter the Definer Mode perform the following step:
 1 In the File menu, click the Definer Mode item.
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  Now the Definer Mode is entered.

Figure 9.28: File menu
  A check indicates that the Definer Mode is entered.

Figure 9.29: Definer Mode menu item
  A new main menu item is added to the menu bar called Definer.

Figure 9.30: Definer Mode main menu item
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  The Definer menu contains the following items:

Figure 9.31: Definer Mode menu

B Enter the Definer Mode when a restricted Workbench is loaded

To enter the Definer Mode when a restricted Workbench is loaded perform
the following step:

 1 In the File menu, click the Definer Mode item.
  If the loaded Workbench is protected with a restrictions password the

following dialog is shown:

Figure 9.32: Enter Restrictions Password dialog
 2 Enter the restrictions password.
  Now the Definer Mode is entered.

Note On what to do when the user does not know the password refer to paragraph
"What to do if the Restrictions Password is not known" on page 389.
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C Set up Menu restrictions

To set up Menu restrictions perform the following steps:
 1 In the Definer menu, click the Set Up Menu Restrictions item.

Figure 9.33: Definer Mode menu item - Set Up Menu Restrictions
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 2 The Set Up Menu Restrictions dialog is shown.

Figure 9.34: Set Up Menu Restrictions dialog
  In this window on the left side all Menu items, including the menus of

all sheets (not just the active one) are listed.

On the right side of this window the Items of the selected Menu are
shown as a tree structure. In this tree structure it is possible to check
an item. The checked items are then restricted. If a tree item has sub
items beneath it and is (un)checked, all sub-items are also
(un)checked.

 3 Select the items which must be restricted.
 4 To apply the selected restrictions select the Apply or OK button.
  Select the Cancel button to cancel all changes made since the last time

the Apply button was selected.
Select the Remove all menu restrictions button to undo all selections.
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  When an item is restricted by selecting Apply or OK the restricted items
are immediately visually indicated by setting a grey background for the
restricted item.

In Figure 9.35 restrictions are applied to some of the sub items in main
menu item Control. The restricted items are marked by a grey back-
ground in the menu sub items and in the corresponding toolbars.

Figure 9.35: Visualization of restricting some items of a menu in Definer Mode
  In Figure 9.36 restrictions are applied to all the sub items in main menu

item Control. The restricted items are marked by a grey background in
the menu sub items and in the corresponding toolbars.
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Figure 9.36: Visualization of restricting all items of a menu in Definer Mode

D Set up Control restrictions

To set up Control restrictions perform the following step:
 1 In the Definer menu, click the Set Up Control Restrictions item.

Figure 9.37: Definer Mode menu item - Set Up Control Restrictions
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 2 The Set Up Control Restrictions dialog is shown:

Figure 9.38: Set Up Control Restrictions dialog
  In this window on the left side a list of all Controls is shown.
  On the right side of this window the Items of the selected Control are

shown as a tree structure. In this tree structure it is possible to check
an item. The checked items are then restricted. If a tree item has sub
items beneath it and is (un)checked, all sub-items are also
(un)checked.

 3 Select the items which must be restricted.
 4 To apply the selected restrictions select the Apply or OK button.
  Select the Cancel button to cancel all changes made since the last

time the Apply button was selected.
Select the Remove all control restrictions button to undo all selec-
tions.

  When an item is restricted by selecting Apply or OK the restricted
items are not visually indicated.
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E Set the Read-Only state of Sheets

It is possible to put a sheet in a read-only state. If a sheet is in a read-only
state certain functionality on this sheet is not accessible anymore. Which
functionality is disabled cannot be defined by the Definer but is predefined
by Perception and is sheet specific. In principle when a sheet is in Read-
Only mode then only the functionality that allows users (both normal and
Definer) to visualize the data is enabled. When the screen is not in Read-
Only mode then this restriction is removed.

A sheet can be put in read-only state in two ways.
 1 Setting the read-only state by using the main menu of the sheet.

Open the menu of the sheet in the main menu and select menu item
Read only.

Figure 9.39: Active sheet menu
 2 Setting the read-only state by using the tab of the sheet.

Right click on the tab of the sheet and select Read only.
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Figure 9.40: Active sheet menu item Read only
  If a sheet is in Read-only state this is indicated in the above menus by

a check before the menu item.

Figure 9.41: Active sheet menu item Read only selected
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F Remove the Read-Only state of Sheets

The read-only state of a sheet can be removed in two ways.
 1 Removing the read-only state by using the main menu of the sheet.

Open the menu of the sheet in the main menu and select menu item
Read only.

Figure 9.42: Active sheet menu
 2 Removing the read-only state by using the tab of the sheet.

Right click on the tab of the sheet and select Read only.
  

Figure 9.43: Active sheet menu item Read only
  The check before menu item Read only in the above menus is re-

moved.
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G Set a Restrictions Password

It is possible to protect the restrictions in a Workbench from changing by
setting a Restrictions Password.

A Restrictions Password has the following properties:

l It must contain at least six characters.
l It is case sensitive.
l It can contain any character.

To set a Restrictions Password perform the following steps:
 1 In the Definer menu, click the Set Restrictions Password item.

Figure 9.44: Definer menu item - Set Restrictions Password
 2 The Set Restrictions Password dialog is shown:

Figure 9.45: Set Restrictions Password dialog
 3 In the New password textbox enter a password.
 4 In the Confirm password textbox enter the same password.
 5 Select the OK button to set the password.
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  When a restrictions password is set the menu items Change Restric-
tions Password and Clear Restrictions Password are selectable and
Set Restrictions Password cannot be selected. It is possible to
change (see paragraph “Change a Restrictions Password” on
page 381) or to remove (see paragraph “Clear a Restrictions Password”
on page 382) the entered password.

  

Figure 9.46: Definer menu

H Change a Restrictions Password

To change a Restrictions Password perform the following steps:
 1 In the Definer menu, click the Change Restrictions Password item.

Figure 9.47: Definer menu item - Change Set Restrictions Password
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 2 The Change Restrictions Password dialog is shown:

Figure 9.48: Change Restrictions Password dialog
 3 In the Old password textbox enter the previously set password.
 4 In the New password textbox enter a new password.
 5 In the Confirm password textbox again enter the new password.
 6 Select the OK button to set the new password.

I Clear a Restrictions Password

To remove a Restrictions Password perform the following steps:
 1 In the Definer menu, click the Clear Restrictions Password item.

Figure 9.49: Definer menu item - Clear Restrictions Password
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 2 The Clear Restrictions Password dialog is shown:

Figure 9.50: Clear Restrictions Password dialog
 3 In the Old password textbox enter the previously set password.
 4 Select the Clear button to remove the password.

J Exit the Definer Mode

To exit the Definer Mode perform the following step:
 1 In the File menu, click the Definer Mode item.
  Now the Definer Mode is exited.

The check before the Definer Mode item is removed.
Main menu item Definer is removed.
The restrictions are now applied. The restricted items which were vis-
ually indicated are now hidden.

  Figure 9.35 on page 374 in paragraph “Set up Menu restrictions” on
page 372 shows how menu items and corresponding toolbars of Con-
trol are shown in Definer Mode when some items are restricted.
Figure 9.51 shows the result after the Definer Mode is exited.

Figure 9.51: Effect of restricting some items of a menu after exiting Definer
Mode

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 383



  Figure 9.36 on page 375 in paragraph “Set up Menu restrictions” on
page 372 shows how menu items and corresponding toolbars of Con-
trol are shown in Definer Mode when all items are restricted.
Figure 9.52 shows the result after the Definer Mode is exited.

Figure 9.52: Effect of restricting all items of a menu after exiting Definer
Mode
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K Load a Workbench
 Load a workbench containing restrictions. The workbench is now loaded

as it was setup by the Definer with the restrictions applied. If a Workbench
contains restrictions an icon is shown in the right corner of the status bar.
See Figure 9.53.

Figure 9.53: Icon which indicates that the Workbench contains restrictions

Some details of the effect of restrictions on toolbars and docking panes
In this paragraph some effects of restrictions on toolbars and docking panes
are explained.

A Linked Toolbar buttons
B Linked Toolbars Close buttons
C Linked Docking Pane Close buttons
D Linked Control elements

A Linked Toolbar buttons

In Perception the buttons on the toolbars have corresponding menu items.
So by restricting a menu item the corresponding toolbar buttons also gets
restricted.
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 In Figure 9.54 an example of links between menu items and corresponding
toolbar buttons is shown.

Figure 9.54: Visualization of restricting menu items and corresponding
toolbar buttons in Definer Mode

B Linked Toolbars Close buttons

If the menu item which is used to show or hide a toolbar is restricted the
Close button on the toolbar is removed (when exiting the Definer Mode).
The reason for this is if the toolbar is closed it cannot be made visible again
because the menu item which takes care of this is not accessible anymore
by a user.
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 In Figure 9.55 an example is given.

Figure 9.55: Effect of restricting a toolbar on the toolbar Close button
 a Close icon
 b File menu entry

C Linked Docking Pane Close buttons

If the menu item to show/hide a Docking Pane (e.g. Acquisition Control,
Hardware, and Data Sources) is restricted the Close button on the docking
pane is removed (when exiting the Definer Mode). This is done because if
the docking pane is closed it cannot be shown anymore because the menu
item which takes care of this is not accessible anymore by a user.
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 In Figure 9.56 an example is given.

Figure 9.56: Effect of restricting a docking pane on the docking pane Close
button

 a Close icon

D Linked Control elements

In Perception the items on Controls can have corresponding menu items.
So by restricting a menu item the corresponding item on the Control also
gets restricted.
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 In Figure 9.57 an example of links between menu items, corresponding
toolbar buttons and corresponding items on a Control is shown.

Figure 9.57: Effect of restricting menu items on the corresponding toolbar
buttons and items on a Control
 a Effect of restricting menu items on the corresponding toolbar buttons
 b Acquisition control while in Definer Mode
 c Acquisition control after leaving Definer Mode. The restricted items are

now hidden.

What to do if the Restrictions Password is not known
If the restrictions password is not known (e.g. the password is forgotten or the
creator of the restricted Workbench is not available) contact HBM technical
service.
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Definer Mode use case examples
A Disable access to a sheet
B Set a sheet into the Read-only mode

A Disable access to a sheet

Access to a sheet can be completely disabled. As an example the
Information sheet will be disabled. This can be accomplished as follows:

 1 Open an existing Workbench or create a new one.
 2 Select menu Sheets.
 3 De-select menu item Information.
 4 Enter Definer mode.
 5 In Definer menu select Set Up Menu Restrictions.
 6 In Menu selection list select Sheets
 7 In Items selection tree select Information.
 8 Select the OK button to apply the restrictions and leave the Set Up

Menu Restrictions dialog.
 9 In Definer menu select Set Restrictions Password to protect the

restrictions with a password.
 10 Save the Workbench.
 11 Exit Definer mode.
 When this Workbench is now loaded the Information sheet is not shown

and cannot be loaded.

B Set a sheet into the Read-only mode

There are cases where a user should not be able to make changes to a
sheet but must still be able to read information on this sheet. For example
a user must be able to view the traces on the Active sheet but should not
be able to add Data Sources to the Active sheet. This can be accomplished
as follows:

 1 Open an existing Workbench or create a new one.
 2 Select menu Active.
 3 De-select menu item Read only.
 4 Enter Definer Mode.
 5 In Definer menu select Set Up Menu Restrictions.
 6 In Menu selection list select Active
 7 In Items selection tree select Read only.
 8 Select the OK button to apply the restrictions and leave the Set Up

Menu Restrictions dialog.
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 9 In Definer menu select Set Restrictions Password to protect the
restrictions with a password.

 10 Save the Workbench.
 11 Exit Definer Mode.
 When this Workbench is now loaded the Active sheet is still visible but

cannot be changed. Data sources cannot be added to the sheet. Also
several menu items in the context menu of the sheet are disabled.
Figure 9.58 (left side) shows the context menu when the sheet is not in the
read only mode and Figure 9.58 (right side) shows the context menu when
the sheet is in the read only mode.

Note If the Read only menu item of a sheet is not made restricted it can still be useful
to set a sheet in read only mode. In this way it can be avoided to make unwanted
changes to the sheet by accident while working with Perception. It is however
at any time possible to remove the read only mode of the sheet.

 

Figure 9.58: Context menu of the Active sheet if NOT in read only state
(left); context menu of the Active sheet if in read only state (right)
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9.3 Edit menu
The Edit menu gives direct access to the various editing commands. You can
use these commands to transfer objects or data, depending on the selected
item / object.

Figure 9.59: Edit menu

Sometimes editing functions may not be available through the standard Edit
menu, but through the context sensitive menu.

9.3.1 Transfer an object
The command method for transferring objects uses the Cut, Copy and Paste
commands.

To transfer an object:

1 Make a selection.
2 In the Edit menu choose either Cut or Copy:

l The Cut command removes the selection and transfers it (or a
reference to it) to the clipboard.

l The Copy command duplicates the selection (or a reference to it) and
transfers it to the clipboard.

3 Navigate to the destination (and set the insertion location, if appropriate).
4 Choose Paste.

The Paste command completes the transfer operation.

9.3.2 Delete an object
The Delete command removes a selection without transferring it to the
clipboard for later use.
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9.4 Control menu
The Control menu provides access to the basic acquisition controls as well as
a timer for Conditional Start Stop, starting and stopping of Voicemark recording,
Zero Balance and the possibility to reboot systems. The acquisition controls
perform the same function as the controls within the Perception Acquisition
Control panel. These commands can also be accessed through the acquisition
control icons in the toolbar.

Figure 9.60: Control menu

9.4.1 Basic acquisition control
Four commands are provided for basic acquisition control. For more information
also refer to "Acquisition control" on page 114.

Start
The Start command starts continuous acquisition of data. In this mode the
recorder(s) acquire(s) data until a stop command is issued.

Stop
To stop an acquisition, select this button. This stops the current recording.
When in a sweep acquisition mode, the current sweep will be aborted
immediately.

Single Shot
To start a single sweep acquisition select this command. In this mode the
recorder acquires data until a valid trigger condition is met and the posttrigger
data has been recorded or when a stop command has been received. Sweep
length and pre-/ posttrigger values can be set in the Acquisition Control or
Settings sheet.

Pause
This command serves two purposes:
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l When no acquisition is active it will place the recorder in the pause or
stand-by mode. Although the recorder is digitizing, no data is stored in
memory or disk. This is useful for monitoring purposes.

l When a continuous acquisition is active, it will place the recorder in a hold
mode: although the recorder is digitizing, no data is stored in memory or
disk. At this point when Start is selected, the current recording continues;
when Stop is selected, the recording is finished.

9.4.2 Manual Trigger
The Trigger command is used to send a manual trigger command to the
recorder(s) under control.

9.4.3 Voicemark
The Voicemark command is used to add Voicemarks to a recording while the
Voicemark is being recorded to PC storage. You can then play back the
Voicemark from the display.

While a Voicemark is being recorded, the Voicemark button (A)  is highlighted
and the status bar displays feedback (B).

Figure 9.61: Highlighted Voicemark/Feeback status bar

Note The Voicemark button/Feeback in the status bar is enabled only while
Voicemarks are being recorded to PC storage.
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How to use the Perception Voicemark feature
The Perception Voicemark feature allows you to record audio notes while a
recording is in process. The audio recording is saved with the PNRF file and is
accessible through an icon displayed at the top of the display.

Note The only equipment required is a microphone or other recording device that is
compatible with the Perception PC. Connect the microphone to the PC and then
configure it.

1 To access the Recording devices setup page in Windows®, right-click on
the speaker icon in the Windows® task bar. It is typically in the lower right
hand corner:

 

Figure 9.62: Windows® speaker icon

A Speaker icon
  
2 Right-click to open the context menu (see Figure 9.63).
 

Figure 9.63: Windows® speaker context menu
  
3 Select Recording devices to open the Windows® Sound dialog. Select

the device you plan to use.
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Figure 9.64: Windows® Sound dialog
  
 Click on the Properties button to configure the device. Click OK to close

all dialogs. Your recording device is now ready to be used.
  

Note Recording a Voicemark is only possible when a recording is in process.

4 The microphone icon is part of the Perception Controls Toolbar (see
Figure 9.65)

 

Figure 9.65: Voicemark control (microphone not activated)
  
 If you don’t see those icons in your toolbar, go to the menu Window ►

Toolbar and make sure 3- Controls is selected. The microphone icon will
be grey until a recording is started.
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5 Start a recording and the microphone icon changes to black to show it is

active (see Figure 9.66)
 

Figure 9.66: Voicemark control (microphone activated)
  
 Click on the Voicemark icon to start recording a voicemark. You can also

select Voicemark from the Controls menu or use the F9  keyboard
shortcut. The icon becomes reverse highlighted to show it is in use (see
Figure 9.67.

 

Figure 9.67: Voicemark control (microphone in use)
  
 In addition, Recording voicemark is displayed at the bottom of the

Perception screen (see
Figure 9.68 "Recording voicemark status" on page 397)

Figure 9.68: Recording voicemark status
  
 Speak into the microphone. When you are done, click the microphone icon

again to stop the voicemark recording.
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6 When you view the recorded PNRF file, you will see a voicemark icon at

the top of the display. If you hold your mouse over the icon, Perception
indicates the time at which the voicemark recording started.

 

Figure 9.69: PNRF file with additional Voicemark information

A Voicemark recording starting time
  
7 If you right click on the Voicemark icon, an option to play the recording is

displayed.
 

Figure 9.70: Voicemark play option
 The voicemark will also be played back when the recording is replayed.

9.4.4 Zero Balancing
Zero balancing is a method to set a channel’s most currently measured value
as the new zero value. For GHS systems, there are two possibilities to
accomplish this: Balancing and Zeroing.
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l Balancing is performed on bridges to avoid overloading the input amplifier
at high gains. This is accomplished by inserting a physical current into the
bridge to balance the bridge. The net effect is a zero output when the bridge
is in balance.

l Zeroing is performed on all other sensors. Here a possible offset is
measured. This measured value is then used to determine the zero level
when scaling the ADC data.

For bridge channels, a balance is performed first. If the bridge channels are not
balanced enough, they can be zeroed afterwards. For more information please
refer to Figure 9.71.

Figure 9.71: Zero/balance process flow

Zero Balance:
The Zero Balance commands performs zero balancing on all channels which
have the “Zero Balance enabled” setting set to “On”. For more information,
please refer to "Zero Balance and Calibration" on page 678.
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Undo Zero Balance:
Select this command to undo the previously performed zero balance.

9.4.5 Timer for Conditional Start Stop
When the timer for Conditional Start Stop... is selected the dialog for settings
of start, stop and automatic restart are displayed. You can combine the various
settings.

Figure 9.72: Timer for Conditional Start Stop

A Enable timer

B Conditional start settings

C Conditional stop settings

D Automatic restart settings

The Timer for Conditional Start Stop allows you to create an unattended
recording sequence. You can define start and stop moments as well as
automatic restart options.

To enable the timer:

l Select the Enable check box on top of the dialog. Now you have access to
the various options.
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To use conditional start:

1 Select the Use conditional start check box. Now you have access to the
various options.

2 Do one of the following:
l Specify a date when you want to start on a specific date. The acquisition

will start on the specified date at the time as specified at Every day
at.

l When you want to start every day on a specific time select the Every
day at option and set the time. When Specified date is also selected,
the acquisition will only start once.

To use conditional stop:

1 Select Use conditional stop. Now you have access to the various options.
2 Do one of the following:

l If you want to stop after a specified amount of time after the start of an
acquisition, select the Stop option and enter the required value.

l Specify a date when you want to stop on a specific date. The acquisition
will stop on the specified date at the time as specified at Every day
at.

l When you want to stop every day on a specific time select the Every
day at option and set the time. When Specified date is also selected,
the acquisition will only stop once.

To use automatic restart:

1 Select Use automatic restart. Now you have access to the various
options.

2 Do one of the following:
l Select unlimited. The acquisition will restart always until you unselect

the Enable option.
l Select Number of restarts when you want a specific number of

acquisitions.
l Use the Start ... after options to set the time interval between the

restarts.

9.4.6 Reboot System(s)
With Reboot System(s), you can reboot mainframe(s)/system(s) remotely, if
necessary. Only system(s) which are online and not in use can be rebooted.

Note This will set the system to its factory default settings, so make sure you have
saved the settings before rebooting.
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To reboot a mainframe/system: 

1 In the menu bar choose Control ► Reboot system(s)...

Figure 9.73: Reboot System(s)

A Reboot system(s)

2 The Reboot System(s) dialog opens.

Figure 9.74: Reboot System(s) dialog

A Online mainframe(s)/system(s)

B Reboot

C List of mainframe(s)/system(s)

D Refresh
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A Online mainframes: The list of mainframe(s)/system(s) that have been
found.
l Enabled check box: The mainframe(s)/system(s) are not in use and

can be rebooted. Check the item to reboot the mainframe/system.
l Disabled check box: The mainframe(s)/system(s) are in use and

cannot be rebooted.
B Reboot: Click Reboot to reboot the mainframe(s)/system(s).

Figure 9.75: Rebooting

The Rebooting window (Figure 9.75) closes automatically when all
mainframes have been rebooted. Or click Close to close this dialog.

C List of mainframes: The list of mainframe(s)/system(s) that have been
found.

D Click Refresh to refresh the list of the mainframes(s)/system(s).
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9.5 Automation menu
When you need the results from your tests without delay, the automation feature
lets you analyze or export triggered segments of data while or immediately after
recording. Now you can extract information from your test data quickly and
share the results instantly. This feature also allows for unattended processing
of data when long recordings are made. Or use batch processing to easily
access and load test data for post analysis and reporting.

In this menu you also find the Merge Files feature that allows you to combine
multiple files into one recording. In addition you can quickly generate a
customized basic report into Word. The Report to Word feature is available as
a separate option and allows you to create fully customizable, template-based
reports.

Figure 9.76: Automation menu

9.5.1 Logfile
You can create a logfile that allows you to store the contents of variables.
Storage can be done automatically in one of the automation options, but you
can also add entries in the logfile manually.

You can display the logfile in Excel.

Note The logfile is created as an XML stream. To read it you must have access to
an application that can read XML streams, for example Internet Explorer. When
you want to open the logfile in Excel you must have Microsoft® Excel 2003 or
higher installed.
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Figure 9.77: Logfile examples: XML and Excel

Manual logging
You can manually add entries to the logfile when this option is enabled.

To enable/disable manual logging:

l In the Automation menu click [Enable/Disable] Manual Logging.
l When available in the toolbar click the [Enable/Disable] Manual

Logging button 

Configure Logfile
The contents of the logfile needs to be defined. Apart from the menu entry you
have also access to the logfile definition from within the various automation
setup dialogs.

To configure the logfile:
1 Make sure Manual Logging is enabled, and do one of the following:

l In the Automation menu click Configure Logfile...
l When available in the toolbar click the Configure Logfile... icon 

2 In the dialog that comes up make your settings.
3 Click OK when done.
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Figure 9.78: Logfile Configuration dialog

A List of available data sources

B Additional options

C Location and name of the logfile

D Browse for folder/file

E List of selected data sources

F Move data source entry up/down in list

G Add/remove data source from list

To set up the logfile configuration proceed as follows:

To add a data source:
To add a data source you must select a data source and add this source to the
list of selected data sources as follows:

1 In the list of Available Data Sources select one or more data sources.
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2 Do one of the following:
l With the sources selected drag them into the list of Selected Data

Sources.
l  Click the Add Data Source button. This will add the selected

source. The source will be appended to the end of the source list.

To delete a data source:
1 Click the source in the Selected Data Sources list you want to delete.
2  Click the Delete source button.

To move a data source:
1 Click the source in the Selected Data Sources list you want to move.
2 To move the selected source do one of the following:

l  Click the Move source up button to move the selected source one
position up.

l  Click the Move source down button to move the selected source
one position down.

To set the name of the logfile:

To set the name and storage folder for the logfile do one of the following:
l Type/modify the complete storage path and filename in the filename entry

field.
l Click Browse. In the Save As dialog that comes up:

1 Select the file you want to save into/replace or type a name for a new
file.

2 Click Save.

Add to Logfile
To append a new entry manually in the logfile click Add to Logfile in the
Automation menu or the corresponding button  on the toolbar when available.

Clear Logfile
To completely empty the logfile click Clear Logfile in the Automation
menu or the corresponding button  on the toolbar when available.

Open Logfile in Excel
You can view the contents of the logfile in Excel. This requires Microsoft® Excel
2003 or higher.

To open the Logfile in Excel:
l Click Open Logfile in Excel in the Automation menu.
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l When available in the toolbar click the Open Logfile in Excel button 

Options
For the Logfile two options are provided that expand the usability of the feature:

l Enable logfile record replacement
l Open and refresh in Excel

The Enable logfile record replacement option allows you to replace an
existing record in the current logfile. The selection of the record is based on a
Unique Record ID (URID) . Currently the (URID) is the same as the recording
ID.

If you select this option, you can make a recording with the same name (and
therefore the same (URID) ) and automatically replace the logfile entry.

Typical applications:

1 You make recordings with automatic logging. Recording one goes well, two
goes well and the third goes wrong because a cable is broken. If you now
“reset” the recording name and the option was “on”, you can make the third
recording again and the third record will be replaced with a new record.

2 After ten recordings you notice an incorrect calculation in recording 5.
Reload this recording, make the modification and issue a manual replace
command. The fifth record will be replaced.

The Enable logfile record replacement has a warning icon in front to alert you
of a condition that might cause problems in the future: possible loss of data.

The Open and refresh in Excel option makes it possible to monitor all actions
while they take place (for example on a secondary monitor).

When this option is selected Excel will be launched the first time a new entry is
created. Once open, each new entry will automatically refresh the Excel sheet
and therefore become visible immediately.

Note This only works when Excel is started from within Perception . When launched
separately the auto refresh will not work and you will need to do a manual
refresh in Excel.
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9.5.2 Process Display
Use the Process Display command to manually start a pre-configured
automation process after a recording has been made

This command is identical to the Process command in the Setup Process
Display dialog box. When you use Process Display the settings from the Setup
Process Display dialog box are used.

9.5.3 Setup Process Display
The Setup Process Display option allows you to transfer data from a waveform
display to a file in a specific file format and / or transfer data to another program
on request.

Depending on the primary choice you make and the display settings, one or
more options within the dialog may not be available. For example when the
measurement cursors are not set, you will not have the option to process the
data between cursors.

To process display data:

To process data that is currently available in a display, proceed as follows:

1 Make the display that you want to use the active display.
2 Select Automation ► Setup Process Display...
3 In the Setup Process Display dialog that comes up make your selections.
4 Click Process to start processing. A progress dialog comes up.
5 Click Close in the progress dialog when done.
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Figure 9.79: Setup Process Display dialog

A Time interval

B Sources for processing

C Actions list

Note The various options are similar to export settings. Therefore you may also want
to have a look at "File menu" on page 332 and Figure 9.23 on page 359.

Interval selection
The Interval selection section allows you to specify in detail what part of the
data you want to process. Depending on your data source selection and / or
display settings one or more of the following options may be available:

l Complete recording Since a display can contain data from various
recordings, this option defines that the area used is between the first Start
of Recording marker and the last End of Recording marker.

l Between cursors  This time interval is limited to the area defined by the
position of the two vertical measurement cursors. When the two cursors
are at their home position, this option is disabled.

l Active triggered segment When data is available with triggered segments
you can export a specific triggered segment. For this the active cursor must
be positioned within the triggered segment that you want to export. When
no triggered segments are available, or when the active cursor is positioned
outside a triggered segment, or when the active display is set to Review-
Sweep mode, this option is disabled.

l Zoomed segment With this option the time interval of the export will be set
to the start and stop time of the Zoom view. When no Zoom view is
available, this option is disabled.
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l Alternate zoomed segment  With this option the time interval of the export
will be set to the start and stop time of the Alternate Zoom view. When no
Alternate Zoom view is available, this option is disabled.

l Triggered Segments A specific number of segments will decrease the
overall file size as well as time required to process the data. When you
select to transfer Triggered segments you can select one of the following
options:
l Process all triggered segments.
l Use a selected number of triggered segments, starting from the

beginning Skip triggered segments.

Data source
Within the Data source section the currently active waveform display is used
as data source.

At this point you will have the option to select:

l Current Trace Only data from the currently selected active trace is used.
l Current Pane Only data from the currently selected active pane is used.
l Current Page Only data from the currently selected active (and therefore

visible) page is used.
l All Traces in Display All data from all traces on all pages of the waveform

display are processed.

Automation actions
Here you define what you want to do with the selected data.

A Automation actions
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Generally, you can create a list of actions that are performed sequentially. You
can select actions from the Select action and add to action list box and add
them to the Action list. The available actions are:

l Save Perception report Save the data as an Enhanced Metafile
or .pReport file.

l Post to Send the data to the FlexPro application.
l Report to Word Create a Word report using the data and a predefined

template document.
l Quick report to Word Create a Word report with minimal configuration.
l Export to Save the data to a file after formatting them to one of the available

export format specifications.
l Add to logfile Save the data to a logfile as XML.
l Run external program Launch an external application after collecting the

data.
l Save a copy as Store a copy of the current active experiment.
l Print Perception report Send the data to the default printer.

Each action can be configured separately: select it in the Action list, and click
Configure… In the dialog that shows up enter your options.

In addition, if you have more than one action in the list, you can configure their
order of execution.

To move an Automation action:
1 Select the action you want to move in the Action list.
2 To move the selected action do one of the following:

l  Click the Move action up button to move the selected action one
position up.

l  Click the Move action down button to move the selected action one
position down.

To delete an Automation action:
1 Select the action you want to delete in the Action list.
2  Click the button Delete action from list.

Finally, to execute the configured list of actions, click Process.

9.5.4 Recordings Batch Processing
Recordings Batch processing allows you to perform actions on a list of files.
The actions defined in this dialog will be applied to all the selected files, with
the same time interval and data source configuration.
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To process data files:
1 Select Automation ► Recordings Batch Processing...
2 In the Recordings Batch Processing dialog that comes up make your

selections.
3 Click Process to start processing. A progress dialog comes up.
4 Click the Close button in the progress dialog when done.

Figure 9.80: Recordings Batch Processing dialog

A Time interval

B List of files for processing

C Data source

D Actions list

Note The various options are similar to the Setup Process Display dialog. Refer to
section "Setup Process Display" on page 409 for further information.

Interval selection
The Interval selection section allows you to specify what part of the data you
want to process.

l Complete recording Process the complete recording contained in the
selected file(s).
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l Triggered Segments A specific number of segments will decrease the
overall file size as well as time required to process the data. When you
select to process Triggered segments you can choose one of the following
options:
l Process all triggered segments
l Use a selected number of triggered segments, starting from the

beginning
l Skip triggered segments

Recordings
Here you create a list of files to process.

To make a list of files to process:
l Click Add Files.
l In the Add Recording Files dialog select the file(s) and click Open when

done.
l To remove a file from the list select a file and click Remove.

Data source
In this section you have the option to select the source of your data for
processing. You can either select to:

l Only process the data that resides in the recorders, or
l Process the recorder data as well as the on-line computed data.

Automation Actions
Here you define what you want to do with the selected files. The way of defining
a list of actions to perform is the same as in the Setup Process Display dialog.
Refer to the respective section "Setup Process Display" on page 409 for more
information.

9.5.5 Automated Recording Processing
As opposed to the user-initiated Display and Recordings Batch processing, the
Automated Recording Processing is driven by the actual acquisition. A post
processing task is started automatically at the end of an acquisition or - when
triggered segments are used - even while recording.

Combined with the Timer for Conditional Start Stop this allows for powerful
automated - unattended - testing.

To start automated processing:
1 Select Automation ► Automated Recording Processing...
2 In the Recording Automated Processing dialog that comes up select

Enable automation first to enable the rest of the options.

Perception

414 A02689_09_E00_00   HBK: UNRESTRICTED



3 Make your selections in the dialog.
4 Click Close.

Note The progress dialog will not come up until an acquisition is started.

Figure 9.81: Recording Automated Processing dialog

A Time interval

B Data source

C Enable automation

D Actions list

Interval selection
The Interval selection section allows you to specify what part of the data you
want to process and when.

l Complete recording Use the complete recording to process. This can only
be done once the recording has finished.

l Triggered Segments A specific number of segments will decrease the
overall size as well as time required to process the data. When you select
to process Triggered segments you have the option to:
l Process data while recording or wait until recording has finished.
l Process all triggered segments.
l Use a selected number of triggered segments, starting from the

beginning.
l Skip triggered segments.
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With the Triggered Segments selection, you can choose to perform the data
processing While Recording orAfter Recording from the list box. When you
select After Recording, the processing will start after the recording has
finished. When you select While Recording, each triggered segment will be
processed as soon as it becomes available.

Data source
In this section you have the option to select the source of your data for
processing. You can either select to:

l Only process the data that resides in the recorders, or
l Process the recorder data as well as the on-line computed data.

Automation Actions
Here you define what you want to do with the selected files. The way of defining
a list of actions to perform is the same as in the Setup Process Display dialog.
Refer to the respective section "Setup Process Display" on page 409 for more
information.

9.5.6 Actions configuration dialogs
In the Automation Actions section of the Processing dialogs, each action has a
Configure button. When you click this button you gain access to additional
settings with respect to the processing in general and the application in
particular. This section explains the general configuration options of the
currently supported actions.

Export
Because this a standard export function refer to "Export Recording..." on
page 356 for more details.
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Figure 9.82: Example of export settings: ASCII

A File title

B Storage folder

C Storage folder naming options

D Filename

E Filename options

F Path and filename example preview

G Name format-specific options

H Browse for folder

The example given here is from ASCII export.

A You can give a file a descriptive title. This is not the filename.
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B, C, H, F Each file is exported to a folder. You can enter a name for the folder
or browse for a folder.

Using the storage folder naming options you can modify the path
name to include relevant settings:

l Recording date
l Recording time

Select if you want to overwrite the existing file.

The result is displayed in the Filename example section.
 
D, E, F Define the filename and filename extension.

Using the filename options you can modify the filename to include
relevant settings:

l Sequence number
l Recording name
l Title

The result is displayed in the Filename example section.
 
G The Option section provides options that are pertinent to the ASCII

export format:

l Time format and control characters
l Optional information to include besides the waveform data

Post to
For a more tightly coupled communication, Perception supports the Post to
FlexPro action. Posting to an application allows you to send data to an
application directly: there is no need to start FlexPro and import or load an
external file. The application is started automatically and data is instantly
available.
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Figure 9.83: Example of Post to FlexPro configuration

A Print Options

B Time base

C Location

Print Options
The configuration dialog above allows to Print a report, either for each trigger
or for the whole recording. This is not the report from Perception , but a report
generated by FlexPro after the analysis.

Time base
Select Absolute time to send the data to FlexPro with their timestamps as
recorded.

Select Resample data to use a specific sampling rate. You can either use the
recording’s high sampling rate or a custom rate. This way the data can be
reduced.

Location
Since FlexPro uses a database folder you need to specify this in the Location
section. The used filename can be extended with a prefix and a number
generated by the auto number option.

Add to logfile
The logfile feature is described in full detail in "Configure Logfile" on
page 405 section.
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Print Perception report
This action configuration dialog allows you to print a Perception report. It shows
the default Print dialog where you may select a printer to send the report to,
the page range to be printed, and choose additional print settings.

Save Perception report
When the Save Perception report action is selected to be configured, the Build
Storage Path and Filename dialog shows up. It allows you to define the way
Perception reports are saved.

Figure 9.84: Build Storage Path and File Name dialog

A Folder settings

B File settings

C Full path example

D File name extension

E File name

A Folder To select the destination of the report, type a folder name in the
Folder box or click Browse to select an existing one.

The folder name can also contain the recording date and/or recording
time, by selecting the respective check boxes.
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B File

The options below allow for building up a more complex filename, which
can include:

l Recording name The recording name, as set in the Acquisition
Control palette.

l Recording date
l Recording time
l Autonumber A number that increases automatically by 1 for every

new file, starting at the specified number and consisting of the
specified total number of digits.

l Trigger The number of the triggered segment that contains the data
to be saved.

l Overwrite When this option is selected, only one file is created each
time the action is initiated.
Placeholders
In addition to the options described above, you can also manually edit
the filename. Insert placeholders to the filename box (E). The
placeholder is inserted on the cursor position within the text box when
you select the option. You can cut and paste text to your preference
in the filename box (C), in order to set the placeholders and eventual
fixed file name text in the desired order. A placeholder is a text
identifier between percent (“%”) symbols, which is automatically
replaced by another text when its value is calculated (for example
%date% will be replaced by the current date). These placeholders are
documented in the Export Formats User’s Guide.
 
Typical placeholders are:
l %recname%
l %date%
l %time%
l %autonumber%
l %trigger%

C Full path example Shows what the final file name(s) will look like. When
satisfied with the result, click OK to save the configuration.
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D Extension Use the extension list to choose one of the available
extensions, which defines the type of the file that will be saved. This dialog
is applicable in two situations: Configuration of the Save Perception report
action, and configuration of the report document filename for the Report
to Word action. These two situations have different available extensions:

l For the Save Perception report action, the file extension can be:
l • .emf, for a Windows® Enhanced Metafile type
l • .pReportData, for a Report file type

l For the Report to Word action’s report document filename, the file
extension can be:
l .doc, for Word 97-2003 document format
l .docx, for Word 2007 document format

 
E File Name  In this text box you can enter a name for the report file. Note

that this might only be part of the whole file name, depending on the rest
of the options in the dialog.

Save a copy as
When the Save a copy as report action is selected to be configured, the Build
Storage Path and Filename dialog shows up. It allows you to define the way
the copy is saved. For more information about the settings of “Build Storage
Path and File Name” dialog refer to
Figure 9.84 "Build Storage Path and File Name dialog" on page 420. All settings
are the same except the file extension (.pnrf)

Run External Program
The configuration dialog for this action allows you to define the program to be
executed.

Define the program to be executed:
l Click Browse to select the program to run.
l Type the command line arguments to input to the program, if applicable.
l Select the Mode you want the program’s window to run in (Minimized,

Normal, Maximized, or Hidden).
l Under Automatic execution, you can set the automation action to wait until

the program has completed. If this option is not selected, the next
automation task will run, without waiting for the external program. In
addition, if you select the With time out option, the automation will only
wait for the specified amount of seconds before continuing with the next
action.
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Figure 9.85: Configure Run External Program dialog

Report to Word
The configuration dialog of the Report to Word action is described in the
separately supplied “ Perception 5.0 – Reporter Option” manual, see Chapters
“Report menu” and “Advanced Report”.

Quick report to Word
The configuration dialog of the Quick report to Word action is described in the
following chapter "Quick Report to Word" on page 426.

9.5.7 Automation Progress dialog
All processing commands include a progress dialog. The specific information
available depends on the type of processing.
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Figure 9.86: Automation Progress dialog example

A Recording

B Action

C Progress bar

D Hide dialog

E Stop all actions

F Skip current action

G List area

A Recording Displays the name of the current recording.
B Action Displays the current action.
C Progress bar Indicates the progress of the current action.
D Hide Click this command to hide the progress dialog. To show this dialog

again select Window ► Automation Progress.
E Stop all Click this command if you want to abort all actions instantly, in-

cluding the current action.
F Skip Click this command if you want to skip the current action instantly

and continue with the next one.
G List area Displays the list of files to process, including the current one.

9.5.8 Merge Files
Merge Files is a tool to enable you to quickly merge data files together to
produce a single file that can be saved.
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Before you start the file merge, validate that the files to be merged are available
on the PC. If not all files are available, you can:

1 Connect the storage device that contains the recording to the PC using
peripheral PC hardware if required.

2 Copy the files to the PC using the recording manager. Please refer to
"Recordings navigation" on page 94 for instructions on how to copy files.

To merge files:

1 In the Automation menu click Merge Files.
2 Add the files that should be merged.
3 Select an output file location by:

l Typing an output file location in the output file area.
l Clicking the Browse button and browsing to the output location.

4 Click the Merge files button.
5 Wait for the merge process to be completed.
6 Click Close to exit the Merge Files dialog.

Figure 9.87: Merge Files dialog

A Merge list

B Output file path
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C Merge files command

D Progress bar

E Add a file to the merge list

F Remove a file from the merge list

G Approximate file size

H Browse for folder or file

I Cancel the merge operation

A Merge list This is the list of original files that will be merged into a single
file. One of the files is shown in bold; this recording file will be used as
the master recording. You can change the master recording by double
clicking on one of the recordings in the list. The file highlighted is the
currently selected master file.
The original files will not be altered in any way.

B Output file path The full path of the merged file. If the file name already
exists, you can optionally overwrite the existing file.

C Merge files  Starts the merge process.
D Progress bar Shows the progress of the merge process.
E Add file Adds files to the list of files to merge
F Remove Removes the currently selected recording from the merge list.
G Approximate file size Shows the approximate size of the resulting

merge file.
H Browse Allows browsing to a file or folder to store the resulting merge

file.
I Cancel Cancels the merge process.

9.5.9 Quick Report to Word
The quick report functionality can post various sheet objects to Microsoft® Word
with a click of a button. The currently supported objects are:

l Various Display types
l User Table
l Image
l Cursor Table (if visible)

This functionality is available in all versions of Perception .

A quick report can be created manually or automatically. For automation setups
refer to "Setup Process Display" on page 409.
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To set up the report, the Quick Report to Word dialog is used.

To set up the report:

l Click Automation in the menu bar and then click Quick report to word.
l In the dialog that comes up check which objects you want to report to word,

re order them with the blue arrow icons as you wish and click Report now.
l Word will open automatically and paste the selected objects into a blank

document.

Figure 9.88: Quick Report to Word dialog

A Perception object name

B Perception object type

C Report now command

D Close this dialog

E Move object down in the list

F Move object up in the list
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A Perception object name The Perception objects that are available at
the moment of calling the dialog are listed in this column. The names of
the Perception objects are shown. The check box in front of the name
indicates if the object is used or not.
Changing the name of an object after closing the dialog is not applied to
the Quick Report settings.

B Perception object type This column indicates the type of the Perception
object.

C Report now Performs the actual posting.
D Close Close the dialog box window, keeping any existing settings.
E Move down Objects are posted in the order they are listed. Use the Move

down button to move the selected object down in the order.
F Move up Use the Move up button to move the selected object up in the

order.

How it works
When a quick report is created, either manually or automatically, a new blank
Word document is created and all selected objects are posted in the order they
are listed. After posting, Word is activated and the new document is shown.

Displays

For the quick report option all pages of the display are posted, separated by an
empty line.

When a display is posted, it is created using the size of the display on the screen
(in pixels), converted to mm/inches. If this size does not fit on the page, it is
resized to fit.

The display is posted as-is, using the current layout settings.

Note The default color scheme used is: Color on white.

Images

Images are posted to Word using the size of the real image file inside the image
object. If the size is larger than the page, it is rescaled to fit on the page.

Note The fitting properties of the image object have no effect on the output.
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Tables

If a user table or cursor table is transferred to Word, a table is created with the
same number of columns as the source using the same division percentage.
The created table uses the full width of the page. Fonts and font styles are also
sent over to Word.

Note The values of the data sources inside the table are retrieved at the moment of
posting.

Operation
A Quick Report to Word can be created manually or automatically. Both
operations are activated in the Quick Report to Word dialog box in which the
setup is done.

To create a quick report manually:

1 Set up Perception with the objects that you want posting.
2 In the main menu go to: Automation ► Quick Report to Word

In the dialog that comes up:
3 Select the objects that you want to be posted.
4 Reorder the objects to your preferred order.
5 Click Report now.
6 When posting is done, Word is shown with the new document.

Note You must save the file in Word to avoid losing data.
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9.6 Window menu
The Window menu provides access to the various palettes and other ‘floating’
user interface dialogs and controls.

For more details on palettes refer to "Using palettes" on page 66.

Figure 9.89: Window menu

9.6.1 Hardware
The hardware navigator lists all available hardware within a network. This
includes all mainframes that you use, is in use by somebody else or is not in
use at all. This is also the place where you can select (connect to) the hardware
that you want to use for a specific experiment.

To show or hide the hardware navigator:

l In the menu bar choose Window ► Hardware. A check mark appears in
the tab margin next to the hardware entry if it is currently visible.

For details on the hardware navigator refer to "Hardware navigation" on
page 80.

9.6.2 Recording
The recordings navigator lists all available recordings. Recordings can be
physically stored in archives on your PC or network, cached in acquisition
hardware, or referenced by Perception .
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To show or hide the recording navigator:

l In the menu bar choose Window ► Recording. A check mark appears in
the tab margin next to the recording entry if it is currently visible - either
open or auto-hidden.

For details on the recording navigator refer to "Recordings navigation" on
page 94.

9.6.3 Data Sources
The data sources navigator allows you to browse and access all data that is
available within Perception . This can be referenced/opened recordings,
(system) variables, formula results, etc.

To show or hide the data sources navigator:

l In the menu bar choose Window ► Data Sources. A check mark appears
before the data sources entry if it is currently visible - either open or auto-
hidden.

For details on the data sources navigator refer to "Data Sources navigation" on
page 108.

9.6.4 Properties
The Properties window displays the properties of a selected item in one of the
navigators. Therefore it will be generally used in combination with one or more
of the navigators.

To show or hide the properties window:

l In the menu bar choose Window ► Properties. A check mark appears
before the properties entry if it is currently visible - either open or auto-
hidden.

For details on the properties window refer to "Properties window" on
page 112.
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9.6.5 Automation Progress
All processing commands include a progress dialog. Depending on the type of
processing specific information is available.

To show or hide the automation progress dialog:

l In the menu bar choose Window ► Automation Progress. A check mark
appears before the automation progress entry if it is currently visible.

For details on the progress window refer to "Automation Progress dialog" on
page 423.

9.6.6 Acquisition Controls
The Acquisition Control palette is used for quick access to the main parameters
of an acquisition. It is also used to control the actual acquisition and to give
feedback on the acquisition status of the controlled system(s).

To show or hide the acquisition control:

l In the menu bar choose Window ► Acquisition Controls ► [control
group]. A check mark appears before a control that is currently visible -
either open or auto-hidden.
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For details on the acquisition control refer to "Acquisition control" on
page 114.

9.6.7 Battery Status
For systems with built-in batteries a battery status palette is available that
provides detailed information about the batteries and their “health” in a
graphical and condensed format.

Note This does not include the battery status of remote front-ends. The battery status
of remote front-ends is available on a dedicated Fiber Status sheet.

To show or hide the battery status:

l In the menu bar choose Window ► Battery Status ► [mainframe]. A check
mark appears before a battery status palette that is currently visible.

For details on the battery status refer to .

9.6.8 Status
The Status palette is used for a quick overview of vital system parameters. A
large font is used to allow visibility at larger distances.

To show or hide the Status palette:

l In the menu bar choose Window ► Status. A check mark appears before
the status palette entry when it is visible.

For details on the status palette refer to "Status" on page 125.
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9.6.9 Cursor Navigation
The Cursor Navigation Keys are used to easily navigate the display cursors
through your displayed waveforms.

To show or hide the Cursor Navigation palette:

l In the menu bar choose Window ► Cursor Navigation. A check mark
appears before the status palette entry when it is visible.

For details on the Cursor Navigation palette refer to "Cursor navigation" on
page 178.

9.6.10 Toolbars
A toolbar contains (buttons with) images that provide quick access to commonly
used commands and operations. Perception includes various built-in toolbars
that you can show and hide as needed. By default, all built-in toolbars are
docked side by side below the menu bar.

To show or hide a specific toolbar:

To show or hide a specific toolbar do one of the following:

l Using the toolbar area:
1 Right-click the toolbar area.
2 In the context menu that comes up click the toolbar that you want to

show or hide.
l Using the Window menu:

l In the menu bar choose Window ► Toolbars ► [toolbar]. A check mark
appears before a toolbar that is currently visible.
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For details on the toolbars refer to "Using toolbars" on page 70.
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9.7 Help menu
The Help menu provides access to various support functions.

Figure 9.90: Help menu

9.7.1 Check for Software Updates
Perception uses the InstallShield Update Manager to automatically check for
updates of the software. If updates are available, you will see an icon alerting
you that updates are available. When you select the icon, you will see a list of
available updates. You decide which updates to install. If no updates are
available, you will not receive any notification.
Within the Update Manager you can select not to automatically check for
updates. However, you can still manually request to run a check for updates.
To do this choose the Check for Software Updates command in the Help
menu. It is recommended that you check for available updates at least once
per month.

9.7.2 Update Key...
The Perception software requires a HASP key. HASP (Hardware Against
Software Piracy) is a hardware-based (hardware key) software copy protection
system that prevents unauthorized use of software applications.
Each HASP key contains a unique ID number used for personalization of the
application according to the features and options purchased. Also the key is
used for storing licensing parameters, and applications and customer-specific
data.
When upgrading the software to a higher level or when additional features are
purchased, you will receive a personalized ”key file”. Use this file to unlock the
additional features.

You can find the serial number of your key in Help ► About Perception
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To update the key information:

1 Choose Help ► Update Key...
2 In the Open dialog locate the Key File (*.pKey), and click Open.
3 When all is well you should see the following message:

Figure 9.91: Software copy protection dialog

4 Click OK.

When you added options you can go to Help ► About Perception ► More... to
see if all options are there.

9.7.3 Open Perception Diagnostics Folder
During normal Perception operation various diagnostic files are kept up-to-date.
Also in the rare event of a system malfunction, diagnostic files are created.
When something goes wrong and you need to contact HBM support, you should
keep these files within reach. They may contain valuable information.

These files are located in a special folder. Use this command to open the
diagnostics folder without the need to search for it when requested.

9.7.4 Performance Tests...
You can run performance tests to see if your system is optimized for the
Perception application.

To run performance tests:

1 Choose Help ► Performance Tests...
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2 The System Performance Tests dialog will open and the tests will start
automatically. When done the results are displayed:

Figure 9.92: System Performance Tests dialog

3 When required scroll down to see all results.
4 Click Close when done.

9.7.5 Network Load
It is possible to see a graphical overview of your network load. But next to the
load it also shows which mainframe is connected to which network adapter on
the PC. This is very useful to check if the hardware connections are done
correct.
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The dialog is a modal dialog which means it can stay open while continuing the
work in Perception. It will update when this is needed.

To see the network load:

1 Choose Help ► Network Load
2 The Network Load dialog will open:

Figure 9.93: Network Load

A Local PC (main area)
 A1 Used network adapters (local PC)
 A2 Unused connected network adapters (local PC)
 A3 Unused disconnected network adapters (local PC)
B Network (main area)
C Acquisition systems (main area)
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A Local PC
 This area lists all enabled network adapters in a predefined “group” order.

Possible groups are:
 A1 Used network adapters: Adapters with correct status and used for

mainframe connections. This group is only present when connections
are made.

 A2 Unused connected network adapters: Adapters with correct status but
not currently used for mainframe connection.

 A3 Unused disconnected network adapters: Adapters with disconnected
status.

 Inside each group the network adapters are ordered alphabetically.

Figure 9.94: Graphical representation of a network adapter
 Depending on the “group” a network adapter it’s in, the information inside

it is different.
  
 Each Network adapter representation consists out of:
 l Name

l IP address
l Network connection state icon
l Network adapter reported Link-speed (Throughput speed)

Note Only shown for adapters with correct status (excluded is the Loopback adapter).

Perception

440 A02689_09_E00_00   HBK: UNRESTRICTED



B Network
 The network area indicates which physical network connections are made

(external or internal).

Figure 9.95: Graphical representation of the network connections
 When a Mainframe is connected to Perception, there is a complete link

between the “Acquisition Systems” and the “Local PC”. Because the GEN
series Acquisition systems dynamically know the expected output to the
network (and updates when relevant changes are made) we can calculate
the expected load to the Network. And the (possible combined) load to the
“Local PC”.

  
 Based on the given maximum network throughput speeds, we can extract

the load in percentage on each connection.

Note The most important thing here is that it sometimes is forgotten that a “combined”
load to the “Local PC” is created by the physical connections.

 When a recording is started while we have more than 100% network load
on any connection the following dialog is shown:
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Figure 9.96: Network overload message

When the Show details and stop…  button is pressed, the Network
Load dialog is shown.

  
C Acquisition Systems
 This area contains the connected mainframes, which are always in the

“Used network adapters” group. They are ordered alphabetically.

Figure 9.97: Graphical representation of Acquisition Systems
 Each Acquisition system representation consists out of:

l Mainframe name
l Mainframe IP address
l Network connection state icon
l Mainframe reported Link-speed (Mainframe reported throughput

speed)
l Synchronization source and state
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9.7.6 About Perception 
Click this command to see additional information about the application.

Figure 9.98: About dialog

A Application information

B License information

C Support information

D More information

A Application This section gives information on the version number and
build number of the application. This combination defines uniquely which
version you have.

B License This section gives information about the license of the software:

l Licensee name and company
l Key serial number
l When available: maintenance expiration date

C Support Website and e-mail address for support.
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D More Click this button to get more information on the installed options.

Figure 9.99: About dialog: More

This window shows the installed options. Options that are not installed are
greyed out.

Select the Module Versions page to get a list of installed software modules and
their version number. This is useful for service purposes.
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10 QuantumX in Perception
10.1 Introduction

This section is intended to help first time and existing QuantumX users become
familiar with operating a QuantumX using Perception software. It will guide
them through the required steps to setup a new experiment including a
QuantumX and create a first recording.

This section will explain the basics of using QuantumX with Perception,
explaining what can and cannot be done and how to do it.
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10.2 Supported QuantumX modules
The following QuantumX data acquisition modules are currently supported by
Perception:

Table 10.1: Supported QuantumX modules

Pr
od

uc
t

Se
ns

or
s

N
o.

 o
f c

ha
nn

el
s

Sa
m

pl
e 

ra
te

s

 M
ax

 a
gg

re
ga

te
sa

m
pl

e 
ra

te

Po
w

er
 c

on
su

m
pt

io
n

MX1609KB K-type
thermocouples

16 0.1, 0.2, 0.5, 1, 2, 5,
10, 20, 50, 100,
200, 600 S/s

9.6 kS/s < 6 W

MX1609TB T-type
thermocouples

16 0.1, 0.2, 0.5, 1, 2, 5,
10, 20, 50, 100,
200, 600 S/s

9.6 kS/s < 6 W

MX809B K, J, T, B, E, N,
R, S, C type
thermocouples

8 0.1, 0.2, 0.5, 1, 2, 5,
10, 20, 50, 100,
200, 600 S/s

4.8 kS/s < 10 W

MX471B CAN 4 x 128 Asynchronous,
max: 1 kS/s
CAN data is
resampled to
2.5 kS/s

4 x
9.6 kS/s

< 6 W

All B type
modules

See product data sheet for specific information

MX1609KB/TB:
The MX1609 is a thermocouple amplifier. Up to 16 K- resp. T-type
thermocouples can be connected to it. Each input is individually configurable
and electrically isolated. It is used for measuring temperatures.

MX809B:
The MX809B is a thermocouple amplifier. Up to eight thermocouples can be
connected to it. Each input is individually configurable and electrically isolated
up to 1 kV. It is used for measuring temperatures.
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MX471B:
The MX471B has four connectors that can be individually configured as CAN
input or CAN output. When configured as input, up to max. 128 signals and a
total of 9600 samples per second can be received. In addition, CCP and XCP
(XCP-on-CAN) messages can be received. The MX471B can also operate as
a gateway transferring analog input(1) to a CAN-out message. Up to max. 200
signals and a total of 4800 samples/second can be transmitted on CAN bus.
The individual CAN signals can be easily configured with the aid of a CAN
communication description file in DBC format. For each connector, a bitrate can
be set, with maximum of 1 Mbit/s.
For configuring the MX471B, you need to use the MX Assistant tool (see
appendix "Configuring the MX471B using the MX Assistant" on page 848).

(1) Analog inputs from other QuantumX units only. For proper connection and
more information on CAN out, please refer to the MX471B documentation.

All B-type modules
All other B-type QuantumX modules are supported in Perception for data
streaming only. For configuring these modules, you need the MX Assistant tool.

Note Perception checks the number of connected mainframes against the amount
of RAM on the system it is running on. Once the required amount of memory
exceeds the amount of RAM in the system, Perception will no longer connect
to further mainframes and report back on this. If this happens, extending the
amount of RAM in the PC will also increase the number of mainframes that can
be simultaneously connected.
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10.3 References
This section will not go into full detail on operating Perception, Genesis High
Speed equipment or QuantumX equipment. If more information on any of these
subjects is required, please refer to:

l Genesis High Speed Data Sheets
l Perception option manuals
l Genesis High Speed Operating Manuals
l QuantumX Data Sheets
l QuantumX Operating manual
l QuantumX Quick Start Guide
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10.4 Concepts and terminology

Recorders & time base
Historically, Perception was designed to operate with Genesis High Speed
family products that typically support highly configurable setups. Mainframes
are compatible with a wide variety of acquisition cards and each user can
configure the system to meet their specific needs. All connectors on the same
card will sample at the same rate. Thus each card in the mainframe is a
Recorder within Perception and each Recorder has multiple channels. This
differs from the QuantumX concept where a single unit contains multiple
connectors.

For the QuantumX modules, the following approach is used regarding
Recorders and sample rate:

l For the MX1609KB/TB and MX809B modules, each connector represents
a Recorder with 1 channel. For each Recorder a sample rate can be
configured. This ensures maximum flexibility, as each channel can now be
configured to run with its own sample rate. However if all channels need to
sample at the same rate, this can be easily accomplished by using time
base groups. All channels with the same sample rate capabilities will be
grouped together by default.

l For the MX471B, each CAN bus connector represents a Recorder with a
maximum of 128 CAN bus channels. No sample rate can be configured,
because of the asynchronous nature of the data (CAN samples may arrive
at irregular intervals).

l For the all other B type modules, each input connector represents a
Recorder. All channels within this connector should have the same
sampling rate. The sample rate of the first signal of the connector is used
as sample rate for the Recorder in data storage and representation.

Note With the “Time monitoring’” feature of the MX471B you can define that signal
data must be received within a certain time interval at the latest, otherwise the
signal will be labeled with Overflow (OVR). Perception will display very high
sample values in that case.
For more information, please refer to
Figure H.18 "Configure CAN signal repetition time" on page 861.

Settings
The Perception approach to settings is, “what you see, you can get”. In other
words, when setting up the equipment, Perception will only show those
possibilities that can actually be selected. While this typically ensures a simple
setup process, it may cause some settings to be invisible. This can happen
especially in these scenarios:
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l Filter frequency missing: If the desired filter frequency is not available, try
changing the sample rate.

Filters
Filter naming conventions within Perception may differ from other software. For
the currently supported QuantumX modules the following filters are available:

QuantumX module Perception filter name MX Assistant/CatMan
filter name

MX1609KB or TB
MX809B

Bessel IIR (Fc@-3dB) IIR Bessel, Lowpass

MX1609KB or TB
MX809B

Butterworth (Fc@-3dB) IIR Butterworth, Lowpass

MX471B - -

Note For all other streaming-only modules Perception will not shown these settings,
but the data that is recorded, is filtered as set up in the MX Assistant.

PTP
Precision time protocol: protocol to synchronize clocks between multiple
devices in a network. It has a better accuracy than NTP at lower cost than GPS/
IRIG.

CAN bus
The CAN bus (Controller Area Network) is a serial bus developed by Bosch
GmbH in the 80s. It is a Message-based protocol, designed originally for
automotive applications, but is nowadays also used as a fieldbus in real-time
distributed automation environments.

The nodes on the CAN bus are called Electronic Control Units or shortly ECUs.
Two or more nodes are required on the CAN network to communicate. The
complexity of the node can range from a simple I/O device up to an embedded
computer with a CAN interface and sophisticated software. The node may also
be a gateway allowing a standard computer to communicate over a USB or
Ethernet port to the devices on a CAN network.
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All nodes are connected to each other through a two wire bus. The wires are
120 Ω nominal twisted pair.

ISO 11898-2 Network

CAN Node

Not Terminated

At Node

Rterm

Stub Length Stub LengthCAN Node

Not Terminated

At Node

CAN Node

Not Terminated

At Node

Stub Length

Rterm

Figure 10.1: CAN nodes connected to a CAN bus

Each CAN node is able to send and receive messages, but not simultaneously.

A CAN message or frame consists primarily of the ID (identifier), which
represents also the priority of the message, and up to eight data bytes. A CRC,
acknowledge slot (ACK) and other overhead are also part of the message.

Message IDs must be unique on a single CAN bus. Message IDs are 11 (or 29
for CAN 2.0B) bits.

A CAN message is transmitted serially onto the bus and may be received by
all nodes. To ensure enough transitions for the CAN bus nodes to maintain
synchronization, a bit of opposite polarity is inserted after five consecutive bits
of the same polarity. This practice is called “bit stuffing” and is necessary due
to the non-return-to-zero (NRZ) coding used with CAN. The stuffed data frames
are unstuffed by the receiver.

CAN data transmission uses a bit-wise arbitration method for contention
resolution. This arbitration method requires all nodes on the CAN network to
be synchronized to sample every bit on the CAN network at the same time. This
is why CAN is sometimes called synchronous. Unfortunately the term
synchronous is imprecise here since the data is transmitted without a clock
signal in an asynchronous format.

How the CAN bus arbitration works:
l If a logical 1 is transmitted by all transmitting nodes at the same time, then

a logical 1 is detected by all of the nodes, including both the transmitting
node(s) and receiving node(s).
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l If a logical 0 is transmitted by all transmitting node(s) at the same time, then
a logical 0 is detected by all nodes.

l If a logical 0 is being transmitted by one or more nodes, and a logical 1 is
being transmitted by one or more nodes, then a logical 0 is detected by all
nodes including the node(s) transmitting the logical 1.

When a node transmits a logical 1 but detects a logical 0, it realizes that there
is a contention and it quits transmitting. Any node that transmits a logical 1 when
another node transmits a logical 0 "drops out" and loses the arbitration. A node
that loses arbitration stores its message for later transmission and the existing
CAN frame bit-stream continues transmitting. This means that the node that
transmits the first 1 loses arbitration. So the node that transmits a message with
the lowest CAN message identifier transmits more zeroes at the start of the
frame, and is therefore the node that wins the arbitration. So, the lower the CAN
message ID, the higher the message priority.

A CAN network can be configured to work with two different message/frame
formats:

l Standard or base frame format
l Extended frame format (CAN 2.0 B)

The only difference between the two formats is that the CAN base frame
supports a length of 11 bits for the message identifier, and the CAN extended
frame supports a length of 29 bits for the message identifier.

For configuring the CAN network, typically use is made of a so called CAN
communication description file (DBC file). The company Vector Informatik
GmbH (www.vector.com) offers tools (like CANdb++) to create such a DBC file.

XCP
The XCP or “Universal Measurement and Calibration Protocol” is a network
protocol for connecting calibration systems to Electronic Control Units (ECUs).
It is a successor to the CAN Calibration Protocol (CCP) that was developed
back in the mid-1990s. XCP support several transport layer protocols, such as
Ethernet, USB and CAN (XCP-on-CAN).

The MX471B can read CCP or XCP-on-CAN messages and, in addition,
operate as a gateway transferring analog input(1) to a CAN message. For
example, MX1609B thermocouple signal data coming in via FireWire being
forwarded as CAN-out messages by the MX471B.
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(1) Analog inputs from other QuantumX units only. For proper connection and
more information on CAN out, please refer to the MX471B documentation.

Figure 10.2: Example configuration with both CAN input, CAN output and
XCP-on-CAN

* Only CAN bus output of QuantumX Input signals (i.e MX1609KB)
CCP & XCP-on-CAN: software CANape needed to generate DBC out of A2L
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10.5 How to use a QuantumX module in Perception
Typically using a QuantumX module in Perception requires the following
workflow, similar to any other measurement in Perception:

1 Properly connect all mainframes.
2 Start Perception, selecting the user mode of choice (see section

"Perception user modes" on page 33).
3 Connect to the mainframes in the system.
4 To enable time synchronous measurements, enable PTP on the relevant

systems(1).
5 Setup the rest of the measurement using the settings sheet in Perception.
6 Check the settings for conflicts, resolve if found.

a Save the settings into a pVWB file to avoid having to setup the settings
twice for consecutive tests.

7 Check the Perception status, if no warnings. Start the recording.

(1) Check the hardware manuals for information on how to setup the hardware
for proper PTP synchronized recordings.

Using an MX471B type QuantumX module
The workflow of creating a measurement with a MX471B is similar to the
previous workflow; however Perception cannot setup CAN settings for the
MX471B. So in order to properly use the MX471B, a pre-setup is required using
another tool. This should happen before connecting to the system with
Perception. This results in the following workflow:

1 Properly connect all mainframes.
2 Setup the MX471B using the MX Assistant software (see appendix

"Configuring the MX471B using the MX Assistant" on page 848).
3 Disconnect from the MX471B in the MX Assistant.
4 Connect to the mainframes in Perception.
5 To enable time synchronous measurements, enable PTP on the relevant

systems.
6 Setup the rest of the measurement using the settings sheet in Perception.
7 Check the settings for conflicts, resolve if found.

a Save the settings into a pVWB file to avoid having to setup the settings
twice for consecutive tests(1).

8 Check the Perception status, if no warnings. Start the recording.

(1) Note that the MX471B CAN settings that were setup using the MX
Assistant are not part of the pVWB. These settings always need to be
checked and potentially setup through the MX Assistant software.
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Using multiple QuantumX modules of the same type in Perception
Upon receiving a new QuantumX unit, its default name is the mainframe type.
So an MX1609B module is called MX1609, MX809B is called MX809 and
MX471B is called MX471. Perception uses these mainframe names to present
the mainframes in the user interface.

When multiple mainframes are used, they may have the same name. In that
case Perception only shows a single entry with a warning symbol. There are
several ways to resolve this scenario. Refer to chapter "First time connecting"
on page 461 on how to resolve this using Perception, or refer to
Figure H.6 "Rename module" on page 852 for more information on how to
resolve the issue using external tooling.
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10.6 Connection basics
Two typical workflows when using a QuantumX module are:

l Measuring with a tethered GEN series system (i.e. a GEN3t).
l Measuring with an integrated GEN series system (i.e. a GEN3i).

Example configuration with a GEN3t:

Figure 10.3: Perception, GEN3t and single MX1609KB for temperatures -
Using PTPv2 switch

Note In most cases a PTP aware switch is used to ensure PTP synchronization.
When using a normal (non PTP aware) switch, PTP synchronization might fail.
See "Synchronized recording setup" on page 474 for details.
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Example configuration with a GEN3i:

Figure 10.4: GEN3i with three QuantumX MX1609KB "B" version modules

Note Setup only shows GEN3i. GEN3i can be replaced by GEN3iA/GEN7i.

Note * All modules must be “B“ versions; one module must set to “clock master“ and
connected to the GEN3i PTP Ethernet.

Note Perception only supports Ethernet communication with the QuantumX
modules. This means that the FireWire connection of the QuantumX unit cannot
be used for communication with Perception. It may however be used to setup
synchronization between several QuantumX modules and/or to power the
module via the FireWire power out port that is available on some of the Genesis
High Speed mainframes. Refer to the GEN series hardware manual for more
information.

HINT/TIP

This setup uses multiple network ports on the GEN3i PC section.
Use fixed IP address setup with different base IP address and non-overlapping
IP-ranges (Combination of base IP address and net mask) for each of the
GEN3i network ports to make sure the setup always works.
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Background network details
If the network ports are configured for DHCP setup, each of the connections
using the APIPA protocol to find a free IP address. As none of the network ports
are linked together the APIPA protocol does not detect the address used any
of the network devices in this setup. At random all QuantumX systems might
end up with exactly the same network IP address. If this happens the systems
are not uniquely addressable anymore and the communication fails.

Background FireWire chaining details
Using a FireWire connection between QuantumX modules may impact the
measurement systems time synchronization behaviour. This paragraph
explains the details of a FireWire connection and its influence on the sync
source in detail.

In Perception, open the Settings Sheet tab and in the General group, select
Mainframe.
With Mainframe the time sync source can be set to PTP or Auto.

Figure 10.5: Perception settings tab/General group/Mainframe

A Settings Sheet tab

B Mainframe option in General group

C Sync source setting

For the Sync source setting, dependent whether or not the QuantumX system
is also connected via FireWire to another QuantumX system, time
synchronization will behave differently. See next table:
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Sync source FireWire
connected

Time synchronization source

Auto No RTC MX471B
Auto Yes FireWire input source
PTP No PTP master

Yes Setup depended*

* Only one QuantumX in a FireWire chain can have an external time source. If
multiple units in one chain are setup for an external source, only one will actually
use that source. The other units will synchronize to that unit via FireWire.
Perception will indicate these units as having a conflict as the actual time
synchronization source (FireWire) is different from the selected one (PTP). To
solve the conflict, leave one unit in the chain to PTP and set the others to Auto.
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10.7 Configuring a QuantumX module

Configuring a MX1609KB/TB and MX809B
The relevant settings to setup an MX1609KB/TB and a MX809B module are
available in the settings sheet. For more information refer to the section on
settings (see "Settings sheet" on page 299) and the appendix “Settings Sheet
Reference” on page 534).

Configuring a MX471B
To configure a MX471B module, the MX Assistant tool is used. This is described
in Appendix: "Configuring the MX471B using the MX Assistant" on page 848.
It describes:

l How to change the network settings of a MX471B.
l How to change the MX471B module name.
l How to configure the general CAN bus settings.
l How to configure the CAN signal settings.
l How to configure the CAN signal repetition time.

Configure other modules
Time source selection and channel and mainframe naming are available for all
modules in Perception. Use the MX Assistant to configure all other settings of
the module.
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10.8 First time connecting
Once a proper hardware setup is created and all equipment is turned on,
Perception should be able to discover the QuantumX modules on the network.

Connecting
Once a proper hardware setup is created and all equipment is turned on,
Perception should be able to find the equipment on the network.

Figure 10.6: Hardware Navigator in Perception

The hardware navigator in Perception shows all equipment that was discovered
on the network.
If everything is OK it will be shown using the informational icon . In some
cases the exclamation icon  will be shown.

Here is a list of known causes and solutions:
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Cause Description Solution
Same name Perception requires your

equipment to be uniquely
named.

Connect to the
mainframe*, rename it
using the network setup
dialog, then rescan the
unused hardware and
connect to the next
device. Repeat these
steps until all units are
uniquely named.

Incorrect network
configuration

If the unit’s Ethernet
settings do not match
(one of) the PCs Ethernet
settings it is not possible
to setup a point to point
TCP/IP connection.

Start a connection to the
mainframe. During the
connection phase a
dialog will be shown that
allows the network
settings to be changed**.

Unsupported
equipment

Perception is able to
detect all members of the
QuantumX family;
however only B-type
hardware is supported.

Unsupported hardware
cannot be used from
Perception.

Unresponsive
hardware

In some rare cases,
communication between
QuantumX units and
Perception may be
blocked.

Reboot the system and
restart Perception. If the
problem persists, please
contact technical support.

* The identification mechanism can be used to determine which unit is or
will be connected.

** When using Perception remotely, make sure that the PC and mainframes
network settings match before connecting!

Once the equipment is discovered, a connection can be established. See
chapter "Perception Start-up" on page 42 on how to start with Perception.
Alternatively this can be done by double clicking the item in the hardware
navigator, or using the right click menu and selecting Connect. Using multi-
select, it is possible to connect to multiple units at the same time. The progress
of the connection process is shown in the connection dialog. The connection
will go through several steps potentially requiring input to successfully
complete.
The following actions will be performed:
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1 Checking the network IP address setup. If the current network setup of the
equipment conflicts with the network setup of the PC, the network setup
dialog can be used to ensure correct network settings. Use the information
stated on available network adapters to configure the network correctly, or
use DHCP configuration if this is supported in the network.

Figure 10.7: Network IP Address Setup dialog

Note Reconfiguring the network of a mainframe may take some time as this
typically requires a (partial) reboot of the system.

2 Firmware upgrade: To ensure dependable behaviour, Perception enforces
a fixed firmware version to the equipment. If the equipment’s firmware is
not up to date, or a newer version is loaded, Perception will load a
predetermined firmware version into the module. Note that the firmware
upgrade process may take some time to complete.

Note DO NOT POWER OFF OR DISCONNECT EQUIPMENT DURING THE
FIRMWARE UPGRADE PROCESS.
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Identification
In case of multiple units it may be difficult to determine which navigator entry
matches which unit. For a QuantumX it is possible to use the identification
functionality by right clicking in the hardware tree and selecting Identify. The
corresponding unit will now have a blinking power LED and the identify menu
item will be checked. The blinking can be stopped by clicking the Identify item
again.

Figure 10.8: Identify hardware

Note The identification feature is not available for all type of hardware. If the feature
is not available for selected hardware the menu item will be disabled.

MX471B
When connected to a MX471B module, only the CAN channels for which a
signal has been activated will be visible in Perception. CAN signals which are
deactivated are not visible. CAN signals can be activated (or deactivated) using
the MX Assistant tool. For more information, please refer to "Configuring the
CAN signal settings" on page 854.
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Each MX471B CAN connector is mapped to a single Recorder in Perception.
Only CAN connectors for which at least one signal has been activated will be
mapped to a Recorder.

Figure 10.9: Example configuration of a MX471B with one recorder and three
activated CAN signals

A Mapped MX471B CAN connector
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10.9 Configuring the hardware via the Settings Sheet
Within Perception, preparing equipment for measurements is done through the
settings sheet. Once connected to the equipment, the setting categories that
are available will be enabled.

Figure 10.10: Setting categories

Typically all Basic (Reduced Settings) are shown, it is also possible to show
Advanced (All Settings) by using the right click menu on the setting column
headers.
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Figure 10.11: Basic/Advanced settings

This is especially interesting when setting up the system for synchronized
measurement between multiple units using PTP, as more detailed PTP
information will be shown.

Figure 10.12: Settings information

Information that is currently not relevant is marked with the  sign. These
settings may become relevant later on depending on other settings, in the
example above when the sync source is set from Auto to PTP.

When connected to a unit it is also possible to review or change the unit’s
network settings by activating the settings sheet, and then going to the Settings
► Mainframe Network Setup menu item.
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Figure 10.13: Mainframe Settings - Network Setup menu

The mainframe network setup dialog will show all connected units and within
the unit the available configurable Ethernet connections.

Note The new settings will only take effect when disconnecting the unit. When the
network settings are changed, disconnecting from the unit will take longer
because the unit will be rebooted.

Saving and loading a setup
After setting up the experiment it is possible to store the setup information to a
file on disk for future reference; such a file is called a Virtual Workbench within
Perception. It contains information on:

l The connected units
l The time base grouping of the units and recorders
l The hardware settings of the connected units
l The layout of Perception

(displays, meters information and any other experiment related information)

To save a virtual workbench follow the following steps:

1 Connect to the units to configure.
2 Setup the units’ settings.
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3 Setup Perception layout.
4 Use File ► Save Virtual Workbench or File ► Save Virtual Workbench

As and select the name and location for the virtual workbench.

Besides the manual setup and creation of a virtual workbench, Perception also
stores setup information in every recording that is created in the PC Storage
location. There are multiple ways to redo an experiment with the same setup:

1 Select File ► Open Virtual Workbench and select the pVWB or PNRF file
containing the experiment setup to use

Figure 10.14: Open Virtual Workbench
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2 Select File ► New and select Redo an existing Experiment from the
Perception start dialog

Figure 10.15: Perception start dialog

A Redo an existing Experiment
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10.9.1 MX471B specific settings

Note For the MX471B module only a limited number of settings can be configured
via the settings sheet. Use the MX Assistant for the other settings.

Recorder (General group)
In Perception, open the Settings Sheet tab and in the General group, select
Recorder.
Here the Recorder can be enabled or disabled and the Recorder name can be
changed.

Figure 10.16: Perception settings tab/General group/Recorder

A Recorder option in General group

B Settings Sheet tab

C Recorder name

D Enable/Disable option

Note The CAN data recorded by the MX471B is asynchronous in nature and the
sample rate can therefore not be set. The data may be up-sampled in
Perception in case synchronous data is required to complete an operation.

Note These settings are not stored into the MX471B. These settings are lost when
the MX471B is disconnected. If you want to keep these settings you have to
save them in a Virtual Workbench file.
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Can-Bus (Input group)
In Perception, open the Settings Sheet tab and in the Input group, select CAN-
Bus
With CAN-Bus the display range can be adjusted. The initial value is taken from
the CAN channels minimum and maximum value which are defined outside of
Perception. For more information, please refer to "Configuring CAN signal
minimum/maximum value" on page 863.

Figure 10.17: Perception settings tab/Input group/CAN-Bus

A CAN-Bus option in Input group

B Settings Sheet tab

C Range from

D Range to

Note The range only adjusts the display range settings in Perception. These settings
are not stored into the CAN amplifier settings of the MX471B. This means the
adjusted display settings are lost when the MX471B is disconnected. If you want
to keep these settings you have to save them in a Virtual Workbench file. Or
adjust the CAN signal minimum/maximum value settings in the MX471B device.
For more information, please refer to "Configuring CAN signal minimum/
maximum value" on page 863.

Perception

472 A02689_09_E00_00   HBK: UNRESTRICTED



When there is conflict with the display range, the involved CAN channel gets
colored:

Figure 10.18: CAN channel conflict

A Colored conflict area

A conflict is indicated if the range is 0 or negative. A range conflict might prevent
you from seeing a trace in the Perception time display.

You can adjust the display range either via Perception or via the MX Assistant:

Adjusting display
range via:

When Reboot of
QuantumX
device needed

Changes lost on
reboot/
disconnect

MX Assistant A physically
different range is
measured.

Yes No

Perception Data is only
available for a
specific portion of
physical
measurement
range.

No Yes

In the MX Assistant, the display range can be changed via the CAN Sensor
adaptation dialog. (See "Configuring the MX471B using the MX Assistant" on
page 848).
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10.10 Combining QuantumX and GEN series

Synchronized recording setup
To ensure aligned data when recording with multiple measurement devices,
those devices should be synchronized. Perception, in combination with
Genesis High Speed and QuantumX modules offers a single synchronization
method to accomplish this, PTP or Precision Time Protocol.

To setup a synchronized recording take the following steps after connecting to
the units:

1 Start GEN series mainframe with PTP enabled with PTP tolerance set to
150 ns (default value).

Note All modules connected through FireWire should be set to Auto, also the ones
that are connected but not supported by Perception, these modules can be set
to Auto using the MX Assistant.

2 Wait until the Time base status changes to PTP Synchronized.

Figure 10.19: Time base status

A PTP Synchronized

Note PTP synchronization may fail when using a non-PTP aware switch. If this is the
case, and you are not using an external PTP grandmaster, set the PTP
tolerance of the GEN series mainframe to 1000 ns  or higher. The QuantumX
will now become the master in the PTP network, and the GEN series
mainframe(s) will only report it is out of sync when the difference with the
grandmaster exceeds the selected tolerance. If a higher tolerance is not
acceptable OR you are using an external grandmaster, a PTP aware switch is
required.
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3 Ensure that status is PTP and not PTP : Conflict.
4 In the settings sheet verify that all units use the same PTP Master by

checking the PTP Master MAC-address. (Advanced setting).

Figure 10.20: Settings MAC-Address, setup without FireWire connection
between QuantumX mainframes

 In the settings sheet verify that all units use the same PTP Master(1) by
checking the PTP Master MAC-address. (Advanced setting).
The value shown in the PTP Master MAC-address is the MAC-address of
the PTP master clock used by the mainframe in that row. If the mainframe
is the master this will be the MAC-address of the mainframe itself. If the
mainframe is a slave it should be another address.
To perform a synchronized recording, all mainframes should use the same
PTP master, and thus the PTP master MAC-addresses for all slave
mainframes should be the same.
In the example shown above, the GEN3i is the PTP master to both MX1609
mainframes. So the PTP MAC-address shown for all units is the MAC-
address of the GEN3i.

5 Ensure that the PTP Master is either a GEN series mainframe or an
external PTP master clock.

6 Repeat these steps for all mainframes in the connected mainframes.
  
(1) In most typical PTP setups all data acquisition will be using the same PTP

clock and all Master MAC-addresses should be the same. Only when using
multiple subnets it may be valid if two different MAC-addresses are shown.
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Possible topologies
When using PTP synchronization in an Ethernet network, make sure the PTP
synchronized modules are connected using a PTP aware switch. Using a
standard switch will cause the PTP to randomly loose synchronization, resulting
in an unsynchronized recording.

Figure 10.21: GEN7t with single QuantumX MX1609KB - Overview

For detailed information on PTP setup, please see the Genesis High Speed
hardware manuals.

QuantumX as master
QuantumX can be master within a PTP network. However when using only
QuantumX units, this may result in an unsynchronized recording as the
QuantumX typically has no reference to an absolute time. Perception will
recognize this and try to match the QuantumX data to its own internal absolute
time, however due to internal latencies of the data, this will not happen at the
same time for all mainframes. This will introduce a data shift that matches the
size of the latency. Typically the shift will be on the order of 400 µs.
If a recording is started with QuantumX as in the PTP master role, Perception
will show a warning notification stating that the recording may not be properly
synchronized.
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Figure 10.22: Clock Synchronization warning

PTP Exceptional behaviour
When correctly configured, the PTP protocol should provide a stable
synchronized recording. It is possible however that the PTP master fails at a
given moment (power outage, hardware failure). When this happens, the PTP
protocol will select a new master clock device.
When the new master is selected a number of scenarios may occur:

1 The new master time signal is very close to the original master
Within Perception you may see an indication that synchronization was lost
and recovered. All equipment continues running synchronized to the new
master.

2 The new master is ahead of time
If the new master’s time is very far ahead of the original master clock the
system behaviour depends on connected hardware.
For QuantumX, Perception will detect a jump forward in time. The last
known ‘old’ sync sample will be marked, and the first ‘new’ sample will be
marked with an event mark in the display. Between these two samples there
will be no data, but all measured samples are written into the recording.

3 The new master is back in time
If the new master’s time is back in time compared to the original master
clock the system behaviour depends on connected hardware.
For QuantumX, Perception will detect a jump back in time. The last known
‘old’ sync sample will be marked, and the first ‘new’ sample will be marked
with an event mark in the display. Data that is reported at a time which
overlaps with the previous synchronization time will be discarded!

FireWire synchronization
When using multiple QuantumX modules, it is possible to combine PTP
synchronization with FireWire synchronization between the QuantumX
modules. To setup the system like this, set at least one of the QuantumX
modules to PTP as described earlier. For the other systems that will be
synchronized to the PTP QuantumX via FireWire, make sure the Sync source
is set to Auto.
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Figure 10.23: GEN3i with multiple MX1609KB/MX1609TB - Using PTP switch

Note * Multiple QuantumX modules might require more than one power supply. For
more information, please refer to the QuantumX data sheets for power
consumption.

Using FireWire synchronization may be the better option from a cost point of
view as it does not require a PTP aware switch. This only applies if the system
contains more units than can be connected to a single PTP-aware switch, or in
case the QuantumX units are connected directly to an integrated GEN series
unit.

Note Refer to the QuantumX manual for detailed information on synchronization
methods.

Perception

478 A02689_09_E00_00   HBK: UNRESTRICTED



 

When using FireWire create the following setup:

Figure 10.24: Setup using fire wire

1 Set GEN series to PTP 1
2 Set the QuantumX connected to the PTP capable switch to PTP 1
3 Set the QuantumX modules that should be FireWire slave to the PTP

QuantumX to Auto

After all modules are synced:

1 The GEN series has PTP Role Master, or slave to an external PTP master
clock

2 The QuantumX modules have PTP Role Slave, the PTP Master MAC-
address of all QuantumX modules set to PTP should be the same as the
PTP Master MAC-address of the GEN series

Note In case multiple QuantumX mainframes are set to PTP and connected using
FireWire, only one mainframe will use PTP synchronization. The other
mainframes will use FireWire synchronization. Mainframes that are set to PTP,
but that use FireWire will show this as a conflict. To avoid conflicts, make sure
only one mainframe in the FireWire chain is set to PTP.
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10.11 Perception with a QuantumX via a CX27B
One way to connect a QuantumX module to the rest of your system is using a
CX27B. Main advantage of this is the reduction in cabling, and potential to
connect multiple QuantumX modules to a single integrated GEN series system
without the need for a PTP aware switch. Consider the following points when
set up QuantumX via a CX27B.

10.11.1 Hardware setup
For general information on using a CX27B and its capabilities, please refer to
the CX27B data sheet which can be found on this website:
www.hbm.com/en/2131/quantumx-cx27/

Direct connection to an integrated GEN series mainframe

AC mains

DC power

supply
GEN DAQ 

signal inputs

QuantumX

 rack

P
T

P
 

P
T

P
 

Ethernet for communication and 

PTP synchronization

QuantumX signal inputsGEN3i with Perception
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Figure 10.25: Connection of a GEN series mainframe and QuantumX

Note Please make sure to use the Ethernet connector on the back of the CX27B
when working with PTP synchronization as the front Ethernet connector does
not support PTP.
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CX27B combined with a tethered GEN series mainframe and/or other
QuantumX modules
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Figure 10.26: Connection of a GEN series mainframe, PC and QuantumX

Note Please make sure to use the Ethernet connector on the back of the CX27B
when working with PTP synchronization as the front Ethernet connector does
not support PTP.

10.11.2 Synchronization and network setup
When using the CX27B in a BPX002 backplane, all QuantumX units are
interconnected though a FireWire bus. This means there is only one Ethernet
connection, which is on the CX27B.

Note Make sure to connect the CX27B to the network.

As there can be only one FireWire synchronization master, this should be set
to PTP. The CX27B needs to be set up to PTP Sync mode, all other modules
should be in Auto mode.

Similar as using a single QuantumX unit, the CX27B also has an Ethernet port
to connect it to the network, and also similar, this setup should be correct for
the CX27B to properly operate within the network.
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Because the CX27B is a transparent switch for Perception, it’s synchronization
mode and network cannot be setup through Perception. Please use the MX
Assistant to setup the CX27B network and synchronization functions.

10.11.3 Miscellaneous information
Although using the CX27B in a BPX002 backplane has some great advantages
in reducing the required cabling, there are also some limitations(1) to be aware
of when working in combination with Perception.

● Aggregate sample rate
 Depending on the exact setup of QuantumX modules, running them at their

maximum sample rate might produce more data than can be passed
through the CX27B. Perception will not warn about this, as the CX27B is
a transparent switch. Please refer to manuals and specification sheets of
the exact hardware in your setup for more information.

● Network setup
 If the CX27B is not properly configured for the network, attempting to

connect to modules attached to it within Perception will show a network
setup dialog. However, this will not try to adapt the setup of the CX27B,
but of the module you are connecting to. As this will have no effect to the
actual communication setup in this case, the connection will eventually fail.
In this case, please use the MX Assistant to properly setup the Ethernet
settings of the CX27B.

● Using additional CX27B features
 The CX27 has a variety of additional features (such as EtherCAT© out)

which cannot be used from Perception. However, it is possible to turn these
on using the MX Assistant.
Note These features were not tested in combination with Perception.

● PTP Status
 Because the CX27B only acts as a communication switch for other

QuantumX modules to Perception, it’s PTP status is not not read or shown
by Perception. Please wait long enough to allow PTP to synchronize after
turning on and configuring the system. MX Assistant maybe used to enquiry
the current PTP status.
Note It is highly recommended not to connect to the system using multiple
software platforms at the same time.

(1) While this chapter explains some limitations, the exact specification of the
CX27B can be found in it’s data sheet which is available on the website.
Specifications are not included in this manual as they might be improved
with product updates over time.
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A Acquisition and Storage
A.1 Introduction

Note When you are using Perception Version 8, some of the information in this
manual may be outdated. Especially the acquisition modes described in chapter
"5 Acquisition Control and Status" on page 113 and appendix
"A Acquisition and Storage" on page 483 have been updated in Perception
Version 8. For more information on new acquisition modes, please visit the
Perception product page for the document “Perception V8 Acquisition Modes
Quick Start”.

Data acquisition within modern HBM Genesis HighSpeed instruments is based
on the concept of a recorder. A recorder consists of a number of acquisition
channels that share the same basic recording parameters: sample rate, sweep
length and pre- and posttrigger length. Usually a single recorder is physically
identical to a single acquisition card. Multiple recorders can be placed in a single
mainframe. The mainframe is the housing for the recorders, provides the
power and includes the interface for the local area network. A mainframe has
its own network address (IP address). Within the Perception software recorders
can be combined into logical groups for easy reference. Recorders within a
group are not bound by physical mainframes.    
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For the sake of simplicity we will consider a single channel in this section.

A

C

B
D

E F G

Figure A.1: Simplified generic single channel data acquisition system

A SigCon / Amp

B ADC

C Downsampler

D RAM

E Trigger Detector

F Acquisition Logic

G Internal high speed data bus

In Perception a separation is made between acquisition and storage. 
Acquisition is the act of digitizing analog data and making it available for
monitoring or storage. Storage is the actual archiving of digitized data.
Recording (verb) is acquisition + storage.
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A.2 Acquisition
For more information on acquisition control refer to "Acquisition control" on
page 114.

This section provides the fundamental acquisition control.

Figure A.2: Acquisition control

1 Status display Shows the current status of the acquisition.
2 Acquisition control The following controls are available:
    
 ● Preview  This button serves two purposes:
  ● When no acquisition is active it will place the recorder in the pause

or stand-by mode. Although the recorder is digitizing, no data is
stored is memory or disk. This is useful for monitoring purposes.

  ● When a an acquisition is active, the button will update to Pause
once Record is selected (see Figure A.3). Using the control now it
will place the recorder in a hold mode: although the recorder is
digitizing, no data is stored in memory or disk. At this point the
Record button will change into Resume (see Figure A.4), when
Resume is selected, the current recording continues, when Stop
is selected, the recording is finished.

   

Figure A.3: Acquisition control - Record selected
   

Figure A.4: Acquisition control - no data in memory or disk
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  ● Record

The Record command starts acquisition of data.
  ● Stop

To stop an acquisition, select this button. This stops the current
recording. When in a sweep acquisition mode, the current sweep
will be aborted immediately.

  ● Trigger
The button is used to send a “manual” trigger command to the
recorder(s) under control.

These acquisition controls are combined with the various storage modes.
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A.3 Storage
A generic data acquisition system provides two storage paths as shown in the
"Introduction" on page 483 (Figure A-1):

l Store data in on-board RAM at high speed
l Transfer data directly at reduced speed to the controlling PC or (when

installed) to a local disk.

In addition to these storage paths a system provides two fundamental storage
modes:

l Sweeps: data storage of predefined length. Sweeps typically use a trigger
to define the start and end of the sweep.

l Continuous: data storage of an undefined length. The end of this storage
mode can be defined by various events, as described later.

When data is stored, this data is organized in recordings. A recording is defined
as all the data that has been stored between the start of acquisition (Record
command) and the end of acquisition. The end can be defined in various ways.
A recording can have one or multiple sweeps, a continuous data stream or a
combination of both.

In Perception, a recording is organized as a PNRF file (Perception Native
Recording File).

The storage mode defines how data is digitized and saved. The continuous
storage mode will store all data. The Sweep storage mode will store only the
sweeps. However, the resulting file - or recording - will be different for the
various storage modes.

Figure A.5: Record - Storage: Continuous
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Figure A.6: Acquisition: Record - Storage: Sweeps only

Figure A.7: Acquisition: Record – Storage: Single Sweep only

The basic storage modes can be combined to create more advanced storage
modes:

Dual  In this mode, sweeps as well as continuous data is stored. Therefore the
end result is a recording that comprises the higher speed sweeps as well as
the lower speed continuous data in between the sweeps.

Slow-Fast Sweep  In this mode sweep data with different sample rates are
stored. The difference with the dual mode is the fact that the slower data stream
is now actually a slower speed sweep, i.e. it has a predefined length and
requires a trigger. The trigger position is the same as the trigger of the first
high-speed sweep. The recording stops at the end of the slow sweep, without
regard to the set number of fast sweeps.

A.3.1 More on sweeps
Figure A.1, as shown in the "Introduction" on page 483 is a very simplified block
diagram of the general concept of a single channel digitizer. Once the analog
values have been converted by the ADC into binary codes, they are stored in
successive order in a buffer memory, the on-board RAM. This memory can be
divided into multiple segments to allow for the storage of multiple sweeps.

If the last storage location of a segment is filled and acquisition is still taking
place, the first storage location is overwritten with a new sample, followed by
the second storage location, etc.
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Figure A.8: Ring buffer operation of memory

A Data storage

B Begin

C End

The physical memory therefore forms a ring buffer, into which information can
be continuously added (Figure A.8). This process of filling the ring buffer
memory terminates only when the recording logic indicates that the sweep must
be ended. Once the sweep recording has stopped, the content of the buffer
memory becomes available to the control PC for processing. This is also called
circular recording. Sweep data is automatically moved from onboard RAM
memory to the recording file.
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A.3.2 Pre-trigger sweeps

As we have seen, data emerging from the ADC is stored in the buffer memory.
When recording, the memory is continuously refreshed with new sample
values, until storage is halted. The information available in the memory is a
history of the recorded signal up to the moment of “end-of-sweep”. The extent
of this history depends on the sample rate and the data storage capacity
(length) of the memory. If we assume a memory length of 40 000 samples and
a sample rate of 10 000 samples per second, then the time window of the
history will be:

(EQ 1)

twindow = =
40000

10000
4 seconds

 

Storage into the ring buffer can be stopped only by a 'stop' signal from the
recorder. This signal is called the "trigger". 

Figure A.9: Ring buffer with trigger and end-of-recording

A Data storage

B Begin

C End

D Trigger

E End of recording
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Since the trigger stops the storage, all stored information is termed pre-trigger
information. When storage stops because the acquired signal has met a trigger
condition, only pre-trigger information is available - information recorded before
the signal met the trigger condition.

Figure A.10: Full pre-trigger storage: pre-trigger = 100%

More often one is interested in what happened just before and after the
condition was met. To achieve this aim, a delay is introduced. Once the trigger
condition is met, storage is stopped - not immediately, but only after a
programmable delay counter has counted out. The memory now contains pre-
trigger information and posttrigger information.

Figure A.11: Pre-trigger / posttrigger storage: 0% < pre-trigger < 100%

The usage of a variable delay counter allows for a user-definable pre-trigger
length. The length of the pre-trigger segment equals the length of the memory
segment minus the delay. When the length of the delay is equal to, or exceeds,
the length of the memory segment, only posttrigger information is available.

Figure A.12: Full posttrigger storage: pre-trigger = 0%
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Figure A.13: Delayed trigger storage: pre-trigger < 0%

A Delay

A.3.3 Fast sweep stretch storage

Figure A.14: A single trigger event

Figure A.15: A Second trigger initiating a sweep stretch

If a second trigger (transient event) is encountered during posttrigger data
collection, the triggered sweep is automatically extended to record the second
event completely including additional posttrigger data. For more information
see "Advanced settings" on page 575.
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A.3.4 More on continuous data storage
The most important difference between continuous data storage and sweeps
in a system is the fact that sweeps are stored in on-board volatile RAM, while
continuous storage takes place on the controlling PC's hard disk (or local hard
disk when installed).

The continuous data storage provides four modes:

l Standard  The continuous mode is standard when storage is started and
stopped manually as depicted below:

l Circular   The continuous mode is circular when storage is started and
stopped manually AND the length of the buffer is defined. Operation is now
similar to standard sweep storage, but storage is on PC hard disk and not
in volatile memory. In this mode the lead-out is specified which is basically
the same as the posttrigger segment in a sweeped recording. 

l Stop on trigger   The continuous mode now operates like a pre-trigger
sweep, but with storage on the PC hard disk, not in volatile memory.
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l Specified time The continuous mode now stores data until the specified
time has elapsed.
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A.4 Time base
The power of modern data acquisition techniques is achieved by digitizing
analog information. Digitizing is the conversion of the instantaneous value of
an analog signal (static or dynamic) into a numeric value. When the signal
varies, sampling the instantaneous amplitude at sufficiently rapid intervals
converts this signal into a series of numbers that can represent the original
analog signal.

A.4.1 Real-time sampling and time base
Real-time sampling is a straightforward sampling method and is the only
method to record non-periodical phenomena. In this method, the intervals
between the samples taken of the original signal are as short as possible and
equidistant. If the sample rate used is high enough, the original signal can be
reconstructed without any additional processing.

The sample rate is determined by the time base: the time base is a clock that
generates pulses used to drive the A-to-D Convertor. Within a system you can
have the following time base options:

l Internal time base  When you select the internal time base, the clock used
to drive the ADC’s is the built-in clock.

l External time base  When you select the external time base, the clock
used to drive the ADC’s is the clock signal presented at the external clock
input BNC on the system. When you select this mode, the interval between
two consecutive samples may not be equidistant. This all depends on the
accuracy of the supplied clock signal. Refer to the user manual supplied
with your hardware for more details.

The above selection is made in the Settings Sheet > Recorder > Time base
Source.

When internal time base is selected there can be two related options:

l Internal Clock Base Decimal    This setting is used to create time base
values that are base 10, for example 1 MHz, 100 kHz, 50 kHz, 2.5 Hz, etc.
These values are derived from a main oscillator that operates at a base 10
frequency, for example 1 MHz.

l Internal Clock Base Binary    This setting is used to create time base
values that are base 2, for example 1.024 MHz, 512 kHz, 64 Hz, etc. These
values are derived from a main oscillator that operates at a base 2
frequency, for example 1.024 MHz.

The above selection is made in the Settings Sheet > Mainframe > Internal Clock
Base and is therefore mainframe-wide, i.e. the same for all recorders.
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A binary clock base is a useful time base settings when doing FFT’s (frequency
domain analysis).

See image Figure A.16 for a schematic overview of the clock base selection.

Decimal

20.00 MHz

Sample rate

divider

Sample rate

Clock base

selection

Binary

20.00 MHz

Decimal

Binary

External Clock In

External

Figure A.16: Clock base selection

A.4.2 Time base settings for FFT’s
When doing FFTs, there are two topics that affect the acquisition:

1 It makes life easier when the final FFT yields spectral lines with a distance
∆ f that is a "nice" value. Otherwise stated: the FFT bin size should
preferably be a nice value. Sometimes, this is also called the "frequency
resolution". The bin size is determined by the actual frame size or frame
length: bin size = 1 / T in which T is the total frame size time. E.g. a one-
second frame size will result in a 1 Hz bin size, a 0.5 second frame size
results in a 2 Hz bin size.

2 The frame size in samples should be equal to a power of two.
Fundamentally, most FFT algorithms work on data sets with a length of
2^N.
 

The binary clock base of the internal time base in combination with the division
factors allow for a broad range of values that meet both requirements. In the
table below (see "Examples of FFT bin sizes" on page 497), various sample
rates are given, as well as the corresponding division factor (divisor). The table
shows the bin sizes that result from these sample rates in combination with
various sweep lengths.

Example: from the table (see "Examples of FFT bin sizes" on page 497) you
can read that a sample rate of 40.960 kHz and a frame length of 8192 samples
result in a 5 Hz bin size, i.e. the spectral lines are 5 Hz from each other.

"Nice" values are considered to be "minor" values that easily fit in "major" values
for (grid) display purposes.
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In the table below, the values are in the colored cells and basically comprise
the range 1.25, 2.5, 5, 10, 20.

Table A.1: Examples of FFT bin sizes

TIME BASE
MAIN = 1.024
MHZ

FFT SIZE (FRAME LENGTHS)
256 512 1024 2048 4096 8192

SMP/S DIVI-
SOR

FFT BIN SIZE IN HZ

1024000 1 4000 2000 1000 500 250 125
512000 2 2000 1000 500 250 125 62.5
256000 4 1000 500 250 125 62.5 31.25
204800 5 800 400 200 100 50 25
128000 8 500 250 125 62.5 31.25 15.625
102400 10 400 200 100 50 25 12.5
51200 20 200 100 50 25 12.5 6.25
40960 25 160 80 40 20 10 5
25600 40 100 50 25 12.5 6.25 3.125
20480 50 80 40 20 10 5 2.5
12800 80 50 25 12.5 6.25 3.125 1.5625
1024 100 40 20 10 5 2.5 1.25
5120 200 20 10 5 2.5 1.25 0.625
4096 250 16 8 4 2 1 0.5
2560 400 10 5 2.5 1.25 0.625 0.3125
2048 500 8 4 2 1 0.5 0.25
1280 800 5 2.5 1.25 0.625 0.3125 0.0156
1024 1000 4 2 1 0.5 0.25 0.125
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Additional information
The Nyquist frequency (f/2) is the maximum frequency that can be accurately
measured by a digitizer sampling at a rate of (f). Otherwise stated: a digitizer
sampling at a rate of (f) cannot measure an input signal with frequency
components exceeding f/2 without experiencing "aliasing" inaccuracies.

Nyquist's theorem determines the range of frequencies that can be measured.
They range from DC to one half the sampling rate at which the data was
captured. An FFT of a sweep of N points produces N/2 frequency domain data
points within the range of frequencies between DC and the Nyquist frequency.
So the frequency resolution is:

(EQ 2)

f =
samplerate / 2

N / 2

 

For example, assuming that a frame has 8192 points (N=8192) and a sample
rate has 40.96 kHz. This will yield the following:

l Frequency resolution Δf = (½ * 40960) / (½ * 8192) = 5 Hz
l Number of frequency domain points: N/2 = 4096
l The minimum frequency component that can be measured is equal to the

frequency resolution Δf = 5 Hz
l The maximum frequency component that can be measured is 40.96 kHz /

2 = 20.48 kHz

The FFT X-scale (frequency) will start at 5 Hz, end at 20480 Hz, and has 4096
points.

It is just described using Nyquist's theorem how to come to the FFT X-scale.
However, because most times the analog signal passes through an anti-
aliasing filter at the input, the entire frequency span is not useable. A filter has
a flat response from DC to a frequency lower than the Nyquist frequency and
then rolls off. No filter can make a steep transition instantly.

Therefore the frequency span is typically set to a smaller value. Usually a value
of 0.390625 is chosen that is, not divide by 2 (Nyquist) but by 2.56. For the
delta-f calculation this has no influence: delta-f = sample rate / N. Only the
frequency span is smaller. In the above example 40.96 kHz / 2.56 = 16 kHz.
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B Digital Trigger Modes
B.1 Introduction

Within a typical HBM Genesis HighSpeed data acquisition system, each and
every channel is equipped with a trigger detector, which makes it possible to
record just the phenomenon of interest, instead of having to search the full
memory to find it. The trigger detector gives the system the power to capture
elusive, short and unpredictable events. It determines how easily you can
extract the event of interest.

The word trigger has a dual meaning in recording techniques. In the passive
sense, the instrument is triggered, i.e. the instrument responds to a certain
stimulus. In the active sense, as in trigger point, it indicates the point (in time)
where the instrument triggers an event. In both cases, trigger refers to a known,
pre-defined situation.

The trigger can be generated in several ways:

l by the user, i.e. manually
l using an externally applied signal, i.e. external trigger
l when the acquired signal complies with a certain condition: the trigger

condition. Each channel within a recorder can trigger this recorder.

For transient recording the third option is of great importance. The trigger
facilities determine to a large extent the application capabilities of the data
acquisition system – i.e. how effectively the data can be captured.

In this chapter the trigger capabilities of HBM Genesis HighSpeed data
acquisition systems and the Perception support will be explained in full detail.

Each channel within a recorder can trigger this recorder. This functionality is
realized by combining all channel triggers into a logical OR combination. When
one of the channels (or multiple channels) generates a trigger, the complete
recorder triggers. Each channel's trigger detector can be switched off or set to
one of the modes described in this chapter.

Note This chapter describes all GEN series trigger options. However, not every
acquisition card will support each described option. Check the specifications of
each acquisition card to find out what options are supported for this specific
card.
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Figure B.1: Channel triggers combined

A Channel 1

B Channel n

C Channel x

D Recorder Trigger
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B.2 Understanding digital triggering
Technically speaking, there are two approaches to determine the known, pre-
defined situation of the signal: analog or digital.

Each channel in the GEN series system is equipped with a digital trigger
detector. Digital triggering has the benefit of stable vertical reference levels, no
horizontal jitter, and not depending on signal frequency.

A disadvantage of a digital trigger detector is its inability to detect events that
occur between two consecutive samples. This does not usually interfere with
normal operation because the event is not recorded anyway.

B.2.1 Digital trigger detector
Figure B.2 shows a simplified diagram of a single-level digital trigger detector.
Digitized values coming from the ADC are fed into an Arithmetic (and) Logic
Unit – ALU. The value that comes out of the ALU is then referenced against a
preset value (trigger level). The result can be either positive, i.e. the value is
larger, or negative, i.e. the value is smaller. Based on this information the level
crossing detector verifies if a level crossing in the correct direction has occurred
and if so, sends out a trigger.

+

A

E F

B C D

Figure B.2: Single-level trigger detector

A ADC DATA

B ALU

C Level crossing detect

D Trigger

E DELAY

F Compare value
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The delay register in front of the ALU is used to compare the ADC value with
“older” values. This means that triggering does not react to specific levels, but
to the differential signal or slope.

As explained later in this chapter, a signal must actually cross the preset level.
This is to avoid erroneous triggering due to a small amount of noise on the
signal. To make the trigger detector even more stable when noisy signals are
used, the single-level trigger detector has been expanded with a hysteresis.
After the level detector signals a level crossing, a new level crossing will only
be signaled if the input signal first goes outside the hysteresis band and then
returns to the trigger level. 
For the advanced trigger modes, the single-level trigger detector with
programmable hysteresis has been implemented twice to provide a dual-
level trigger detector. Levels are usually referenced as primary trigger level and
secondary trigger level.
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B.2.2 Valid trigger conditions
Trigger detection is based on level crossing: A signal has to cross a specified
level to be considered a trigger condition. As a consequence, reaching the
required level is not a valid trigger condition. Since trigger detection is digital,
inter-sample analog values are omitted.

In the following graphs these conditions are shown.

T T

T

A B

C

A

A A

Figure B.3: Level crossing detector

Trigger

Trigger level

Sample

Last sample before trigger

Trigger

Figure B.3 shows the basic trigger mode with a specified level (T) and a level
crossing in positive direction. In Figure B.3 A the trigger occurs on the first
sample after the level crossing. Figure B.3 B shows the situation in which a
sample equals the specified level. Trigger does not occur until a sample is
actually above the specified level.
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Since the trigger detector requires a level crossing, no trigger occurs when a
signal is above the set level when recording starts.
This is depicted in Figure B.3 C.

Figure B.4 shows the influence of the hysteresis. The difference is that a second
level (H) is used to “arm” the level trigger detector. In other words, the trigger
level has been expanded to be a trigger zone that spans multiple levels.

T

H

A A

Figure B.4: Trigger level hysteresis

Trigger

Trigger level

Hysteresis level

Sample

Trigger

Set hysteresis

Reset hysteresis
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B.3 Trigger modes
Using the various trigger modes, your data acquisition system is expanded to
an extremely versatile transient recorder. The trigger circuits may be configured
to trigger on many types of phenomena. In this section the different trigger
modes and their extensions are discussed in detail.

B.3.1 Basic trigger mode
The basic trigger mode can be compared to the trigger mode available when
using an analog trigger detector, for example as found on a classic scope.

A A

P
P

1 2

Figure B.5: Basic trigger mode

A Trigger

In this mode, a single-level trigger detector is active, the primary level. As
mentioned previously, the signal needs to actually cross the preset level. Both
the level and direction of crossing can be selected.

Relevant settings for this mode:

l Mode: basic
l Primary level: any value within the input range
l Direction: positive or negative
l Hysteresis: any relevant value
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B.3.2 Dual trigger mode
In dual trigger mode two detectors are active and working simultaneously: the
primary level P and the secondary level S. With two levels, it is possible to define
a range that the input signal must be within. As soon as the signal becomes
larger than the upper level or smaller than the lower level, the detector
generates a trigger. By inverting the slopes of both detectors, the trigger is
generated when the signal returns into the specified range.

Figure B.6 shows the various possibilities.

A A

A A

P P
1 2

S

S

P

P

3 4

S S

Figure B.6: Dual trigger mode

A Trigger

Any value for each level and the slope of the primary level can be selected. The
slope of the secondary level is automatically set to the opposite direction.

Diagrams 1 and 3 show a signal that exits the range. Diagrams 2 and 4 show
signals that enter the range.

Relevant settings for this mode:

l Mode: dual
l Primary level: any value within the input range
l Secondary level: any value within the input range
l Direction: positive or negative for primary level; secondary level is

automatically set to the opposite direction
l Hysteresis: any relevant value is used for both levels.
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B.3.3 Window trigger mode
For the window trigger mode, both levels are used. One of the levels has a dual
function, arm and trigger. The other level is used as a disarm level. To generate
a trigger, the trigger detector must be armed. This is done by crossing the arm/
trigger level in the opposite direction. Once armed, the trigger is generated by
crossing the arm/trigger level in the set direction, unless the disarm level has
been crossed after the arm level has been.

A A

A A

A/T A/T
2

D D

D
D

3 4

A/T A/T

1

Figure B.7: Window trigger mode

A Trigger

Diagrams 1 and 3 show the intended use of the window trigger mode, detecting
a dip in a repetitive signal. Diagrams 2 and 4 show alternatives, detecting a
peak pulse in a repetitive signal.

The window trigger mode is very useful if a periodic signal is monitored and the
system must be triggered on peak level changes. This mode is most effective
on uni-polar signals, for example a TTL level pulse train. For bi-polar signals
the dual-window trigger mode is more suitable as described in the following
section.

Relevant settings for this mode:

l Mode: window
l Primary level: any value within the input range
l Secondary level: any value within the input range
l Direction: positive or negative for primary level; secondary level is

automatically set to the opposite direction
l Hysteresis: any relevant value is used for both levels.
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B.3.4 Dual-window trigger mode
The dual-window trigger mode is a more sophisticated version of the window
trigger mode. Now both levels are used as an arm/trigger/disarm level. This
allows the trigger detector to react to a dip in both directions.

A A

A/T/D

21

A/T/D

A/T/D

A/T/D

Figure B.8: Dual-window trigger mode

A Trigger

Diagram 1 shows one situation, whereas Diagram 2 shows the other situation
with the same settings. In this mode, the following conditions determine the
trigger result:

l Level crossing in opposite set direction = arm level
l Level crossing in set direction = disarm when other level is armed
l Level crossing in set direction = trigger when level is armed

Since this is true for both levels, a “dip” in both directions is detected, as shown
in Diagrams 1 and 2 (see Figure B.8).

Relevant settings for this mode:

l Mode: dual-window
l Primary level: any value within the input range
l Secondary level: any value within the input range
l Direction: positive or negative for primary level; secondary level is

automatically set to the opposite direction
l Hysteresis: any relevant value is used for both levels.
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B.3.5 Sequential trigger mode
The two level comparators are set in a sequence in this mode. One is used to
arm the trigger detector while the other one is used to actually generate the
trigger. If the incoming signal crosses the level of the first comparator, the
second is activated (armed).

A A

A A

P
P

1 2

S S

P P

3 4

S S

Figure B.9: Sequential trigger mode

A Trigger

This mode can be used to help eliminate false triggering due to noise or
hysteresis. The concept is sometimes also referred to as a sensitivity window.

Although not very common, you can also set the level of the primary detector
to a value lower than the secondary detector. This will give you the options
shown in diagrams 3 and 4 (see Figure B.9).

Relevant settings for this mode:

l Mode: sequential
l Primary level: any value within the input range
l Secondary level: any value within the input range
l Direction: positive or negative for primary level; secondary level is

automatically set to the opposite direction
l Hysteresis: any relevant value is used for both levels.
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B.3.6 Trigger qualifier
The trigger detectors of a channel can also be used as a qualifier. A trigger
qualifier is a situation that enables (arms) the recorder trigger features. The
recorder trigger features are a combination of various channel, external,
between-recorders and other trigger options.

There are two qualifier modes:

l Basic single-level qualifier. Level detector operates identical to "Basic
trigger mode" on page 505

l Dual-level qualifier. Level detector operates identical to "Dual trigger mode"
on page 506.

When in qualifier mode, the output of the trigger detector is sent to a qualifier
line of the recorder trigger logic. For a full description of the recorder trigger
features see "Recorder and system trigger" on page 519.
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B.4 Trigger add-ons
The trigger modes mentioned can be combined with a variety of extra features,
allowing triggers on almost any signal.

Some of these extra features are used to fine-tune the selected trigger mode.
Other extra features expand the capabilities of the basic trigger detector.

The following simplified diagram is from the settings sheet and shows the
building blocks that make the complete channel trigger logic.

Figure B.10: Channel trigger logic

A To recorder trigger

From left to right, the following add-ons are available:

l Slope detector: allows to trigger on a slope instead of level
l Pulse qualifier: detects or rejects trigger conditions that meet a specific time

frame
l Hold off: disables the trigger detector for a set period of time after a trigger

condition
l Interval: defines a time interval between two consecutive trigger conditions
l Events: counts the number of trigger conditions before an actual trigger is

generated

B.4.1 Slope detector
All trigger functions described so far work on the absolute level of the incoming
signal. The slope detector allows the same functions to work on the
difference between samples. This means that the triggering does not react to
specific levels, but to the differentiated signal or slope. The slope detector is
also known as differentiator or dY/dt detector. The output of the slope detector
is the difference between the newest sample and the sample that was recorded
the given number of sample intervals ago.
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P

Figure B.11: Slope trigger

A Trigger

B Original signal

C Differentiated signal

With the slope triggering, it is possible to trigger on a specific change in slope
of the signal, for example on a spike on a repetitive signal. If the slope (or
frequency) of the signal exceeds the specified level, a trigger is generated.

B.4.2 Pulse detector
The pulse detector can be used together with the basic (slope) trigger level
detector. It can be used for two opposite purposes:

l Detect trigger conditions smaller than a set period of time: pulse detect
l Detect trigger conditions larger than a set period of time: pulse reject

All operations of the trigger detector are the result of crossing the level of a
comparator.

Pulse detect
If, after crossing, the condition of the comparator is NOT stable for the specified
period of time, the crossing is a valid trigger condition, i.e. it is a short pulse (or
noise), and a trigger is generated.

Pulse reject
If, after crossing, the condition of the comparator is stable for at least a specified
period of time, the crossing is a valid trigger condition, i.e. it is a long enough
pulse that must be recorded, and a trigger is generated.
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The pulse detector operates on samples. In the Perception software, this is
translated into time.

A

A

B

B

W

W

P P
1 2

P P

3 4

Figure B.12: Pulse detect/reject methods

A Trigger

B Width

Figure B.12: In Diagrams 1 and 2, the pulse detection is depicted. In Diagram
1, when the trigger level is crossed, the signal remains above the trigger level
for a time interval larger than pulse width W. In Diagram 2, there is a situation
in which the signal returns through the trigger level within pulse width W. A
trigger is generated on a “small” pulse.

In Diagrams 3 and 4, the opposite situation is depicted, pulse reject. Now “small”
pulses are not recognized as trigger condition, while a wider pulse generates
a trigger.

The pulse detector can be used for both trigger levels. Combined with a
hysteresis setting, the pulse detector is less sensitive to noise on the signal.

B.4.3 Holdoff
The trigger hold off feature is used to disable the trigger detector for a period
of time after a trigger condition has been met.

This can be used to generate only one trigger on a slowly decaying repetitive
signal, or to eliminate the effect of after-ringing. Using a 16 bit counter, triggering
can be disabled for as long as 6.5535 seconds when sampling at 10 kS/s.
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Figure B.13: Trigger hold off

A Trigger

B Hold off

The feature is most useful in combination with the interval timer and/or the event
counter.

B.4.4 Interval timer
A highly sophisticated trigger add-on is the interval timer. The interval timer is
used to define a time relation between two trigger events. When the time
relation is correct, a trigger is generated.

The following relations are possible:

l Less: The time interval between two consecutive trigger events is less than
the specified time interval.

l More: The time interval between two consecutive trigger events is more
than the specified time interval.

l Between: The time of the second trigger event is within a specified time
interval that starts a specified time after the first trigger event.

l NotBetween: The time of the second trigger event is not within a specified
time interval that starts a specified time after the first trigger event.

The interval timer operates on samples (2 to 65535). In the Perception software,
this is translated into time. At 1 MS/s sample rate, this results in a maximum of
65.535 millisecond.

Interval timer - Less
This interval time mode is fairly straightforward. When the second trigger event
is within the set time interval, a trigger is generated.
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Figure B.14: Interval timer - Less

A Trigger

B Interval

The time interval is reset on the first new trigger event. For example, this feature
allows additional pulses to be detected in a standard train of pulses.

Interval timer - More
This interval timer mode is more complicated. When the second trigger event
is within the set time interval, no trigger is generated and the time interval is
reset on each trigger event. When a new trigger event occurs after the specified
time interval, i.e. the interval is not reset in time, then a trigger is generated at
the end of the specified time interval.

The reset moments are denoted with a dotted line and the actual trigger moment
is denoted with a straight line.

A

B

P

Figure B.15: Interval timer - More

A Trigger

B Interval

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 515



For example, this function allows a "missing " pulse to be detected in a standard
pulse train.

Interval timer - Between
For the Between mode, basically two timers are used: one to set the start of a
time window and a second one to set the width of the time window. The second
trigger event must be within this time window.

A

P

1 2 3 8 119 104 5 76

Figure B.16: Interval timer - Between

The following sequence explains what happens:
1 The first trigger event starts Interval Timer 1.
2 A second trigger event occurs before Interval Timer 1 has expired and the

timer is reset.
3 A third trigger event occurs before Interval Timer 1 has expired and the

timer is reset.
4 Interval 1
5 Interval Timer 1 expires and Interval Timer 2 is started.
6 Interval 2
7 Interval Timer 2 expires while no trigger event occurred within the set

period. The complete trigger logic is reset.
8 The first new trigger event starts Interval Timer 1.
9 A second trigger event occurs before Interval Timer 1 has expired and the

timer is reset.
10 Interval Timer 1 expires and Interval Timer 2 is started.
11 A trigger event occurs before Interval Timer 2 expires and a trigger is

generated.
A Trigger
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The first interval timer can be compared to the trigger hold off feature described
above. The second interval timer defines a period in which a trigger event must
occur. If not, it is not a related trigger event.

Interval timer - NotBetween
The inverse function of the Between mode of the interval timer is the
NotBetween mode. The second interval is not used to define a trigger-safe area,
but to denote a trigger-restricted area. A trigger event within the first interval is
valid. A trigger event within the second interval resets the trigger logic. A trigger
is also generated when both interval timers expire. A typical use of this mode
is to detect changes in the interval between pulses ("too early" / "too late"
detection).

P

1 6 872 3 5 94 10

AA

Figure B.17: Interval timer - NotBetween

The following sequence explains how this mode functions:

1 The first trigger event starts Interval Timer 1.
2 Interval 1
3 If a trigger event occurs within the first interval, a trigger is generated.
4 End of sweep.
5 The first new trigger event starts Interval Timer 1.
6 Interval Timer 1 expires and Interval Timer 2 is started.
7 A trigger event occurs within the second interval. Interval Timer 1 is

restarted.
8 Interval 2
9 Interval Timer 1 expires and Interval Timer 2 is started.
10 Interval Timer 2 expires and a trigger is generated.
A Trigger
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B.4.5 Event counter
Sometimes it is not possible to trigger on a specified condition using a selected
trigger mode alone, because several events meet the required situation. So far,
we have seen “filters” that can be used to narrow the range of trigger
candidates, like hold off and interval timer.

As a last resource, the event counter can be used. The event counter counts
all channel triggers that have been detected and generates a system trigger
when the count equals a user defined value.
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B.5 Recorder and system trigger
The trigger modes and features described so far are channel-based. Each
analog channel within a GEN series system has a digital trigger detector. The
trigger signals of all channels of a single recorder are combined through a
logical OR to generate a combined trigger. This trigger can be combined with
an external trigger and qualifiers. The final result is a recorder trigger. The
triggers that are generated by individual recorders can be distributed to other
recorders and mainframes.

The following simplified diagram is from the Perception software and shows the
building blocks that make the complete recorder trigger logic. Please note that
not all features may be available depending on the exact hardware used.

Ext Trigger Out

Ext Trigger In

Channel 1

Calculated Ch 1

Calculated Ch "N"

Channel "N"

Qualifier 1

Qualifier "N"
Combine

Figure B.18: Recorder trigger logic

The heart of the recorder trigger logic is the “Combine” block. Here all trigger
sources come together and, depending on their setting, can generate a
recorder trigger. This can be blocked, however, by qualifiers: If one of the
qualifiers is not armed, no recorder trigger can be generated.

l Channel 1 through N: These are the channel triggers as described earlier.
Refer to Figure B.1 "Channel triggers combined" on page 500 for a more
accurate diagram.

l External Trigger In: This is an external trigger signal that is mainframe-
related: The input connector is placed on the mainframe controller. You can
select to use it on rising or falling edge, all input cards in the mainframe will
use the same edge. Each input card can select to use the external trigger
as a trigger source or not.

l Qualifier 1 through N: These are the qualifiers as described earlier: See
"Trigger qualifier" on page 510.
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l External Trigger Out: The recorder trigger can be used to send a trigger
signal to the outside world. The output connector is placed on the
mainframe controller. You can select to use it on active High or Low level
output, all input cards in the mainframe will use the same output level. Each
input card can select to send the trigger to the external trigger output or not.

l Internal Trigger Line 1 through 3: There are three internal trigger lines.
These are used to transfer recorder triggers from one recorder to another.
Each recorder can select to set its recorder trigger on one or more lines. It
can also pick up a trigger from one or more lines.

l Master/Sync: Multiple mainframes can be synchronized by using the
Master/Sync module. When in use, a recorder can put the recorder trigger
on the Master/Sync trigger line and/or pick up the trigger from the Master/
Sync trigger line. When Master/Sync operation is not used, this line
functions just like the other three trigger lines. Depending on the hardware
capabilities of the Master/Sync module, trigger line 3 can also be used to
synchronize triggers between mainframes.
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B.6 Channel alarm
Each channel has the capability to generate an alarm. An alarm situation is
detected with a basic dual level detector.

There are two alarm modes:

l Basic single-level alarm. The alarm line is active as long as the signal
exceeds the level in the specified direction. For details on the level
comparator see "Basic trigger mode" on page 505.

l Dual-level alarm. The alarm line is active as long as the signal exceeds one
of the two levels in the specified direction. For details on the level
comparators see "Dual trigger mode" on page 506.

The output of the alarm detector is sent to an alarm line and combined (OR-ed)
with alarm conditions of the other channels and recorders. The result is
available as an external output located on the mainframe controller.
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C Offline Setup & Configuration Manager
C.1 Introduction

The offline setup mode in Perception allows you to create and setup your
experiment, based on the hardware you have, without actually being connected
to that hardware. You can modify hardware settings, create formulas and
reports all based on the hardware you have and save this as a virtual
workbench. When you are connected to your hardware you can load this
workbench and you are up and running.

The offline setup is based on two components:

l The Configuration Manager.
l The Perception offline setup mode.

The Configuration Manager is an additional program that acts as if it is actual
hardware. The “hardware” can be configured. 

The  Perception offline setup mode is a program mode that allows you to
communicate with the “simulated” hardware in the Configuration Manager
instead of the actual hardware. Perception ‘knows’ it is in offline mode and will
make the required communication changes accordingly without influencing the
normal operation of the software.

The hardware configuration for use with this mode is stored:

l automatically with each experiment when starting a recording as part of
the .pnrf file,

l when saving a Virtual Workbench as part of the .pVWB file,
l manually when required in an .pOfflineConfig file.

Although the file is created from within Perception, the file itself is not used by
Perception. When required Perception uses information stored in the settings
sheet.

The offline setup mode / Configuration Manager:

l does not allow you to make recordings,
l does not allow you to load recordings,
l supports most of the GEN DAQ products configurations.
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Note The offline configuration file is an exact copy of your hardware, including
mainframe capabilities, options, cards installed, IP address, etc. It is therefore
unique to a specific setup. Not all hardware* is supported within offline setup,
so some of the hardware* may not be shown in offline mode.
 
* Hardware used, depending on the Perception version.
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C.2 Creating offline configuration information
As mentioned earlier, offline confitguration information is created automatically
when saving experiments and virtual workbenches.

To save offline configuration information in a blank PNRF file: 

1 Open a new experiment, see "Set up new blank experiment" on
page 334.

2 Connect to hardware, see "Add and remove a data acquisition system" on
page 82.

3 Make a recording.
4 Save the experiment, see "Save" on page 339.

You can save the offline configuration any time in a separate file.

To save the configuration for offline use:

1 Do one of the following:
l Select File ► Save Configuration for Offline Use...
l In the Hardware Navigator do a right-click to call up the context menu.

In the context menu click Save Configuration for Offline Use...
2 In the Save Offline Configuration dialog that comes up select the file you

want to save into/ replace or type a name for a new file.
3 Click Save.

Once you have saved a configuration you can use it together with the
Configuration Manager.
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C.3 Configuration Manager
The Configuration Manager is a separate application.

To start the Configuration Manager:

l Choose Start ► All Programs ► HBM ► Perception ► Configuration
Manager.
l The application will start with an empty work area.

Before you can start using the application you must load a saved configuration
file.

To open a saved configuration: 

1 In the File menu click Open...
2 In the Open Offline Configuration File dialog that comes up select your file

type if required:
l Configuration file *.pOfflineConfig
l Virtual Workbench *.pVWB
l Experiment *.pnrf

3 Select the file you want to load.
4 Click Open.
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Figure C.1: Configuration Manager - example

A Menus The menus in the menu bar contain commands for performing
tasks.

B Mainframe You can have multiple mainframes in a configuration. Both
Tower and 19” rack mainframes are supported.

C Power button The power button can be used to switch on/off the main-
frame.

D Master/Sync card Actual position of this card depends on mainframe
type.

E Interface card The interface card includes the actual installed options like
GPS, IRIG, SCSI interface when installed.

F Empty slot Slot(s) not occupied by interface or acquisition cards.
G Acquisition cards The acquisition cards represent the actual installed

cards. When you hover with the mouse over a card, a tooltip comes up
with a short description of the installed card.

H Work area Empty area for mainframes.
I Title bar [mainframe name] Indicates the currently selected mainframe.
J Close button Mainframe remove button.
K Title bar [file name] Name of the offline configuration file.
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C.3.1 Moving mainframes
Within an offline configuration there can be one or more mainframes. You can
remove, import and export mainframes and save (new) configuration files.

To save a configuration file:

1 In the File menu click Save As....
2 In the Save Offline Configuration File dialog that comes up select the file

you want to replace or type a name for a new file.
3 Click Save.

Various commands operate on the currently selected mainframe.

To select or deselect a mainframe:

To select or deselect a mainframe do one of the following:

l Click on the mainframe you want to select.
l Click the Mainframe menu. In the menu that comes up click the mainframe

name. The selected mainframe is denoted with a check mark.

You can remove a mainframe from the current configuration to create a new
configuration.

To remove a mainframe:

l Select File ► Remove Mainframe.
l Click the mainframe Close button.

You can import individual mainframes from other configuration files to create a
custom configuration without the need to be connected to real hardware.

To import a mainframe:

1 Select File > Import Mainframe...
2 In the Import Offline Configuration File dialog that comes up select the file

you want to import.
3 Click Open.

You can also export individual mainframes into a configuration file for later use.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 527



To export a single mainframe:

1 Select the mainframe you want to export.
2 Select File ► Export Mainframe....
3 In the Export Offline Configuration File dialog that comes up select the file

you want to replace or type a name for a new file.
4 Click Save.

C.3.2 Using mainframes
You can use mainframe(s) by switching on the power.

To switch on the power of a mainframe:

Do one of the following:

l Click the power button on the mainframe.
l Select Power ► Power On All to switch on the power of all mainframes.
l Select Power ► Power On ►  . In the sub menu that comes up select the

individual mainframe you want to switch on.

After switching on a mainframe, the mainframe display will show start up
messages.

To switch off the power of a mainframe:

Do one of the following:

l Click the power button on the mainframe that is on.
l Select Power ►Power Off All to switch off the power of all mainframes.
l Select Power ► Power Off ► . In the sub menu that comes up select the

individual mainframe you want to switch off.
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C.3.3 Miscellaneous configuration commands
To open a recently used file:

l Select File ► Recent opened files ► . In the submenu that comes up select
the file you want to use.

To exit the Configuration Manager:

l Select File ► Exit to quit the application.

For more information:

l Select Help ► About to see additional information about the application.
l Click the More... button to get a list of installed software modules and

their version number.
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C.4 Perception offline setup mode

To start Perception in offline mode:

l Choose Start ► All Programs ► HBM ► Perception ► Perception
Offline.

Once Perception is started, the offline setup mode is also noted in the right-
hand corner of the status bar at the bottom of the application:

Figure C.2: Status bar (detail)

C.4.1 Using the offline setup mode
To use the Perception offline setup mode you must:

l Start Perception in offline setup mode as described in the previous section.
l Start the Configuration Manager with the correct setup as described in

"Configuration Manager" on page 525.
l Switch on the mainframes as described in "Using mainframes" on

page 528.

At this point you can operate Perception as usual: create display setups,
reports, modify settings, etc., and save all this as a Virtual Workbench.

When you are not in offline setup mode you can use this Virtual Workbench for
normal operation: it will connect to the actual hardware as usual with all the
settings and modifications you have made earlier to this workbench.

To load a mainframe in offline setup mode:

To load a mainframe when in offline setup mode from the Configuration
Manager:

1 Start the Configuration Manager with the correct setup as described in
"Configuration Manager" on page 525.

2 Switch on the mainframes as described in "Using mainframes" on
page 528.
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3 In Perception call up the Hardware Navigator. Because you are in offline
setup mode, only hardware that is available through the Configuration
Manager is displayed in a new tree “Offline Hardware”:

Figure C.3: Hardware navigator

4 Proceed as usual (refer to"Add and remove a data acquisition system" on
page 82 for details).
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C.5 Hints, tips and techniques
This section gives additional information on the Perception offline setup mode.

C.5.1 Limitations
When using the offline mode you cannot:

l use real hardware,
l make actual recordings,
l open recordings.

Note Not all hardware is usable in the offline configuration tool. Below is a list of
hardware that will typically work when using offline configuration:

Mainframes:

● GEN7t Transient Recorder and Data Acquisition System
● GEN16t Transient Recorder and Data Acquisition System
● GEN5i Portable Data Recorder
● GEN2i Portable Data Recorder

Note If the mainframe has an IM2 module, some mainframe features will not show
up in the offline configurator.

Acquisition cards:

● 1-GN410-2 GEN series GN410 Bridge ISO 200 kS/s Input Card
● 1-GN411-2 GEN series GN411 Bridge ISO 1 MS/s Input Card
● 1-GN412-2 GEN series GN412 Differential 100 MS/s Input Card
● 1-GN413-2 GEN series GN413 Differential 25 MS/s Input Card
● 1-GN440-2 GEN series GN440 Universal ISO 200 kS/s Input Card
● 1-GN441-2 GEN series GN441 Universal ISO 1 MS/s Input Card
● 1-GN810-2 GEN series GN810 Basic 200 kS/s Input Card
● 1-GN811-2 GEN series GN811 Basic 1 MS/s Input Card
● 1-GN812-2 GEN series GN812 Basic ISO 1 MS/s Input Card
● 1-GN813-2 GEN series GN813 Basic XT ISO 1 MS/s Input Card
● 1-GN814-2 GEN series GN814 Basic XT ISO 200kS/s Input Card
● 1-GN1610 GEN series GN1610 Basic/IEPE/Charge 250 kS/s 16 chanel

Input Card
● 1-GN3210 GEN series GN3210 Basic/IEPE/Charge 250 kS/s 32

channel Input Card
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● 1-GN3211 GEN series GN3211 Basic/IEPE/Charge 20 kS/s 32 channel
Input Card

● 1-GN4070-2 GEN series GN4070 Binary marker HV Input Card
● 1-GN6470-2 GEN series GN6470 Binary Marker Input Card

C.5.2 Perception without a key
The Perception software requires a HASP key.  HASP (Hardware Against
Software Piracy) is a hardware-based (hardware key) software copy protection
system that prevents unauthorized use of software applications. You must have
the HASP®4 USB Token installed in a USB port before you can run the
software.

However, you can use Perception without a key in offline setup mode. When
you start Perception without a key automatically the software is launched in
offline setup mode and you can use it to create Virtual Workbenches based on
a loaded configuration file in the Configuration Manager.
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D Settings Sheet Reference
D.1 Settings Sheet – Introduction

The settings sheet provides a spreadsheet-style user interface combined with
graphical user interface elements to access all hardware-related settings. If a
hardware setting cannot be found here, it does not exist.

The settings sheet uses two important concepts:

1 It shows only those settings that are physically available to you with the
currently connected hardware.

2 By itself the settings sheet does not have “intelligence”. All capabilities and
settings are “fetched” from the hardware. When a modification is made, the
modification is sent to the firmware that controls the hardware, verified,
maybe modified by the firmware to comply with physical limits, and sent
back to the software. This concept allows for connection of a great variety
of hardware. Also new hardware, now and in the future, can be connected
to the software without software modifications or installation of additional
software modules.
 
The layout of the settings sheet is designed to provide an efficient interface
that allows for quick modification of hardware settings of the connected
acquisition systems. Features are implemented to modify settings of large
systems equally simple as those of smaller systems.
 
On the left-hand side of the settings sheet there is a task pane. In this task
pane the settings are combined into logical groups for easy reference. Use
this task pane as a “table of contents” to select a specific settings section,
for example the input settings of all basic channels.
 
The actual settings matrix is based on channel/recorder/group rows and
setting columns:

l Each column provides access to a single setting.
l Each row represents a channel:

  ○ Channels can be combined into a recorder.
  ○ Recorders can be combined into groups.

Modifications made on a certain level are applied to all lower levels, for example
a settings change in a recorder row will affect all channels of this recorder. You
can select if you want to use the groups and recorder levels. For more details
on how to use the settings sheet refer to the appropriate section in the manual.
This part of the manual focuses on the details of the specific settings.

Important: Please note that all available settings within all supported hardware
components are listed here, although not all may apply to your situation.
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D.1.1 Conventions
Throughout this section of the manual, text written in bold refers to topics that
you can find by that name in the settings sheet. Text written in italics refers to
an actual setting. Example: You can set the Sync source in the Mainframe
section to RTC, GPS or IRIG.

If a setting is Read-Only, you cannot modify this setting. This is indicated by an
(RO) note after the name of the setting. Example: Type (RO).

As mentioned in section "Settings Sheet Layout", the settings sheet has two
viewing modes: basic and advanced. In this section the basic settings are
described first, followed by the advanced settings if available.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 535



D.2 General group

D.2.1 Introduction
The General group within the settings sheet comprises global settings and
selections of the connected hardware. Here you can find common settings
related to mainframes and recorders. In addition, general channel settings
are located here. These types of settings include channel type information,
usage and channel mode settings.

D.2.2 Mainframe

Introduction
A mainframe is a physical housing that provides the power, holds an interface
unit for communication and data transfer, one or more acquisition cards and
miscellaneous hardware. Typically an acquisition card holds one recorder.
Communication is performed through a local area network. A mainframe has
its own network address (IP address).

For each mainframe in your data acquisition system you typically set up the
logical name, timing and synchronization constraints as well as communication
parameters.

Detailed timing settings can be found in the Mainframe section of the Memory
and Time base group (on page 574).

 

Basic settings

External trigger in direction

Summary
Sets the edge sensitivity of the external trigger input.

Description
If External trigger in is enabled, this setting generates a trigger on the recorder
whenever the external trigger signal has the specified direction.
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External trigger out

Summary
Sends the internal recorder trigger to the external trigger output on the
mainframe.

Description
The recorder’s trigger detector output is directed to the mainframe’s external
trigger output connector.

Although this is a per-recorder setting, there is only one external trigger output
for the complete mainframe. Each individual recorder can be set to produce an
external output trigger.

However, a level setting (if provided by the hardware) is mainframe-wide and
cannot be set on a per-recorder basis.

 

Name

Summary
Logical name of mainframe.

Description
This is the name of the mainframe as used throughout Perception . It is not the
“physical” or “network” name of the mainframe that identifies it on the network.
Editing the network name is possible from the mainframe, please refer to your
hardware manual for more information on how to do this.

The logical name is also used in hardware-related data sources such as fan
speeds, temperatures and similar information. These data sources may be
used in features such as system monitoring, reporting or formula database.

You can also find the name setting in the hardware tree where it identifies your
hardware.
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Storage location

Summary
Storage location for streaming data.

Description
The storage location indicates the physical location where recording data will
be stored. When choosing mainframe storage the recording data will be stored
to a device physically attached to or inside the mainframe such as a SCSI disk
or memory card. PC storage will record data to the PC hard drive or a network
location. To find out how to configure the exact location on the network or hard
drive please refer to the appropriate section of this manual.

 

Sync source

Summary
Defines the source used for the actual time synchronization in a mainframe.

Description
The synchronization source is used to synchronize recordings within
recordings with the mainframe. The internal clock (RTC) of a system is
synchronized with the PC time every time Perception connects to the system.
Time Zone Correction is also applied. This correction is added to the source's
UTC time when “local time” is requested.

When working with multiple mainframes, the internal clocks of the mainframes
may differ. Even if initially set accurately, real clocks will differ after some time
due to clock drift, caused by clocks counting time at slightly different rates. To
solve this issue in a multiple mainframe setup, it is possible to use global
synchronization sources like IRIG and GPS.

The most common synchronization sources are RTC (internal clock), IRIG,
GPS and PTP.

For detailed information on IRIG, GPS and PTP consult your hardware manual.
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Master/Sync mode

Summary
Defines the system’s role in a Master/Sync configuration.

Description
Defines whether or not the system is part of a Master/Sync configuration and
if yes, which role it has in this setup.

Master/Sync is a model for a communication protocol where one system has
unidirectional control over one or more other systems. Once a Master/Sync
relationship between systems is established, the direction of control is always
from the master to the slaves.

The most common modes are Master, Sync and Stand-Alone.

For details on Master/Sync operation refer to the separate manual that came
with your Master/Sync hardware option.
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Advanced settings

Auto charge

Summary
When turned ON the battery will be charged when connected to the main power
supply.

Description
If the main power supply is connected to the system and the Auto Charge option
is turned ON, the system will automatically charge the battery/batteries until
full. When full the system will perform trickle charging to keep the battery/
batteries full.

 

Auto power

Summary
When turned ON the system will switch to main power supply when connected.

Description
When the Auto Power option is turned ON and the main power supply is
connected to the system, the system will run on the power directly received
from the connected external power supply instead of the internal power supply
(battery).

 

External Trigger In Minimum Pulse Width

Summary
Filter spikes from digital signals.
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External Trigger In Minimum Pulse Width

Description
The minimum pulse width can be used to filter the input signal from high-
frequency noise. If the input has some noises/signals which contain higher
frequencies (or shorter pulse widths) than the used filter time, the system filters
out these values.

The best filter time setting is application dependent if the test environment
introduces signal spikes on the measurement though electrical or magnetic
disturbances AND the pulses that should be detected are wide enough. The
noise can be filtered out by selecting a filter time value larger than the typical
spike width but shorter than the expected valid pulse width.

For example, if a 1 kHz signal with 100 kHz noise is applied, adjusting the filter
time to 10 µs is the best choice.

The default setting is 0.5 µs. This will basically not filter based on pulse width.

The table below shows the different characteristics for each setting of the input
filter.

Selections
Filter Time (µs)1 Min detected pulse width (µs)1

0.5 > 0.40
1 > 0.90
2 > 1.90
5 > 4.90
10 > 9.90

(1) The character of the setting is shown in the table. According to the table,
if the filter time is set on 1 µs, the input signal with the pulse width of
0.8 µs cannot be detected. However, there is a tolerance on the setting so
for example, the input signal with the pulse width of 0.95 µs (or larger than
0.91 µs) can be detected. This is illustrated below.
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Pulse Width Setting: 1 µs

Input

Output

(filtered)

Output

(Detected)

Input

0.8 µs

0.95 µs 0.95 µs

Figure D.1: Pulse width settings

Alarm out

Summary
Sets the function of the alarm output on the mainframe.

Description
Each channel has the capability of generating an alarm. The output of a
channel’s alarm detector is sent to an alarm line and combined (OR-ed) with
alarm conditions of the other channels and recorders. The result is available
as an external output located on the mainframe controller.

This setting can have one of the values Alarm High Level, Alarm Low Level, or
Recording High Level. When Recording High Level is selected, the output
connector on the controller is high when a recording is in process. When Alarm
High Level is selected, the output is high when channel alarm detectors activate
on the alarm line. When Alarm Low Level is selected, the output is low when
the alarm line level is active; the signal is therefore the inverse of the previous
setting.

 

Trigger Out delay

Summary
The delay between the actual trigger event and the pulse on the External
Trigger output can be controlled by means of the Trigger Delay setting.
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Trigger Out delay

Description
This value defaults to 516 µs for compatibility reasons. Reducing the delay is
especially useful when the External Trigger output controls external equipment
like a high-speed camera.

Note Use the lower case character “u” for “µ” and do not type the “s”, e.g. type
“300 u” for 300 microseconds. Enter “0” to select the lowest possible delay.
Enter “1” to select the highest value again.

External startmode

Summary
Enables the possibility to initiate a start of the acquisition through an external
signal.

Description
When the external start setting is turned on and a signal is applied to the
external start pin, a new acquisition is started. If the acquisition is already
running, nothing will happen. This allows automated start of the data acquisition
system in a larger measurement system.

Note This option is only available if supported by the mainframe. See the GEN DAQ
hardware manual for details.

Note For more detailed information on hardware connection, signals and pinning;
refer to the GEN DAQ hardware manual. 

 

External Start Minimum Pulse Width

Summary
Filter spikes from digital signals.
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External Start Minimum Pulse Width

Description
The minimum pulse width can be used to filter the input signal from high-
frequency noise. If the input has some noises/signals which contain higher
frequencies (or shorter pulse widths) than the used filter time, the system filters
out these values.

The best filter time setting is application dependent if the test environment
introduces signal spikes on the measurement though electrical or magnetic
disturbances AND the pulses that should be detected are wide enough. The
noise can be filtered out by selecting a filter time value larger than the typical
spike width but shorter than the expected valid pulse width.

For example, if a 1 kHz signal with 100 kHz noise is applied, adjusting the filter
time to 10 µs is the best choice.

The default setting is 0.5 µs. This will basically not filter based on pulse width.

The table below shows the different characteristics for each setting of the input
filter.

Selections
Filter Time (µs)1 Min detected pulse width (µs)1

0.5 > 0.40
1 > 0.90
2 > 1.90
5 > 4.90
10 > 9.90

(1) The character of the setting is shown in the table. According to the table,
if the filter time is set on 1 µs, the input signal with the pulse width of
0.8 µs cannot be detected. However, there is a tolerance on the setting so
for example, the input signal with the pulse width of 0.95 µs (or larger than
0.91 µs) can be detected. This is illustrated below.
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Pulse Width Setting: 1 µs

Input

Output

(filtered)

Output

(Detected)

Input

0.8 µs

0.95 µs 0.95 µs

Figure D.2: Pulse width settings

External stopmode

Summary
Enables the possibility to initiate a stop of the acquisition through an external
signal.

Description
When the external stop setting is turned on and a signal is applied to the stop
pin and an acquisition is running, the acquisition will be stopped. If no
acquisition is running, nothing will happen. This allows automated stop of the
data acquisition system in a larger measurement system.

Note This option is only available if supported by the mainframe. See the GEN DAQ
hardware manual for details.

Note For more detailed information on hardware connection, signals and pinning;
refer to the GEN DAQ hardware manual. 

External Stop Minimum Pulse Width

Summary
Filter spikes from digital signals.
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External Stop Minimum Pulse Width

Description
The minimum pulse width can be used to filter the input signal from high-
frequency noise. If the input has some noises/signals which contain higher
frequencies (or shorter pulse widths) than the used filter time, the system filters
out these values.

The best filter time setting is application dependent if the test environment
introduces signal spikes on the measurement though electrical or magnetic
disturbances AND the pulses that should be detected are wide enough. The
noise can be filtered out by selecting a filter time value larger than the typical
spike width but shorter than the expected valid pulse width.

For example, if a 1 kHz signal with 100 kHz noise is applied, adjusting the filter
time to 10 µs is the best choice.

The default setting is 0.5 µs. This will basically not filter based on pulse width.

The table below shows the different characteristics for each setting of the input
filter.

Selections
Filter Time (µs)1 Min detected pulse width (µs)1

0.5 > 0.40
1 > 0.90
2 > 1.90
5 > 4.90
10 > 9.90

(1) The character of the setting is shown in the table. According to the table,
if the filter time is set on 1 µs, the input signal with the pulse width of
0.8 µs cannot be detected. However, there is a tolerance on the setting so
for example, the input signal with the pulse width of 0.95 µs (or larger than
0.91 µs) can be detected. This is illustrated below.
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Pulse Width Setting: 1 µs

Input

Output

(filtered)

Output

(Detected)

Input

0.8 µs

0.95 µs 0.95 µs

Figure D.3: Pulse width settings

PTP Master MAC‐address

Summary
Shows the MAC‐address of the PTP master.

Description
When the sync source is set to PTP this field becomes relevant.
The MAC‐address of the best PTP master is shown here. This could be another
PTP (grand) master or the mainframe itself. The value “00‐00‐00‐00‐00‐00” is
shown while doing an initial PTP master search.
Events that may occur while synched with a PTP master:
l A better PTP master is found

This better PTP master is used, and its MAC‐address will be shown
l PTP master lost

The mainframe searches for the best PTP master and uses this. This could
mean either another mainframe or the mainframe itself.

During changing of PTP masters, the old known MAC‐address will be shown
but the status will be “out-of‐sync”.

The mainframe also monitors the synchronization interval of the PTP master.
For best sync accuracy a GHS system requires this update rate to be at least
once per second. If the PTP master fails to meet this requirement a notification
is shown in Perception. An interval greater than once a second significantly
reduces the PTP synchronization accuracy and may even cause mainframes
to loose PTP clock synchronization.
 
A GHS system acting as master uses an update rate of once per second.
 
Note
This option is only available if supported by the mainframe. See the GEN DAQ
hardware manual for details and detailed PTP explanation.
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PTP Role

Summary
Shows the assigned role of the mainframe in a PTP setup.

Description
When the sync source is set to PTP this field becomes relevant.

The PTP master selection process assigns roles to all participants. Only one
participant will be selected as master.

This field can have the following values:

l None: The PTP master selection process is ongoing.
l Master: The master selection process has assigned this mainframe the

role ‘Master’. The “PTP Master MAC‐address” now indicates the MAC‐
address of the mainframe.

l Slave: The master selection process has assigned this mainframe the role
‘slave’. The “PTP Master MAC‐address” now indicates the MAC‐address
of the used PTP Master.

Note
This option is only available if supported by the mainframe. See the GEN DAQ
hardware manual for details and detailed PTP explanation.

PTP Tolerance

Summary
Select the maximum allowed deviation between the mainframe and PTP
master before an “out‐of‐sync” will be reported.
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PTP Tolerance

Description
When the sync source is set to PTP this field becomes relevant.

The PTP Tolerance indicates the maximum allowed deviation between the time
from the PTP master and the internal mainframe time. If the deviation exceeds
the given PTP tolerance, the sync status will go to ‘sync lost’ and if a recording
is in progress, a timemarker is added to the recording.

Note
This option is only available if supported by the mainframe. See the GEN DAQ
hardware manual for details and detailed PTP explanation.

Use Accurate Master

Summary
When ON, a warning will be shown if the master found is not an accurate
master.

Description
PTP clocks have a clock class indicating the accuracy. The clock class is an
assigned number in the range of 0 to 255. The lowest number has the highest
accuracy. Commercial available grandmasters normally have clock class 6.
This means that the time source is traceable to a primary source (e.g. GPS ).
When enabled this option means that if a master with clock class 8 or higher
is found, a warning will be shown. Also recordings made in with a clock
class 8 master clock and accurate master setting enabled will receive a mark
indicating that no accurate master was used.

This option means that only a master with clock class 7 or better will be
accepted as master in the master selection process.

Note
This option is only available if supported by the mainframe. See the GEN DAQ
hardware manual for details and detailed PTP explanation.
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PTP Delay Method

Summary
Indicates the delay method for the PTP signal.

Description
HBM systems are designed to work with End-to-End Two‐Step PTP protocol
only. This End-to-End protocol measures and compensates the delay between
the mainframe to the PTP master, including PTP aware switches.

Next to this “End-to-End” protocol there is also the “Peer-to-Peer” protocol. In
this protocol each PTP aware device in the chain between PTP master and
mainframe does its own time delay compensation. This protocol reduces the
load on the PTP master for correcting different delays for different mainframes
behind different PTP aware devices when using the “End-to-End” protocol. This
also means each device needs to be setup for this “Peer-to-Peer” protocol. As
explained earlier: The HBM systems currently do not support this protocol.

Note
This option is only available if supported by the mainframe. See the GEN DAQ
hardware manual for details and detailed PTP explanation.

Clock Class

Summary
Indicates the clock class of the master clock used by the mainframe.
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Clock Class

Description
This is the clock class used to determine if the master clock is an accurate
master when the Use Accurate Master setting is enabled.
Most important clock classes to be aware of are:

l Clock class 6 designates a clock that is synchronized to a primary
reference time source(1). A clock class 6 clock shall not be a slave to anther
clock in the domain.

l Clock class 7 designates a clock that was previously clock class 6 but that
has lost the ability to synchronize with its primary reference time source.
A clock class 6 clock shall not be a slave to anther clock in the domain.

l Clock class 248 is the default clock class.
l Clock class 255 is a clock class for slave only clocks.

Note
The clock class, combined with the clock accuracy defines the overall quality
of a PTP Clock in the PTPv2 protocol. The overall quality is used in the best
master clock protocol to select the best clock in the PTP network.
Note
This option is only available if supported by the mainframe. See the GEN DAQ
hardware manual for details and detailed PTP explanation.

(1) Examples (but not limited to) of primary reference time sources are GPS
and IRIG.

Accurate Clock Status

Summary
Indicates if the current master clock is or is not an accurate clock.
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Accurate Clock Status

Description
Based on the master clocks’ class it is determined if the master clock is an
accurate master clock. The evaluation may result, in the following three states:

l Unknown: The clock class of the master clock could not be determined. It
is uncertain if the current clock is an accurate clock.

l Not found: The currently selected master clock is not an accurate master
clock.

l Found: The currently selected master clock is an accurate master clock.

Note
This option is only available if supported by the mainframe. See the GEN DAQ
hardware manual for details and detailed PTP explanation.

D.2.3 Recorder

Introduction
A recorder consists of a number of acquisition channels that share the same
basic recording parameters, sample rate, sweep length and pre- and post-
trigger length. Usually a single recorder is physically identical to a single
acquisition card. Multiple recorders can be placed in a single mainframe.

The recorder acquisition parameters can be found in the Time base groups
section of the Memory and Time base group (on page 581).

Note The acquisition parameters of all recorders in a group will be the same. If
different settings are required, move recorders into different groups.

 

Basic settings

Name

Summary
Logical name of the recorder.
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Name

Description
This is the name of the recorder as used throughout Perception . It is not a
“physical” name.

The logical name is used in the data sources navigator and is used for the
display, formula database, reporting, etc.

Note
If a recorder with the same name already exists in the group, that recorder will
be automatically renamed to a unique name. Two recorders with the same
name cannot exist in the same group.

 

Enabled

Summary
When ON the recorder can be used for acquisition and data storage.

Description
To increase performance, usability and system overview it is possible to turn
off those parts of your system that you do not use during a certain experiment.
Powering off unused hardware will also limit the amount of storage space
required.

 

Groups

Summary
Shows the group that the recorder is in and allows the group to be changed.
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Groups

Description
Recorders are grouped together based on their capabilities. The time base
settings, such as the sampling rate, sweep/continuous and related settings,
are the same for all recorders in a group. This allows the system to be set up
much more quickly, since the settings are applied to all recorders within the
group. The groups setting allows the groups to be changed in the settings
sheet.

 

Type

Summary
Shows the type of the recorder.

Description
The type of the recorder provides information on what type of recorder is in
which slot of the mainframe. This setting is informational only.

 

Resolution

Summary
This is the resolution of the recorder.

Description
The resolution of the samples from a recorder depend on the hardware
capabilities of that recorder. Some recorders support both 16 and 24 bit
resolution. 24 bit resolution is more precise, but it also doubles the bandwidth
and storage usage. Some features of a card may be only available at a specific
resolution.

Note
Detailed information about precision and card-specific features are available
in the GEN DAQ manual or card specification sheet.
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Advanced settings

Output 1

Summary
Allows signal out for certain events in the acquisition.

Description
To allow the data acquisition system to be integrated into a larger measurement
system or to monitor the data acquision system, signals can be generated for
certain events during the acquisition. The signal is raised on the pin assigned
to output 1.

Note
This option is only available if supported by the mainframe AND the recorder.
See the GEN DAQ hardware manual for details.
Note
For more detailed information about hardware connection, signals and pinning,
see the GEN DAQ hardware manual.

 

Output 2

Summary
Allows signal out for certain events in the acquisition.

Description
To allow the data acquisition system to be integrated into a larger measurement
system or to monitor the data acquision system, signals can be generated for
certain events during the acquisition. The signal is raised on the pin assigned
to output 2.

Note
This option is only available if supported by the mainframe AND the recorder.
See the GEN DAQ hardware manual for details.
Note
For more detailed information about hardware connection, signals and pinning,
see the GEN DAQ hardware manual.
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External start/stop enabled

Summary
Enables an acquisition start/stop to be initiated by an external signal.

Description
When the external start/stop setting is turned on and a signal is applied to the
external start pin, a new acquisition is started. If the acquisition is already
running, nothing will happen. If a signal is applied to the stop pin and an
acquisition is running, the acquisition will be stopped. This allows the data
acquisition system to start/stop automatically in a larger measurement system.

Note
This option is only available if supported by the mainframe AND the recorder.
See the GEN DAQ hardware manual for details.
Note
For more detailed information about hardware connection, signals and pinning,
see the GEN DAQ hardware manual.
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D.2.4 Analog channel

Introduction
An analog channel is any channel that converts instantaneous values of a
signal – that represents a physical phenomenon – into numeric values using
digitizing. Digitizing is done by means of an A-to-D converter.

In this section you can set the global parameters. You can also set the Amplifier
mode for channels that support multiple input configurations.

Detailed settings of an analog input channel can be found in the related section
of the Input group.

 

Basic settings

Name

Summary
Logical name of the channel.

Description
This is the name of the channel as used throughout Perception . It is not a
“physical” name.

The logical name is used in the data sources navigator and is used for the
display, formula database, reporting, etc.

Note
If a channel with the same name already exists in the recorder, that channel
will be automatically renamed to a unique name. Two channels with the same
name cannot exist in the same recorder.

 

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 557



Type (RO)

Summary
Channel type

Description
The channel type is a read-only property and describes what kind of channel
it is. For example, the channel type can be GEN series 100MS/s Fiber Amp.
The type of the channel is determined by the acquisition cards which are used.

Sensor

Summary
Sensor connected to the channel. Selecting a sensor will automatically setup
the channel using information from the sensor database.

Description
When acquiring data, sensors are used to convert physically changing
phenomena to measurable signals. To properly record this data, the acquisition
system must be correctly configured. This can be achieved by manually
entering the information in the relevant fields in the settings sheet, but an easy
and less error-prone alternative is to use the sensor database. By selecting the
correct sensor all relevant settings are automatically set.

Note
This column is only available with the sensor database option, sensors for all
available amplifier modes are available.

 

Amplifier mode

Summary
Switch between various modes if available. Selected type is reflected in
Input group.
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Amplifier mode

Description
Most channels can only be used in one amplifier mode; this mode is described
as “basic” mode. However, there are also channels which support different
modes like the bridge amplifier. This amplifier can work in basic mode, basic
sensor mode and in bridge mode.

Once a type has been set, you can find the detailed settings of the selected
type of input in the Input group.

 

Color

Summary
Default trace color in displays.

Description
When recorded data from this calculator is displayed, the default trace color is
defined by this setting. The trace color can always be changed via the display
trace properties.

 

Storage

Summary
When ON the channel is enabled for data storage.

Description
The storage setting determines whether or not the data of this channel will be
stored during a recording.
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Out enabled

Summary
Enables analog output signal on mainframe front panel of remote front-end
channel.

Description
When working with a fiber optic isolated digitizing front-end it is possible to
enable an analog output signal on the mainframe front panel. This signal is
equivalent to the measured signal at the front-end.

 

Power enabled

Summary
Enables remote front-end channel to be switched on.

Description
When working with a fiber optic isolated digitizing front-end it is possible to
switch the power at the front-end on or off under software control. By switching
the power off, the operating time of the front-end before recharging will be
extended.

 

Power status (RO)

Summary
Power status of remote front-end channel.

Description
When working with a fiber optic isolated digitizing front-end this field displays
status information from the front-end channel.

Typical power status values are: “Power Off”, “No Signal”, “Warming Up” and
“Power OK”.
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Advanced settings

Capacitance

Summary
This is the capacitance range of the channel.
 

Description
The capacitance of a channel can be off interest when using certain sensors.
Some sensors depend on the acquisition systems capacitance for proper
operation.

 

Note 1

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.
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Advanced settings

Note 2

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.

 

Note 3

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.
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Note 4

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.

 

D.2.5 Marker (Events)

Introduction
As opposed to an analog channel, Marker (Events) channels only register two
levels of information: on and off, high and low, or open and close. This
information is represented on the inputs as a “low” voltage (typically < 1 V) and
a “high” voltage (typically > 2 V). Each channel basically provides 1-bit internal
information, in contrast to the typical 16-bit data from an analog channel.

Detailed settings can be found in the Marker (Events) section of the Input
group (on page 645).

Basic settings

Name

Summary
Logical name of the channel.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 563



Name

Description
This is the name of the channel as used throughout Perception . It is not a
“physical” name.

The logical name is used in the data sources navigator and is used for the
display, formula database, reporting, etc.

Note
If a channel with the same name already exists in the recorder, that channel
will be automatically renamed to a unique name. Two channels with the same
name cannot exist in the same recorder.

 

Color

Summary
Default trace color in displays.

Description
When recorded data from this calculator is displayed, the default trace color is
defined by this setting. The trace color can always be changed via the display
trace properties.

 

Storage

Summary
When ON the channel is enabled for data storage.

Description
The storage setting determines whether or not the data of this channel will be
stored during a recording.
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Technical unit high

Summary
Label for logical high level.

Description
A marker channel has only two different output values, logical low (0) or logical
high (1). With “Technical unit high” it is possible to link a label to the logical high
value. This label is shown as the Y value in a display when the marker channel
is displayed.

 

Technical unit low

Summary
Label for logical low level.

Description
A marker channel has only two different output values, logical low (0) or logical
high (1). With “Technical unit low” it is possible to link a label to the logical low
value. This label is shown as the Y value in a display when the marker channel
is displayed.

 

Note 1

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 565



Advanced settings

Note 2

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.

 

 

Note 3

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.
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Note 4

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.

 

 

D.2.6 Timer/Counter

Introduction
Timer/Counter channels are usually combined on a card that also provides
other digital functionality.

Typical capabilities include:

l Up/down counter
l Frequency/RPM measurement
l Position measurement

In this section you set the global parameters for the channels. Once storage is
enabled you can set the details in the Timer/Counter section of the Input
group.

Refer to your hardware manual to find details on capabilities and connections.
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Basic settings

Name

Summary
Logical name of the channel.

Description
This is the name of the channel as used throughout Perception . It is not a
“physical” name.

The logical name is used in the data sources navigator and is used for the
display, formula database, reporting, etc.

Note
If a channel with the same name already exists in the recorder, that channel
will be automatically renamed to a unique name. Two channels with the same
name cannot exist in the same recorder.

 

Color

Summary
Default trace color in displays.

Description
When recorded data from this calculator is displayed, the default trace color is
defined by this setting. The trace color can always be changed via the display
trace properties.

 

Storage

Summary
When ON the channel is enabled for data storage.
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Storage

Description
The storage setting determines whether or not the data of this channel will be
stored during a recording.

 

Note 1

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.

 

 

Advanced settings

Note 2

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.
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Note 3

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.

 

 

Note 4

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.

 

 

D.2.7 CAN-Bus

Introduction
CAN-Bus (Controller Area Network bus) is a rugged, digital serial bus designed
for industrial environments. Introduced by Bosch in the mid-1980s for in-vehicle
communications, it is used in myriad applications including factory automation,
building automation, aircraft and aerospace as well as in cars, trucks and buses.
CAN-Bus replaces bulky wiring harnesses with a two-wire differential cable.
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CAN-Bus uses a broadcast method for placing frames on the wire somewhat
similar to Ethernet. Bus distance is based on speed, ranging from a maximum
of 40 meters at 1 Mbps to a maximum of six kilometers at 10 Kbps. At speeds
up to 125 Kbps, CAN provides fault tolerance. If one of the two wires is cut or
shorted, the other keeps transmitting.

Currently CAN-Bus channels cannot be configured within Perception, an
external tool is required to do CAN-Bus setup, prior to connecting to the CAN-
Bus device in Perception.

Basic settings

Name

Summary
Logical name of the channel.

Description
This is the name of the channel as used throughout Perception . It is not a
“physical” name.

The logical name is used in the data sources navigator and is used for the
display, formula database, reporting, etc.

Note
If a channel with the same name already exists in the recorder, that channel
will be automatically renamed to a unique name. Two channels with the same
name cannot exist in the same recorder.

 

Color

Summary
Default trace color in displays.
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Color

Description
When recorded data from this calculator is displayed, the default trace color is
defined by this setting. The trace color can always be changed via the display
trace properties.

 

Storage

Summary
When ON the channel is enabled for data storage.

Description
The storage setting determines whether or not the data of this channel will be
stored during a recording.

 

Note 1

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.
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Advanced settings

Note 2

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.
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D.3 Memory and Time base group

D.3.1 Introduction
In the Perception software a difference is made between acquisition and
storage. Acquisition is the act of digitizing analog data and making it available
for monitoring or storage. Storage is the actual archiving of digitized data.
Recording (verb) is defined as acquisition + storage.

The acquisition of data is determined by a sample rate and an acquisition mode.

The storage mode defines how data that is digitized and acquired will be saved.
The continuous storage mode will always store data, regardless of the
acquisition mode. The sweeps storage mode will store only the sweeps,
regardless of the acquisition mode. However, the resulting file – or recording –
will be different for the various combinations of acquisition and storage mode.

To make all this possible, the Memory and Time base group allows you to set
the clock base or time base (for the sample rate) and the memory usage for the
storage modes. For more details on acquisition and storage modes refer to the
appropriate section in this manual.

D.3.2 Mainframe

Introduction
The time base is used as the basis for the digitizing sample rate. The mainframe
section of the Memory and Time base group allows you to select the source
of your time base. Typically you will have the option to select between (internal)
decimal, (internal) binary and external.

If external is selected, an externally applied signal is used to define the sample
rate and sample moments. For external time base a variety of options is
available to tailor the system to your needs.

If an internal base is selected, you can have a decimal base that gives you
“standard” sample rates, or a binary base. The binary clock base of the internal
time base in combination with the various division factors allow for a broad
range of sweep length values that meet FFT requirements.

More details about your system’s capabilities can be found in the related
hardware manual.
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Basic settings

Clock base

Summary
Sample rate basis

Description
The sample rate of the digitizer is determined by the clock base: The clock base
is a clock that generates pulses used to drive the A-to-D converter. You have
the following clock base options:

l Decimal or binary internall: If you select the internal clock base, the clock
used to drive the ADC is the built-in clock.

l External: If you select the external clock base, the clock used to drive the
ADC is the clock signal present at the external clock input.

The internal clock has two operating modes:

l Internal Clock Base Decimal: This setting is used to create clock base
values that are base 10, for example 1 MHz, 100 kHz, 50 kHz, 2.5 Hz, etc.
These values are derived from a main oscillator that operates at a base 10
frequency, for example 1 MHz.

l Internal Clock Base Binary: This setting is used to create clock base values
that are base 2, for example 1.024 MHz, 512 kHz, 64 Hz, etc. These values
are derived from a main oscillator that operates at a base 2 frequency, for
example 1.024 MHz.

Advanced settings

Unit

Summary
The X-units of the external clock signal.
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Unit

Description
A string representing the X-unit used for the connected external clock source.

This unit is returned if the X-unit of a data source is requested. Whereas “s” is
used for all internal clock base X-units, this unit is used for all external clock
X-units.

Unit scaling

Summary
The unit scaling factor of the external clock signal.

Description
This setting is one of the two settings that determine the scale result. The unit
scaling is the number of “units” that represents a number of clock pulses (=
Clock Scaling).

For example: If three pulses received from the external clock signal represent
eight “Units”, the Unit Scaling needs to be set to 8, and the Clock Scaling
needs to be set to 3.

 

Clock scaling

Summary
The clock scaling factor of the external clock signal.
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Clock scaling

Description
Clock scaling is the second setting that determines the scale result. The clock
scaling is the number of clock pulses that represents a number of “units” (=
Unit Scaling).

For example: If three pulses received from the external clock signal represent
eight “Units”, the Unit Scaling needs to be set to 8, and the Clock Scaling
needs to be set to 3.

 

Clock shift

Summary
The clock shift is the offset in X-scale applied after scaling.

Description
To determine the X-position of a sample while using external clock, the clock
shift is added to the result of multiplying the scale result by the pulse number
received from the connected external clock.

Otherwise stated:
X-Position = ((Unit Scaling/Clock Scaling) * External Clock Pulse number) +
Clock Shift

Example:
Unit Scaling : 1, Clock Scaling: 360, Clock Shift = 0.5.
Every pulse received from the external clock source is multiplied by a scale
result of 1/360 Unit. As there is a clock shift we need to add 180/360 (= 0.5)
to this. Result: First clock pulse received results in 181/360 Unit, second pulse
= 182/360 Unit, etc.
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External Clock Minimum Pulse Width

Summary
Filter spikes from digital signals.

Description
The minimum pulse width can be used to filter the input signal from high-
frequency noise. If the input has some noises/signals which contain higher
frequencies (or shorter pulse widths) than the used filter time, the system filters
out these values.

The best filter time setting is application dependent if the test environment
introduces signal spikes on the measurement though electrical or magnetic
disturbances AND the pulses that should be detected are wide enough. The
noise can be filtered out by selecting a filter time value larger than the typical
spike width but shorter than the expected valid pulse width.

For example, if a 1 kHz signal with 100 kHz noise is applied, adjusting the filter
time to 10 µs is the best choice.

The default setting is 0.1 µs. This will basically not filter based on pulse width.

The table below shows the different characteristics for each setting of the input
filter.

Selections
Filter Time (µs)1 Min detected pulse width (µs)1

0.1 (default setting) > 0.00
0.2 > 0.10
0.5 > 0.40
1 > 0.90
2 > 1.90
5 > 4.90
10 > 9.90
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(1) The character of the setting is shown in the table. According to the table,
if the filter time is set on 1 µs, the input signal with the pulse width of
0.8 µs cannot be detected. However, there is a tolerance on the setting so
for example, the input signal with the pulse width of 0.95 µs (or larger than
0.91 µs) can be detected. This is illustrated below.

Pulse Width Setting: 1 µs

Input

Output

(filtered)

Output

(Detected)

Input

0.8 µs

0.95 µs 0.95 µs

Figure D.4: Pulse width settings

TDC enable

Summary
If turned ON, an external signal is used to locate the Top Dead Center position.

Description
For rotation-based measurements it can be convenient to automatically shift
the horizontal annotation so that zero degrees in the annotation match with the
zero degrees position of the object under test. This is done by using an external
signal. The Nth pulse (TDC delay ) on this input is used to mark the 0:000.0
position. The Clock Shift can be used if the TDC detector is not positioned at
zero degrees.

 

TDC delay

Summary
Determines which external Top Dead Center signals should be skipped.
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TDC delay

Description
If TDC enable is ON, the Nth pulse on the TDC input is used for marking the
0:000.0 position. Because initially incorrect TDC pulses may occur, it is useful
to skip the first TDC signals received from the TDC detector before marking
the 0:000.0 position.

This setting determines the number of TDC detector signals that are skipped
before marking.

Use qualifier

Summary
If turned ON, the alarm is used as TDC qualifier.

Description
Use this option to disable the TDC detection as long as the Alarm is not active.
The required alarm settings can be found in the Alarm group. The system’s
alarm is used to “hold” the TDC detection as long as the alarm is not active.
When the alarm becomes active as defined by the settings in the Alarm group,
the TDC pulses are forwarded to the system.

 

Scale result

Summary
The scale result (factor) used to create the X-scaling.
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Scale result

Description
The scale result is constructed by dividing the unit scaling by the clock
scaling.

To determine the X-position of a sample this factor is multiplied with the pulse
number received from the connected external clock. This value is then added
to the Clock Shift and the X-position is known.

Otherwise stated:

X-Position = (Scale Result * External Clock Pulse number) + Clock Shift

D.3.3 Time base groups

Introduction
Within the Time base groups section of the Memory and Time base group you
set all parameters related to storage modes.

When data is stored, this data is organized in recordings. A recording (noun) is
defined as all data that has been stored between the start of acquisition (START
command) and the end of acquisition. The end can be defined in various ways.
A recording can have one or multiple sweeps, a continuous data stream or a
combination of both.

Refer to the hardware manual of your data acquisition system for more details
on available storage modes.

Basic settings

External clock divider

Summary
Reduction factor of the external clock rate.
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External clock divider

Description
This setting is available if the mainframe Clock base is set to External. In this
case the clock used to drive the ADC converter for the channels is the signal
present at the external clock input connector. This sample rate can be further
reduced using this value. The actual sample rate is the external clock divided
by the clock divider setting.

 

Slow sweep time base

Summary
The lower sample rate of the digitizer.

Description
For storage modes with two sample rates, this setting defines the number of
samples per second for the lower speed sweep. It is enabled when the Storage
mode is Slow-Fast Sweep.

 

Slow sweep trigger position

Summary
Sets the trigger position within the slow sweep.

Description
The trigger position within a sweep defines the amount of pre- and posttrigger
information to be stored. In the Slow-Fast Sweep storage mode, the low-speed
sweep uses the trigger of the high-speed sweep.

When set to zero the complete sweep contains posttrigger data. When set to
the sweep length the sweep contains all pre-trigger data.
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Slow sweep length

Summary
The total amount of data to be recorded for slow sweeps.

Description
This setting is enabled when the Storage mode is Slow-Fast Sweep. It sets
the number of samples that the slow-speed sweep will contain.

 

Fast sweep time base

Summary
Sets the main (high) sample rate of the recorder for digitizing.

Description
This setting defines the main (or high) sample rate of the recorder. The upper
limit is defined by the actual hardware in use.

 

Fast sweep mode

Summary
Defines how the data is stored.
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Fast sweep mode

Description
This setting is available if the Storage mode is Sweeps, Dual, or Slow-Fast
Sweep. The available sweep modes are Normal, Pre-Trigger, and Delayed:

l In Normal mode, the storage becomes active as soon as the trigger is
generated, and lasts for the length defined by the Fast sweep length
setting, and (optionally) the Slow sweep length if the selected Storage
mode is Slow-Fast Sweep.

l In Pre-Trigger mode, samples are stored before and after the sample
where the trigger is positioned. Therefore it is necessary to define the
whole sweep length and, in addition, the number of samples that will be
stored before the actual trigger position. These two settings are defined for
the fast-rate and (optionally) the slow-rate digitizer by:
(a) Fast sweep length and Fast sweep trigger position
(b) Slow sweep length and Slow sweep trigger position

l In Delayed mode a trigger is detected, the storage remains inactive for a
certain time, and then a full sweep is recorded. The delay is given in
number of samples by the Fast sweep trigger delay and (optionally) the
Slow sweep trigger delay setting.

 

Fast sweep trigger position

Summary
Sets the trigger position within the fast sweep.

Description
The trigger position within a sweep defines the amount of pre- and posttrigger
information to be stored. This setting is only available if the Fast sweep
mode is Pre-Trigger.

When set to zero the complete sweep contains posttrigger data. When set to
the sweep length the sweep contains all pre-trigger data.
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Fast sweep length

Summary
The total amount of data to be recorded for fast sweeps.

Description
This setting is enabled if the Storage mode is Sweeps, Dual or Slow-Fast
Sweep. It sets the number of samples that each recorded sweep will contain.

 

Fast sweeps

Summary
Number of sweeps to be acquired.

Description
If Fast sweep count enabled is ON, this setting allows the user to define a
specific number of sweeps to be recorded. The recording (acquisition +
storage) will stop automatically when all the sweeps have been processed.

 

Fast sweep count enabled

Summary
Enables multiple sweeps to be acquired within a single recording.

Description
This setting is available when the Storage mode is Sweeps or Dual.

Switch this option on to allow a recording to have a fixed number of sweeps
defined by the Fast sweeps setting. If this setting is switched off, a recording
will have an infinite number of sweeps, which means that it has to be stopped
manually.
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Continuous time base

Summary
The sample rate of the digitizer for continuous storage mode.

Description
If the Storage mode is set to Continuous or Dual, this sets the number of
samples per second that the digitizer (A-to-D converter) will convert.

 

Continuous mode

Summary
Defines how the data is stored in continuous mode.

Description
If the Storage mode is Continuous, this setting can take one of three possible
values: Standard, Circular Recording, or Stop On Trigger. It defines the precise
way of storing data to the controlling PC’s (or local) hard disk, as explained in
the manual of your data acquisition device.

l For the Standard mode, the user manually starts and stops the storage.
There are no other relevant settings to be set.

l For the Circular Recording mode, the Continuous length needs to be
defined before the user can manually start and stop the storage.

l For the Stop On Trigger mode, the Continuous lead-out needs to be
defined. The acquisition is started manually and stopped automatically
after the defined recording time once a trigger is detected.

l For the Specified time mode, the Continuous length needs to be defined.
The acquisition is started manually and stopped automatically after the
defined recording time.

 

Continuous length

Summary
The total amount of data to be recorded.
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Continuous length

Description
If the Continuous mode is set to Circular Recording, this is the storage buffer
size in time units. The samples stored for any acquisition time length never
exceed the number defined by this setting.

 

Continuous lead-out

Summary
Posttrigger segment of a continuous circular recording.

Description
Sets the length of data to be stored after the detection of a trigger on the
selected recorder when performing a continuous recording with the
Continuous mode set to Stop On Trigger. The data length is defined in time
units, which is equivalent to the number of samples divided by the sampling
rate.

Note
If Continuous lead-out > Continuous length, the Continuous length setting
is ignored.
This setting is similar to the posttrigger segment of a sweep, when performing
a sweep-based acquisition. The samples are now stored on PC hard disk
instead of volatile memory.

Advanced settings

Fast sweep trigger delay (Advanced)

Summary
Shifts the trigger position outside the sweep length.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 587



Fast sweep trigger delay (Advanced)

Description
This setting is enabled only if the Fast sweep mode is set to Delayed. When
a trigger is detected, the storage is set to start after the specified number of
samples. Thus, the recording is “postponed” for a time interval after trigger
generation, and only posttrigger information is recorded.

Fast sweep stretch (Advanced)

Summary
When a second trigger (transient event) is encountered during posttrigger data
collection, the triggered sweep is automatically extended to record the second
event completely including additional posttrigger data.

Description
The sweep stretch is a function of the fast sweep and available on the following
storage modes:

l Sweeps
l Dual: on the fast sweep

When OFF (disabled) the system operates as usual: upon each trigger event
it acquires the selected amount of pre-trigger and posttrigger data at the fast
time base rate. A fixed number of samples are acquired for each trigger, so all
sweeps are the same length.

When ON (enabled) the system operates as usual; however, additional triggers
detected during the posttrigger data collection are accepted and these restart
the posttrigger count. The fast sweep length is correspondingly "stretched" to
include the new trigger(s) and additional posttrigger data. Therefore there is
no predetermined limit on the length of a sweep, and each sweep may be a
different length depending on the number of triggers.

Note
When the system is in dual mode only the standard storage mode is supported
for the continuous data stream and not the circular or stop-on-trigger mode.
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D.4 Input group

D.4.1 Introduction
The Input group within the settings sheet comprises all data acquisition
channels that are currently available within your measurement system.
Channels that are not supported by your hardware are not included. However,
channels that are supported by your hardware, but not enabled, are displayed
as disabled (greyed).

Various channels within the acquisition hardware can be configured for multiple
purposes. To modify this you need to go to the General group where you can
select the operation mode of a specific channel if applicable.

For example there are analog channels that can be configured to be used as a
basic amplifier or as an accelerometer input. Both options will be displayed in
the Input group, but only the selected option is active, the other is disabled.

 

D.4.2 Basic-voltage 

Introduction
Of all input channels the basic-voltage input channel is the most straight-
forward. The basic-voltage input channel can either be a Single-Ended (SE)
input or a differential input.

Signal coupling (how the signal is fed into the amplifier) can either be AC or DC,
depending on your hardware. Input coupling (how the amplifier itself is
configured) can be single-ended (positive or negative) or differential, also
depending on your hardware.

The diagram on top of the settings can be of assistance in determining the
correct setup.

Here you can also set the amplifier range and offset as well as the filter
characteristics.
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Basic settings

Sensor

Summary
Sensor connected to the channel. Selecting a sensor will automatically setup
the channel using information from the sensor database.

Description
When acquiring data, sensors are used to convert physically changing
phenomena to measurable signals. To properly record this data, the acquisition
system must be correctly configured. This can be achieved by manually
entering the information in the relevant fields in the settings sheet, but an easy
and less error-prone alternative is to use the sensor database. By selecting the
correct sensor all relevant settings are automatically set.

Note
This column is only available with the sensor database option, sensors for all
available amplifier modes are available.

 

Signal coupling

Summary
Defines how the analog signal is "coupled" into the amplifier.
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Signal coupling

Description
This setting defines how the analog signal is "coupled" into the amplifier. The
coupling feature defines which signal component (content) is passed to the
amplifier.

When “AC” is selected, the AC content of a signal without any DC bias voltage
is measured. With DC selection, both AC and DC content are passed to the
amplifier.

A “GND” mode is usually provided to ground an amplifier to minimize the
influence of random noise.

Depending on the capabilities of your hardware additional settings can include
"AC external probe", "DC external probe", "Reference" or “1PPS Sync”. Refer
to your hardware manual for these non-standard settings.

 

Input coupling

Summary
Mode of operation of the input amplifier.

Description
This setting determines how the input signal is routed to the amplifier. If for
example “Single-Ended Positive” is selected, the negative input of the amplifier
is grounded and the positive input is connected to the incoming signal. For a
better understanding it is useful to look at the graphics on top of the settings
sheet.

The available modes depend on the type of channel. Typical values are:
“Single-Ended Positive”, “Single-Ended Negative” and “Differential”.
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Span

Summary
Peak-to-peak scale that the digitizer can measure at the input.

Description
Sets the full input range (peak-to-peak) of the amplifier. Combined with the
offset it defines the physical measurement range. You can also use range
from and range to to set the measurement range. To switch between these two
alternatives make a right mouse click in the column header. In the shortcut
menu that comes up click Show Ranges to toggle the modes.

 

Offset

Summary
Offset positions the waveform around the specified DC.

Description
Adds a specified DC value to the measured waveform. Combined with the
span it defines the physical measurement range. You can also use range
from and range to to set the measurement range. To switch between these two
alternatives make a right mouse click in the column header. In the shortcut
menu that comes up click Show Ranges to toggle the modes.

Range from

Summary
Lower limit of the input span.

Description
Defines the lower limit of the input span. Combined with the range to it defines
the physical measurement range. You can also use span and offset to set the
measurement range. To switch between these two alternatives make a right
mouse click in the column header. In the shortcut menu that comes up click
Show Ranges to toggle the modes.
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Range to

Summary
Upper limit of the input span.

Description
Defines the upper limit of the input span. Combined with the range from it
defines the physical measurement range. You can also use span and offset to
set the measurement range. To switch between these two alternatives make
a right mouse click in the column header. In the shortcut menu that comes up
click Show Ranges to toggle the modes.

 

Technical units multiplier

Summary
Multiplier “a” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
system or convert the measured input into a different unit. The technical units
multiplier is the scaling factor “a” in the formula above.

The other related settings are “Technical units offset” and “Technical units”.
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Technical units offset

Summary
Offset “b” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
offset is the offset factor “b” in the formula above.

The other related settings are “Technical units multiplier” and “Technical units”.

 

Technical units

Summary
Units of “y” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
define the new units.

The other related settings are “Technical units multiplier” and “Technical units
offset”.
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Filter type

Summary
Removes unwanted frequency signal components by selecting the correct filter
type.

Description
A filter can be used to suppress unwanted high-frequency signal components.
A filter is defined by its “Filter type” and “Filter Frequency”, often called cut-off
frequency.

Typical available filter types are:
l FIR: This is a lowpass Finite Impulse Response filter.
l Bessel: This is a lowpass Infinite Impulse Response (IIR) filter.
The cut-off frequency of the filters is defined by the “Filter Frequency” setting.

 

Filter frequency low

Summary
Frequency below which the power is 0.5 the power of the pass band
(-3 dBpoint) when using bandpass filters.

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.
The filter frequency low is only available when using a bandpass filter.
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Filter frequency high

Summary
Frequency above which the power is 0.5 the power of the pass band
(-3 dBpoint).

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.

Typical available values are:
l FIR: 1/4, 1/10,1/20 and 1/40 of the sample rate
l Bessel: 1/10, 1/20, 1/40 and 1/100 of the sample rate

 

Advanced settings

Impedance (RO)

Summary
Input impedance is the effective resistance and capacitance seen at the input
to the digitizer.

Description
This setting is read-only and shows the effective resistance and capacitance
seen at the input to the digitizer.
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Capacitance

Summary
This is the capacitance range of the channel.
 

Description
The capacitance of a channel can be off interest when using certain sensors.
Some sensors depend on the acquisition systems capacitance for proper
operation.
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Fine gain

Summary
Select fine gain to adjust the input span to the signal in small steps for a
maximum dynamic range without clipping the signal.

Description
This setting is used to adjust the input span in small steps. If for example the
entered span is 2.4 V, the offset is 0 V, the technical units multiplier is 1 and
the technical units offset is 0, the amplifier range will be set from +2 V to -2 V.
However, if fine gain is switched on, the amplifier range will be set from -1.2 V to
+1.2 V. The amplifier range is shown in the graphics at the top of the settings
sheet.
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D.4.3 Basic-sensor

Introduction
The basic-sensor input channel operates as a basic-voltage channel with an
additional excitation voltage/current capability. It is a derivative of the bridge
amplifier. To enable this channel type you must select the correct mode in the
Amplifier mode setting of the applicable bridge channel. This is done in the
Analog Channel section in the General group.

Signal coupling (how the signal is fed into the amplifier) can either be AC or DC,
depending on your hardware. Input coupling (how the amplifier itself is
configured) is differential by nature.

Here you can set the amplifier range and offset as well as the filter
characteristics and excitation parameters.

 

Basic settings

Sensor

Summary
Sensor connected to the channel. Selecting a sensor will automatically setup
the channel using information from the sensor database.

Description
When acquiring data, sensors are used to convert physically changing
phenomena to measurable signals. To properly record this data, the acquisition
system must be correctly configured. This can be achieved by manually
entering the information in the relevant fields in the settings sheet, but an easy
and less error-prone alternative is to use the sensor database. By selecting the
correct sensor all relevant settings are automatically set.

Note
This column is only available with the sensor database option, sensors for all
available amplifier modes are available.
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Signal coupling

Summary
Defines how the analog signal is "coupled" into the amplifier.

Description
This setting defines how the analog signal is "coupled" into the amplifier. The
coupling feature defines which signal component (content) is passed to the
amplifier.

When ”AC” is selected, the AC content of a signal without any DC bias voltage
is measured. With “DC” selection, both AC and DC content are passed to the
amplifier.

A “GND” mode is usually provided to ground an amplifier to minimize the
influence of random noise.

 

Input coupling

Summary
Mode of operation of the input amplifier.

Description
This setting determines how the input signal is routed to the amplifier. If for
example “Single-Ended Positive” is selected, the negative input of the amplifier
is grounded and the positive input is connected to the incoming signal. For a
better understanding it is useful to look at the graphics on top of the settings
sheet.

The available modes depend on the type of channel. Typical values are:
“Single-Ended Positive”, “Single-Ended Negative” and “Differential”.
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Span

Summary
Peak-to-peak scale that the digitizer can measure at the input.

Description
Sets the full input range (peak-to-peak) of the amplifier. Combined with the
offset it defines the physical measurement range. You can also use range
from and range to to set the measurement range. To switch between these two
alternatives make a right mouse click in the column header. In the shortcut
menu that comes up click Show Ranges to toggle the modes.

 

Offset

Summary
Offset positions the waveform around the specified DC.

Description
Adds a specified DC value to the measured waveform. Combined with the
span it defines the physical measurement range. You can also use range
from and range to to set the measurement range. To switch between these two
alternatives make a right mouse click in the column header. In the shortcut
menu that comes up click Show Ranges to toggle the modes.

Range from

Summary
Lower limit of the input span.

Description
Defines the lower limit of the input span. Combined with the range to it defines
the physical measurement range. You can also use span and offset to set the
measurement range. To switch between these two alternatives make a right
mouse click in the column header. In the shortcut menu that comes up click
Show Ranges to toggle the modes.
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Range to

Summary
Upper limit of the input span.

Description
Defines the upper limit of the input span. Combined with the range from it
defines the physical measurement range. You can also use span and offset to
set the measurement range. To switch between these two alternatives make
a right mouse click in the column header. In the shortcut menu that comes up
click Show Ranges to toggle the modes.

 

Technical units multiplier

Summary
Multiplier “a” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
system or convert the measured input into a different unit. The technical units
multiplier is the scaling factor “a” in the formula above.

The other related settings are “Technical units offset” and “Technical units”.
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Technical units offset

Summary
Offset “b” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
offset is the offset factor “b” in the formula above.

The other related settings are “Technical units multiplier” and “Technical units”.

 

Technical units

Summary
Units of “y” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
define the new units.

The other related settings are “Technical units multiplier” and “Technical units
offset”.
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Filter type

Summary
Removes unwanted frequency signal components by selecting the correct filter
type.

Description
A filter can be used to suppress unwanted high-frequency signal components.
A filter is defined by its “Filter type” and “Filter Frequency”, often called cut-off
frequency.

Typical available filter types are:
l FIR: This is a lowpass Finite Impulse Response filter.
l Bessel: This is a lowpass Infinite Impulse Response (IIR) filter.
The cut-off frequency of the filters is defined by the “Filter Frequency” setting.

 

Filter frequency low

Summary
Frequency below which the power is 0.5 the power of the pass band
(-3 dBpoint) when using bandpass filters.

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.
The filter frequency low is only available when using a bandpass filter.
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Filter frequency high

Summary
Frequency above which the power is 0.5 the power of the pass band
(-3 dBpoint).

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.

Typical available values are:
l FIR: 1/4, 1/10,1/20 and 1/40 of the sample rate
l Bessel: 1/10, 1/20, 1/40 and 1/100 of the sample rate

 

Excitation

Summary
Enable or disable excitation.

Description
Switch the excitation on or off. The excitation type can be either voltage or
constant current.

 

Excitation type

Summary
Set the excitation type.
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Excitation type

Description
Select the excitation type. The excitation type can be either voltage or constant
current. Select the one required by the application.

  

Excitation span

Summary
Span value for voltage-type excitation.

Description
When Excitation type is set to Voltage this setting represents the Full Scale
voltage that is applied. The span is twice the Excitation range. This setting is
ignored when Excitation type is set to Current.

 

Excitation range

Summary
Range value for voltage-type excitation.

Description
When Excitation type is set to Voltage this setting represents the range of the
voltage that is applied. The excitation range is bipolar and therefore half the
Excitation span. This setting is ignored when Excitation type is set to
Current.
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Excitation current

Summary
Current value for current-type excitation.

Description
When Excitation type is set to Current this setting represents the current that
is applied. This setting is ignored when Excitation type is set to Voltage.

 

Advanced settings

Enable Scan for TEDS

Summary
Enable or disable TEDS sensor auto-detection.

Description
Switch on to include this channel in the search for TEDS sensors, both
automatically or manually invoked.

Impedance (RO)

Summary
Input impedance is the effective resistance and capacitance seen at the input
to the digitizer.

Description
This setting is read-only and shows the effective resistance and capacitance
seen at the input to the digitizer.
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Capacitance

Summary
This is the capacitance range of the channel.
 

Description
The capacitance of a channel can be off interest when using certain sensors.
Some sensors depend on the acquisition systems capacitance for proper
operation.

 

Fine gain

Summary
Select fine gain to adjust the input span to the signal in small steps for a
maximum dynamic range without clipping the signal.

Description
This setting is used to adjust the input span in small steps. If for example the
entered span is 2.4 V, the offset is 0 V, the technical units multiplier is 1 and
the technical units offset is 0, the amplifier range will be set from +2 V to -2 V.
However, if fine gain is switched on, the amplifier range will be set from -1.2 V to
+1.2 V. The amplifier range is shown in the graphics at the top of the settings
sheet.

 

D.4.4 Bridge

Introduction
Of all input channels the bridge input channel is the most sophisticated
channel.
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The classic DC Wheatstone bridge circuit is a very sensitive indicator used with
a variety of transducers for both static and dynamic measurements. The bridge
is composed of four resistances. A DC excitation voltage is applied to the bridge
and the voltage across the center terminals is fed to the input of the amplifier.
When the voltages on all four resistors are identical, the bridge is balanced.

When used for instrumentation, a strain gauge (or other “transducer”) replaces
one or more resistors in the bridge, and as the strain gauge undergoes
dimensional changes (because it is bonded to a test object), it unbalances the
bridge and produces an output voltage proportional to the strain.

Because a correct setup of a bridge requires numerous settings, a bridge wizard
is available that allows you to set up your bridge channel(s) instantly without
errors. You can also use the bridge wizard to swiftly copy settings from one
channel to one or more other channels.

When you set up your bridge channel you should also refer to your hardware
manual because some settings are related to hardware changes that you can
make yourself.

 

Basic settings

Sensor

Summary
Sensor connected to the channel. Selecting a sensor will automatically setup
the channel using information from the sensor database.

Description
When acquiring data, sensors are used to convert physically changing
phenomena to measurable signals. To properly record this data, the acquisition
system must be correctly configured. This can be achieved by manually
entering the information in the relevant fields in the settings sheet, but an easy
and less error-prone alternative is to use the sensor database. By selecting the
correct sensor all relevant settings are automatically set.

Note
This column is only available with the sensor database option, sensors for all
available amplifier modes are available.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 609



Gain/Span

Summary
Amplifier gain

Description
Defines the gain that the amplifier applies to the input. In other words, it is the
amount of increase in voltage expressed as the ratio of output to input. From
the context menu of the column header you can swap between Gain and
Span readout.

 

Excitation

Summary
Sets system excitation yes or no.

Description
Use this settings to enable or disable the excitation. It is good practice to
remove excitation before you connect or disconnect a (bridge) sensor to the
input.

 

Excitation type

Summary
Selects type of system excitation.

Description
The bridge circuit can be supplied with either a voltage or a current. Choose
the one that applies.
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Excitation span

Summary
Span value for voltage-type excitation.

Description
When Excitation type is set to Voltage this setting represents the Full Scale
voltage that is supplied as excitation to the bridge circuit. The span is twice the
Excitation range. This setting is ignored when Excitation type is set to
Current.

 

Excitation range

Summary
Range value for voltage-type excitation.

Description
When Excitation type is set to Voltage this setting represents the range of the
voltage that is supplied as excitation to the bridge circuit. The excitation range
is bipolar and therefore half the Excitation span. This setting is ignored when
Excitation type is set to Current.

 

Excitation current

Summary
Current value for current-type excitation.

Description
When Excitation type is set to Current this setting represents the current that
is sent through the bridge circuit. This setting is ignored when Excitation
type is set to Voltage.
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Sensitivity (RO)

Summary
Returns the measured voltage as function of applied strain and excitation.

Description
This value represents the degree to which changes in the applied strain or
stress causes changes in the measured output voltage as function of the
applied excitation.

 

Bridge type

Summary
Bridge completion type

Description
Specifies the configuration of the internal and external resistors that all together
complete the bridge circuit. Typical values are Quarter, Half, Full, where Full
means that the bridge consists only of external resistors.

Gauge resistance

Summary
Electrical resistance of the strain gauge.

Description
The resistance of a strain gauge is defined as the electrical resistance of the
gauge when no strain or stress is applied. Typically a strain gauge has a
nominal resistance between 120 and 1000 Ohms.
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Bridge factor

Summary
Bridge factor used for the actual measurement.

Description
Defines the number of gauges that are placed in a position and orientation so
as to be exposed to physical strain. The other, passive gauges are isolated
from all mechanical stress.

 

Shunt location

Summary
Location of the shunt resistor.

Description
Specifies whether the shunt resistor that is currently in use is Internal or
External.

 

Shunt value

Summary
Resistive value of shunt, external or internal.

Description
The shunt value is the electrical resistance of the shunt resistor that is currently
in use. If Shunt location is set to Internal  this value matches the value of the
resistor in the mainframe, if set to External it matches the resistance of the
external custom resistor.
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Shunt active Gauge

Summary
Active gauge for shunt calibration.

Description
Defines the location of the shunt resistor: either in parallel with the gauge that
is located in the positive arm of the bridge circuit or in parallel with the gauge
located in the negative arm.

 

Technical units multiplier

Summary
Multiplier “a” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
system or convert the measured input into a different unit. The technical units
multiplier is the scaling factor “a” in the formula above.

The other related settings are “Technical units offset” and “Technical units”.

 

Technical units offset

Summary
Offset “b” in a technical units formula:
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Technical units offset

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
offset is the offset factor “b” in the formula above.

The other related settings are “Technical units multiplier” and “Technical units”.

 

Technical units

Summary
Units of “y” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
define the new units.

The other related settings are “Technical units multiplier” and “Technical units
offset”.

 

Filter type

Summary
Removes unwanted frequency signal components by selecting the correct filter
type.
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Filter type

Description
A filter can be used to suppress unwanted high-frequency signal components.
A filter is defined by its “Filter type” and “Filter Frequency”, often called cut-off
frequency.

Typical available filter types are:
l FIR: This is a lowpass Finite Impulse Response filter.
l Bessel: This is a lowpass Infinite Impulse Response (IIR) filter.
The cut-off frequency of the filters is defined by the “Filter Frequency” setting.

 

Filter frequency low

Summary
Frequency below which the power is 0.5 the power of the pass band
(-3 dBpoint) when using bandpass filters.

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.
The filter frequency low is only available when using a bandpass filter.

 

Filter frequency high

Summary
Frequency above which the power is 0.5 the power of the pass band
(-3 dBpoint).
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Filter frequency high

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.

Typical available values are:
l FIR: 1/4, 1/10,1/20 and 1/40 of the sample rate
l Bessel: 1/10, 1/20, 1/40 and 1/100 of the sample rate

 

Advanced settings

Enable Scan for TEDS

Summary
Enable or disable TEDS sensor auto-detection.

Description
Switch on to include this channel in the search for TEDS sensors, both
automatically or manually invoked.

Impedance (RO)

Summary
Input impedance is the effective resistance and capacitance seen at the input
to the digitizer.

Description
This setting is read-only and shows the effective resistance and capacitance
seen at the input to the digitizer.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 617



Capacitance

Summary
This is the capacitance range of the channel.
 

Description
The capacitance of a channel can be off interest when using certain sensors.
Some sensors depend on the acquisition systems capacitance for proper
operation.

 

Fine gain

Summary
Select fine gain to adjust the input span to the signal in small steps for a
maximum dynamic range without clipping the signal.

Description
This setting is used to adjust the input span in small steps. If for example the
entered span is 2.4 V, the offset is 0 V, the technical units multiplier is 1 and
the technical units offset is 0, the amplifier range will be set from +2 V to -2 V.
However, if fine gain is switched on, the amplifier range will be set from -1.2 V to
+1.2 V. The amplifier range is shown in the graphics at the top of the settings
sheet.

 

D.4.5 Charge

Introduction
The charge amplifier transfers the input charge to another reference capacitor
and produces an output voltage equal to the voltage across the reference
capacitor. Thus, the output voltage is proportional to the charge of the reference
capacitor and to the input charge respectively. Hence, the circuit acts as a
charge-to-voltage converter. As a result of the Miller effect, the input impedance
of the circuit is reduced. Therefore, all additional capacitance, like wiring and
amplifier capacitance, are virtually grounded and have no influence on the
output signal.
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The advantages of using a charge amplifier instead of a voltage amplifier are:

l The piezo element transducer can be used in much hotter environments
than voltage amplifiers with internal electronics can be.

l Gain is dependent only on the feedback capacitor, whereas voltage
amplifiers, which are greatly affected by the input capacitance of the
amplifier and by the parallel capacitance of the cable.

The disadvantage of using a charge amplifier instead of a voltage amplifier is:

l The frequency response of a charge amplifier is limited by the first stage
input amplifier. The proportional amount of charge that is produced in the
sensor needs to be fed into the reference capacitor simultaneously.

Basic settings

Sensor

Summary
Sensor connected to the channel. Selecting a sensor will automatically setup
the channel using information from the sensor database.

Description
When acquiring data, sensors are used to convert physically changing
phenomena to measurable signals. To properly record this data, the acquisition
system must be correctly configured. This can be achieved by manually
entering the information in the relevant fields in the settings sheet, but an easy
and less error-prone alternative is to use the sensor database. By selecting the
correct sensor all relevant settings are automatically set.

Note
This column is only available with the sensor database option, sensors for all
available amplifier modes are available.

 

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 619



Signal coupling

Summary
Defines how the analog signal is "coupled" into the amplifier.

Description
This setting defines how the analog signal is "coupled" into the amplifier. The
coupling feature defines which signal component (content) is passed to the
amplifier.

When “AC” is selected, the AC content of a signal without any DC bias voltage
is measured. With DC selection, both AC and DC content are passed to the
amplifier.

A “GND” mode is usually provided to ground an amplifier to minimize the
influence of random noise.

The signal coupling can be set to GND or Charge.

 

Span

Summary
Peak-to-peak scale that the digitizer can measure at the input.

Description
Sets the full input range (peak-to-peak) of the amplifier. Combined with the
offset it defines the physical measurement range. You can also use range
from and range to to set the measurement range. To switch between these two
alternatives make a right mouse click in the column header. In the shortcut
menu that comes up click Show Ranges to toggle the modes.
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Offset

Summary
Offset positions the waveform around the specified DC.

Description
Adds a specified DC value to the measured waveform. Combined with the
span it defines the physical measurement range. You can also use range
from and range to to set the measurement range. To switch between these two
alternatives make a right mouse click in the column header. In the shortcut
menu that comes up click Show Ranges to toggle the modes.

 

Technical units multiplier

Summary
Multiplier “a” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
system or convert the measured input into a different unit. The technical units
multiplier is the scaling factor “a” in the formula above.

The other related settings are “Technical units offset” and “Technical units”.
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Technical units offset

Summary
Offset “b” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
offset is the offset factor “b” in the formula above.

The other related settings are “Technical units multiplier” and “Technical units”.

 

Technical units

Summary
Units of “y” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
define the new units.

The other related settings are “Technical units multiplier” and “Technical units
offset”.
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Filter type

Summary
Removes unwanted frequency signal components by selecting the correct filter
type.

Description
A filter can be used to suppress unwanted high-frequency signal components.
A filter is defined by its “Filter type” and “Filter Frequency”, often called cut-off
frequency.

Typical available filter types are:
l FIR: This is a lowpass Finite Impulse Response filter.
l Bessel: This is a lowpass Infinite Impulse Response (IIR) filter.
The cut-off frequency of the filters is defined by the “Filter Frequency” setting.

 

Filter frequency low

Summary
Frequency below which the power is 0.5 the power of the pass band
(-3 dBpoint) when using bandpass filters.

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.
The filter frequency low is only available when using a bandpass filter.
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Filter frequency high

Summary
Frequency above which the power is 0.5 the power of the pass band
(-3 dBpoint).

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.

Typical available values are:
l FIR: 1/4, 1/10,1/20 and 1/40 of the sample rate
l Bessel: 1/10, 1/20, 1/40 and 1/100 of the sample rate

 

Advanced settings

Impedance (RO)

Summary
Input impedance is the effective resistance and capacitance seen at the input
to the digitizer.

Description
This setting is read-only and shows the effective resistance and capacitance
seen at the input to the digitizer.
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D.4.6 CAN-Bus

Introduction
CAN-Bus (Controller Area Network bus) is a rugged, digital serial bus designed
for industrial environments. Introduced by Bosch in the mid-1980s for in-vehicle
communications, it is used in myriad applications including factory automation,
building automation, aircraft and aerospace as well as in cars, trucks and buses.
CAN-Bus replaces bulky wiring harnesses with a two-wire differential cable.

CAN-Bus uses a broadcast method for placing frames on the wire somewhat
similar to Ethernet. Bus distance is based on speed, ranging from a maximum
of 40 meters at 1 Mbps to a maximum of six kilometers at 10 Kbps. At speeds
up to 125 Kbps, CAN provides fault tolerance. If one of the two wires is cut or
shorted, the other keeps transmitting.

Currently each LIBERTY CAN-Bus Node must be configured prior to use by
using the LIBERTY CAN Configuration Utility.

In this section you can set the general properties of the CAN-Bus channel like
span, offset, units and filter type.

 

Basic settings

Span

Summary
Peak-to-peak scale that the digitizer can measure at the input.

Description
Sets the full input range (peak-to-peak) of the amplifier. Combined with the
offset it defines the physical measurement range. You can also use range
from and range to to set the measurement range. To switch between these two
alternatives make a right mouse click in the column header. In the shortcut
menu that comes up click Show Ranges to toggle the modes.
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Offset

Summary
Offset positions the waveform around the specified DC.

Description
Adds a specified DC value to the measured waveform. Combined with the
span it defines the physical measurement range. You can also use range
from and range to to set the measurement range. To switch between these two
alternatives make a right mouse click in the column header. In the shortcut
menu that comes up click Show Ranges to toggle the modes.

 

Range from

Summary
Lower limit of the input span.

Description
Defines the lower limit of the input span. Combined with the range to it defines
the physical measurement range. You can also use span and offset to set the
measurement range. To switch between these two alternatives make a right
mouse click in the column header. In the shortcut menu that comes up click
Show Ranges to toggle the modes.

 

Range to

Summary
Upper limit of the input span.
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Range to

Description
Defines the upper limit of the input span. Combined with the range from it
defines the physical measurement range. You can also use span and offset to
set the measurement range. To switch between these two alternatives make
a right mouse click in the column header. In the shortcut menu that comes up
click Show Ranges to toggle the modes.

 

Technical units offset

Summary
Offset “b” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
offset is the offset factor “b” in the formula above.

The other related settings are “Technical units multiplier” and “Technical units”.

 

Technical units

Summary
Units of “y” in a technical units formula:
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Technical units

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
define the new units.

The other related settings are “Technical units multiplier” and “Technical units
offset”.

 

Filter type

Summary
Removes unwanted high-frequency signal components by selecting the
correct filter type.

Description
A filter can be used to suppress unwanted high-frequency signal components.
A filter is defined by its “Filter type” and “Filter Frequency”, often called cut-off
frequency.

Typical available filter types are:
l FIR: This is a lowpass Finite Impulse Response filter.
l Bessel: This is a lowpass Infinite Impulse Response (IIR) filter.
The cut-off frequency of the filters is defined by the “Filter Frequency” setting.
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D.4.7 IEPE

Introduction
An accelerometer measures the acceleration and local gravity it experiences.
Both are typically expressed in SI units meters/second2 (m · s-2) or popularly
in terms of g-force. For a moving object, the output of the accelerometer is off
from the true acceleration by a 1 g factor in the local vertical axis. In the other,
non-vertical axis the accelerometer measures acceleration and the equivalent
specific external force. Counter-intuitively, an accelerometer at rest (zero
acceleration) on the earth's surface will indicate the acceleration of gravity of
1 g because it is reading the ground reaction force.

Accelerometers can be used to measure vibration on cars, machines, buildings,
process control systems and safety installations. They can also be used to
measure seismic activity, inclination, machine vibration, dynamic distance and
speed with or without the influence of gravity.

The electronics within typical (ICPTM / IEPE) accelerometers require excitation
power from a constant-current-regulated, DC voltage source.

The accelerometer channel is a derivative of a basic-voltage channel. To
enable this channel type you must select the correct mode in the Amplifier
mode setting of the applicable channel. This is done in the Analog Channel
section in the General group.

 

Basic settings

Sensor

Summary
Sensor connected to the channel. Selecting a sensor will automatically setup
the channel using information from the sensor database.
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Sensor

Description
When acquiring data, sensors are used to convert physically changing
phenomena to measurable signals. To properly record this data, the acquisition
system must be correctly configured. This can be achieved by manually
entering the information in the relevant fields in the settings sheet, but an easy
and less error-prone alternative is to use the sensor database. By selecting the
correct sensor all relevant settings are automatically set.

Note
This column is only available with the sensor database option, sensors for all
available amplifier modes are available.

 

Sensor Status

Summary
Physical status of the sensor connected to the channel.

Description
This setting only checks if the sensor physically connected and if possible some
details on the type of sensor. The setting does not show if the sensor attached
matches the sensor selected in the sensor setting. The setting will be updated
automatically if a change in status is detected.
Shows the status of the sensor connected to the channel.

 

Auto detect TEDS

Summary
Enable or disable TEDS sensor auto-detection.
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Auto detect TEDS

Description
Switch on to include this channel in the search for TEDS sensors, both
automatically or manually invoked.

Excitation

Summary
Enable or disable excitation.

Description
Switch the excitation on or off. The excitation type is constant current by
definition.

 

Excitation current

Summary
Value of the excitation current.

Description
This sets the value of the excitation current.

 

Span

Summary
Peak-to-peak scale that the digitizer can measure at the input.
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Span

Description
Sets the full input range (peak-to-peak) of the amplifier. Combined with the
offset it defines the physical measurement range. You can also use range
from and range to to set the measurement range. To switch between these two
alternatives make a right mouse click in the column header. In the shortcut
menu that comes up click Show Ranges to toggle the modes.

 

Offset

Summary
Offset positions the waveform around the specified DC.

Description
Adds a specified DC value to the measured waveform. Combined with the
span it defines the physical measurement range. You can also use range
from and range to to set the measurement range. To switch between these two
alternatives make a right mouse click in the column header. In the shortcut
menu that comes up click Show Ranges to toggle the modes.

 

Range from

Summary
Lower limit of the input span.

Description
Defines the lower limit of the input span. Combined with the range to it defines
the physical measurement range. You can also use span and offset to set the
measurement range. To switch between these two alternatives make a right
mouse click in the column header. In the shortcut menu that comes up click
Show Ranges to toggle the modes.
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Range to

Summary
Upper limit of the input span.

Description
Defines the upper limit of the input span. Combined with the range from it
defines the physical measurement range. You can also use span and offset to
set the measurement range. To switch between these two alternatives make
a right mouse click in the column header. In the shortcut menu that comes up
click Show Ranges to toggle the modes.

 

Technical units multiplier

Summary
Multiplier “a” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
system or convert the measured input into a different unit. The technical units
multiplier is the scaling factor “a” in the formula above.

The other related settings are “Technical units offset” and “Technical units”.
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Technical units offset

Summary
Offset “b” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
offset is the offset factor “b” in the formula above.

The other related settings are “Technical units multiplier” and “Technical units”.

 

Technical units

Summary
Units of “y” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
define the new units.

The other related settings are “Technical units multiplier” and “Technical units
offset”.
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Filter type

Summary
Removes unwanted frequency signal components by selecting the correct filter
type.

Description
A filter can be used to suppress unwanted high-frequency signal components.
A filter is defined by its “Filter type” and “Filter Frequency”, often called cut-off
frequency.

Typical available filter types are:
l FIR: This is a lowpass Finite Impulse Response filter.
l Bessel: This is a lowpass Infinite Impulse Response (IIR) filter.
The cut-off frequency of the filters is defined by the “Filter Frequency” setting.

 

Filter frequency low

Summary
Frequency below which the power is 0.5 the power of the pass band
(-3 dBpoint) when using bandpass filters.

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.
The filter frequency low is only available when using a bandpass filter.
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Filter frequency high

Summary
Frequency above which the power is 0.5 the power of the pass band
(-3 dBpoint).

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.

Typical available values are:
l FIR: 1/4, 1/10,1/20 and 1/40 of the sample rate
l Bessel: 1/10, 1/20, 1/40 and 1/100 of the sample rate

 

Advanced settings

Impedance (RO)

Summary
Input impedance is the effective resistance and capacitance seen at the input
to the digitizer.

Description
This setting is read-only and shows the effective resistance and capacitance
seen at the input to the digitizer.
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Capacitance

Summary
This is the capacitance range of the channel.
 

Description
The capacitance of a channel can be off interest when using certain sensors.
Some sensors depend on the acquisition systems capacitance for proper
operation.

 

Fine gain

Summary
Select fine gain to adjust the input span to the signal in small steps for a
maximum dynamic range without clipping the signal.

Description
This setting is used to adjust the input span in small steps. If for example the
entered span is 2.4 V, the offset is 0 V, the technical units multiplier is 1 and
the technical units offset is 0, the amplifier range will be set from +2 V to -2 V.
However, if fine gain is switched on, the amplifier range will be set from -1.2 V to
+1.2 V. The amplifier range is shown in the graphics at the top of the settings
sheet.

 

D.4.8 Current loop

Introduction
The current loop, also known as 4-20 mA channel, is a standard in industrial
and process sectors. It operates based on Ohm’s law by leading the current
through an internal shunt resistor and Kirchoff’s current law that stipulates that
the sum of all currents flowing toward a point are equal to all currents flowing
into that point.
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These types of sensors typically use a 4 mA zero level current, which means
they can detect a broken wire or other problem by differentiating between
0 mA and 4 mA. Using a current means the signal can be used with longer lead
wires and is less prone to electrical disturbances.

This allows for a cost-effective, precise current measurement with some
valuable diagnostic information all-in-one channel.

Basic settings

Sensor

Summary
Sensor connected to the channel. Selecting a sensor will automatically setup
the channel using information from the sensor database.

Description
When acquiring data, sensors are used to convert physically changing
phenomena to measurable signals. To properly record this data, the acquisition
system must be correctly configured. This can be achieved by manually
entering the information in the relevant fields in the settings sheet, but an easy
and less error-prone alternative is to use the sensor database. By selecting the
correct sensor all relevant settings are automatically set.

Note
This column is only available with the sensor database option, sensors for all
available amplifier modes are available.

 

Signal coupling

Summary
Defines how the analog signal is "coupled" into the amplifier.
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Signal coupling

Description
This setting defines how the analog signal is "coupled" into the amplifier. The
coupling feature defines which signal component (content) is passed to the
amplifier.

When “AC” is selected, the AC content of a signal without any DC bias voltage
is measured. With DC selection, both AC and DC content are passed to the
amplifier.

A “GND” mode is usually provided to ground an amplifier to minimize the
influence of random noise.

Depending on the capabilities of your hardware additional settings can include
"AC external probe", "DC external probe", "Reference" or “1PPS Sync”. Refer
to your hardware manual for these non-standard settings.

 

Span

Summary
Peak-to-peak scale that the digitizer can measure at the input.

Description
Sets the full input range (peak-to-peak) of the amplifier. Combined with the
offset it defines the physical measurement range. You can also use range
from and range to to set the measurement range. To switch between these two
alternatives make a right mouse click in the column header. In the shortcut
menu that comes up click Show Ranges to toggle the modes.
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Offset

Summary
Offset positions the waveform around the specified DC.

Description
Adds a specified DC value to the measured waveform. Combined with the
span it defines the physical measurement range. You can also use range
from and range to to set the measurement range. To switch between these two
alternatives make a right mouse click in the column header. In the shortcut
menu that comes up click Show Ranges to toggle the modes.

 

Range from

Summary
Lower limit of the input span.

Description
Defines the lower limit of the input span. Combined with the range to it defines
the physical measurement range. You can also use span and offset to set the
measurement range. To switch between these two alternatives make a right
mouse click in the column header. In the shortcut menu that comes up click
Show Ranges to toggle the modes.

 

Range to

Summary
Upper limit of the input span.
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Range to

Description
Defines the upper limit of the input span. Combined with the range from it
defines the physical measurement range. You can also use span and offset to
set the measurement range. To switch between these two alternatives make
a right mouse click in the column header. In the shortcut menu that comes up
click Show Ranges to toggle the modes.

 

Technical units multiplier

Summary
Multiplier “a” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
system or convert the measured input into a different unit. The technical units
multiplier is the scaling factor “a” in the formula above.

The other related settings are “Technical units offset” and “Technical units”.

 

Technical units offset

Summary
Offset “b” in a technical units formula:

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 641



Technical units offset

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
offset is the offset factor “b” in the formula above.

The other related settings are “Technical units multiplier” and “Technical units”.

 

Technical units

Summary
Units of “y” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
define the new units.

The other related settings are “Technical units multiplier” and “Technical units
offset”.

 

Filter type

Summary
Removes unwanted frequency signal components by selecting the correct filter
type.
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Filter type

Description
A filter can be used to suppress unwanted high-frequency signal components.
A filter is defined by its “Filter type” and “Filter Frequency”, often called cut-off
frequency.

Typical available filter types are:
l FIR: This is a lowpass Finite Impulse Response filter.
l Bessel: This is a lowpass Infinite Impulse Response (IIR) filter.
The cut-off frequency of the filters is defined by the “Filter Frequency” setting.

 

Filter frequency low

Summary
Frequency below which the power is 0.5 the power of the pass band
(-3 dBpoint) when using bandpass filters.

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.
The filter frequency low is only available when using a bandpass filter.

 

Filter frequency high

Summary
Frequency above which the power is 0.5 the power of the pass band
(-3 dBpoint).
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Filter frequency high

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.

Typical available values are:
l FIR: 1/4, 1/10,1/20 and 1/40 of the sample rate
l Bessel: 1/10, 1/20, 1/40 and 1/100 of the sample rate

 

Advanced settings

Impedance (RO)

Summary
Input impedance is the effective resistance and capacitance seen at the input
to the digitizer.

Description
This setting is read-only and shows the effective resistance and capacitance
seen at the input to the digitizer.

 

Capacitance

Summary
This is the capacitance range of the channel.
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Capacitance

 

Description
The capacitance of a channel can be off interest when using certain sensors.
Some sensors depend on the acquisition systems capacitance for proper
operation.

 

Fine gain

Summary
Select fine gain to adjust the input span to the signal in small steps for a
maximum dynamic range without clipping the signal.

Description
This setting is used to adjust the input span in small steps. If for example the
entered span is 2.4 V, the offset is 0 V, the technical units multiplier is 1 and
the technical units offset is 0, the amplifier range will be set from +2 V to -2 V.
However, if fine gain is switched on, the amplifier range will be set from -1.2 V to
+1.2 V. The amplifier range is shown in the graphics at the top of the settings
sheet.

 

D.4.9 Marker (Events) 

Introduction
As opposed to an analog channel, Marker (Events) channels only register two
levels of information: on and off, high and low, or open and close. This
information is represented on the inputs as a “low” voltage (typically < 1 V) and
a “high” voltage (typically > 2 V). Each channel basically provides 1-bit internal
information, in contrast to the typical 16-bit data from an analog channel.

Depending on the hardware in use you can set the threshold level and a
hysteresis level.
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Basic settings

Invert

Summary
Inverts the input signal.

Description
Selection of this item will invert the signal.

 

Hysteresis

Summary
Sets the hysteresis range to ensure a clean on/off transition.

Description
This value defines the difference in the input signal before the opposite logic
level will be set. This setting will be used together with the Threshold
Voltage to define predefined switching levels.

 

Pull-up

Summary:
Uses the internal pull-up resistor for open collector signals.

Description:
This function can be used to select an internal resistor to work as a “pull-up”.
It can be used for so-called “open collector” switches. These only supply a
“short circuit” to ground when activated, but no active voltage when not
activated.
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Threshold level

Summary
Transition level to go from low to high.

Description
This value defines the input level from where the output transition from low to
high will take place. This setting is used together with Hysteresis to ensure a
defined switching level.

 

D.4.10 Thermocouple

Introduction
Thermocouples are widely used to measure temperature. A variety of
thermocouples are available, suitable for different measuring applications.
They are usually selected based on the temperature range and sensitivity
needed.

The required cold-junction compensation is done in (front of) the data
acquisition system. To achieve accurate measurements, the necessary
linearization is done by the firmware in the data acquisition system.

Within the software there is also support for the commonly used Pt-100 and
Pt-1000 Resistance Temperature Detectors (RTDs).

Basic settings

Type

Summary
Type of temperature sensor.

Description
Selects the kind of temperature sensor used on this input. Each type of sensor
has a specific sensitivity, temperature range and other characteristics.
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Scale

Summary
Temperature scale

Description
Selects the temperature unit of the sensor in use. Typical values are Kelvin,
Celsius and Fahrenheit.

Range from

Summary
Lower limit of the input span.

Description
Defines the lower limit of the input span. Combined with the range to it defines
the physical measurement range.

 

Range to

Summary
Upper limit of the input span.

Description
Defines the upper limit of the input span. Combined with the range from it
defines the physical measurement range.
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Filter type

Summary
Removes unwanted frequency signal components by selecting the correct filter
type.

Description
A filter can be used to suppress unwanted high-frequency signal components.
A filter is defined by its “Filter type” and “Filter Frequency”, often called cut-off
frequency.

Typical available filter types are:
l FIR: This is a lowpass Finite Impulse Response filter.
l Bessel: This is a lowpass Infinite Impulse Response (IIR) filter.
The cut-off frequency of the filters is defined by the “Filter Frequency” setting.

 

Filter frequency low

Summary
Frequency below which the power is 0.5 the power of the pass band
(-3 dBpoint) when using bandpass filters.

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.
The filter frequency low is only available when using a bandpass filter.
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Filter frequency high

Summary
Frequency above which the power is 0.5 the power of the pass band
(-3 dBpoint).

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.

Typical available values are:
l FIR: 1/4, 1/10,1/20 and 1/40 of the sample rate
l Bessel: 1/10, 1/20, 1/40 and 1/100 of the sample rate

 

D.4.11 Resistance thermometers

Introduction
Resistance thermometers can be used to measure temperature, just like
thermocouples. Where thermocouples use the thermo-electrical effect of two
materials, thermo-resistors use the change in electrical resistance to measure
the temperature. This typically means they provide better stability and accuracy,
but also requires the sensor to be electrically fed and usually offers a smaller
temperature range to be measured.

Another difference to a thermocouple sensor is that thermo-resistors are offered
in various wiring configurations, each with its own up- and downsides; for proper
usage the correct wiring needs to be selected.

For more detailed information on how to configure these sensors and connect
them to the data acquisition system, please refer to the datasheet of the
acquisition card you are using.
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Basic settings

Sensor

Summary
Sensor connected to the channel. Selecting a sensor will automatically setup
the channel using information from the sensor database.

Description
When acquiring data, sensors are used to convert physically changing
phenomena to measurable signals. To properly record this data, the acquisition
system must be correctly configured. This can be achieved by manually
entering the information in the relevant fields in the settings sheet, but an easy
and less error-prone alternative is to use the sensor database. By selecting the
correct sensor all relevant settings are automatically set.

Note
This column is only available with the sensor database option, sensors for all
available amplifier modes are available.

 

Type

Summary
Type of temperature sensor.

Description
Selects the kind of temperature sensor used on this input. Each type of sensor
has a specific sensitivity, temperature range and other characteristics.

 

Scale

Summary
Temperature scale
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Scale

Description
Selects the temperature unit of the sensor in use. Typical values are Kelvin,
Celsius and Fahrenheit.

 

Wiring

Summary
Wiring of the sensor to the amplifier

Description
Specifies how the sensor is connected to the amplifier and how the sensor is
powered. Basic sensors are connected through two wires but more complex
sensors may also use three or four wires.

Three or four wire sensors maybe powered through an external power source.
Please refer to the documentation of the sensor and amplifier that is used for
more detailed information.

 

Filter type

Summary
Removes unwanted frequency signal components by selecting the correct filter
type.

Description
A filter can be used to suppress unwanted high-frequency signal components.
A filter is defined by its “Filter type” and “Filter Frequency”, often called cut-off
frequency.

Typical available filter types are:
l FIR: This is a lowpass Finite Impulse Response filter.
l Bessel: This is a lowpass Infinite Impulse Response (IIR) filter.
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Filter type

The cut-off frequency of the filters is defined by the “Filter Frequency” setting.

 

Filter frequency low

Summary
Frequency below which the power is 0.5 the power of the pass band
(-3 dBpoint) when using bandpass filters.

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.
The filter frequency low is only available when using a bandpass filter.

 

Filter frequency high

Summary
Frequency above which the power is 0.5 the power of the pass band
(-3 dBpoint).

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.

Typical available values are:
l FIR: 1/4, 1/10,1/20 and 1/40 of the sample rate
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Filter frequency high

l Bessel: 1/10, 1/20, 1/40 and 1/100 of the sample rate

 

Advanced settings

Capacitance

Summary
This is the capacitance range of the channel.
 

Description
The capacitance of a channel can be off interest when using certain sensors.
Some sensors depend on the acquisition systems capacitance for proper
operation.

 

D.4.12 Timer/Counter

Introduction
Timer/Counter channels are usually combined on a card that also provides
other digital functionality.

Typical capabilities include:

l Up/down counter
l Frequency/RPM measurement
l Quadrature (position) measurement
l Angle (position) measurement

Refer to your hardware manual to find details on capabilities and connections.

In this section you set the Timer/Counter mode, reset operation, pulses per
rotation for RPM and Angle measurements and the standard parameters like
range and technical units.
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Basic settings

Sensor

Summary
Sensor connected to the channel. Selecting a sensor will automatically setup
the channel using information from the sensor database.

Description
When acquiring data, sensors are used to convert physically changing
phenomena to measurable signals. To properly record this data, the acquisition
system must be correctly configured. This can be achieved by manually
entering the information in the relevant fields in the settings sheet, but an easy
and less error-prone alternative is to use the sensor database. By selecting the
correct sensor all relevant settings are automatically set.

Note
This column is only available with the sensor database option, sensors for all
available amplifier modes are available.

 

Timer/Counter mode

Summary
Select the channel measurement mode.

Description
Select the mode of operation of the channel. Depending on the requirements,
the channel can be set to count, to measure RPM, frequency, Angle, or to do
quadrature decoding.

 

Reset mode

Summary
Defines on what event the counter should be reset.
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Reset mode

Description
On some kinds of selections for Timer/Counter mode there is the possibility
to reset the timer. Typical values are: Manual, Start of Acquisition.

Note
Not all Timer/Counter modes have this selection enabled.

 

Measuring Time

Summary
Measuring (or gate) time for RPM and frequency.

Description
Selection of the time period to measure the RPM or frequency. The gate-time
determines the time interval used to resolve the count or period for the
frequency or RPM information. It therefore also automatically determines the
possible accuracy of the measurement. Remark: This can only be selected at
certain types of Timer/Counter mode.

 

Pulses per rotation

Summary
Required value when measuring RPM (Revolutions per minute) or the Angle.
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Pulses per rotation

Description
Revolutions per minute (abbreviated rpm, RPM, r/min, or r·min−1) is the
number of full rotations completed in one minute.

The actual count value divided by the “pulses per rotation” setting yields the
RPM or Angle value.

Angular rotation is determined by the count value divided by the number of
pulses per degree or rotation. Angles are always in the range
0 to 360 degrees. When using an Angle with ref pos Timer/Counter mode then
reset events will result in the Angular rotation begin set to 0 (zero).

 

Range from

Summary
Lower limit of the input span.

Description
Defines the lower limit of the input span. Combined with the range to it defines
the physical measurement range. You can also use span and offset to set the
measurement range. To switch between these two alternatives make a right
mouse click in the column header. In the shortcut menu that comes up click
Show Ranges to toggle the modes.

 

Range to

Summary
Upper limit of the input span.
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Range to

Description
Defines the upper limit of the input span. Combined with the range from it
defines the physical measurement range. You can also use span and offset to
set the measurement range. To switch between these two alternatives make
a right mouse click in the column header. In the shortcut menu that comes up
click Show Ranges to toggle the modes.

 

Frequency Prescaler

Summary
Allows onboard frequency dividing.

Description
By using this setting the incoming frequency is dived by the Frequency
Prescaler value in the hardware. Making it possible to handle higher
frequencies.

 

Technical units multiplier

Summary
Multiplier “a” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
system or convert the measured input into a different unit. The technical units
multiplier is the scaling factor “a” in the formula above.

The other related settings are “Technical units offset” and “Technical units”.
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Technical units offset

Summary
Offset “b” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
offset is the offset factor “b” in the formula above.

The other related settings are “Technical units multiplier” and “Technical units”.

 

Technical units

Summary
Units of “y” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
define the new units.

The other related settings are “Technical units multiplier” and “Technical units
offset”.
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Invert clock pin

Summary
Inverts the clock input signal.

Description
Select this setting to invert the clock input signal.

 

Clock pin pull-up

Summary
Use the internal pull-up resistor to support open-collector driven clock input
signal.

Description
The output of an open-collector output essentially acts as either an open circuit
(no connection to anything) or a short-circuit to ground.

When connected to the pull-up resistor a correct voltage is applied to the clock
input when the switch is open.

 

Clock pin hysteresis

Summary
Sets the hysteresis range of the clock input signal to ensure a stable transition
from one state to another.

Description
This value defines the difference in the level of the clock input signal before the
opposite logic level will be set.

This setting together with the treshold level defines a stable transition from one
logic state to the other.
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Clock pin threshold voltage

Summary
Defines the transition level of the clock input signal.

Description
This setting defines at what level the clock input must switch. Combined with
the hysterese it ensures a stable and defined transistion.

 

Invert direction pin

Summary
Inverts the direction input signal.

Description
Select this setting to invert the direction input signal.

 

Direction pin pull-up

Summary
Use the internal pull-up resistor to support open-collector driven direction input
signal.

Description
The output of an open-collector output essentially acts as either an open circuit
(no connection to anything) or a short-circuit to ground.

When connected to the pull-up resistor a correct voltage is applied to the
direction input when the switch is open.
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Direction pin hysteresis

Summary
Sets the hysteresis range of the direction input signal to ensure a stable
transition from one state to another.

Description
This value defines the difference in the level of the direction input signal before
the opposite logic level will be set.

This setting together with the treshold level defines a stable transition from one
logic state to the other.

 

Direction pin threshold voltage

Summary
Defines the transition level of the direction input signal.

Description
This setting defines at what level the direction input must switch. Combined
with the hysterese it ensures a stable and defined transistion.

Invert reset pin

Summary
Inverts the reset input signal.

Description
Selection of this item will invert the signal from this input for the reset.
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Reset pin pull-up

Summary
Uses the internal pull-up resistor for open collector signals.

Description
This function can be used to select an internal resistor to work as “pull-up”. It
can be used for so-called “open collector” switches. These only supply a “short
circuit” to ground, but no active voltage.

 

Reset pin hysteresis

Summary
Sets the hysteresis range to ensure a clean on/off transition.

Description
This value defines the difference in the input signal before the opposite level
will be set. This setting will be used together with the Reset treshold level
voltage to define predefined switching boundaries.

 

Reset pin threshold voltage

Summary
Transition level to go from low to high.

Description
This value defines the input level from where the output transition from low to
high will take place. This setting is used together with Reset Pin Hysteresis
to ensure a defined switching level.
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Advanced settings

Minimum Pulse Width

Summary
Filter spikes from digital signals.

Description
The minimum pulse width can be used to filter the input signal from high-
frequency noise. If the input has some noises/signals which contain higher
frequencies (or shorter pulse widths) than the used filter time, the system filters
out these values.

The best filter time setting is application dependent if the test environment
introduces signal spikes on the measurement though electrical or magnetic
disturbances AND the pulses that should be detected are wide enough. The
noise can be filtered out by selecting a filter time value larger than the typical
spike width but shorter than the expected valid pulse width.

For example, if a 1 kHz signal with 100 kHz noise is applied, adjusting the filter
time to 10 µs is the best choice.

The default setting is 0.1 µs. This will basically not filter based on pulse width.

The table below shows the different characteristics for each setting of the input
filter.

Selections
Filter Time (µs)1 Min detected pulse width (µs)1

0.1 (default setting) > 0.00
0.2 > 0.10
0.5 > 0.40
1 > 0.90
2 > 1.90
5 > 4.90
10 > 9.90
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(1) The character of the setting is shown in the table. According to the table,
if the filter time is set on 1 µs, the input signal with the pulse width of
0.8 µs cannot be detected. However, there is a tolerance on the setting so
for example, the input signal with the pulse width of 0.95 µs (or larger than
0.91 µs) can be detected. This is illustrated below.

Pulse Width Setting: 1 µs

Input

Output

(filtered)

Output

(Detected)

Input

0.8 µs

0.95 µs 0.95 µs

Figure D.5: Pulse width settings

D.4.13 Resistor

Basic settings

Sensor

Summary
Sensor connected to the channel. Selecting a sensor will automatically setup
the channel using information from the sensor database.

Description
When acquiring data, sensors are used to convert physically changing
phenomena to measurable signals. To properly record this data, the acquisition
system must be correctly configured. This can be achieved by manually
entering the information in the relevant fields in the settings sheet, but an easy
and less error-prone alternative is to use the sensor database. By selecting the
correct sensor all relevant settings are automatically set.

Note
This column is only available with the sensor database option, only sensors for
the current amplifier mode are available.
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Completion Resistance

Summary
Electrical resistance of the bridge.

Description
The schematic in Figure D.6 below indicates the value of resistor R2. The
resistor values are hardware dependent. For GEN series hardware, 120 and
350 Ohm internal resistors are typically available and there is an option to
connect an external value. For more detailed and specific information, please
refer to the hardware manual.

TEDS Class 3

TEDS 

Class 2 

optional

Resistor sensor

Shunt

-

+
R1

R2

R4

R3

Amplifier

-1

Excitation

Sense (-)

Excitation (-)
Sense (+)

Excitation (+)

120 Ω - ¼ bridge

Signal (-)

Signal (+)

½ bridge

Signal ground

TEDS

Control

Teds (+) 

Teds (-) 

+

-

+V

-V

TEDS class 2/3

External shunt 

CAL

Signal conditioner

+
-

+
-

Uexcit

Int shunt 

350 

10 MΩ

10 MΩ

Ω - ¼ bridge

Pos/negInt/ext

Figure D.6: Resistor mode block diagram

Excitation span

Summary
Span value for excitation.
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Excitation span

Description
This setting represents the Full Scale voltage that is applied. The span is twice
the Excitation range.

Excitation range

Summary
Range value for excitation.

Description
Represents the range of the voltage that is applied. The excitation range is
bipolar and therefore half the Excitation span.

Wiring

Summary
Wiring of the sensor to the amplifier

Description
Specifies how the sensor is connected to the amplifier and how the sensor is
powered. Basic sensors are connected through two wires but more complex
sensors may also use three or four wires.

Three or four wire sensors maybe powered through an external power source.
Please refer to the documentation of the sensor and amplifier that is used for
more detailed information.

Range from

Summary
Lower limit of the input span.
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Range from

Description
Defines the lower limit of the input span. Combined with the range to it defines
the physical measurement range.

Range to

Summary
Upper limit of the input span.

Description
Defines the upper limit of the input span. Combined with the range from it
defines the physical measurement range.

Technical units multiplier

Summary
Multiplier “a” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
system or convert the measured input into a different unit. The technical units
multiplier is the scaling factor “a” in the formula above.

The other related settings are “Technical units offset” and “Technical units”.
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Technical units offset

Summary
Offset “b” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
offset is the offset factor “b” in the formula above.

The other related settings are “Technical units multiplier” and “Technical units”.

Technical units

Summary
Units of “y” in a technical units formula:

Description
The measured input data can be transformed to a different scale by using the
linear equation described above. This can be used for example to calibrate the
channel or convert the measured input into a different unit. The technical units
define the new units.

The other related settings are “Technical units multiplier” and “Technical units
offset”.
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Filter type

Summary
Removes unwanted frequency signal components by selecting the correct filter
type.

Description
A filter can be used to suppress unwanted high-frequency signal components.
A filter is defined by its “Filter type” and “Filter Frequency”, often called cut-off
frequency.

Typical available filter types are:
l FIR: This is a lowpass Finite Impulse Response filter.
l Bessel: This is a lowpass Infinite Impulse Response (IIR) filter.
The cut-off frequency of the filters is defined by the “Filter Frequency” setting.

 

Filter frequency low

Summary
Frequency below which the power is 0.5 the power of the pass band
(-3 dBpoint) when using bandpass filters.

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.
The filter frequency low is only available when using a bandpass filter.
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Filter frequency high

Summary
Frequency above which the power is 0.5 the power of the pass band
(-3 dBpoint).

Description
The filter frequency defines the pass band of the filter. This frequency is also
often called the cut-off frequency. This is the frequency where the signal has
been attenuated to half the power of the pass band.

The available filter frequencies depend on the sample rate and the Filter type.

Typical available values are:
l FIR: 1/4, 1/10,1/20 and 1/40 of the sample rate
l Bessel: 1/10, 1/20, 1/40 and 1/100 of the sample rate
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D.5 Sensors group

D.5.1 Introduction
The Sensors group includes more procedures than settings. These procedures
are typically used for various calibration purposes of bridge amplifiers, although
some of them (balancing) can also be used in combination with basic-sensor
channels.

The need for calibration arises frequently in the use of strain gauge
instrumentation. Periodic calibration is required, of course, to assure the
accuracy and/or linearity of the instrument itself. More often, calibration is
necessary to scale the instrument's sensitivity (by adjusting gauge factor or
gain) so that the registered output corresponds conveniently and accurately to
some predetermined input.

The Sensors group provides the means to accurately determine the zero point
of a bridge or sensor, to verify proper operation by means of shunt verification,
and to calibrate a channel using one- or two-point calibration methods.

 

D.5.2 Shunt verification

Introduction
Decreasing the resistance of a bridge arm by shunting with a larger resistor
offers a simple, potentially accurate means of simulating the action of a strain
gauge. This method, known as shunt verification, does not place severe
tolerance requirements on the shunting resistor and is relatively insensitive to
modest variations in contact resistance.

Because of its numerous advantages, shunt verification is the normal procedure
for verifying or setting the output of a strain gauge instrument relative to a
predetermined mechanical input at the sensor.

The Shunt verification section provides the means to do one-click verification.
It also allows you to observe the output of the bridge with a shunt applied.
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Task pane
Within the Shunt verification section there is an area above the settings that
provides:

l A graphical representation of the verification circuit
l A task pane with verification-related commands and feedback

You can also use the diagram to modify settings.

The task pane provides the following groups: Control and Warnings.

Control
Within the Control group there is a single command:

l Verify Click this command to verify the impact of the shunt
resistor.

To verify the selected channel(s) the system must be
acquiring data. Typically the Pause mode is used to do
this. When the system is not acquiring data, a
confirmation dialog will come up.

The verify process by itself will bring in the shunt
resistor and measure the output variation (Deflection).
This value will be compared to the Target value and
the Error will be calculated.

Warnings
Within the Warnings group you can define a personal warning level: the error
measured during verification that is unacceptable. Percentages are given as a
percentage of the Target.

l Warning level Set the warning level as a percentage of the Target. If
the error is equal to or above the set level, a warning
will be generated.

l Detected
warnings

The number of detected warnings after the last verify
command

l Show only
channels with
warnings

If checked, only the channels that have a warning will
be displayed in the settings grid. For large channel
count systems this gives an instant overview of the
conflicting channels.
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Basic settings

Actual value (RO)

Summary
Shows actual values when monitoring is on.

Description
Use the column header context menu to turn on monitoring of the actual value
of the channel. The actual value will be shown in Volts and is updated about
once a second.

 

No Shunt (Volt/TU) – (RO)

Summary
Measured value without shunt resistor.

Description
The No Shunt value is the output of the bridge if no shunt resistor is applied
to the active gauge(s). This value is measured when you click the verify button
in the graphics area related with the shunt verification settings. The system will
automatically turn off the shunt resistor and then measure the output of the
bridge.

Verification of the bridge using a shunt resistor typically requires the bridge to
be unloaded. The value of the bridge without a shunt resistor may be displayed
as a voltage output or in technical units. If using technical units, please make
sure that your bridge amplifier has been set up correctly by going through the
bridge wizard, or loading a settings file or experiment containing hardware
settings. The system will use the information from these sources to translate
between voltage and technical units. Failing to load or set the relevant
information may cause values to look inappropriate.
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Shunt (Volt/TU) – (RO)

Summary
Measured value with shunt resistor.

Description
The Shunt value is the output of the bridge if a shunt resistor is applied to the
active gauge(s). This value is measured when you click the verify button in the
graphics area related with the shunt verification settings. The system will
automatically turn on the shunt resistor and then measure the output of the
bridge.

Verification of the bridge using a shunt resistor typically requires the bridge to
be unloaded. The value of the bridge without a shunt resistor may be displayed
as a voltage output or in technical units. If using technical units, please make
sure that your bridge amplifier has been set up correctly by going through the
bridge wizard, or loading a settings file or experiment containing hardware
settings. The system will use the information from these sources to translate
between voltage and technical units. Failing to load or set the relevant
information may cause values to look inappropriate.

 

Deflection (Volt/TU) – (RO)

Summary
Measured difference between the No Shunt and Shunt measurement.

Description
After the No Shunt and Shunt values have been measured, the difference
between these values is taken and displayed as the Deflection value. This
value may be displayed in technical units or volts. You can switch between
these two options by right-clicking the column header and selecting or
deselecting Show Values in TU.
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Target (Volt/TU)

Summary
Calculated target deflection

Description
When doing a shunt verification, the measured Deflection is compared to an
expected deflection. The Target is the expected deflection. The value entered
here will be used to verify if the difference between the bridge output value with
and without a shunt resistor is within the specified tolerance. The difference
between this value and the Deflection is represented as the error of the
balance.

You can enter this value in technical units or in volts. Right-click the column
header and turn the Show Values in TU option on or off as desired.

 

Error (TU/Volt) – (RO)

Summary
Difference between measured and target value.

Description
The difference between the Target value and the Deflection is represented
as the Error of the verification. The error is noted as the absolute difference
between the values.

You can enter this value in technical units or in volts. Right-click the column
header and turn the Show Values in TU option on or off as desired.

 

Error (%) – (RO)

Summary
The correction made during balancing as a percentage.
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Error (%) – (RO)

Description
The Error value as a percentage.

The difference between the Target value and the Deflection is represented
as the Error of the verification. The error is calculated as the relative difference
between the target and the deflection using the following formula:

You can also set up a tolerance for the error by setting the Warning level
(%) that is shown in the graphics area of the shunt verification. If the calculated
error exceeds the tolerance it will be shown in the settings sheet warning color.
Refer to the color legend to see what your warning color is and how to change
it.

 

Shunt location

Summary
Location of the shunt resistor.

Description
Specifies whether the shunt resistor that is currently in use is Internal or
External.

 

Shunt value

Summary
Resistive value of shunt, external or internal.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 677



Shunt value

Description
The Shunt value is the electrical resistance of the shunt resistor that is
currently in use. If Shunt location is set to Internal, this value matches the
value of the resistor in the mainframe. If set to External, it matches the
resistance of the external custom resistor.

Note When selecting an internal user mounted shunt resistor or an external shunt
resistor you need to make sure that the correct shunt value is entered. The
system by itself has no means to verify the correct values.

 

Shunt active Gauge

Summary
Active gauge for shunt calibration.

Description
Defines the location of the shunt resistor: either in parallel with the gauge that
is located in the positive arm of the bridge circuit or in parallel with the gauge
located in the negative arm.

 

D.5.3 Zero Balance and Calibration

Introduction
This section is used to calibrate a channel by means of Zero balance, a
single- or two-point calibration. Start and end points can be entered manually
or be part of the standard bridge configuration.

The procedure measures a point and converts it to a given value. By doing so,
the technical units multiplier is corrected.

A Wheatstone bridge is said to be in balance if the output voltage equals zero.
This situation occurs when the bridge resistors (clockwise named R1, R2, R3,
R4) have the following relation:
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Note This balance condition is valid independent of line resistance and excitation
voltage.

However, due to resistance tolerances or an inherent deviation (pre-load), a
residual voltage may be present in the initial situation. To compensate for this
error, the output of the bridge can be nulled.

Also, within the restrictions of your hardware, any “offset” voltage can be
compensated here for basic-sensor channels.

Task pane
Within the Channel calibration section there is an area above the settings that
provides:

l A graphical representation of the balance circuit
l A task pane with related commands and feedback

This task panel provides the following groups: Zero Balance, Warnings,
Calibrate, Control and Amplifier

Figure D.7: Zero Balance and Calibration

A Zero balance area

B Warnings area

C Calibration area

D Control area

E Amplifier area

Within the Zero balance group there are two commands:
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l Zero balance This command will actually balance the channel(s)
which have the setting “Zero balance enabled” setting
set to “On”. To Zero balance the channel(s) the system
must in Pause mode. When the system is not in this
mode we set the mode to Pause while balancing. After
balance the system will be set back to Idle.
For more info see section "Zero Balancing" on
page 398.

l Verify This command will only measure the actual input
value(s) without making a physical (electrical)
correction. Use this command to verify if all selected
channels are still within your specifications.

 

Warnings
Within the Warnings group you can define a personal warning level: the error
remaining after balancing that is unacceptable. Percentages are given as a
percentage of the Full Scale range. Example: a Full Scale range of ± 5 V (=
10 V span) can have a 1% remaining error. This equals a physical deviation of
0.01 x 10 V = 0.1 V.

l Warning level Set the warning level as a percentage of the Full
Scale. If the remaining error is equal to or above the
set level, a warning will be generated.

l Detected
warnings

The number of detected warnings after the last
balance or verify command

l Show only
channels with
warnings

If checked, only the channels that have a warning will
be displayed in the settings grid. For large channel
count systems this gives an instant overview of the
conflicting channels.

 

Calibration
Within the Calibrate group there are two commands: Start point and End point.

l Start point Apply a start reference value to the selected
channel(s) and click Start point. This will measure the
voltage that corresponds to the set start point
reference value.
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l End point Apply an end reference value to the selected
channel(s) and click End point. This will measure the
voltage that corresponds to the set end point reference
value.

 

Control

l Calibrate Click Calibrate to actually apply the measured values
to the technical units of the selected channel(s).

Amplifier
This group shows the input range of the amplifier(s) of the selected channel(s).

 

Basic settings

Zero Balance Enabled

Summary
Allows the channel to be zero balanced.

Description
Specifies whether the channel is allowed to be zero balanced. This option must
be ON for actual zero balancing.

Calibration method

Summary
Type of calibration: single or two-point.
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Calibration method

Description
Depending on what you want to do, you should select an appropriate
Method of calibration. Single-point calibration can be used to determine the
slope or Technical units multiplier of the channel. Single-point calibration
requires only a single point, the end point. The start point is assumed at 0. You
can also use a two-point calibration method to determine both the slope or
Technical units multiplier and the Technical units offset of a channel.

 

Manual Entry

Summary
If ON, uses manually entered values, if OFF, measures the values.

Description
When doing a sensor channel calibration you have two options for all calibration
methods. The first option is to manually set a known reference level point in
technical units and then apply a known input signal to the channel you want
to calibrate and measure this signal. The second option is to manually set a
known reference point in technical units and also manually set the actual
level.

 

Start point reference

Summary
Theoretical start value

Description
The Start point reference is the value you want to be recorded when the Start
point actual value is measured. After you have completed the calibration, this
is the value that will be displayed when the actual start point signal is applied
to the amplifier.
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Start point actual

Summary
Actually measured start value

Description
The actual start value is the real value at the start point. If Manual entry is set
to ON, you can manually enter a value to use for calibration, for example from
a spec-sheet. If the Use shunt setting is enabled, the actual start point will be
the value measured at the amplifier without the shunt resistor.

Use the Measure Start button in the graphic area of this sheet to start the actual
measurement.

 

End point reference

Summary
Theoretical end value

Description
The End point reference is the value you want to be recorded when the End
point actual value is measured. After you have completed the calibration, this
is the value that will be displayed when the actual end point signal is applied
to the amplifier.

 

End point actual

Summary
Actually measured end value
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End point actual

Description
The actual end value is the real value at the end point. If Manual entry is set
to ON, you can manually enter a value to use for calibration, for example from
a spec-sheet. If the Use shunt setting is enabled, the actual end point will be
the value measured at the amplifier with the shunt resistor.

Use the Measure End button in the graphic area of this sheet to start the actual
measurement.

Use shunt for end point

Summary
If ON, uses a shunt resistor to measure the end value.

Description
When calibrating bridge amplifier channels, it is possible to use a shunt
resistor to get a measured start and end point. If the Use shunt setting is set
to ON, doing a start measurement using the Measure Start button in the graphic
area will automatically turn off the shunt resistor before doing the
measurement. When using the Measure End button in the graphics area while
the shunt resistor is set to ON, the shunt resistor will automatically be turned
on before doing the measurement.

If you intend to use the shunt resistor for channel calibration, it is good practice
to balance the channel or channels you want to set up. Doing this will
automatically prepare the channel calibration values.

Status (RO)

Summary
Displays the status and result of the balancing.
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Status (RO)

Description
This column will show the balancing status of the channel. Typical values are
Not Balanced and Balanced. If Balance enable is set to OFF, the status is not
applicable.

 

Deviation (TU) – (RO)

Summary
The correction made when balancing.

Description
Shows the correction that was made when the channel was balanced. This
setting can be shown in technical units (default) and in volts. Use the column
header context menu to toggle the view. The deviation is also shown as a
percentage of the Span in a separate column. If Balance enable is set to
OFF, the deviation is not applicable.

 

Deviation (%) – (RO)

Summary
The correction made during balancing as a percentage.

Description
The Deviation value as a percentage.

 

Remainder (TU) – (RO)

Summary
The value that could not be corrected.
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Remainder (TU) – (RO)

Description
Shows the value that could not be corrected during balancing of the channel.
This setting can be shown in technical units (default) and in volts. Use the
column header context menu to toggle the view. If Balance enable is set to
OFF, the remainder is not applicable.

 

Remainder (%) – (RO)

Summary
The correction made during balancing as a percentage.

Description
The Remainder value as a percentage.
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D.6 Real-time calculators group

D.6.1 Introduction
The Real-time calculators group within the settings sheet comprises all cycle
based calculators that can be setup for real-time calculators and all other
settings related to how these channels behave within your measurement
system.
Channels that are not supported by your hardware are not included. However,
channels that are supported by your hardware, but not enabled, are displayed
as disabled (greyed).

The cycle based calculators use data from the input/general section as input
for the calculations performed. If input channels are used for real-time
calculators, they can still be disabled for storage, in that case only the calculated
results are stored and the raw data is discarded. Please note that calculation
results/trigger points can be affected by the setup of the input channels. For
example filtering may introduce a phase shift or amplitude change to the signal
being calculated. Cycle based calculators do not automatically compensate for
these influences. This can be done by changing the settings of input channels
in the Input group.

Note Real-time calculators do not introduce a phase shift to the data.

D.6.2 Cycle based calculator

Introduction
In order to setup a cycle based calculator, first the source on which the
calculation needs to be done needs to be selected. The listed sources are a
combination of Analog channels, Timer/Counter channels and Cycle Source of
the same recorder. Depending on the selected input channel, the list of
calculations allowed is updated.

Currently all cycle based calculators operate on a periodic basis and not sample
by sample. The period is determined by the selected cycle source (either a fixed
time or a cycle detect on one of the analog input signals of the card).
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Calculations allowed on “Analog channel” source:
Single channel calculation:
l Area
l Crest factor
l Energy
l Maximum
l Mean
l Minimum
l None
l Peak to Peak
l RMS

Note Selecting a “cross channel” calculation type enables the Source 2 column,
containing the analog channels of the recorder.

Calculations allowed on “Timer/Counter channel” source:
Single channel calculation:
l Frequency
l Frequency (gated)
l None
l RPM of Angle

Calculations allowed on “Cycle Source” source:
Single channel calculation:
l Cycles
l Cycle Frequency
l None

Note These are based on the cycle source, which in turn uses an analog channel’s
input to determine where cycles start and end. The output of these channels
depends on Cycle Source settings.

Basic settings

Enabled

Summary
When ON the channel is enabled for calculation and data storage.

Description
The enabled setting determines whether or not the data of this channel will be
stored during a recording.
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Name

Summary
Logical name of the channel.

Description
This is the name of the channel as used throughout Perception. The logical
name is used in the data sources navigator and is used for the display, formula
database, reporting, etc.

Source

Summary
The source of data on which the calculation is performed.

Description
This is the calculation source on which a calculation is wanted.

Calculation

Summary
The calculation performed by this channel on the selected source.

Description
This is the calculation performed on the calculation source data. Only
Calculations that are valid for the selected source data type are shown here.
When the selected source data type changes the Calculation is set to “None”.
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Cycle Source

Summary
The used cycle source for the calculation.

 
Description
This is the cycle source used for the calculation. It shows the name which can
be found in the “Cycle Source” grid.

Range From

Summary
Lower limit of the measurement range.

Description
Defines the lower limit of the measurement range. Combined with the range
to it defines the physical measurement range.

Range To

Summary
Upper limit of the measurement range.

Description
Defines the upper limit of the input measurement range. Combined with the
range from it defines the physical measurement range.
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Technical Unit

Summary
Units of the calculated quantity.

Description
The unit which is used throughout Perception to display which quantity is
calculated.

Note 1

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.
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Advanced settings

Note 2

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.

 

 

Note 3

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.
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Note 4

Summary
An additional field to enter miscellaneous information.

 

Description
Use this field to enter any additional information as text.

 

 

D.6.3 Cycle Source

Introduction
Every recorder that is real-time math capable can use multiple cycle sources.
A cycle source is the source of the interval to calculate over. There are two
types of cycle sources:

1 Timer based
2 Cycle detect based

In case a timer is selected, the cycle source is not related with any of the input
data, instead on a pre-defined regular interval, calculations are performed.
Calculation will always be performed at the given interval.

In case a cycle detect is selected, the interval between calculations is not
constant, but determined by the signal on the source of the cycle detector.
Besides having an influence on the time when calculations are performed, the
source input signal may also impact whether calculations can be performed at
all. If the shape (combination of amplitude and frequency) of the source signal
can no longer be resolved to cycles, or if the cycles coming out no longer fall
within the calculation specifications, this will be indicated in the recording and/
or live display showing the cycle based calculator using this detector as cycle
source.
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Basic settings

Cycle Source

Summary
Method of cycle detection.

 
Description
Select if cycle detection should be performed based on analyzing an input
signal or if a timer should be used that initiates calculations every Timer
Duration seconds.

Available methods of cycle detection are:
l Cycle detect
l Timer

Timer Duration

Summary
Time to use in each calculation.

 
Description
After every timer duration, the samples within that duration are processed by
the cycle based calculator and a new output value is generated.

Note
The timer duration is only available if the cycle detect is set to timer.
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Source

Summary
Channel which input is used to determine cycles for this recorder.

 
Description
The signal coming in through this channel is analyzed by the cycle source to
determine if/where new cycles start. These times are then distributed to the
calculations on the recorder to invoke new calculations over the cycle.

Note
The timer duration is only available if the cycle detect is set to cycle detect.

 

Level

Summary
Base-line to use for the cycle detection.

 
Description
Cycles are detected as crossings through the base line of a signal. For a typical
sine wave generator this level is 0, however there maybe influences that
introduce an (DC) offset to the signal. Use this setting to compensate for this
value in the cycle detection if you want to detect cycles based on crossing the
base of the signal.

Note
The timer duration is only available if the cycle detect is set to cycle detect.
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Hysteresis

Summary
Sets the hysteresis range for the cycle detect.

 
Description
The hysteresis is used to reduce the influence of noise for the Cycle Detect.
If a signal contains noise it can cause a false level crossing. Increasing the
hysteresis can help to avoid this.
With a hysteresis the cycle detect level is expanded to be a cycle detect zone
that spans multiple levels. As a consequence the actual level crossing position
is less clearly defined.

Note
The timer duration is only available if the cycle detect is set to cycle detect.

 

Direction

Summary
Sets the response direction of the level.

 
Description
This setting is used to determine in which direction the input signal should cross
the level. The possible directions are: Rising, Falling.
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Cycles

Summary
Sets how many level detects are required before a cycle based calculator
calculates.

 
Description
Cycle based calculators perform calculations based on a certain period of time,
the actual number of cycles required is based on the nature of your
applications. Use the Cycles setting to determine how many cycles should be
used.

Note
Use 0.5 to use half cycle accuracy.

 

D.6.4 Formula Database

Introduction
Real-time Formula Database (RT-FDB) calculators can be configured much
like formulas in the Formula sheet of the Analysis option supporting flexible
expressions. The RT-FDB expressions are executed in real-time while
acquisition is active.

Calculations in the Formula Database are defined as:

name = expression

The name is available in the Data Sources navigator as a variable when storage
is enabled (see Figure D.8). It can be found as an item in the Active.RTFormulas
tree.

The name can be used as parameter in another expression, regardless of the
physical order in the database.

You can enter calculations much like you would write them on paper. Standard
mathematical rules apply.
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Figure D.8: Example of a formula database setup

A Defines MyInput as an alias to the physical input signal
Recorder_B.Ch_B3 (a synchronous signal sampled with the sample rate
set for Recorder_B).

B Defines Multiplier as a scalar with value (2.5 * π).

C Defines MyScaledInput which represents a new synchronous signal with
the same sample rate as Recorder_B. The expression
(RTFormulas.MyInput * RTFormulas.Multiplier + 0.4) is evaluated for every
sample of physical input signal Recorder_B.Ch_B3.

D Defines CycleInput as a lowpass filtered version of input signal
Recorder_B.Ch_B2.

E Defines CycleSource as a cycle signal representing the detected cycles
on the defined CycleInput signal using default cycle detector settings.

F Defines RMSofInput as an asynchronous signal which represents the
RMS values of MyScaledInput calculated between the successive
detected cycles of the cycle signal CycleSource.

The example above (see Figure D.8) shows a read-only column (F - Result
type) which indicates the result type of each expression which is one of:
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l Synch: a signal with values at equidistant time intervals; i.e. sampled using
an internal time base.

l Asynch: a signal with values at non-equidistant time intervals; i.e. values
computed at timestamps of cycle source events.

l SyncAnalog: a synch signal of an analog input channel.
l SyncFilteredAnalog: a sync signal of a lowpass filtered analog input

channel.
l SyncTcFreq: a sync signal of a Timer/Counter channel in frequency mode.
l SyncTcCount: a sync signal of a Timer/Counter channel in counter mode.
l SyncTcAngle: a sync signal of a Timer/Counter channel in angle mode.
l SyncEventBit: a synch signal of an marker (event) channel.
l Scalar: a single numerical value.
l Cycles: a signal representing detected cycles on a periodic synchronous

signal.
Limitations apply to the operations/functions that can be used in combination
with certain result types.

Introduction to RT-FDB Boolean formulas
The Boolean family of RT-FDB formulas extend the real-time formula database
with possibility to output and operate on values true (one) and false (zero). This
allows for decision making logic to be added to the real time formula database.

The output types of these formulas are:
l SyncBool
l AsyncBool
Similar to the standard arithmetic functions, these two types cannot be mixed.
Entering formulas that combines these two output types will return an error
explaining the condition.

The underlying type of these variables is the same as a sync or async (Float or
Double) that just takes values of 1.0 and 0.0 and does not blend in with any of
the existent output types.

RTFDB Boolean formulas can be divided into two types:
l Arithmetic Boolean formulas: These take inputs signals or scalars in

general as an input, process them and return a Boolean result.
l Combinatorial formulas: These only take other Boolean values or scalars

as input. Any scalar input different than “zero” is considered as “one”.

When shown in Perception, the Boolean function have a different default range
for better reading:
Instead of:
 -10 to 10  is -1 to 2
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The following table shows differences between RT-FDB calculators, Analy-
sis option formulas and Cycle Based calculators:

 RT-FDB
calculators

Analysis option
formulas

Cycle Based
calculators

Execution Real-time during
acquisition

Recorded data Real-time during
acquisition

Execution
location

Supported
mainframe and
acquisition cards

PC Running
Perception

Supported
acquisition cards

Results can be
stored in PNRF
Triggering on
results (planned)
Input data Input signals and

RT-FDB from
mainframe

All (recorded) data
sources

Input signals of
own acquisition
card

Input signals
filtering

HW Filter before
digital filter
All other functions
after digital filter

All input signals
are used with filters
applied as
recorded

Input signals are
digitally filtered for
all functions and
cycle detectors

Result editing Results cannot be
changed after
recording

Formulas can be
changed updating
the results

Results cannot be
changed after
recording

CAN publishing
(Asynchronous

and scalar results)
GENDAQ API
publishing (Asynchronous

and scalar results)
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Errors and warnings
Entered expressions are checked for correctness as they are entered or
modified. These checks may result in an error or warning. Warnings are
indicated with a yellow triangle after the line number as shown in Figure D.9.

Figure D.9: RT-FDB warning notification

A Warning indicator

When clicking on the yellow triangle a description of the warning appears:

Figure D.10: Real Time Formulas warning message

This warning indicates that the entered parameter has been clipped
automatically to a valid value. A recording can still be made when one or more
warnings are present.
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Errors are indicated with a red error symbol before the line number as shown
in Figure D.11:

Figure D.11: RT-FDB error message

A Error indicator

Resource usage
The complete set of expressions is deployed on the mainframe hardware using
the following algorithms:

l A CycleDetect formula is deployed on the acquisition card of the analog
input.

l A CycleEvent formula is deployed on the acquisition card of the event bit
input.

l Calculations on synchronous input data are deployed on the acquisition
card where the source of the synchronous data resides.

l A CycleInterval formula is deployed on the first acquisition card which
needs this cycle source.

l Calculations on asynchronous data are deployed on the mainframe.
l The number of CycleDetect, CycleEvent and CycleInterval formulas that

can be deployed on a recorder is limited.
l Every synchronous result which is enabled for storage increases the

required storage bandwidth.

Basic arithmetic operations
The basic arithmetic operations (+, -, * and /) are supported on the following
result types:
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Table D.1: Operation result type

Expression1 type Expression2 type Operation result
type

Limitations

Scalar Scalar Scalar  
Scalar Synch Synch  
Synch Scalar Synch  
Synch Synch Synch Both sync signals

must stem from the
same acquisition
card

Scalar Async Async  
Asyn Scalar Async  
Async Async Async  

Note The unary minus operation (-) is supported on: scalars, sync and async signals.

Data storage

Storage mode Sample based
calculations sample
rate

Cycle based
calculations sample
rate

Sweep Fast Sweep sample rate Fast Sweep sample rate
Continuous Continuous sample rate Continuous sample rate
Dual Sweeps: Fast Sweeps

Sample rate
Continuous: No data
recorded

Sweeps: No data
recorded(1)

Continuous sample
rate(2)

Slow-Fast Sweep No data recorded No data recorded

(1) This means data is not visible when displayed on a display in Sweep mode.
(2) Calculations are performed at the Fast Sweep sample rate and then down

sampled and stored at the Continuous sample rate.

Note Real-time formulas are not supported when the system is in external time base
mode. Deployment of any RT-FDB formula will fail when in external time base
mode. Please switch the clock base setting to Decimal or Binary when working
with real-time formulas.
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Basic settings

Name

Summary
Logical name of the calculator result.

Description
This is the name as used throughout Perception. The logical name is used in
the data sources navigator, the display and the fieldbus.

Expression

Summary
The expression to use for the calculator.

Description
This can be a composite of input signals, numerical values, calculator results,
functions and mathematical operators describing the calculation(s) to execute.
In case the Name field is empty, the contents for the expression are treated as
comment.

Technical Unit

Summary
Units of the calculated quantity.

Description
The unit which is used throughout Perception to display which quantity is
calculated.
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Result type(RO)

Summary
Shows the type of the calculator result.

Description
Indicates the data type of the result. The result type can be:

l Sync (sample based)
l Async (cycle based)
l Cycles (cycle source output)
l Scalar
l SyncAnalog (analog input channel)
l SyncFilteredAnalog (filtered version of analog input channel)
l SyncTcFreq (Timer/Counter channel in frequency mode)
l SyncTcCount (Timer/Counter channel in counter mode)
l SyncTcAngle (Timer/Counter channel in angle mode)
l SyncEventBit (event channel bit)

 

Storage

Summary
When ON the calculator result is enabled for data storage.

Description
The storage setting determines whether or not the calculator results will be
stored during a recording.

 

Color

Summary
Default trace color in displays.
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Color

Description
When recorded data from this calculator is displayed, the default trace color is
defined by this setting. The trace color can always be changed via the display
trace properties.

Range from

Summary
Lower limit of the measurement range.

Description
Defines the lower limit of the measurement range. Combined with the range
to it defines the physical measurement range.

Range to

Summary
Upper limit of the measurement range.

Description
Defines the upper limit of the measurement range. Combined with the range
from it defines the physical measurement range.

Real-time calculators - Functions
Most functions accept parameters with different types. The following table
shows the function result type for functions which accept multiple input
parameters.
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Table D.2: Functions result types

Input types Function result type
Scalar and scalar Scalar
Scalar and async Async
Scalar and sync Sync
Async and async Async
Async and sync Sync
Sync and sync Sync

Note All @Cycle… functions produce cycle based results and thus always produce
async results.
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@Abs

Function
Calculates the absolute value of the parameter.

Syntax
@Abs(Input1)

Parameters
Input1 Input of type: scalar, sync or asyn

Output
The absolute value of Input1 with the same type as Input1.

Description
Calculates the absolute value of the input.
Positive values remain unchanged, negative values change their sign. This
function can be used to rectify signals or to force positive values for results.

Example
The following example creates a sine wave and rectifies this signal:

 Signal = @SineWave(100)
 Rectif = @Abs(RTFormulas.Signal)
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@And

Function
Computes the combinatorial And between two Boolean inputs.

Syntax
@And(Bool_Input1; Bool_Input2)

Parameters
Bool_Input1 Boolean Input signal 1
Bool_Input2 Boolean Input signal 2

Output
One (Boolean True) if both input signals are true, zero (Boolean False)
otherwise.

Description
Computes the combinatorial And between two Boolean inputs.

The underlying math is as:

=Out BoolInput1 && BoolInput2  

Example
The following example computes And for Bool_Output_Formula_1 and
Bool_Output_Formula_2:

 AndSig = @And(Boolean_Signal_1; Boolean_Signal_2)
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@AronConversion

Function
Calculates the given phase in a 2 phase to 3 phase conversion.

Syntax
@ AronConversion(Input1; Input2; PhaseNumber)

Parameters
Input1 Input signal phase 1
Input2 Input signal phase 2
Cd The number of the phase to calculate

Output
The value of the given phase.

Description
Calculates the given phase in a 2 phase to 3 phase conversion.

The underlying math is as:

=Phase number 1 out = input1 - ( ( input1 + input2 ) / 3)=>

=Phase number 2 out = (( (-1) * input1)  - input2) / 3=>

=Phase number 2 out = input2 - ( ( input1 + input2) / 3)=>

Example
The following example calculates the value of the phases from the signals
measured with Ch_A1 and Ch_A2:

 Phase1 = @AronConversion(Recorder_A.Ch_A1;
Recorder_A.Ch_A2; 1)

 Phase2 = @AronConversion(Recorder_A.Ch_A1;
Recorder_A.Ch_A2; 2)

 Phase3 = @AronConversion(Recorder_A.Ch_A1;
Recorder_A.Ch_A2; 3)
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@ATan

Function
Calculates the arctangent of the input parameter.

Syntax
@ATan(Input1)

Parameters
Input1 Input of type: scalar, sync or async

Output
The arctangent of Input1 with the same type as Input1.

Description
The ATan function returns the angle for which the tangent equals the argument.
The angle is returned in radians in the range between –π/2 and + π/2. The
arctangent is the inverse trigonometric function of the tangent.

Example
The following example calculates Pi by multiplying ATan(1) by four:

 Pi = 4 * @ATan(1)
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@ATan2

Function
Calculates the arctangent of the two input parameters.

Syntax
@ATan2(Input1, Input2)

Parameters
Input1 Input of type: scalar, sync or async
Input2 Input of type: scalar, sync or async

Output
The arctangent of the inputs.

Description
The ATan2 function computes the value of the arc tangent of Input1/Input2,
using the signs of both parameters to determine the quadrant of the angle. The
angle is returned in radians in the range between -π to + π.

Example
The following example calculates Pi by multiplying ATan2(1,0) by two:

 Pi = 2 * @ATan2(1;0)
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@BetweenBand

Function
Determines if an input is between the values of two other inputs

Syntax
@BetweenBand(Input1; Bound1; Bound2)

Parameters
Input1 Input signal 1.
Bound1 Bound to check.
Bound2 Bound to check.

Output
One (Boolean True) if signal 1’s value is between the bounds, zero (Boolean
False) otherwise.

Description
Determines if a signal is between the bounds of two other inputs.

The underlying math is as:

=Lowbound 

Out True 

min(bound1,bound2)  
=

=
=

Out False=

Highbound 
If (input1 > 

Else 

max(bound1,bound2)  
Lowbound && input1 <= Highbound) 

Example
The following example determines if the signal measured with Ch_A1 is
between the values of the signal measured with Ch_A2 and Ch_A3:

 BBandSig = @BetweenBand(Recorder_A.Ch_A1;
Recorder_A.Ch_A2; Recorder_A.Ch_A3)
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@Cosine

Function
Calculates the cosine of the input parameter.

Syntax
@Cosine(Input1)

Parameters
Input1 Input of type: scalar, sync or async signal

Output
The cosine of Input1 with the same type as Input1.

Description
The Cosine function computes the trigonometric cosine of the input angle
expressed in radians.

Example
The following example calculates the cosine of π/2:

 CosHalfPi = @Cosine(System.Constants.Pi / 2)
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@CycleArea

Function
Calculates the area under curve.

Syntax
@CycleArea(Input1, Cd)

Parameters
Input1 Input of type sync
Cd The cycle source to use

Output
The area under the curve of Input1, the output type is async.

Description
The CycleArea function computes the area under the curve of Input1 between
two successive cycles present in Cd.

Example
The following example creates a periodic cycle timer with an interval of 0.1 s.
The async area signal represents the area under the input signal
Recorder_A.Ch_A1 at 0.1 s intervals:

 CycleTimer = @CycleInterval(0.1)
 Area = @CycleArea(Recorder_A.Ch_A1;

RTFormulas.CycleTimer)
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@CycleCount

Function
Counts the number of cycles.

Syntax
@CycleCount(Cd)

Parameters
Cd The cycle source to use

Output
The async signal representing the number of cycles since start of recording.

Description
The CycleCount function counts the number of cycles present in Cd. In case
the cycle source is a cycle detector this function accounts for the number of
cycles set for the detector: the result of this function counts the number of cycles
at the input of the cycle detector.

Example
The following example creates a cycle detector on Recorder_B.Ch_B6, and an
asynchronous waveform counting the number of cycles found:

 Filtered_B6 = @HWFilter(Recorder_B.Ch_B6; 0)
 CycleSource = @CycleDetect(RTFormulas.Filtered_B6)
 NumCycles = @CycleCount(RTFormulas.CycleSource)
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@CycleCrestFactor

Function
Calculates the crest factor of a signal.

Syntax
@CycleCrestFactor(Input1; Cd)

Parameters
Input1 Input of type sync
Cd The cycle source which determines the calculation period

Output
The crest factor of Input1 between two successive cycles of cycle source Cd.
The output type is async.

Description
This function calculates the crest factor: the absolute peak amplitude of
Input1 divided by the RMS value of Input1.

For a pure sinusoidal input signal the crest factor is sqrt(2).

Example
The following example calculates the energy of input signal Recorder_A.Ch_A1
for every two full periods:

 Input = Recorder_A.Ch_A1
 Filtered = @HWFilter(RTFormulas.Input; 0; 500)
 Cd = @CycleDetect(RTFormulas.Filtered; 2)
 CrestFactor = @CycleCrestFactor(RTFormulas.Input;

RTFormulas.Cd)
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@CycleDetect

Function
Detects cycles on a filtered analog input signal.

Syntax
@CycleDetect(Input1; Cycles; Level; Hysteresis; HoldoffTime; Direction)

Parameters
Input1 The filtered analog input signal on which to detect cycles. This

needs to be the output of a @HWFilter function.
Cycles The number of cycles to use (0.5, 1, 2, 3 … 50; default is 1).
Level The detection level; default is 0.

At least 1 and no more than 2000 events per second can be
processed by the cycle detector. Outside of this range no
cycles are detected (no trace is shown and meter shows
dashes). Therefore, the ‘Cycles’ argument controls the
operating range. The table below lists the range.

    
 ‘Cycles’ Valid results in ‘Operating

range’
 

 0.5 [0.5 Hz; 1 kHz]  
 1 [1 Hz; 2 kHz]  
 2 [2 Hz; 4 kHz]  
 … …  
 50 [100 Hz; 200 kHz]  
    
Hysteresis The “Hysteresis” above and below the detection level; default

is 1. “Hysteresis” can be an absolute value or relative to the
channel's span. Check “Hysteresis Mode” argument
description.

Hysteresis
Mode

An integer value that defines the “Hysteresis” mode.
0 - Absolute mode
1 - Relative [to span percentage] mode.
In this mode, the “Hysteresis” value must vary between 1 and
10. Check additional notes. Default value is 0, absolute.

HoldoffTime The holdoff time to use for edge detections: edges detected
within the holdoff time are suppressed; default is 0.

Direction Set the direction of the signal to react on (0 for rising, 1 for
falling; default is rising); ignored when Cycles is 0.5.
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Output (SyncBool / AsyncBool / Scalar)
A cycle signal representing detected cycles.

Description
The CycleDetect function detects cycles of periodic signals on a physical
analog input. Each CycleDetect function uses a dedicated hardware cycle
detector with a block diagram shown in Figure D.12.

 

+ 

 

 

Edge selector

Fc

HWFilter
Level

Level - Hyst  

Rising edge detector

Level

Level + Hyst  

Falling edge detector

Holdoff timer Divider Timeout

Figure D.12: Cycle detector block diagram

The analog input signal is lowpass filtered with a HWFilter function.
The filtered signal is fed to two edge detectors:

l Detecting rising edges
l Detecting falling edges

Both detectors use the Level setting as detection level which needs to be
crossed, the Hysteresis level is used by both detectors to re-arm the level
detector. Hysteresis parameter will be clipped from 1 to 10 percent of the
channel’s span, even if in absolute mode.

The Edge selector selects rising edges or falling edges depending on the
Direction setting when the Cycles setting is greater or equal to 1. The Edge
selector selects both rising and falling edges when the Cycles setting is 0.5
and the Direction setting will be ignored.
The selected edges are fed to the Holdoff timer which suppresses edge
detections within the Holdoff time setting after the last passed edge detection.

Note The Holdoff timer is a non-retriggerable one-shot timer.

Finally the edge detections are passed to a divider which passes 1 out of N
edge detections, where N equals the Cycles setting (for Cycles ≥ 1) or 1 for
Cycles = 0.5.
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The output of the divider is a cycle signal which can be used to end/restart
calculation periods of cycle based calculation functions (@CycleXXX).

Limitations
HoldoffTime: the holdoff time is rounded to a multiple of the sample interval.

Example
The following example creates a HWFilter and a cycle detector on
Recorder_B.Ch_B6 to detect full cycles on each rising edge. The input signal
is lowpass filtered at 500 Hz, and edges within 700 µs are suppressed:

 CdFilterFreq = 500
 CdHoldoff = 700u
 Filtered = @HWFilter(Recorder_B.Ch_B6; 0;

RTFormulas.CdFilterFreq)
 CycleSignal = @CycleDetect(RTFormulas.Filtered; 1; 0;

1; RTFormulas.CdHoldoff; 0)

The following example uses the same filtered signal as the previous, but this
time has a relative hysteresis of 5% of the channel’s span and a 50 ms  hold
off time:

 CycleSignal = @CycleDetect(RTFormulas.Filtered; 1; 0;
5; 0.050; 1)
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@CycleEnergy

Function
Calculates the energy of a signal.

Syntax
@CycleEnergy(Input1; Cd)

Parameters
Input1 Input of type Sync
Cd The cycle source which determines the calculation period

Output
The energy of Input1. The output type is async.

Description
Let yi be the value of the first input sample of the calculation period.
Let yj be the value of the last input sample of the calculation period.
Let Δt be the time between two consecutive input samples.

CycleEnergy =
j

n n=i
y 2(( ) )§  

t

Example
The following example calculates the energy of input signal Recorder_A.Ch_A1
for every two full periods:

 Input = Recorder_A.Ch_A1
 Filtered = @HWFilter(RTFormulas.Input; 0; 500)
 Cd = @CycleDetect(RTFormulas.Filtered; 2)
 Energy = @CycleEnergy(RTFormulas.Input;

RTFormulas.Cd)
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@CycleEvent

Function
Detects cycles on an event channel bit.

Syntax
@CycleEvent(Input1; Cycles; HoldoffTime; Direction, Timeout)

Parameters
Input1 The event bit input signal
Cycles The number of cycles to use (0.5, 1, 2, 3 … 50; default is 1)
HoldoffTime The hold off time to use for edge detections: edges detected

within the hold off time are suppressed; default is 0
Direction Set the direction of the event bit to react on (0 for rising edge,

1 for falling edge; default is rising edge); ignored when
Cycles is 0.5 (which means both rising and falling edge)

Timeout Timeout value in seconds. Select 0 to disable timeout function.
Default value is 0, “disabled”

Output
A cycle signal representing detected cycles or expired timeouts. The timeout
shall only be active when it is enabled.

Description
Detects cycles on an event bit input.

Timeout
The timeout timer monitors if cycle signals are generated within the specified
Timeout time frame. Each cycle signal resets the timeout timer. When the
timeout timer expires a cycle signal is generated. This cycle signal is handled
by the cycle based functions (@CycleXXX).

Example
The following example creates a cycle detector on an event bit input. Every
other rising edge of the event bit input results in a cycle:

 Cd = @CycleEvent(Recorder_A.Ev_A7_01; 2)
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@CycleFrequency

Function
Calculates the input frequency of a cycle source.

Syntax
@CycleFrequency(Cd)

Parameters
Cd The cycle source

Output
An async signal representing the frequency of the input signal of the cycle
source.

Description
The CycleFrequency function uses the cycle source information to calculate
the frequency of the cycle detector input signal. The function compensates for
the number of (half-)cycles parameter of the cycle detector Cd. The resolution
of the function output depends on the following:

l The sample rate of the cycle detector input signal: higher sample rates give
higher resolution.

l The number of cycles parameter of the cycle detector: higher number of
cycles gives a higher resolution (but at a lower async result rate).

Example
The following example creates a filter and a cycle detector on an analog input
channel and computes the frequency of the input signal:

 Filtered = @HWFilter(Recorder_A.Ch_A1; 0
 Cd = @CycleDetect(RTFormulas.Filtered; 2; 0; 1)
 Ch_A1_Freq = @CycleFrequency(RTFormulas.Cd)
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@CycleFundamentalPhase

Function
Calculates the phase difference of the fundamental frequency present in two
input signals.

Syntax
@CycleFundamentalPhase(Input1; Input2; Cd; MinCycleFrequency)

Parameters
Input1 Reference input signal
Input2 Input signal
Cd The cycle source which determines the calculation period
MinCycleFrequency The minimum cycle frequency to account for

Output
The phase difference of the fundamental frequency present in Input1 and
Input2.

Description
The CycleFundamentalPhase function calculates the fundamental frequency
from the input frequency of cycle source Cd. The phase of this fundamental
frequency is determined for Input1 and Input2, the output of this function is the
difference between these two phases.

The output is in the range from 0 to 2*π radians, and indicate how much
Input2 is ahead of the reference Input1.

In case Input1 or Input2 do not contain the fundamental frequency, the output
of this function is unpredictable.

Limitations
The MinCycleFrequency parameter is used to limit the resource usage of this
function: it sets the minimum cycle source frequency. In case the actual cycle
source frequency drops below the MinCycleFrequency the function does not
calculate the phase difference anymore and yields a QNaN (Quiet Not-a-
Number) value.
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Example
The following example computes the fundamental phase difference between
analog inputs Ch_A1 and Ch_A2:

 Filtered = HWFilter(Recorder_A.Ch_A1; 0)
 Cd = @CycleDetect(RTFormulas.Filtered; 2; 0; 1)
 PhaseDiff = @CycleFundamentalPhase(Recorder_A.Ch_A1;

Recorder_A.Ch_A2; RTFormulas.Cd; 20)
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@CycleFundamentalRMS

Function
Calculates the RMS value of the fundamental frequency present in the input
signal.

Syntax
@CycleFundamentalRMS(Input1; Cd; MinCycleFrequency)

Parameters
Input1 Input signal
Cd The cycle source which determines the calculation period
MinCycleFrequency The minimum cycle frequency to account for

Output
The RMS value of the fundamental of Input1 for each detected cycle Cd.

Description
The CycleFundamentalRMS function calculates the RMS value of the
fundamental of the signal for each detected cycle of cycle source Cd.

Limitations
The MinCycleFrequency parameter is used to limit the resource usage of this
function: it sets the minimum cycle source frequency. In case the actual cycle
source frequency drops below the MinCycleFrequency the function does not
calculate the RMS anymore and yields a QNaN (Quiet Not-a-Number) value.

Example
The following example computes the fundamental RMS of analog input Ch_A1:

 Filtered = HWFilter(Recorder_A.Ch_A1; 0
 Cd = @CycleDetect(RTFormulas.Filtered; 2; 0; 1
 Rms = CycleFundamentalRMS(Recorder_A.Ch_A1;

RTFormulas.Cd; 20)
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@CycleInterval

Function
Generates cycle events at a fixed time interval.

Syntax
@CycleInterval(Interval; LeadinTime)

Parameters
Interval The time between two successive cycle events in seconds
LeadinTime The first cycle event offset time (default value is 0)

Output
A cycle signal with cycle events.

Description
The CycleInterval function creates a cycle signal with cycle events at fixed time
intervals of interval seconds. The first cycle event occurs at (Interval +
LeadinTime) seconds since start of acquisition.

Both the Interval and LeadinTime are rounded to a multiple of the sample
interval (1 / sample rate).

l The minimum Interval that can be specified is 500 µs.
l The LeadinTime must be in the range of -Interval to +Interval.

Example
The following example creates a cycle interval timer which generates cycle
events every second, with the first cycle event at 0.5 seconds after start of the
acquisition:

 CycleTimer = @CycleInterval(1; -0.5)
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@CycleMax

Function
Calculates the maximum value of a sync signal.

Syntax
@CycleMax(Input1; Cd)

Parameters
Input1 The sync input signal
Cd The cycle source which determines the calculation period

Output
The maximum value of Input1 between two cycle events of Cd.

Description
The CycleMax function calculates the maximum value of the input signal during
the calculation period.

Example
The following example calculates the maximum value of a signal during a full
period:

 Filtered = @HWFilter(Recorder_A.Ch_A1; 0)
 CycleDetect = @CycleDetect(RTFormulas.Filtered; 1; 0;

1)
 Max = @CycleMax(Recorder_A.Ch_A1;

RTFormulas.CycleDetect)
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@CycleMean

Function
Calculates the mean value of a sync signal.

Syntax
@CycleMean(Input1; Cd)

Parameters
Input1 The sync input signa
Cd The cycle source which determines the calculation period

Output
The mean value of Input1 between two cycle events of Cd.

Description
The CycleMean function calculates the mean value of the input signal during
the calculation period.

Example
The following example calculates the mean value of a signal during a full period:

 Filtered = @HWFilter(Recorder_A.Ch_A1; 0)
 CycleDetect = @CycleDetect(RTFormulas.Filtered; 1; 0;

1)
 Mean = @CycleMean(Recorder_A.Ch_A1;

RTFormulas.CycleDetect)
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@CycleMin

Function
Calculates the minimum value of a sync signal.

Syntax
@CycleMin(Input1; Cd)

Parameters
Input1 The sync input signal
Cd The cycle source which determines the calculation period

Output
The minimum value of Input1 between two cycle events of Cd.

Description
The CycleMin function calculates the minimum value of the input signal during
the calculation period.

Example
The following example calculates the minimum value of a signal during a full
period:

 Filtered = @HWFilter(Recorder_A.Ch_A1; 0)
 CycleDetect = @CycleDetect(RTFormulas.Filtered; 1; 0;

1)
 Min = @CycleMin(Recorder_A.Ch_A1;

RTFormulas.CycleDetect)
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@CyclePeakToPeak

Function
Calculates the peak-to-peak value of a sync signal.

Syntax
@CyclePeakToPeak(Input1; Cd)

Parameters
Input1 The sync input signal
Cd The cycle source which determines the calculation period

Output
The peak-to-peak value of Input1.

Description
The CyclePeakToPeak function calculates the peak-to-peak value of the input
signal during the calculation period.

Example
The following example calculates the peak-to-peak value of a signal during a
full period:

 Filtered = @HWFilter(Recorder_A.Ch_A1; 0)
 CycleDetect = @CycleDetect(RTFormulas.Filtered; 1; 0;

1)
 Pk2Pk = @CyclePeakToPeak(Recorder_A.Ch_A1;

RTFormulas.CycleDetect)
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@CyclePhase

Function
Calculates the phase difference between two cycle signals.

Syntax
@CyclePhase(Cd1; Cd2)

Parameters
Cd1 The input cycle signal
Cd2 The reference cycle signal

Output
The phase difference between the input cycle signal and the reference cycle
signal.

Description
The CyclePhase function calculates the phase difference between an input
and a reference cycle signal. The output is in the range from 0 to 2*π radians,
and indicate how much Cd1 is ahead of the reference Cd2.

Example
The following example calculates the phase difference between cycle detects
on Ch_A1 and Ch_A2:

 InpFilter = HWFilter(Recorder_A.Ch_A1; 1)
 RefFilter = HWFilter(Recorder_A.Ch_A2; 1)
 InpDetect = @CycleDetect(RTFormulas.InpFilter; 1; 0;

1)
 RefDetect = @CycleDetect(RTFormulas.RefFilter; 1; 0;

1)
 PhaseDiff = @CyclePhase(RTFormulas.InpDetect;

RTFormulas.RefDetect)
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@CycleRMS

Function
Calculates the RMS value of a sync input signal.

Syntax
@CycleRMS(Input1; Cd2)

Parameters
Input1 The sync input signal
Cd The cycle source which determines the calculation period

Output
The RMS value of Input1.

Description
The CycleRMS function calculates the RMS value of a sync input signal.

Example
The following example calculates the RMS value of Ch_A1:

 InpFilter = HWFilter(Recorder_A.Ch_A1; 1)
 InpDetect = @CycleDetect(RTFormulas.InpFilter; 1; 0;

1)
 RMS = @CycleRMS(Recorder_A.Ch_A1;

RTFormulas.InpDetect)
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@CycleRPM

Function
Calculates the RPM value of from the angle difference on input1 for each
detected cycle.

Syntax
@CycleRPM(Input1; Cd)

Parameters
Input1 Input signal
Cd The cycle source which determines the calculation period

Output
The RMS value of the fundamental of Input1 for each detected cycle Cd.

Calculates the RPM value from the angle difference on Input1 for each detected
cycle Cd.

Description
The CycleRPM function calculates the RPM value from the angle difference on
Input1 for each detected cycle of cycle source Cd.

Example
The following example calculates the RPM value from the angle measured with
Ch_A8:

 InpFilter = HWFilter(Recorder_A.Ch_A1; 1)
 InpDetect = @CycleDetect(RTFormulas.InpFilter; 1; 0;

1)
 RMS = @CycleRMS(Recorder_A.Ch_A8;

RTFormulas.InpDetect)
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@CycleTHD

Function
Calculates the total distortion of an input signal.

Syntax
@CycleTHD(Input1; Cd; MinCycleFrequency)

Parameters
Input1 The sync input signal
Cd The cycle source which determines the calculation period
MinCycleFrequency The minimum cycle frequency

Output
The total distortion of the input signal.

Description
The CycleTHD function calculates the RMS value of Input1 and the RMS value
of the fundamental frequency F present in Input1. The fundamental frequency
F is the calculated input frequency of the cycle source Cd.

The CycleTHD (expressed as a percentage) is calculated from the two RMS
values using the following equation:

CycleTHD = 1

2

( RMSinput

RMSfundamental
)100 *

Limitations
The MinCycleFrequency parameter is used to limit the resource usage of this
function: it sets the minimum fundamental frequency of which the total distortion
is determined. In case the actual cycle source frequency drops below the
MinCycleFrequency, the function does not calculate the distortion anymore and
yields a QNaN (Quiet Not-a-Number) value.

The RMSinput value is based on all frequencies present in the input signal (from
DC to half the sample rate).
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Example
The following example calculates the CycleTHD of input channel Ch_A1
(provided that the input frequency is above 20 Hz):

 InpFilter = HWFilter(Recorder_A.Ch_A1; 1)
 InpDetect = @CycleDetect(RTFormulas.InpFilter; 1; 0;

1)
 CycleTD = @CycleTHD(Recorder_A.Ch_A1;

RTFormulas.InpDetect, 20)
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@DegreesToRadians

Function
Converts an angle from degrees to radians.

Syntax
@DegreesToRadians(Input1)

Parameters
Input1 The angle in degrees

Output
The angle in radians.

Description
The DegreesToRadians converts the angle Input1 from degrees to radians
using the following equation:

=
180

DegreesToRadians * Input1

Example
The following example converts an angle in degrees to radians:

 AngleRadians = @DegreesToRadians
(RT.Formulas.AngleDegrees)
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@DQ0Transformation

Function
Applies the DQ0Transformation to the input signals.

Syntax
@DQ0Transformation(Phase1; Phase2; Phase3; RefAngle; Comp;
Transform; Orientation)

Parameters
Phase1 The sync phase 1 input signal
Phase2 The sync phase 2 input signal
Phase3 The sync phase 3 input signal
RefAngle The reference angle signal in radians
Comp The resulting component selection: 0=direct, 1=quadrature,

2=zero
Transform The transformation rule to use: 0=amplitude, 1=power (default

is amplitude)
Orientation The orientation rule to use: 0=wiki, 1=matlab (default is wiki)

Output
The direct, quadrature or zero component of the DQ0 transformation depending
on Comp.

Description
The direct-quadrature-zero (DQ0) transformation (also known as Park’s
transformation) is a mathematical transformation used to simplify the analysis
of three-phase systems.

For a more detailed description, please refer to the Reference Guide of the
Perception Analysis User manual.

Example
The following example calculates the direct, quadrature and zero components
using the amplitude transformation rule and the wiki orientation rule:

 Direct = @DQ0Transformation(Recorder_A.Ch_A1;
Recorder_A.Ch_A2; Recorder_A.Ch_A3;
RTformulas.Angle; 0; 0; 0)
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 Quadrature = @DQ0Transformation(Recorder_A.Ch_A1;
Recorder_A.Ch_A2; Recorder_A.Ch_A3;
RTformulas.Angle; 1; 0; 0)

 Zero = @DQ0Transformation(Recorder_A.Ch_A1;
Recorder_A.Ch_A2; Recorder_A.Ch_A3;
RTformulas.Angle; 2; 0; 0)
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@Equal

Function
Determines if an input is equal to another input.

Syntax
@Equal(Input1; Input2)

Parameters
Input1 Input signal 1
Input2 Input signal 2

Output
One (Boolean True) if signals have an equal value, zero (Boolean False)
otherwise.

Description
Determines if a signal has the same value as another.

The underlying math is as:

=Epsilon 

Out True 

1e-9 

=

Out False=

If

Else 

(abs(input1-input2) < Epsilon)

Example
The following example determines if the signals measured with Ch_A1 and
Ch_A2 have an equal value:

 EqualSig = @Equal(Recorder_A.Ch_A1; Recorder_A.Ch_A2)
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@GreaterEqualThan

Function
Determines if an input is greater than or equal to another input.

Syntax
@GreaterEqualThan(Input1; Input2)

Parameters
Input1 Input signal 1
Input2 Input signal 2

Output
One (Boolean True) if signal 1 has a greater or equal value than signal 2, zero
(Boolean False) otherwise.

Description
Determines if a signal has a greater or equal value than another.

The underlying math is as:

=If (input1 > 
Out True 

input2)
=

Out False=
Else 

Example
The following example determines if the signal measured with Ch_A1 has a
greater or equal value than the signal measured with Ch_A2:

 GreaterEQSig = @GreaterEqualThan(Recorder_A.Ch_A1;
Recorder_A.Ch_A2)
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@GreaterThan

Function
Determines if an input is greater than another input.

Syntax
@GreaterThan((Input1; Input2)

Parameters
Input1 Input signal 1
Input2 Input signal 2

Output
One (Boolean True) if signal 1 has a greater value than signal 2, zero (Boolean
False) otherwise.

Description
Determines if a signal has a greater value than another.

The underlying math is as:

If (input1 > 
Out True 

input2)
=

Out False=
Else 

Example
The following example determines if the signal measured with Ch_A1 has a
greater value than the signal measured with Ch_A2:

 GreaterSig = @GreaterThan(Recorder_A.Ch_A1;
Recorder_A.Ch_A2)
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@HWFilter

Function
Creates a lowpass filter on an analog input.

Syntax
@HWfilter(Input1; Type; Fc)

Parameters
Input1 The sync analog input signal
Type The filter type to use: 0=wideband, 1=Bessel
Fc The cutoff frequency in Hz

Output
A lowpass filtered version of the analog input Input1.

Description
The HWFilter function creates a lowpass filtered version of an analog input
signal specifically to be used as input for a CycleDetect function. The actual
used cutoff frequency may differ from Fc depending on the sample rate and the
availability of filter settings.

Limitations
The output of a HWFilter can only be used for one CycleDetect.

Example
The following example creates a lowpass filter on analog input Ch_A1 using a
cutoff frequency of 100 Hz, and use that as an input for a cycle detector:

 InpFilter = HWFilter(Recorder_A.Ch_A1; 1, 100)
 InpDetect = @CycleDetect(RTFormulas.InpFilter; 1; 0; 1)

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 743



@LessEqualThan

Function
Determines if an input is less than or equal to another input.

Syntax
@LessEqualThan(Input1; Input2)

Parameters
Input1 Input signal 1
Input2 Input signal 2

Output
One (Boolean True) if signal 1 has a lower or equal value than signal 2, zero
(Boolean False) otherwise.

Description
Determines if a signal has a lower or equal value than another.

The underlying math is as:

=If (input1  
Out True 

input2)
=

Out False=
Else 

>

Example
The following example determines if the signal measured with Ch_A1 has a
lower or equal value than the signal measured with Ch_A2:

 LessEQSig = @LessEqualThan(Recorder_A.Ch_A1;
Recorder_A.Ch_A2)
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@LessThan

Function
Determines if an input is less than another input.

Syntax
@LessThan(Input1; Input2)

Parameters
Input1 Input signal 1
Input2 Input signal 2

Output
One (Boolean True) if signal 1 has a lower value than signal 2, zero (Boolean
False) otherwise.

Description
Determines if a signal has a lower value than another.

The underlying math is as:

If (input1  
Out True 

input2)
=

Out False=
Else 

>

Example
The following example determines if the signal measured with Ch_A1 has a
lower value than the signal measured with Ch_A2:

 LessSig = @LessThan(Recorder_A.Ch_A1;
Recorder_A.Ch_A2)
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@Max

Function
Calculates the maximum of two inputs.

Syntax
@Max(Input1; Input2)

Parameters
Input1 The first input signal
Input2 The second input signal

Output
The maximum value of Input1 and Input2.

Description
The Max function yields the maximum of Input1 and Input2.

Example
The following example calculates the maximum of input Ch_A1 and Ch_A2:

 InpMax = @Max(Recorder_A.Ch_A1; Recorder_A.Ch_A2)
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@Min

Function
Calculates the minimum of two inputs.

Syntax
@Min(Input1; Input2)

Parameters
Input1 The first input signal
Input2 The second input signal

Output
The minimum value of Input1 and Input2.

Description
The Min function yields the minimum of Input1 and Input2.

Example
The following example calculates the minimum of input Ch_A1 and Ch_A2:

 InpMin = @Min(Recorder_A.Ch_A1; Recorder_A.Ch_A2)
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@Modulo

Function
Calculates the remainder of a truncated division.

Syntax
@Modulo(Input; Divisor)

Parameters
Input1 The input
Divisor The divisor

Output
The remainder of the truncated division Input over Divisor.

Description
The Modulo function calculates the remainder of a truncated division using the
following equation:

=
Divisor

InputModulo *Input trunc( (Divisor

Where trunc(x) is defined as rounding x to an integer value towards zero, i.e.
trunc(-1.2) yields -1.

Note The result of this function always has the same sign as Input.

Example
The following example calculates the modulus of input Ch_A1 and 3.1:

 InpMod = @Modulo(Recorder_A.Ch_A1; 3.1)
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@Not

Function
Negates the Boolean Input.

Syntax
@Not(Bool_Input)

Parameters
Bool_Input1 Boolean Input signal

Output
Reverse of the boolean input signal.

Description
Negates the provided Boolean input.

The underlying math is as:

=Out !(BoolInput)

Example
The following example negates Bool_Output_Formula:

 NotSignal = @Not(Boolean_Signal)
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@NotEqual

Function
Determines if an input is not equal to another input.

Syntax
@NotEqual(Input1; Input2)

Parameters
Input1 Input signal 1
Input2 Input signal 2

Output
One (Boolean True) if signals have a different value, zero (Boolean False)
otherwise.

Description
Determines if a signal value is not equal to another.

The underlying math is as:

=Epsilon 

Out True 

1e-9 

=

Out False=

If

Else 

(!(abs(input1-input2) < Epsilon))

Example
The following example determines if the signals measured with Ch_A1 and
Ch_A2 have a not equal value:

 NEqualSig = @NotEqual(Recorder_A.Ch_A1;
Recorder_A.Ch_A2)
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@Or

Function
Computes the combinatorial Or between two Boolean inputs.

Syntax
@Or(Bool_Input1; Bool_Input2)

Parameters
Bool_Input1 Boolean Input signal 1
Bool_Input2 Boolean Input signal 2

Output
One (Boolean True) if any of the input signals is true, zero (Boolean False)
otherwise.

Description
Computes the combinatorial Or between two Boolean inputs.

The underlying math is as:

=Out BoolInput1 || BoolInput2

Example
The following example computes Or for Bool_Output_Formula_1 and
Bool_Output_Formula_2:

 OrSig = @Or(Boolean_Signal_1; Boolean_Signal_2)
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@OutsideBand

Function
Determines if an input is outside the bounds of two other inputs.

Syntax
@OutsideBand(Input1; Bound1; Bound2)

Parameters
Input1 Input signal 1
Bound1 Bound to check
Bound2 Bound to check

Output
One (Boolean True) if signal 1’s value is outside the bounds, zero (Boolean
False) otherwise.

Description
Determines if a signal is outside the bounds of two other inputs.

The underlying math is as:

=Lowbound 

Out True 

min(bound1,bound2)  
=

=
=

Out False=

Highbound 
If (input1  

Else 

max(bound1,bound2)  
Lowbound    input1 >> = Highbound) 

Example
The following example determines if the signal measured with Ch_A1 is outside
the values of the signal measured with Ch_A2 and Ch_A3:

 OBandSig = @OutsideBand(Recorder_A.Ch_A1;
Recorder_A.Ch_A2; Recorder_A.Ch_A3)
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@RadiansToDegrees

Function
Converts an angle from radians to degrees.

Syntax
@RadiansToDegrees(Input1)

Parameters
Input1 The angle in radians

Output
The angle in degrees.

Description
The RadiansToDegrees converts the angle Input1 from radians to degrees
using the following equation:

= 180RadiansToDegrees * Input1

Example
The following example converts an angle in radians to degrees:

 AngleDegrees = @RadiansToDegrees
(RT.Formulas.AngleRadians)
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@Ramp

Function
Generates a ramp (sawtooth) signal.

Syntax
@Ramp(Freq; Phi)

Parameters
Freq The frequency of the ramp signal in Hz
Phi The phase shift of the generated signal in radians (default 0)

Output
A generated ramp signal ranging from -1 to +1.

Description
The Ramp function generates a ramp signal with given frequency and phase
shift.

Example
The following example generates a ramp signal of 100 Hz:

 MyRamp = @Ramp(100)
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@(RT-FDB)And

Function
Computes the combinatorial And between two Boolean inputs.

Syntax
@And(Bool_Input1; Bool_Input2)

Parameters
Bool_Input1 Boolean Input signal 1 (SyncBool / AsyncBool / Scalar)
Bool_Input2 Boolean Input signal 2 (SyncBool / AsyncBool / Scalar)

Output (SyncBool / AsyncBool / Scalar)
One (Boolean True) if both input signals are true, zero (Boolean False)
otherwise.

Description
Computes the combinatorial And between two Boolean inputs.

The underlying math is as:

=Out BoolInput1 && BoolInput2  

Example
The following example computes And for Bool_Output_Formula_1 and
Bool_Output_Formula_2:

 AndInp = @And(Boolean_Signal_1; Boolean_Signal_2)

Note Any scalar input different than zero (0) is considered as true (1).
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@(RT-FDB)Equal

Function
Determines if an input is equal to another input.

Syntax
@Equal(Input1; Input2)

Parameters
Input1 Input signal 1 (Sync / Async / Analog / Scalar)
Input2 Input signal 2 (Sync / Async / Analog / Scalar)

Output (Sync / AsyncBool)
One (Boolean True) if signals have an equal value, zero (Boolean False)
otherwise.

Description
Determines if a signal has the same value as another.

The underlying math is as:

=Epsilon 

Out True 

1e-9 

=

Out False=

If

Else 

(abs(input1-input2) < Epsilon)

Example
The following example determines if the signal measured with Ch_A1 the value
of 0.5, outputting 1 if true or 0 if not.

 EqualInp = @Equal(Recorder_A.Ch_A1; 0.5)
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@(RT-FDB)GreaterEqualThan

Function
Determines if an input is greater than or equal to another input.

Syntax
@GreaterEqualThan(Input1; Input2)

Parameters
Input1 Input signal 1 (Sync / Async / Analog / Scalar)
Input2 Input signal 2 (Sync / Async / Analog / Scalar)

Output (SyncBool, AsyncBool)
One (Boolean True) if signal 1 has a greater or equal value than signal 2, zero
(Boolean False) otherwise.

Description
Determines if a signal has a greater or equal value than another.

The underlying math is as:

=If (input1 > 
Out True 

input2)
=

Out False=
Else 

Example
The following example determines if the signal measured with Ch_A1 has a
greater or equal value than 1.5, outputting 1 if true or 0 if false.

 GETInp = @GreaterEqualThan(Recorder_A.Ch_A1; 1.5)
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@(RT-FDB)GreaterThan

Function
Determines if an input is greater than another input.

Syntax
@GreaterThan(Input1; Input2)

Parameters
Input1 Input signal 1 (Sync / Async / Analog / Scalar)
Input2 Input signal 2 (Sync / Async / Analog / Scalar)

Output (SyncBool / AsyncBool)
One (Boolean True) if signal 1 has a greater value than signal 2, zero (Boolean
False) otherwise.

Description
Determines if a signal has a greater value than another.

The underlying math is as:

If (input1 > 
Out True 

input2)
=

Out False=
Else 

Example
The following example determines if 3.2 is greater than the signal measured
with Ch_A1, outputting 1 if true or 0 if false.

 GTInp = @GreaterThan(3.2; Recorder_A.Ch_A1)
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@(RT-FDB)InsideBand

Function
Determines if an input is inside the bounds formed by the values of two other
inputs.

Syntax
@InsideBand(Input1; bound1; bound2)

Parameters
Input1 Input signal 1 (Sync / Async / Analog)
Bound1 Bound to check (Sync / Async / Analog / Scalar)
Bound2 Bound to check (Sync / Async / Analog / Scalar)

Output
One (Boolean True) if signal 1’s value is between the bounds, zero (Boolean
False) otherwise.

Description
Determines if a signal is between the bounds of two other inputs.

The underlying math is as:

=Lowbound 

Out True 

min(bound1,bound2)  
=

=
=

Out False=

Highbound 
If (input1 > 

Else 

max(bound1,bound2)  
Lowbound && input1 <= Highbound) 

Example
The following example determines if the signal measured with Ch_A1 is inside
the bounds formed by 2 and 4, outputting 1 if true or 0 if false.

 IBInp1 = @InsideBand(Recorder_A.Ch_A1; 2; 4)
 IBInp2 = @InsideBand(Recorder_A.Ch_A1; 4; 2

Note Both syntaxes have the same behaviour.

Note This formula is not supported in EtherCAT®.
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@(RT-FDB)LessEqualThan

Function
Determines if an input is less than or equal to another input.

Syntax
@LessEqualThan(Input1; Input2)

Parameters
Input1 Input signal 1 (Sync / Async / Analog / Scalar)
Input2 Input signal 2 (Sync / Async / Analog / Scalar)

Output (SyncBool / AsyncBool)
One (Boolean True) if signal 1 has a lower or equal value than signal 2, zero
(Boolean False) otherwise.

Description
Determines if a signal has a lower or equal value than another.

The underlying math is as:

=If (input1  
Out True 

input2)
=

Out False=
Else 

>

Example
The following example determines if the signal measured with Ch_A1 has a
lower or equal value than 5, outputting 1 if true or 0 if false.

 LETInp = @LessEqualThan(Recorder_A.Ch_A1; 5)
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@(RT-FDB)LessThan

Function
Determines if an input is less than another input.

Syntax
@LessThan(Input1; Input2)

Parameters
Input1 Input signal 1 (Sync / Async / Analog / Scalar)
Input2 Input signal 2 (Sync / Async / Analog / Scalar)

Output (SyncBool / AsyncBool)
One (Boolean True) if signal 1 has a lower value than signal 2, zero (Boolean
False) otherwise.

Description
Determines if a signal has a lower value than another.

The underlying math is as:

If (input1  
Out True 

input2)
=

Out False=
Else 

>

Example
The following example determines if the signal measured with Ch_A1 is lower
than 0.7, outputting 1 if true or 0 if false.

 LTInp = @LessThan(Recorder_A.Ch_A1; 0.7)
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@(RT-FDB)Not

Function
Negates the Boolean Input.

Syntax
@Not(Bool_Input)

Parameters
Bool_Input Boolean Input signal (AsyncBool / SyncBool / Scalar)

Output (SyncBool / AsyncBool / Scalar)
Reverse of the boolean input signal.

Description
Negates the provided Boolean input.

The underlying math is as:

=Out !(BoolInput)

Example
The following example negates Bool_Output_Formula:

 NegInp = @Not(Boolean_Signal)

Note Any scalar input different than zero (0) is considered as true (1).
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@(RT-FDB)NotEqual

Function
Determines if an input is not equal to another input.

Syntax
@NotEqual(Input1; Input2)

Parameters
Input1 Input signal 1
Input2 Input signal 2

Output
One (Boolean True) if signals have a different value, zero (Boolean False)
otherwise.

Description
Determines if a signal value is not equal to another.

The underlying math is as:

=Epsilon 

Out True 

1e-9 

=

Out False=

If

Else 

(!(abs(input1-input2) < Epsilon))

Example
The following example determines if the signals measured with Ch_A1 is not
equal to 2, outputting 1 if true or 0 if false.

 NEInp = @NotEqual(Recorder_A.Ch_A1; 2)
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@(RT-FDB)Or

Function
Computes the combinatorial Or between two Boolean inputs

Syntax
@Or(Bool_Input1; Bool_Input2)

Parameters
Bool_Input1 Boolean Input signal 1 (SyncBool / AsyncBool / Scalar)
Bool_Input2 Boolean Input signal 2 (SyncBool / AsyncBool / Scalar)

Output (SyncBool / AsyncBool)
One (Boolean True) if any of the input signals is true, zero (Boolean False)
otherwise.

Description
Computes the combinatorial Or between two Boolean inputs.

The underlying math is as:

=Out BoolInput1 || BoolInput2

Example
The following example computes Or for Bool_Output_Formula_1 and
Bool_Output_Formula_2:

 OrInp = @Or(Boolean_Signal_1; Boolean_Signal_2)

Note Any scalar input different than zero (0) is considered as true (1).
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@(RT-FDB)OutsideBand

Function
Determines if an input is outside the bounds of two other inputs.

Syntax
@OutsideBand(Input1; bound1; bound2)

Parameters
Input1 Input signal 1 (Sync / Async / Analog)
Bound1 Bound to check (Sync / Async / Analog / Scalar)
Bound2 Bound to check (Sync / Async / Analog / Scalar)

Output (SyncBool / AsyncBool)
One (Boolean True) if signal 1’s value is outside the bounds, zero (Boolean
False) otherwise.

Description
Determines if a signal is outside the bounds of two other inputs.

The underlying math is as:

=Lowbound 

Out True 

min(bound1,bound2)  
=

=

Out False=

Highbound 
If  (input1  

Else 

max(bound1,bound2)  
Lowbound    input1 >> Highbound) 

Example
The following example determines if the signal measured with Ch_A1 is outside
the bounds formed by 2.5 and 3.5, outputting true if out of bounds, or false
otherwise.

 OBInp1 = @OutsideBand(Recorder_A.Ch_A1; 2.5; 3.5)
 OBInp2 = @OutsideBand(Recorder_A.Ch_A1; 3.5; 2.5)

Note Both syntaxes have the same behaviour.

Note This formula is not supported in EtherCAT®.

Perception

A02689_09_E00_00   HBK: UNRESTRICTED 765



@(RT-FDB)TriggerOnBooleanChange

Function
Fires a software trigger when a Boolean input changes state and meets the
conditions provided by a given configuration.

Syntax
@TriggerOnBooleanChange(RT-FDB channel; Direction)

Parameters
RT-FDB channel Boolean Channel to be monitored for triggers (SyncBool)
Direction Direction of level crossing to be checked (Scalar)

1 – Trigger on Positive Edge
2 – Trigger on Negative Edge
3 – Trigger on Both Edges

Output (Void)
This formula has no output.

Description
Fires a software trigger when an Input crosses a level and meets another
input’s configuration

The underlying math is as:

If (Direction = 1) 

FireTrigger()
PreviousInput = True

If((RT-FDB channel = True) & (PreviousInput = False)

If (Direction = 2) 

FireTrigger()
PreviousInput = False

If((RT-FDB channel = False) & (PreviousInput = True)

If (Direction = 3) 

FireTrigger()
PreviousInput = True

If((RT-FDB channel = True) & (PreviousInput = False)

FireTrigger()
PreviousInput = BelowThreshold

Else If((RT-FDB channel = False) & (PreviousInput = True)
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Example
The following example configures a Trigger to fire when BooleanSignal1
changes from false to true:
 TrigInp = @TriggerOnBooleanChange(BooleanSignal1; 1)
The following example configures a Trigger to fire when BooleanSignal1
changes from true to false:
 TrigInp = @TriggerOnBooleanChange(BooleanSignal1; 2)
The following example configures a Trigger to fire when BooleanSignal1
changes state:
 TrigInp = @TriggerOnBooleanChange(BooleanSignal1; 3)

Note Since the triggers generated through the RT-FDB structure are software
triggers, there are some limitations to this functionality.
There is a delta time between RT-FDB software triggers of at least
102 milliseconds, which means the triggers that should be fired in less than
102 ms after a previous fired trigger will be discarded.

In Figure D.14 is an example of the triggering behaviour:

Fired

Trigger

#1

Discarded

Trigger

102 ms

402 ms300 ms

Discarded

Trigger

Discarded

Trigger

Discarded

Trigger

Discarded

Trigger

Fired

Trigger

#2

Figure D.13: Behaviour of the RT-FDB triggering
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Table D.3: Operations with Trigger RT-FDB Formulas

Operation Sample
based re-
sults syn-
chronous

Cycle based
results asyn-
chronous

Storage in
PNRF re-
cording

Published to
EtherCAT®

TriggerOnBoolean
Change

Triggers Only

TriggerOnLevel Triggers Only
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@(RT-FDB)TriggerOnLevel

Function
Fires a software trigger when an input crosses a given threshold.

Syntax
@TriggerOnLevel(RT-FDB channel; Level; Direction)

Parameters
RT-FDB channel Channel to be monitored for triggers (Sync)
Level Level for the trigger condition (Sync, Scalar)
Direction Direction of level crossing to be checked (Scalar)

1 – Trigger on Rising Edge
2 – Trigger on Falling Edge
3 – Trigger on Both Edges

Output (Void)
This formula has no output.

Description
Fires a software trigger when an Input crosses a level and meets another
input’s configuration

The underlying math is as:

If (Direction = 1) 

FireTrigger()
PreviousInput = AboveThreshold

If((RT-FDB channel > Level) & (PreviousInput = BelowThreshold)

If (Direction = 2) 

FireTrigger()
PreviousInput = BelowThreshold

If((RT-FDB channel < Level) & (PreviousInput = AboveThreshold)

If (Direction = 3) 

FireTrigger()
PreviousInput = AboveThreshold

If((RT-FDB channel > Level) & (PreviousInput = BelowThreshold)

FireTrigger()
PreviousInput = BelowThreshold

Else If((RT-FDB channel < Level) & (PreviousInput = AboveThreshold)
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Example
The following example configures a Trigger to fire when TestSignal passes
through 10 with a rising edge:
 TrigInp = @TriggerOnLevel(TestRTFDBChannel; 10; 1)
The following example configures a Trigger to fire when TestSignal passes
through -10 with a falling edge:
 TrigInp = @TriggerOnLevel(TestRTFDBChannel; -10; 1)
The following example configures a Trigger to fire when TestSignal passes
through 10 with any edge (both edge mode):
 TrigInp = @TriggerOnLevel(TestRTFDBChannel; 10; 3)

Note Since the triggers generated through the RT-FDB structure are software
triggers, there are some limitations to this functionality.
There is a delta time between RT-FDB software triggers of at least
102 milliseconds, which means the triggers that should be fired in less than
102 ms after a previous fired trigger will be discarded.

In Figure D.14 is an example of the triggering behaviour:

Fired

Trigger

#1

Discarded

Trigger

102 ms

402 ms300 ms
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Figure D.14: Behaviour of the RT-FDB Triggering

Perception

770 A02689_09_E00_00   HBK: UNRESTRICTED



Table D.4: Operations with Trigger RT-FDB Formulas

Operation Sample
based re-
sults syn-
chronous

Cycle based
results asyn-
chronous

Storage in
PNRF re-
cording

Published to
EtherCAT®

TriggerOnBoolean
Change

Triggers Only

TriggerOnLevel Triggers Only
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@(RT-FDB)Xor

Function
Computes the combinatorial Exclusive Or between two Boolean inputs.

Syntax
@Xor(Bool_Input1; Bool_Input2)

Parameters
Bool_Input1 Boolean Input signal 1 (SyncBool, AsyncBool, Scalar)
Bool_Input2 Boolean Input signal 2 (SyncBool, AsyncBool, Scalar)

Output (Sync / Async Bool / Scalar)
One (Boolean True) if one and only one of the Boolean inputs is one, zero
(Boolean False) otherwise.

Description
Computes the combinatorial Exclusive Or between two Boolean inputs.

The underlying math is as:

=Out BoolInput1 ^ BoolInput2

Example
The following example computes Exclusive Or for Bool_Output_Formula_1 and
Bool_Output_Formula_2:

 XorInp = @Xor(Boolean_Signal_1; Boolean_Signal_2)

Note Any scalar input different than zero (0) is considered as true (1).
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@SampleCount

Function
Counts the amount of samples that have been captured since start of
recording.

Syntax
@SampleCount(Input1)

Parameters
Input1 Signifies a channel on a recorder

Output
A counter that starts at 0 and increases by 1 for every sample captured.
The output type is sync.

Description
This function counts the samples that have been produced and makes it
available as a signal.

Example

 Input = Recorder_A.Ch_A1
 sampleCount = @SampleCount(RTFormulas.Input)
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@Sine

Function
Calculates the sine of the input parameter.

Syntax
@Sine(Input1)

Parameters
Input1 Input of type: scalar, sync or async

Output
The sine of Input1 with the same type as Input1.

Description
The Sine function computes the trigonometric sine of the input angle expressed
in radians.

Example
The following example calculates the sine of π/4:

 SinQuarterPi = @Sine(System.Constants.Pi / 4)
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@SineWave

Function
Generates a sine wave signal.

Syntax
@SineWave(Freq; Phi)

Parameters
Freq The frequency of the sine wave signal in Hz
Phi The phase shift of the generated signal in radians (default 0)

Output
This function generates a sine wave signal with amplitude 1.

Description
The SineWave function generates a sine wave signal with given frequency and
phase shift.

Example
The following example generates a sine wave signal of 100 Hz:

 MySine = @SineWave(100)
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@SpaceVectorInverseTransformation

Function
Applies the inverse space vector transformation to the parameters.

Syntax
@SpaceVectorInverseTransformation(Alpha; Beta; Zero; Comp; Transform)

Parameters
Alpha The alpha component
Beta The beta component
Zero The zero(system) component
Comp The resulting component selection: 0=phase1, 1=phase2,

2=phase3, 3=magnitude, 4=angle[rad]
Transform The transformation rule to use: 0=amplitude, 1=power (default

is amplitude)

Output
The phase1, phase2, phase3, magnitude or angle component of the inverse
space vector transformation depending on Comp.

Description
The space vector transformation (also known as Clarke transformation) is a
mathematical transformation used to simplify the analysis of three-phase
systems.

For a more detailed description, please refer to the Reference Guide of the
Perception Analysis User manual.

Example
The following example calculates the alpha component of the space vector
transformation:

 Phase1 = @SpaceVectorInverseTransformation(RTFormulas.
Alpha; RTFormulas.Beta; RTFormulas.Zero;0; 0)
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@SpaceVectorTransformation

Function
Applies a SpaceVectorTransformation to the parameters.

Syntax
@SpaceVectorTransformation(Phase1; Phase2; Phase3; Comp; Transform)

Parameters
Phase1 The sync phase 1 input signal
Phase2 The sync phase 2 input signal
Phase3 The sync phase 3 input signal
Comp The resulting component selection: 0=alpha, 1=beta,

2=zero(system), 3=magnitude, 4=angle[rad]
Transform The transformation rule to use: 0=amplitude, 1=power (default

is amplitude)

Output
The alpha, beta, zero, magnitude or angle component of the space vector
transformation depending on Comp.

Description
The space vector transformation (also known as Clarke transformation) is a
mathematical transformation used to simplify the analysis of three-phase
systems.

For a more detailed description, please refer to the Reference Guide of the
Perception Analysis User manual.

Example
The following example calculates the alpha component of the space vector
transformation:

 Alpha = @SpaceVectorTransformation(Recorder_A.Ch_A1;
Recorder_A.Ch_A2; Recorder_A.Ch_A3; 0; 0)
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@Sqrt

Function
Calculates the square root of the input parameter.

Syntax
@Sqrt(Input1)

Parameters
Input1 Input of type: scalar, sync or async

Output
The square root of Input1 with the same type as Input1.

Description
The Sqrt function computes the square root of the Input1.

Example
The following example calculates the square root of 2:

 Sq2 = @Sqrt(2)
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@Tan

Function
Calculates the tangent of the input parameter.

Syntax
@Tan(Input1)

Parameters
Input1 Input of type: scalar, sync or async

Output
The tangent of Input1 with the same type as Input1.

Description
The Tan function computes the tangent of the Input1 which is expressed in
radians.

Example
The following example calculates the tangent of π/4:

 MyTan = @Tan(System.Constants.Pi / 4)
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@Xor

Function
Computes the combinatorial Exclusive Or between two Boolean inputs.

Syntax
@Xor(Bool_Input1; Bool_Input2)

Parameters
Bool_Input1 Boolean Input signal 1
Bool_Input2 Boolean Input signal 2

Output
One (Boolean True) if one and only one of the Boolean inputs is one, zero
(Boolean False) otherwise.

Description
Computes the combinatorial Exclusive Or between two Boolean inputs.

The underlying math is as:

=Out BoolInput1 ^ BoolInput2

Example
The following example computes Exclusive Or for Bool_Output_Formula_1 and
Bool_Output_Formula_2:

 MyXor = @Xor(Boolean_Signal_1; Boolean_Signal_2)

Perception

780 A02689_09_E00_00   HBK: UNRESTRICTED



D.6.5 RT-FDB Publishing
Some Real-time Formula Database (RT-FDB) results can be published to
external devices using a fieldbus or the GENDAQ API.

Once the RT-FDB formula is added, it will become available for publishing.
Typically, these formulas are either manually entered or generated by an
application such as “eDrive”, however the system also offers some reserved
internal information.

Note Only async and scalar result types can be published on the fieldbus.

Reserved information
AcquisitionState Indicates the systems acquisition state.
AcquisitionTime Current duration of the acquisition.
Latency Recording time for internally process the RT-FDB

data.

Note Depending on the available (fieldbus) options in the mainframe, the publication
target is enabled in the Real-time Calulators Publishing row (see
Figure D.15).

Figure D.15: RT-FDB - Publishing area

A Click button to create CAN DBC file of current setup

B Name of connected GEN series mainframe

C Resource usage

D Deployment status

E CAN bus load contribution
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A Save CAN DBC file as... Clicking button saves the current configuration
as a CAN DBC file.

B Mainframe: GEN7X-EDRIVE This links allows to open the details of the
RT-FDB load in the specific mainframe.

C Resource usage Indicates the load of the RT-FDB calculation in the
mainframe processing unit.

D Deployment status The deployment status indicates if the formula(s) can
be processed by the mainframe. If this does not state Succeeded, the
problem is typically indicated in the RT-FDB - Publishing area by a coloured
line and icon (see Figure D.16).

 

Figure D.16: Deployment status - error message
 Clicking on the icon will show the cause of the problem in more detail:

Figure D.17: Error message details
 Figure D.17: Error in deployment caused by missing “eDrive” license.

Some formulas, such as “SpaceVectorTransformation”, are only available
with licensed applications.

E CAN bus load contribution The CAN bus load contribution shows how
much the amount of published data contributes to the total CAN bus load
(see Figure D.15). The total load is based on the CAN bus bandwidth as
set in the “Mainframe Settings” dialog (see Figure D.19) and the update
rate selected there.

Note This is not  the full load on the CAN bus, only the amount contributed by the
mainframe CAN bus publishing. This means that even though this number is
below 100%, it is still possible the CAN bus is overloaded.
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Basic settings for RT-FDB - Publishing

Publish to GENDAQ API

Summary
Enables publishing to the GENDAQ API.

Description
If enabled, the results of this formula will be included in the data that is
published through the GENDAQ API data retrieval calls.

Publish to EtherCAT®

Summary
Enables publishing to EtherCAT®.

Description
If enabled, the calculator results are published as CoE SDO and PDO on the
EtherCAT® fieldbus.

Publish to CAN

Summary
Enables publishing to the connected CAN bus.

Description
If enabled, the results of this formula will be included in the data that is
published through the CAN fieldbus.
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CAN message ID

Summary
The formula will be published with this message ID.

Description
The formula will be automatically assigned to the first free message ID, at the
first free CAN location.

Figure D.18: CAN message - Automatic indexing

The Automatic indexing dialog (see Figure D.18) from the CAN bus setup
window (see Figure D.19) is used to determine the start index.
The CAN message ID can be manually changed. If it is set to an ID / location
combination that is already in use by another formula, an error will be
generated. When this happens, the formulas in the RT-FDB will not be correctly
deployed to the mainframe. Starting an acquisition in this state will result in an
omission of RT-FDB results.

CAN Message Byte Range

Summary
The formula will be published at these bytes in the message frame.
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CAN Message Byte Range

Description
The formula will be automatically assigned to the first free message ID (see
Figure D.18), at the first free CAN location. When enabling the first formula for
publish to CAN, it will be set to the start index from the mainframe properties,
starting at byte 0..3. When nothing is changed and a second formula is enabled,
this will be published at the same message ID, but from byte 4..8. Formulas
will also use 4 bytes as the values are published as 32 bit floating-point
numbers.
The CAN message ID can be manually changed. If it is set to an ID / location
combination that is already in use by another formula, an error will be
generated. When this happens, the formulas in the RT-FDB will not be correctly
deployed to the mainframe. Starting an acquisition in this state will result in an
omission of RT-FDB results.

Figure D.19: Mainframe settings - CAN bus setup
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D.7 Trigger group

D.7.1 Introduction
Within the HBM Genesis HighSpeed data acquisition systems, typically each
and every channel is equipped with a trigger detector, which makes it possible
to record just the phenomenon of interest, instead of having to search the full
memory to find it. The trigger detector gives the system the power to capture
elusive, short and unpredictable events. It determines how easily you can
extract the event of interest.

Using the various trigger modes, your data acquisition system is expanded to
an extremely versatile transient recorder. The trigger circuits may be configured
to trigger on many types of phenomena. In this section the different trigger
modes and their extensions can be set.

The graphical representation can be very helpful in understanding the various
modes and options.

Please refer to the manual that came with your digitizing equipment for more
details on specific capabilities within your system.

D.7.2 Recorder

Introduction
Trigger settings on the recorder level define how you can combine the channel
triggers with “external” trigger conditions. By definition the channel triggers (if
on for a specific channel) are OR-ed to generate a recorder trigger.

The “external” trigger conditions define other situations for triggering. The
recorder trigger can also be made available to other recorders in the same or
in a Sync mainframe. The recorder can also be set to use one or more of these
triggers.

The diagram gives a visual indication on the flow of the various triggers and
trigger sources.

Basic settings

External trigger in

Summary
Enables the use of the external trigger input on the mainframe.
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External trigger in

Description
The trigger can come from an external signal which is fed to the respective port
on the mainframe’s controller module. If this setting is enabled, a logical OR is
applied to the combination of the internal trigger detectors of each channel and
the external trigger signal.

Although this is a per-recorder setting, there is only one external trigger input
for the complete mainframe. Each individual recorder can be set to accept this
trigger.

However, a direction setting (if provided by the hardware) is mainframe-wide
and cannot be set on a per-recorder basis.

 

External trigger out level

Summary
Sets the active level of the external trigger output.

Description
This setting is applicable if External trigger out is enabled.

Depending on your hardware, one or more of the following settings may be
applicable:

l If its value is set to High Level, the output voltage of the output port is high
only when a trigger occurs (an active-high pulse).

l If its value is set to Low Level, the output voltage is constantly high and
becomes low when a trigger occurs (an active-low pulse).

l If its value is Hold High Level, the output signal becomes high when a
trigger occurs and stays high until the end of the acquisition.
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External qualifier in

Summary
If enabled, qualifies the trigger logic.

Description

When enabled, the qualifier signal is used as a “gate” for the channel and
external triggers.

As long as the qualifier is inactive, no trigger event is passed and the recorder
will not (generate a) trigger.

When enabled and the qualifier is active, triggers are “passed” and the recorder
can (generate a) trigger.

 

Advanced settings

System trigger 1

Summary
Sends and/or receives a trigger to/from another recorder using this trigger line.

Description
There are three trigger lines on the hardware that can be used to transfer trigger
signals among recorders. Each recorder can use these lines as input to or
output from its trigger detection logic, or even both. Therefore this setting can
take the values Disabled, Transmit, Receive, or Transceive.

 

System trigger 2

Summary
Sends and/or receives a trigger to/from another recorder using this trigger line.
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System trigger 2

Description
There are three trigger lines on the hardware that can be used to transfer trigger
signals among recorders. Each recorder can use these lines as input to or
output from its trigger detection logic, or even both. Therefore this setting can
take the values Disabled, Transmit, Receive, or Transceive.

 

System trigger 3

Summary
Sends and/or receives a trigger to/from another recorder using this trigger line.

Description
There are three trigger lines on the hardware that can be used to transfer trigger
signals among recorders. Each recorder can use these lines as input to or
output from its trigger detection logic, or even both. Therefore this setting can
take the values Disabled, Transmit, Receive, or Transceive.

 

System trigger 3 transfer mode

Summary
Selects whether system trigger 3 is reserved for transferring calculated channel
trigger signals or not.

Description
By default system trigger 3 is used to transfer trigger signals of calculated data
between recorders.
In order to transfer trigger signals of measured data like system trigger 1 and
2, system trigger 3 must be set to Measured data. This setting can take either
the value Calculated data or Measured data.
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Master slave trigger

Summary
Sends and/or receives a trigger to/from another mainframe using this trigger
line.

Description
When multiple mainframes are used to perform acquisition(s), a master/slave
module is used in order to synchronize them. The master/slave line is used to
transfer trigger signals between mainframes, and this setting configures how
it is used.

D.7.3 Analog channel

Introduction
The Analog channel trigger is the center of the trigger capabilities within the
data acquisition system.

The most sophisticated version is based on a digital trigger detector. For the
advanced trigger modes this single-level trigger detector with programmable
hysteresis has been implemented twice to provide a dual-level trigger detector
with selectable hysteresis on each channel. Levels are usually referenced as
primary trigger level and secondary trigger level. Various combinations of these
levels provide trigger modes like basic, alarm, window, sequential and more.

In addition, capabilities are available that provide slope triggering, pulse
detection, hold-off, interval detection and event count.

A separate section in this manual is committed to the numerous trigger
capabilities.

 

Basic settings

Trigger mode

Summary
Sets the mode of the trigger detector.

Perception

790 A02689_09_E00_00   HBK: UNRESTRICTED



Trigger mode

Description
Use this setting to enable trigger detection on a channel. The possible trigger
modes are: Off, Basic, Dual, Window, Dual Window, Sequential, Basic
Qualifier, Dual Qualifier. Refer to your hardware manual for more information
on the trigger capabilities of your system.

 

Primary level

Summary
Sets the value of the primary level detector.

Description
The fundamental trigger detection is based on level crossing: a signal has to
go through a specified level before it is considered to be a trigger condition.

As a consequence reaching the required level is not a valid trigger condition.
Since trigger detection is digital, inter-sample analog values are omitted.

This setting defines the level of the primary trigger detector. Direction and
Hysteresis are used to further define the actual trigger condition.

Note
If the dY/dt Trigger is enabled, this setting is actually measured in technical
units per second (for example V/s).

 

Secondary level

Summary
Sets the value of the secondary level detector.
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Secondary level

Description
The fundamental trigger detection is based on level crossing: a signal has to
go through a specified level before it is considered to be a trigger condition.

As a consequence reaching the required level is not a valid trigger condition.
Since trigger detection is digital, inter-sample analog values are omitted.

This setting defines the level of the secondary trigger detector. Direction and
Hysteresis are used to further define the actual trigger condition.

 

Hysteresis

Summary
Sets the hysteresis range for both trigger detectors.

Description
The hysteresis is used to reduce the influence of noise for the Primary level
and the Secondary level.

If a signal contains noise it can cause a trigger detector to produce a false
trigger. Increasing the hysteresis can help to avoid this.

With a hysteresis the trigger level is expanded to be a trigger zone that spans
multiple levels. As a consequence the actual trigger position is less clearly
defined.
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Direction

Summary
Sets the response direction of the primary level. The direction of the secondary
level will be set to the opposite direction by definition.

Description
This setting is used to determine in which direction the input signal should cross
the primary level. Depending on the Trigger mode, the direction is used to arm
or trigger the input. The possible directions are: Rising, Falling.

Advanced settings

dY/dt Trigger

Summary
Enables slope trigger to react on the difference in amplitude between a number
of samples.

Description
Enabling this setting means that the trigger detector reacts on the difference
of the input signal levels between the number of samples specified in Delta
time window, rather than the signal level of the current sample. In other words,
the triggering mechanism detects a slope change on the input signal.

 

Delta time window

Summary
Sets the time window for the dY/dt Trigger .
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Delta time window

Description
This setting is available if the dY/dt Trigger is enabled.

The trigger detector calculates the signal slope in the time interval defined by
this setting. If the slope matches the conditions set by the settings Direction,
Primary level and Secondary level (if applicable), a trigger is generated and
positioned at the window’s last sample.

 

Pulse detector

Summary
Enables pulse detection/rejection.

Description
The pulse detector can be used together with the basic (slope) trigger level
detector. The possible values are: Disabled, Detect, Reject. The Pulse
width is used to define the width of the pulses which should be detected or
rejected.

 

Pulse width

Summary
Sets the width of the pulse detection/rejection.

Description
Use this setting to set the width of the pulses which should be detected or
rejected. The pulse width is only used if the Pulse detector is set to Detect or
Reject. The value is specified in seconds or external time base units depending
on the mainframe Clock base setting.
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Hold-off time

Summary
Disables the trigger detector for a specified period of time after a valid trigger
has been generated.

Description
The trigger hold-off feature is used to disable the trigger detector for a period
of time after a valid trigger has been generated. This can be used to generate
only one trigger on a slowly decaying repetitive signal, or eliminate the effect
of after-ringing.

The feature is most useful in combination with the interval Timer and/or the
Event counter.

 

Timer

Summary
Defines a time relation between two consecutive trigger events.

Description
The interval timer is used to define a time relation between two trigger events.
If the time relation is correct, a trigger is generated. The possible timer modes
are: Disabled, Less, More, Between, NotBetween.

 

Timer window start

Summary
Defines the first interval used for the interval timer.
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Timer window start

Description
Depending on the interval timer mode, there is a difference in functionality for
this setting:

l For the Less and More mode, this setting is the width of the interval.
l For Between and NotBetween, this setting is the time after which the Timer

window width interval is used.

The value is specified in seconds or external time base units depending on the
mainframe Clock base setting.

 

Timer window width

Summary
Defines the second interval used for the interval timer.

Description
The trigger window width is only used if the Timer mode is set to Between or
NotBetween.

The value is specified in seconds or external time base units depending on the
mainframe Clock base setting.

 

Event counter

Summary
Counts a number of trigger events before the actual trigger is generated.

Description
The event counter adds all generated triggers and generates a final trigger if
the count equals the preset value.
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D.7.4 Marker channel

Introduction
You can trigger on a marker (event) channel. Marker channels have only two
electrical states: high and low. You can trigger on a transition between the two
levels.

Basic settings

Trigger mode

Summary
Sets the mode of the marker channel trigger detector.

Description
Use this setting to enable trigger detection on a marker channel.

Depending on your hardware possible trigger modes are: Off, Rising, Falling,
Qualifier High and Qualifier Low.

 

D.7.5 CAN-Bus channel

Introduction
You can trigger on a CAN-Bus channel. Essentially the result of a CAN-Bus
channel is a range of numbers, just like digitized analog data.

The trigger capabilities include basic trigger modes on a dual-level trigger
detector with hysteresis.
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Basic settings

Trigger mode

Summary
Sets the mode of the CAN-Bus channel trigger detector.

Description
Depending on your hardware possible trigger modes are: Off, Basic, Dual,
Basic Qualifier and Dual Qualifier.

 

Primary level

Summary
Sets the value of the primary level detector.

Description
The fundamental trigger detection is based on level crossing: a signal has to
go through a specified level before it is considered to be a trigger condition.

As a consequence reaching the required level is not a valid trigger condition.
Since trigger detection is digital, inter-sample analog values are omitted.

This setting defines the level of the primary trigger detector. Direction and
Hysteresis are used to further define the actual trigger condition.

 

Secondary level

Summary
Sets the value of the secondary level detector.

Perception

798 A02689_09_E00_00   HBK: UNRESTRICTED



Secondary level

Description
The fundamental trigger detection is based on level crossing: a signal has to
go through a specified level before it is considered to be a trigger condition.

As a consequence reaching the required level is not a valid trigger condition.
Since trigger detection is digital, inter-sample analog values are omitted.

This setting defines the level of the secondary trigger detector. Direction and
Hysteresis are used to further define the actual trigger condition.

 

Hysteresis

Summary
Sets the hysteresis range for both trigger detectors.

Description
If a signal contains noise it can cause a trigger detector to produce a false
trigger. Increasing the hysteresis can help to avoid this.

With a hysteresis the trigger level is expanded to be a trigger zone that spans
multiple levels. As a consequence the actual trigger position is less clearly
defined.

 

Direction

Summary
Sets the response direction of the primary level. The direction of the secondary
level will be set to the opposite direction by definition.
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Direction

Description
This setting is used to determine in which direction the input signal should cross
the primary level. Depending on the Trigger mode, the direction is used to arm
or trigger the input. The possible directions are: Rising, Falling.

 

D.7.6 Calculated Channel

Introduction
A calculated channel produces results on which you can trigger. Calculated
channels support Basic trigger mode (see "Basic trigger mode" on page 505)
and Dual trigger mode (see "Dual trigger mode" on page 506). For detailed
information about triggering on calculated channels see "Trigger detector" on
page 822.

 

Trigger mode

Summary
Sets the mode of the calculated channel trigger detector.

Description
Use this setting to enable trigger detection on a calculated channel. The
possible trigger modes are: Off, Basic, Dual.

Primary level

Summary
Sets the value of the primary level detector.
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Primary level

Description
The fundamental trigger detection is based on level crossing: a signal has to
go through a specified level before it is considered to be a trigger condition.

This setting defines the level of the primary trigger detector. Direction and
Hysteresis are used to further define the actual trigger condition.

Secondary level

Summary
Sets the value of the secondary level detector.

Description
The fundamental trigger detection is based on level crossing: a signal has to
go through a specified level before it is considered to be a trigger condition.

This setting defines the level of the secondary trigger detector. Direction and
Hysteresis are used to further define the actual trigger condition.

Hysteresis

Summary
Sets the hysteresis range for both trigger detectors.

Description
The hysteresis is used to reduce the influence of small variations in the result
of a calculated channel for the Primary level and Secondary level.
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Direction

Summary
Sets the response direction of the primary level. The direction of the secondary
level will be set to the opposite direction by definition.

Description
This setting is used to determine in which direction the input signal should cross
the primary level. Depending on the Trigger mode, the direction is used to arm
or trigger the input. The possible directions are: Rising, Falling.
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D.8 Alarm group

D.8.1 Introduction
Most boards allow you to generate an alarm. Alarm detection typically uses a
simplified trigger detector. While a trigger detector generates a trigger signal
that controls the acquisition/storage, an alarm condition only flags a specific
situation. Usually this signal is also available as an electric signal on the data
acquisition system.

 

D.8.2 Channel

Introduction
The alarm capabilities of an analog channel typically include two trigger modes
on a dual-level trigger detector.

 

Basic settings

Alarm mode

Summary
Sets the mode of the alarm detector.

Description
Use this setting to enable an alarm on a channel. Typical enabled alarm modes
are basic, which uses a single level detection, and dual, which uses two levels.

Refer to the general trigger section for more details.
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Primary level

Summary
Sets the value of the primary level for the alarm detector.

Description
The fundamental alarm detection is based on level crossing: a signal has to go
through a specified level before it is considered to be an alarm condition.

As a consequence reaching the required level is not a valid alarm condition.
Since alarm detection is digital, inter-sample analog values are omitted.

This setting defines the level of the primary alarm detector. Direction is used
to further define the actual alarm condition.

Refer to the general trigger section for more details.

 

Secondary level

Summary
Sets the value of the secondary level for the alarm detector.

Description
The fundamental alarm detection is based on level crossing: a signal has to go
through a specified level before it is considered to be an alarm condition.

As a consequence reaching the required level is not a valid alarm condition.
Since alarm detection is digital, inter-sample analog values are omitted.

This setting defines the level of the secondary alarm detector. Direction is used
to further define the actual alarm condition.

Refer to the general trigger section for more details.
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Alarm direction

Summary
Sets the response direction of the primary level. The secondary level will be
set to the opposite direction.

Description
Use this setting to control the alarm logic. You can select whether an alarm
should be generated on a falling or rising signal. If you set the value to falling
with a dual alarm mode, this means the Primary level will be detected on a
falling signal and the Secondary level on a rising one.

Refer to the general trigger section for more details.

 

D.8.3 Marker

Introduction
The alarm capabilities of a marker channel typically include only a high and a
low capability.

Basic settings

Alarm mode

Summary
Sets the mode of the alarm detector.

Description
Use this setting to enable an alarm on a channel. Typical enabled alarm modes
for markers are High or Low, which use a specific level change, and Both
Edges, which uses any level change.
Please refer to your hardware manual to read more about the alarm capabilities
of your system as the capabilities may differ depending on the hardware used.
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D.8.4 Timer/Counter

Introduction
Currently there are no alarm capabilities for Timer/Counter channels.
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E Real-Time Calculations Explained
E.1 Introduction

A calculated channel performs real-time calculations on samples of an input
signal for the duration of a calculation period. The calculated channel produces
a result at the end of such a calculation period. After producing a result, a new
calculation is started. Which calculation formula is used can be selected for
each calculated channel. Calculated channels operate only when using an
internal time base (decimal or binary). All calculated channels are disabled
when an external time base is used.
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Figure E.1: Real-time calculations block diagram

The cycle source output is used by all calculated channels (except the Timer/
Counter channels) to end the current calculation period, produce a calculation
result and to start a new calculation. A recorder has one cycle source. The
following cycle sources can be selected:

l A periodic timer providing a signal at a fixed interval that can be selected.
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l A cycle detector allowing calculation periods to be based on cycles of an
analog input signal.

A recorder has multiple calculated channels. Three types of calculated
channels are available:

l Analog calculated channels process samples of an analog input channel.
The calculation periods are determined by the cycle source.

l Cycle source calculated channels provide information about the selected
cycle source. Two formulas are available: Cycles (a square wave
representing the actual calculation periods) or Cycle frequency (a trace
representing the input frequency of the cycle source).

l Timer/Counter calculated channels process samples of a Timer/Counter
input channel which is set to either frequency or RPM mode.
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E.2 Cycle source

E.2.1 Timer
The timer provides a periodic signal to the calculated channels at a fixed
interval. The interval is set in milliseconds but is internally rounded to the
nearest multiple of the sample interval. The first calculation period of the
calculated channels starts at the first sample of the acquisition.

E.2.2 Cycle detector
The cycle detector provides a signal to the calculated channels at selected level
crossings of an analog input signal. The cycle detector consists of a level
crossing detector, followed by a counter/filter. The level crossing detector
detects rising and falling level crossings. The counter/filter is used to select half
cycle or (multiple) full cycle mode. In multiple cycle mode, the level crossing
direction can be selected (rising or falling). The first calculation period of the
calculated channels starts at the first selected level crossing after the start of
acquisition.

2.2.1 Level crossing detector operation
The level crossing detector uses two thresholds: +Threshold (level + hysteresis)
and -Threshold (level - hysteresis). The area between these two thresholds is
called the hysteresis band.
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Figure E.2: Level crossings

A Level crossing at rising edge

B Level crossing at falling edge

C Hysteresis band

k1 Last sample below -Threshold
k2 First sample above +Threshold
k3 Last sample above +Threshold
k4 First sample below -Threshold

A sample of the input signal can be in one of three states: above, within or below
the hysteresis band. The timestamps for state changes and the sample values
at a state change are used to determine the level crossing times using the
following table:

State sequence Level crossing Level crossing timestamp
below → within →
above
OR
below → above

rising level crossing calculated using linear
interpolation between
timestamp/value of last
sample below hysteresis band
and first sample above
hysteresis band (k1 and k2 in
Figure E.2)
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State sequence Level crossing Level crossing timestamp
above → within →
below
OR
above → below

falling level crossing calculated using linear
interpolation between
timestamp/value of last
sample above hysteresis band
and first sample below
hysteresis band (k3 and k4 in
Figure E.2)

above → within →
above

none

below → within →
below

none

Input signal slew rate limitation
The cycle detector always detects cycles too late for real-time calculations.
Looking at Figure E.2 on page 811, the center amplitude crossing (A) is found
at the time of k2 and the center amplitude crossing (B) is found at the time of
k4. To compensate for this, the cycle detector processes samples as they are
taken, while the calculations on these samples are postponed for 10 ms. This
means that the time difference between the real crossing (A) and the time of
k1 may not be more than 10 ms. In other words, the time between k1 and k2
may not be more than 20 ms.

Figure E.3 shows an analog input signal (blue) and the output of a calculated
channel (green) using a “Maximum” formula. The lower graph shows the
calculation periods (black) as detected by the cycle detector.
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Figure E.3: Cycle detector input signal slew rate too low

A Input signal crosses the +threshold in downwards direction: the detector
is waiting for the input signal to drop below the -threshold.

B Input signal drops below the -threshold: the detector calculates the time of
zero crossing (using linear interpolation), but determines that the zero
crossing occured more than 10 ms in the past. An event bar marker I “Cycle
signal amplitude too small” is generated when the input signal enters the
hysteresis band.

C Input signal crosses -threshold in upwards direction: the zero crossing
detector is waiting for the input signal to rise above the +threshold.

D Input signal rises above the +threshold: the detector calculates the time of
zero crossing (using linear interpolation), but determines that the zero
crossing occured more than 10 ms in the past. Samples older than
10 ms have already been processed (i.e. the older samples are included
in the current calculation period). This means that it is too late to stop the
current calculation period at the correct time. The next rising edge (when
detected correctly) will stop the current calculation period.

E Input signal enters the hysteresis band.
F Input signal leaves the hysteresis band: a valid zero crossing has been

detected (less than 10 ms in the past). The detector was set to detect rising
edges, so this zero crossing is not used to end/start a calculation period.
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G Input signal crosses -threshold in upwards direction: the zero crossing
detector is waiting for the input signal to rise above the +threshold.

H Input signal rises above the +threshold: a valid rising edge has been
detected (less than 10 ms in the past). An event bar marker J “Cycle signal
within range” is generated at the time after the last rejected zero crossing.
The current calculation period ends, the calculated results become
available and a new calculation period is started.

I The event bar marker I “Cycle signal amplitude too small” denotes the first
time that the input signal stays within the hysteresis band for too long (low
slew rate of the input signal around the detector level). If the input signal
stays within the hysteresis band for too long on subsequent occasions, an
event marker will not be generated.

J The event bar marker J “Cycle signal within range” indicates that the cycle
detector is operating normally again.

The level crossing detector also detects whether the input signal stays within
the hysteresis band for more than 20 ms. When the input signal stays withing
the hysteresis band for more than 20 ms, the following two things occur (see
Figure E.4 ):

l No level crossing is reported to the counter/filter.
l An event bar marker (C) is generated at the position where the signal

entered the hysteresis band.
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To prevent numerous event bar markers from being generated, event bar
markers are not generated on subsequent occasions when the level crossing
detector detects this condition repeatedly. As soon as the level crossing
detector has not detected this condition for at least 1 s, an event bar marker
(D) is generated at the end of the last time period when this condition occured.

t

T

+Threshold

-Threshold

t

C

B

D

A

Figure E.4: Temporary low signal amplitude

A Input signal enters the hysteresis band and stays there for longer than
20 ms. An event bar marker C is generated, indicating the start of a low
slew rate/amplitude condition.

B Input signal leaves the hysteresis band. An event bar marker D is
generated, indicating the end of the low signal amplitude condition.

Note Setting lower threshold levels would result in cycles being detected even if the
input signal had a low amplitude.

Note The time T between consecutive rising edges is shorter than the cycle detector
timeout of 1 s. Therefore, the calculation period is still valid.
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State change limitation
The level crossing detector can handle up to 80,000 state changes per second.
If the input signal causes more state changes, the detector will lose track of the
input signal.

t

T

t

A CB

Figure E.5: Cycle detector input signal frequency too high

A Event bar marker “Cycle signal frequency too high” indicates that the
calculation period(s) will be extended by an integral number of cycles to
obtain a calculation period of > 900 µs.

B Event bar marker “Cycle detector overload” indicates that the input signal
frequency of the cycle detector is so high that it cannot determine zero
crossings anymore. The current calculation period is aborted (no results
generated). The cycle detector will wait until the input signal is within normal
operating range again for at least 1 second.

C Event bar marker “Cycle signal within range” indicates that the input signal
is within normal operating range again. A new calculation period starts.
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Figure E.5 and Figure E.6 show what happens when the detector loses track
of the input signal: an event bar marker (B) is generated close to the position
where it was detected. Repeatedly generating event bar markers to report such
a condition is suppressed for 1 s. Calculated channels that depend on the output
of the cycle detector abort their current calculation period.

t

+Threshold

-Threshold

T

t

A CB

Figure E.6: Cycle detector input signal frequency crossing threshold too often

A Event bar marker “Cycle signal frequency too high” indicates that the
calculation period(s) will be extended by an integral number of cycles to
obtain a calculation period of > 900 μs.

B Event bar marker “Cycle detector overload” indicates that the input signal
of the cycle detector crosses the threshold too often. The detector does not
determine zero crossings anymore. The current calculation period is
aborted (no results generated). The cycle detector will wait until the input
signal is within normal operating range again for at least 1 second. The
cycle detector will then resume normal operation.

C Event bar marker “Cycle signal within range” indicates that the input signal
is within normal operating range again. A new calculation period starts.
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Counter/filter operation
The counter/filter receives rising and falling level crossings from the level
crossing detector. The counter/filter then produces a signal at which the
calculated channels produce a result and start a new calculation period. The
counter/filter can be set to half cycle mode or full cycle mode. In half cycle mode,
all rising and falling level crossings are passed to the calculated channels. In
full cycle mode, the direction (rising or falling) and the number of full cycles can
be selected where the calculated channels are signaled.

Cycle detector time out
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Figure E.7: Cycle detector time out

A Valid rising edge detected: ends the current calculation period and starts a
new calculation period.

B First falling edge with low slew rate detected: causes the event bar marker J
“Cycle signal amplitude too small” to be generated.

C Signal leaves hysteresis band for long period. No valid rising edge detected
within 1 s after previous valid rising edge (A): the cycle detector generates
the event bar marker I “No cycles detected” at the time of the last valid rising
edge. The current measurement period is aborted.

D The trace of a cycle-based calculation ends here because no result will
become available.
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E The rising edge is rejected due to a low slew rate. The calculation period
does not start.

F A valid falling edge is detected, but the detector is set to start calculations
at rising edges.

G A valid rising edge is detected: an event bar marker K “Cycle signal within
range” signals the end of the “Cycle signal amplitude too small” condition.
At the same time, the event bar marker J “Cycle signal within range” is
generated to signal the end of the “No cycles detected” condition. A new
calculation period starts here.

H The trace of a cycle-based calculation appears again.

I Event bar marker indicating “No cycles detected”: no calculation results will
be available.

J Event bar marker indicating the start of a low cycle detector input signal
slew rate.

K Event bar marker indicating the end of the low cycle detector input signal
slew rate.

L Event bar marker indicating “Cycle signal within range”: calculations started
again. The results will become available.

An event bar marker (I) is generated if no cycles are detected for a period longer
than 1 s. Calculated channels that depend on the output of the cycle detector
abort their current calculation period. When a cycle is detected again, another
event bar marker (L) is generated and the calculated channels starts a new
calculation period.
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Rate limitation
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Figure E.8: Cycle detector high input signal frequency

A Start of a new calculation period.

B End of the previous calculation period (duration: 1000 µs), start of a new
calculation period.

C Zero crossing too close (400 µs) to the start of the current calculation
period: the zero crossing is ignored and the calculation continues.

D Zero crossing too close (800 µs) to the start of the current calculation
period: the zero crossing is ignored and the calculation continues.

E Zero crossing accepted: the current calculation period ends (duration:
1200 µs) and a new calculation period starts.

F End of previous calculation period (duration: 1000 µs) and start of new
calculation period.

G Event bar marker “Cycle signal frequency too high”.

H Event bar marker “Cycle signal within range”.
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The cycle detector is rate-limited. It does not signal a new calculation period
within 900 µs after the start of the current calculation period. If the cycle detector
detects such a rate-limiting condition, an event bar marker (G) is generated and
the current calculation period is extended by one half cycle or one full cycle
(dependent on half/full cycle mode). The cycle detector keeps extending the
calculation period until the calculation period lasts at least 900 µs.
As soon as the rate-limiting condition has ceased to exist, another event bar
marker (H) is generated to indicate that the cycle detector is operating normally
again.
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E.3 Calculated channels

E.3.1 Processing
A calculated channel processes input samples using a formula that can be
selected. The calculation is performed during a calculation period. When the
calculation period ends:

l A result is generated. This result is positioned at the start of the calculation
period.

l The result is processed by the trigger detector.
l The calculator is reset.
l A new calculation period starts.

Calculated channels which depend on the cycle detector cannot produce
calculation results in the following circumstances:

l The cycle detector reports that no cycles have detected for longer than
1 s.

l The cycle detector reports that a state change limitation condition exists.
l The span or offset of the input channel has changed: the input signal is

temporarily invalid.
l The span or offset of the cycle detector input channel has changed: the

cycle detector signal is temporarily treated as being invalid.

In all these cases, the current calculation period is aborted and a new period is
started as soon as all conditions are back to normal.

All calculated channels provide technical units, multiplier and offset settings to
provide user scaling of the calculated results.

E.3.2 Trigger detector
Every calculated channel has its own trigger detector that provides basic and
dual trigger modes (see also “Trigger Modes” on page 505). Trigger levels are
compared to the calculated (user scaled) results. An enabled trigger detector
of a calculated channel can generate a calculated trigger. Calculated triggers
will always result in a recorder trigger.

Due to the fact that calculated results become available at the end of a
calculation period, but the timestamp is for the start of the calculation period, a
calculated trigger is always generated too late. The system automatically
compensates for this, but this time compensation is limited.
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Calculated triggers are shown on the event bar with two timestamps: the first
timestamp represents the trigger position on which the recorder(s) actually
triggered, the second timestamp (in parenthesis) represents the intended
calculated trigger position. Figure E.9 shows a calculated trigger which has
been compensated for automatically: the calculated trigger position (B) is equal
to the actual trigger position (A).

Figure E.9: Calculated trigger fully compensated

A Actual trigger position

B Calculated trigger position

Figure E.10 shows a calculated trigger which could not be fully compensated:
the calculated trigger position (C) is not equal to the actual trigger position (B).
An additional event bar marker (A) is placed at the intended calculated trigger
position.

Figure E.10: Calculated trigger not fully compensated

A Marker at intended (calculated) trigger position

B Actual trigger position

C Calculated trigger position
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In order to send the calculated triggers to other recorders within the same
mainframe, the System trigger 3 mode must be set to ‘Calculated’ with transmit
enabled, using the advanced settings of the sending recorder:

A

Ext Trigger Out

Ext Trigger In

Channel 1

Calculated Ch 1

Calculated Ch "N"

System Trigger 1
System Trigger 2
System Trigger 3
Master/Slave

Channel "N"

Qualifier 1

Qualifier "N"

Figure E.11: Enabling sending calculated triggers to other recorders

A System trigger 3 mode (set to sending calculated triggers)

In order to receive calculated triggers from other recorders, the System trigger
3 mode must be set to ‘Calculated’ with receive enabled, using the advanced
settings of the receiving recorder:

A

Ext Trigger Out

Ext Trigger In

Channel 1

Calculated Ch 1

Calculated Ch "N"

System Trigger 1
System Trigger 2
System Trigger 3
Master/Slave

Channel "N"

Qualifier 1

Qualifier "N"

Figure E.12: Enabling receiving calculated triggers from other recorders

A System trigger 3 mode (set to receiving calculated triggers)
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E.4 Analog calculated channels
All analog calculated channels require a cycle source to determine the
calculation period and an analog input channel on which the calculation needs
to be performed.

E.4.1 Area
Function
Calculates the area under the curve.

Description
Let yi be the value of the first sample of the calculation period.
Let yj be the value of the last sample of the calculation period.
Let Δt be the time between two consecutive samples.

Area

j

n i
n

=
=

∑ (  (| y .∆t|

E.4.2 Energy
Function
Calculates the energy under the curve.

Description
Let yi be the value of the first sample of the calculation period.
Let yj be the value of the last sample of the calculation period.
Let Δt be the time between two consecutive samples.

Energy

j

n i
n=

=
∑ (  (.∆t(y 2)

E.4.3 Maximum
Function
Determines the maximum value.

Description
Let yi be the value of the first sample of the calculation period.
Let yj be the value of the last sample of the calculation period.

Maximum = max(yi, … , yj)
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E.4.4 Mean
Function
Determines the mean value.

Description
Let yi be the value of the first sample of the calculation period.
Let yj be the value of the last sample of the calculation period.
Let N be the number of samples within the calculation period ( N = j - i + 1 ).

E.4.5 Minimum
Function
Determines the minimum value.

Description
Let yi be the value of the first sample of the calculation period.
Let yj be the value of the last sample of the calculation period.

Minimum = min(yi, … , yj)

E.4.6 Peak to peak

Peak to peak
Function
Calculates the peak to peak value.

Description
Let yi be the value of the first sample of the calculation period.
Let yj be the value of the last sample of the calculation period.

Peak to peak = max(yi, … , yj) - min(yi, … , yj)

E.4.7 RMS
Function
Calculates the RMS (Root Mean Square) value.
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Description
Let yi be the value of the first sample of the calculation period.
Let yj be the value of the last sample of the calculation period.
Let N be the number of samples within the calculation period ( N = j - i + 1 ).

RMS =  

2

=
 

∑
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E.5 Cycle source calculated channels
The cycle source calculated channels perform calculations on the cycle source
signal itself. Cycle source calculated channels do not need an input channel.

E.5.1 Cycles
Function
Visualizes the cycle source output as a square wave.

Description
Cycles can be used to visualize the calculation periods as they were determined
by the cycle source and as they were used by other calculated channels. Having
this visual aid may be helpful in determining the correct level/threshold settings
for the cycle detector and in understanding the results when the cycle detector
input signal is heavily disturbed or contains frequencies that exceed the
specified cycle detector limitations.

Note If the cycle source is a timer, the square wave will have a constant period.

Output
A symmetrical square wave representing the output of the cycle source, the
period is equal to the calculation period. The rising edge of the square wave
indicates the start/end of a calculation period. The falling edge of the square is
always positioned in the middle of two consecutive rising edges and has no
direct relation to the rising/falling level crossings of the cycle detector input
channel.

t

700 300

t

Figure E.13: Cycle detector set to detect half cycles
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Figure E.13 shows the output of this calculated channel (green) and the input
signal of the cycle detector (blue) with the cycle detector set to half cycle mode.
The input signal is asymmetrical.

t

1000

t

A

Figure E.14: Cycle detector set to detect full cycles

A The falling edge of the calculated channel is always positioned in the
middle of two consecutive rising edges. Figure E.14 shows the output of
this calculated channel (green) and the input signal of the cycle detector
(blue) with the cycle detector set to rising edge full cycle mode. The input
signal is asymmetrical.
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t

t

Figure E.15: Cycle detector set to detect multiple full cycles

Figure E.15 shows the output of this calculated channel (green) and the input
signal of the cycle detector (blue) with the cycle detector set to two rising edge
cycles. The input signal is asymmetrical.

E.5.2 Cycle Frequency
Function
Calculates the actual frequency of the input signal of the cycle detector.

Description
The cycle frequency calculator uses the cycle source information to calculate
the frequency of the cycle detector input channel. The cycle detector provides
not only the start/end of each calculation period, but also the actual number of
(half-)cycles that have been detected during each calculation period.

Note A trace of the cycle frequency calculator provides an excellent overview to
detect missed or erroneously detected cycles. These show up as a spike in the
cycle frequency trace.

Note If the cycle source is a timer, the output value of this calculator is very constant.
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Output

t

1000 800 600 800 1000 600

t

Figure E.16: Cycle frequency calculator

Figure E.16 shows the output of this calculated channel (green) and the input
signal of the cycle detector (blue) with the cycle detector set to rising edge full
cycle mode.
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Figure E.17: Cycle frequency calculator and high input frequencies

A Start of calculation period

B End of calculation period: duration 1000 µs, one cycle found, resulting in a
calculated average frequency of 1 kHz during the past period

C Rising edge is too close to the start of the calculation period (400 µs)

D Rising edge is too close to the start of the calculation period (800 µs)

E Rising edge ends the current calculation period: duration 1200 µs, three
cycles found, resulting in a calculated average frequency of 2.5 kHz during
the past period. A new calculation period starts

F Rising edge ends the current calculation period: duration 1000 µs, one
cycle found, resulting in a calculated average frequency of 1 kHz during the
past period. A new calculation period starts

Figure E.17 shows the output of this calculated channel (green) and the input
signal of the cycle detector (blue) with the cycle detector set to rising edge full
cycle mode. Even though the calculation period that starts at (B) has been
extended by two additional full cycles, the output of this calculated channel still
represents the correct cycle detector input channel frequency.
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E.6 Timer/Counter calculated channels
The formula of the calculation is selectable between Frequency, Frequency
(gated) and RPM of Angle.

E.6.1 Frequency
Function
Calculates the frequency of the input signal of the Timer/Counter channel which
is set to frequency or RPM mode. The calculation period is determined by the
selected cycle source.

Description
The calculated channel computes the (average) input frequency of the selected
Timer/Counter input channel, taking the following input channel settings into
account:

l Frequency prescaler
l Technical units multiplier and offset
l Timer/Counter mode

If no pulses are detected within the cycle period, a calculated result of 0 is
produced.

Note The measuring (gate) time of the input Timer/Counter channel must be set to
its minimum value for this calculation function.

If no input pulses are detected for a prolonged time period, the calculation
period continues to be extended. This would mean that triggering on a low
calculated output value would not be possible because no calculated result is
produced as long as no input pulse is detected. To prevent this, the calculator
has a fixed timeout of two gate times. If no pulses are detected within this period,
a calculated result of 0 is produced. As soon as one or more pulses are
detected, the calculated channel produces results again.

E.6.2 Frequency (gated)
Function
Calculates the frequency of the input signal of the channel which is set to
frequency or RPM mode. The calculation period is equal to the measuring
(gate) time of the selected input channel.

Description
The calculated channel computes the (average) input frequency of the selected
input channel, taking the following input channel settings into account:
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l Frequency prescaler
l Technical units multiplier and offset
l Measuring time
l Measuring time

If one or more pulses have been detected during the previous measuring (gate)
time, the calculated channel produces a result. If no pulses have detected
during the previous measuring (gate) time, the calculation period is extended
by an additional gate time and no calculated result is produced (yet).

If no input pulses are detected for a prolonged time period, the calculation
period continues to be extended. This would mean that triggering on a low
calculated output value would not be possible because no calculated result is
produced as long as no input pulse is detected. To prevent this, the calculator
has a fixed timeout of two gate times. If no pulses are detected within this period,
a calculated result of 0 is produced. As soon as one or more pulses are
detected, the calculated channel produces results again.

E.6.3 RPM of Angle
Function
Calculates the RPM of the input signal of the channel which is set to Angle
mode. The calculation period is determined by the selected cycle source.

Description
The calculated channel computes the (average) RPM of the selected input
channel, taking the following input channel settings into account:

l Frequency prescaler
l Technical units multiplier and offset
l mode

If no angle change is detected within the cycle period, a calculated result of 0
is produced.
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E.7 Settings and conflicts
Settings of calculated channels may conflict with other settings of the recorder.
When such a conflict is detected, the ‘Enabled’ setting of a calculated channel
will indicate a conflict. Before starting acquisition, the calculated channels with
conflicts will be automatically disabled.

The following types of conflicts might arise:

l When the clock base of the mainframe is set to external, there is no
guarantee that the samples are equidistant in time. In such a situation
calculated channels cannot provide valid results.

l A calculated channel which is used for calculating the frequency of a Timer/
Counter channel is in conflict when the measuring time of the Timer/
Counter channel is below a certain limit.

l A calculated channel which is used for calculating the frequency of a Timer/
Counter channel is in conflict when the mode of the Timer/Counter channel
is set to something else than frequency or RPM (uni- and bidirectional).

l In the situation where the required calculation power of all enabled
calculated channels exceeds the available calculation power of the
recorder. The required calculation power depends on the sample rate and
resolution, the number of enabled calculated channels and the selected
calculation formula of each channel. The number of calculated channels
that would exceed the available calculation power will have a conflict,
starting from the bottom enabled calculated channel of the setting sheet
towards the top of the sheet. The ‘Multiplication’ calculation formula needs
more calculation power than the other formulas, the ‘Cycle Frequency’ and
‘Cycles’ formula needs less calculation power than the other formulas.
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F Wake-on-LAN
F.1 Overview

F.1.1 Technology background

Purpose
Wake-on-LAN (WoL) is a widely supported networking standard that allows
network connected devices to be remotely turned-on. This can be useful if the
device is in a remote or hard to access location. The technology was originally
introduced by the Advanced Manageability Alliance in April 1997. Turning the
device on is accomplished by sending a wake-up frame to the device over the
network. This frame is also called a “magic packet”. The Wake-on-LAN protocol
utilizes the data link layer (OSI model layer 2) for sending the data. This means
no IP-addresses are used, instead the device MAC-address is important. The
magic packet is broadcasted over the network, so all devices connected to the
network will receive it.

In order for Wake-on-LAN to work properly the device that is turned on needs
to fulfill some requirements:

l It needs to contain a Wake-on-LAN capable network interface.
l This interface needs to be powered, even if the device is turned off.
l The magic packet needs to be sent from sender to receiver.

Note If any of these requirements is not met, Wake-on-LAN will fail. The protocol
does not include a confirmation message. This means there will be no error
messages if Wake-on-LAN fails. The device will not be turned on.

Magic packet
The magic packet is created as a broadcast frame that consists of 6 bytes with
hexadecimal value FF (255), followed by sixteen repetitions of the MAC-
address (48-bit) of the device that needs to be turned on. So the total size of
the magic packet is 102 bytes.

Typically (Perception also does this) the packet is sent over Ethernet by using
a UDP datagram, however alternative implementations are also used.
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F.1.2 Wake-on-LAN in Perception
Connecting
GEN series hardware is automatically detected by Perception when it is turned
on. Perception tracks this hardware and keeps a list of the mainframes it has
once detected (see Figure F.2). When Perception starts and the mainframe
which was detected before is no longer available the network, Perception will
still show the hardware in the hardware navigator (see Figure F.1). The
hardware will be indicated with a different icon:

Figure F.1: Hardware detected but not available

A Status icon: Detected but not available

Figure F.2: Hardware detected and available

A Status icon: Detected and available

When trying to connect a mainframe which is detected but not available (either
manually (1) or through loading a workbench(2)) the mainframe will be turned
on. In this case the connection or loading process will take longer than normal.
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1 Manually connecting will give this feedback:

Figure F.3: Connection status when connected manually
2 When loading a workbench the internal connection process takes more

time, during this process the progress window will be shown:

Figure F.4: Connection status when connected via workbench

Note When loading a workbench there is no separate indication that the system was
not active and turned on.
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Managing Wake-on-LAN mainframes
Retention
Mainframes will be remembered by Perception only for a specific time. When
the specified time has passed, the mainframe is removed from the Wake-on-
LAN list. This is called the retention time. By default this is 15 days, the
following workflow illustrates how the retention policy works (see Figure F.5).

Figure F.5: Wake-on-LAN retention time

In short, mainframes that are in the Wake-on-LAN list will remain there until
more than the number of retention days have passed between them being last
detected and Perception is closed.
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Change retention time in Perception
It is possible to change the retention time in the Perception Preferences (see
Figure F.6). In this dialog, the Wake-on-LAN list can also be cleared.

Figure F.6: Wake-on-LAN preferences

A Wake-on-LAN option

B Set the number of days to keep the mainframe(s) in Wake-on-LAN list

C Clear Wake-on-LAN cache

Changing the retention time will only change the time between last detection
and automatic removal from the Wake-on-LAN list. So mainframes that are
detected will only be removed from that list after the new time period has
exceeded. Mainframes that were already in the Wake-on-LAN list will be
automatically removed upon closing Perception on the date of their last
detection and the new retention time.

In the Wake-on-LAN preferences it is also possible to disable Wake-on-LAN.
This can be done by selecting “Wake-on-LAN cache disabled” from the
retention list (B).

Finally, the preferences allow removal of all currently stored Wake-on-LAN
mainframes from the list with the Clear Wake-on-LAN cache button. Click
Apply to confirm this action.
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Hardware navigator
The hardware navigator also contains some Wake-on-LAN related features.
The icons in the used/unused hardware indicate if a mainframe is either:

Figure F.7: Wake-on-LAN related features

A Detected
The mainframe is powered on and on the network.

 ● Some detected mainframes can report issues such as incorrect
network settings. These mainframes are indicated with a yellow
exclamation mark (D).

B Wake-on-LAN
The mainframe was previously detected on the network, supports Wake-
on-LAN and was stored in the Perception Wake-on-LAN list.

 ● Note As the mainframe is currently not powered on it is unclear if the
mainframe is still available after a Wake-on-LAN request.

C Manually added
It is possible to manually add a mainframe. This option is available for GEN
series mainframes only and is used to connect to mainframes in an
environment where the network does not allow the standard UDP
broadcast messaging between Perception and the mainframe.

D Mainframe with issue There are a number of things that can be wrong
with the mainframe in case it is marked with this icon. Possible issues are
incorrect network settings, but the mainframe could also be unsupported
by Perception. Hover the mouse cursor over the item to get a tooltip with
more detailed information on this specific reason(s).
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Wake-on-LAN in the hardware navigator context menus
The following functionalites are also available in the hardware navigator through
the context menus. These tasks can be done by right clicking one of the
Wake-on-LAN mainframes in the unused hardware.

A Manually turn on a mainframe (Wake Up).
B Remove a single mainframe from the Wake-on-LAN list (Forget Wake-on-

LAN).

A Shut down a mainframe (Shut Down).
B Restart the mainframe remotely (Restart).

A Clear all mainframes in the Wake-on-LAN list  (Clear all WakeOnLAN
devices).
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F.2 Trouble-shooting (Wake-on-LAN)

F.2.1 Connection fails after Wake-on-LAN message

There are a number of potential causes why a mainframe will not wake up after
Perception sends the Wake-on-LAN message.

Cause 1 Solution
Power down procedure Wake-on-LAN is only available if the mainframe

was powered down using Perception or through
the normal power down procedure on the front
panel. If the mainframe was shutdown through a
power loss, or by pressing the power button for an
extended period (forced power down), the Wake-
on-LAN functionality will not be available and the
mainframe needs to be manually powered on
again.

Cause 2 Solution
Network settings Wake-on-LAN technology broadcasts a special

message over the network. The infrastructure
might cause this message not to reach the
mainframe. This can happen if the mainframe is in
a different subnet or if a firewall or a network router
blocks transmission of these messages
completely.
The router should be allowed to forward UDP
message(s) from any source ports to destination
port 9 and 7.

F.2.2 Perception try to connect to a not used mainframe

I have a new mainframe. When loading my workbench Perception keeps trying
to connect to the old mainframe.

Cause Solution
The old mainframe is still in
the workbench and the
Wake-on-LAN list.

To remedy this behavior, remove this mainframe
from the Wake-on-LAN list.
This can be done through the preferences or
context menu in the hardware navigator. When
the old mainframe is removed reload the
workbench. Now the mainframe replacement
dialog should be shown, allowing the new
mainframe to be used instead of the old one. To
complete this, save the workbench again when
the new mainframe is connected and the
workbench finishes loading.
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G QuantumX – Unsupported features
G.1 Unsupported features

Some of the features in Perception and QuantumX are not supported when
using the QuantumX in Perception; in some cases the feature is available but
maybe limited. Below is a list of the most important features.

G.1.1 General limitations/remarks

Feature QX module Detailed information
No C-type
thermocouple

MX809B Currently Perception does not support using
the MX809B with C-type thermocouples.

No sensor MX1609TB/
KB

When no sensor is connected to a MX1609TB/
KB channel, a very high sample value will be
recorded.

No sensor MX471B The signal behaviour when no CAN cable is
connected to a MX471B depends on the signal
repetition time setting. For more information,
please refer to "Configuring CAN signal
repetition time" on page 861.

No voltage
measurements

MX809B Within Perception the MX809B mainframe can
only be used as a thermocouple data recorder.

Channel count MX1609TB/
KB

There are 16 Recorders per mainframe, with
one Channel/Recorder.

Channel count MX809B There are eight Recorders per mainframe,
with one Channel/Recorder.

Channel count MX471B There are four Recorders per mainframe, with
max. 128 Channels/Recorder.

Firmware
version

All Perception will always attempt to enforce the
firmware version distributed with Perception.

Number of
connections

All Detailed information: the amount of modules
that can be connected and recorded
simultaneously is only limited* by the total
amount of RAM in the control PC.
*Please note that the system was tested with
a maximum of 16 QuantumX units, in a mixed
setup.
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G.1.2 Perception features

Feature QX module Detailed information
Spectral
display

All Not supported for QuantumX

XY display All Not supported for QuantumX
Slow-fast-
slow & dual
storage
modes

All QuantumX will use the same sample rate for
high and low rate segments.

Triggering All QuantumX cannot be used as a trigger source
within Perception.

StatStreamTM All There is no StatStreamTM support for data
recorded with a QuantumX. This may cause
decreased performance in reviewing and
calculating large datasets from the QuantumX.

Offline
configuration

All Offline configuration is not supported for the
QuantumX.

Mainframe
setup

MX1609TB/
KB

Use Perception or the MX assistant to configure
the MX1609.

Mainframe
setup

MX471B Use the MX Assistant to configure the MX471B
(CAN settings).
Perception cannot be used to configure these.

G.1.3 QuantumX features

Feature QX module Detailed information
TEDS/RFID All Not supported in Perception for QuantumX.
Virtual math All Not supported in Perception. An alternative

could be using the Perception formula data-
base to do post processing.

CAN output
channels

All Perception will not send CAN out data via the
MX471B.
However, a MX471B, when properly configured
using the MX Assistant, supports the transmis-
sion of CAN out data from input signals it re-
ceives via FireWire (i.e. coming from a
MX1609KB/TB).
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Feature QX module Detailed information
Analog out-
put channels

All Using the MX878 it is also possible to convert
data from other QuantumX units that connected
to it via FireWire as an analog output channel.
Please note that the MX878 is currently not di-
rectly supported by Perception, so please use
the MX Assistant to make the appropriate set-
up. The analog outputs can be recorded using
a GEN series acquisition system.

PTP Re-syn-
chronization
while record-
ing

All If QuantumX modules loose PTP synchroniza-
tion during recording, they will stop acquiring
data. Perception will show a warning that no
more samples are being received but it will not
automatically stop and close the recording in
this case. Acquisition of data will only continue
when stopping the recording and starting a new
one.

IRIG synchro-
nization

All Perception currently does not support IRIG for
QuantumX

Multiple
users

All The QuantumX platform allows multiple clients
to connect to it simultaneously. Perception can-
not detect if multiple users are using a Quan-
tumX unit. It will not show information or protect
against conflicts regarding multiple simultane-
ous users. When using Perception it is advised
not to use the QuantumX module by multiple
users at the same time. Doing so may cause a
recording to be created with different settings
than expected, or the system may even reboot
during a recording.

Classic Data
Rates

All Perception supports only the Decimal data
rates: (0.1, 0.2, 0.5, 1, 2, 5, 10, 20, 50, 100, 200,
600 S/s.
The Classic Data Rates (1200, .., 9600,
19200, ..) are not supported.
For the Decimal data rates, B type hardware is
needed.

FireWire All Perception does not support a direct FireWire
connection between a QuantumX unit and the
PC running Perception. Although the Quan-
tumX unit may be shown in Perception, no guar-
antees are given regarding proper operation of
the either QuantumX or Perception in this set-
up.
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H Configuring MX471B – MX Assistant
H.1 Introduction

This appendix describes how to configure a MX471B using the MX Assistant
tool.
It describes:

l How to change the network settings of a MX471B.
l How to change the MX471B module name.
l How to configure the general CAN bus setttings
l How to configure the CAN signal settings.
l How to configure the CAN signal repetition time.
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H.2 Configuring the MX471B using the MX Assistant
To configure the MX471B, use the MX Assistant tool. The tool can be found on
the QuantumX/SomatXR System CD or can be downloaded from the HBM site.

H.2.1 Ethernet network setting MX471
After connecting the MX471B to the Ethernet network, in the MX Assistant tool
use: File ► Find modules... to scan the network for the QuantumX module:

Figure H.1: Find Modules

A File menu

B Find modules....
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1 Select the MX471 device line and then Edit network settings to configure
the network settings:

Figure H.2: Search for modules dialog

A MX471 checkbox

B Edit network settings
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2 Configure the network settings and click OK to effectuate:

Figure H.3: Configure network settings

A Network settings

B OK button
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3 Select the MX471 checkbox (A) and click OK to connect to it:

Figure H.4: Connect to MX471

A Check the MX471

B OK button
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4 When connected properly, the MX471 will be listed in the list of connected
modules:

Figure H.5: List of connected modules

The default factory name of the MX471B module is “MX471”. To change
the module name (which is advised), activate the context menu (RMB) on
the connected MX471 and select Rename… and change the module
name.

Figure H.6: Rename module

A Rename....

B Change module name
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H.2.2 Configuring the CAN bus settings
Once you are able to connect to the MX471B via the MX Assistant, you can
start configuring the CAN bus settings. These settings need to be set right for
each MX471B CAN bus connector.

l The first connector is selected by selecting a CAN channel in the range
1.1 up to 1.128.

l The second connector is selected by selecting a CAN channel in the range
2.1 up to 2.128.

l The third connector is selected by selecting a CAN channel in the range
3.1 up to 3.128.

l The fourth connector is selected by selecting a CAN channel in the range
4.1 up to 4.128.

1 Select the first connector and then the CAN bus settings dialog:

Figure H.7: Select CAN bus settings

A First connector

B CAN Bus

C Settings...
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2 Set the Bit rate to the right value. The maximum value is 1000000 bits/s:

Figure H.8: CAN bus settings dialog

A Bit rate

B Termination on or off by checking or unchecking

Dependent on the CAN cabling used, the Termination can be switched off
or on. When the used CAN cabling has a built-in physical termination
resistance, there is no need to switch the Termination on.
 
Repeat this for all used MX471 CAN bus connectors (max. four).

H.2.3 Configuring the CAN signal settings
There are two ways to configure the CAN signal settings: Manually or using a
CAN database file (DBC file). The latter is the most common practice.
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H.2.4 Configuring CAN signal settings using a CAN database file
1 Add the CAN database file by selecting Add on the Sensor database

menu:

Figure H.9: Add CAN database

A Sensor database menu

B Add tool
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2 Select the CAN database file (.dbc) and then Open:

Figure H.10: Open CAN database file

A CAN database file

B Open button

3 The opened CAN database file will be added to the list of CAN databases:

Figure H.11: List of CAN databases

A Added file
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4 Now use the signals from the CAN database file to configure the CAN
channels.
 
In the Channels menu (A), select the CAN channel (B) you want to
configure and the signal you want to assign to it. By double clicking on the
signal (C), or using drag and drop, the signal configuration is transferred to
the CAN channel.

Figure H.12: Configure CAN channel

A Channels menu

B CAN channel

C Double click or drag and drop the signal
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5 To inspect the details of the CAN amplifier settings, select the  button
near the Amplifier setting column:

Figure H.13: Inspect details of CAN amplifier

A CAN Amplifier setting button

Figure H.14: Details of CAN amplifier settings

Configure the remaining CAN channels in the same way.
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Note The MX471B supports the following CAN message Data formats:
Unsigned and Signed 32-bit integer, Unsigned and Signed 64-bit integer,32-bit
real and 64-bit real.

Note Multiple signals can share the same CAN message ID. The actual sample bits
used for the signal are specified by means of the Start bit and Number of
bits setting.

Note The MX471B converts the received CAN signal bits to 64-bit asynchronous
sample values before passing them to Perception. Perception displays these
asynchronous sample values as a continuous trace.

H.2.5 Configuring CAN signal settings manually
If there is no CAN database configuration file (.dbc) available, the CAN
channels can be configured manually.

1 In the Channels menu, first activate the signal by using the context menu
(RMB) in the Amplifier setting cell of the involved CAN channel.

Figure H.15: Activate signal

A Channel menu

B CAN channel and open context menu (RMB)

C Activate signal signal
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2 Now configure the CAN amplifier settings by selecting the  button near
the Amplifier setting column:

Figure H.16: Configure CAN amplifier settings

A Amplifier setting button.

3 Fill in the CAN amplifier settings. Select OK to effectuate:

Figure H.17: CAN amplifier settings

A CAN amplifier settings rows

B OK button
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H.2.6 Configuring CAN signal repetition time
The repetition time can be configured for each CAN signal. The repetition time
indicates when to assume an input signal loss.

1 To configure the CAN signal repetition time, select the  button in the
Signals menu near the CAN signal format column.

Figure H.18: Configure CAN signal repetition time

A Signals menu

B Signal adaptation button
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2 In the Signal adaptation dialog, set the value of the Time monitoring in
sec..

Figure H.19: Signal adaptation dialog

A Time monitoring in sec. value row

With the Time monitoring in sec. (or signal repetition time) you can define
that a signal must be received within a certain time interval at the latest,
otherwise the signal will be labeled with Overflow (OVR). The time
specification is not followed exactly and the value may vary by some
milliseconds. Enter 0 as the time monitoring value in order to deactivate the
time monitoring.

Note Perception has no special treatment for Overflow (OVR) samples. They are put
on the display and added to the recording file like all other samples. The
Overflow samples (OVR) have a very high sample value.

Note When the time monitoring is deactivated for a signal, a CAN cable disconnect
does not cause the QuantumX unit to generate OVR samples. So in this case,
no samples are shown on the display nor added to the recording file.

Note CAN channels that have no activated signal in the MX Assistant are not visible
in Perception.
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Note Each MX471B CAN connector is mapped to a recorder in Perception. CAN
connectors that do not contain any active signals are not shown in Perception.

H.2.7 Configuring CAN signal minimum/maximum value

Figure H.20: Sensor adaptation dialog

A Set Minimum value

B Set Maximum value

The Minimum value setting corresponds to “Range from” in the settings sheet.
The Maximum value setting corresponds to “Range to” in the settings sheet.
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I Creating a synchronized recording using
Perception and PTP

I.1 Using PTP
This section explains how to create a synchronized recording within Perception.
Unless otherwise stated, this section assumes Perception is used to setup a
PTP synchronized recording in combination with GEN series DAQ hardware.

I.1.1 Why use a synchronization method
When working with multiple mainframes, the internal clocks of the mainframes
may differ. Even if initially set accurately, real clocks will differ after some time
due to clock drift, caused by clocks counting time at slightly different rates. To
solve this issue in a multiple mainframe setup, it is possible to use
synchronization sources like IRIG, GPS and PTP.

I.1.2 Why choose PTP

PTP is one of many methods to synchronize a network of heterogeneous
devices. It is especially useful when confronted with the following challenges:
l More than one device are measuring data; the data from all devices must

be correlated.
l Equipment from multiple vendors needs to be synchronized.
l Data acquisition equipment runs for a longer period of time.

When selecting PTP, the following requirements should be met by the test
setup:
l When synchronization between equipment that runs on different type of

buses (e.g. Ethernet and Profibus based devices). PTP must be available
on all buses and buses can be interconnected.

l Data acquisition equipment is all connected through a Local Area Network.
Multiple subnets are allowed but require dedicated hardware to
interconnect the subnets.

l PTP typically works using existing Ethernet cabling, making it a cost
effective method. However when switches are used to connect data
acquisition hardware, these must be PTP aware switches, which are more
expensive than normal switches.

In the above mentioned cases (but not limited to), using PTP is most likely the
best choice for the experiment.

Note PTP will only result in a synchronized recording if all equipment in the system
uses PTP and is connected through a network.

Note For PTP to function properly in a larger network it is necessary to use PTP-
aware network switches.
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I.2 Hardware setup
This section briefly discusses how to setup PTP. For more elaborate
instructions, please refer to the hardware manuals of the equipment involved
in the measurement.

However in general please be aware of the following items:

1 Use PTP aware network components if any are required.
 

Note Not using PTP aware components will lead to unstable synchronization or
no synchronization at all.

2 Make sure all hardware involved supports hardware based PTP. Software
based PTP is also available, but has a much lower accuracy (similar to
NTP) than hardware based PTP.

3 When connect GEN series DAQ into a PTP network, use the PTP enabled
network ports.
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I.3 Software setup

How to setup PTP synchronization in Perception
To setup the data acquisition equipment controlled by Perception, use the
following steps:

1 Connect to the mainframes.
2 Open the settings sheet, go to the General ► Mainframe section.

Figure I.1: Mainframe - general settings

3 In the sync source setting, select the PTP source that is connected to the
network:
l PTP 1 for PTP port 1
l PTP 2 for PTP port 2

Note Depending on the type of mainframe, only one PTP selection could be
available.

4 Repeat this for all mainframes.
 

I.3.1 PTP Synchronization status monitoring
Once the sync source setting is set to PTP, the mainframe will start to look for
the PTP Master Clock. This is done using the Best Master Clock (BMC)
algorithm that is defined in the PTP standard. Once the best master clock is
selected, a slave will synchronize to that clock. Within Perception there are
three ways to monitor this process, and also the status of the PTP
synchronization during the rest of the measurement (setup).

1 Advanced setting: Sheet settings
 The advanced settings in the settings sheet allow for fine tuning of the PTP

setup, but also show some information that can be used to check proper
synchronization. There are four settings that can help in determining the
status and configuration of the PTP network.
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 l PTP Master MAC-address: If no master can be found this is set to
00-00-00-00-00-00, otherwise it displays the MAC-address of the
master clock. Especially when using a dedicated PTP Grandmaster
Clock, this MAC-address can typically be found in the interface of the
grandmaster.

l PTP Role: There are three possibilities here. In case the role is “None”
no PTP synchronization can be established. The other options are
“Slave” and “Master”, these both indicate that the mainframe is part of
a PTP network.

Note If a grandmaster clock is used, the mainframe role should always be slave, if it
is not slave the grandmaster could not be found or is not properly operational.

 l Clock class: The clock class is not shown if it could not be
determined, which is the case if Accurate Clock Status is "Unknown".

l Accurate clock status: Closely related to the clock class setting.
Possibilities are:
l Found: Clock class of master clock <= 7
l Not found: Clock class of master clock > 7
l Unknown: No master was found, or the clock class of the master

could not be resolved.

Figure I.2: Advanced PTP settings when no signal can be found
  
2 Status area

Perception also shows a system wide synchronization status. This is
displayed in the status palette. The synchronization status shows the
synchronization mechanism used, in a cascade of multiple methods are
used in the system (e.g. a combination of PTP and master/slave). There
is a priority mechanism in displaying the status.

  
 If one of the synchronization mechanisms is reporting an error or warning,

that mechanism is shown. The issue reported is displayed in the bottom
of the status area. In case no problems are reported, the mechanism that
was reported last is shown.
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3 Network topology
 In case of issues, or if a more detailed overview is desired the network

topology can be used.

HINT/TIP

Clicking on the synchronization status will show the network topology.

 The network topology gives an overview of all mainframes connected with
Perception showing their synchronization mechanism, status and if
available information on the source. If the mainframe is set to PTP, and is
master in the PTP network, the source will be included in the mainframe,
if another node in the PTP configuration is the master is will be outside the
mainframe.

 

Figure I.3: Acquisition system that is a PTP master (left)/Acquisition
system that is a PTP slave and uses an external PTP master (right)

  
 This can be used to inspect if all mainframes are synchronized and if so,

to which master. In case there is a problem prohibiting overall
synchronization to succeed, this overview can be used to determine if one
mainframe is not synchronizing, potentially indicating a wiring or network
topology problem.
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 A typical setup with two mainframes will look like this:

Figure I.4: Two mainframes, one is master, the other one slave
  
 It is clear that mainframe GEN7tA is now the master, both from the fact

that it the PTP synchronization master information is encapsulated in a
single block, also from the fact that the PTP 1 state is (Master 1).
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 A more elaborate setup in which an external PTP source is used may look
like this:

Figure I.5: Two mainframes both slaves with the same master PTP clock
  
 From this image it is clear that the PTP master is not one of the connected

mainframes, as none of the acquisition systems encapsulates a PTP
master block. It is also visible that both acquisition systems use the same
master, as both PTP master blocks contain the same MAC address. In this
case the PTP master is typically connected to a primary time source such
as IRIG or GPS.

Note Some master clock devices allow you to check which slaves are present.
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 The network topology can also be used to diagnose problems with time
synchronization between acquisition systems.

Figure I.6: Two systems connected to the same network. One finds itself as
master; the other system finds no master
  
 For example see Figure I.3. This is a setup with two mainframes, both

connected to the same local area network. A very simple PTP setup is
intended, in which one of the mainframes should be the master, the other
one a PTP slave to the first mainframe. One of the mainframes has
resolved itself as a master. This indicates that is connected to the LAN via
a PTP enabled port. However the second mainframe is not able to find any
master mainframe and it is reporting: “No Signal” indicating that it is
connected to the local area network, but not via a PTP enabled port.
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 It is also possible that all mainframes are having problems synchronizing
which could indicate an issue with the master clock.

 Finally the overview can also be used to diagnose unexpected
synchronization behaviour, for example in case two mainframes have
synchronized to different master clocks. This might happen if a network is
divided into several subnets and the master clock is only available on one
of these subnets.

Note The PTP synchronization status will not affect the ability to start a new
recording. In case a recording is started while one or more mainframes are not
synchronized this information can be added to the recording. If this actually
happens depends on the specific hardware, GEN series mainframes will add
this information.

I.3.2 Advanced setup 1: Accurate master
The main focus of the PTP protocol is to keep a tight synchronization between
all the nodes in the system. It is possible to have a master clock that is not
related or synchronizing to the wall-clock or UTC time, that still keeps all data
acquisition equipment measuring in a synchronous fashion.

However often it is also important to have measurement data synchronous to
UTC or TAI time, when using PTP, this means the PTP Master clock should be
synchronized with primary time source like GPS or IRIG. PTP Masters that have
this capability and that are synchronized against such a time source can be
identified by their clock class. The above mentioned scenario is only true if the
clock class of the master is set to 6 (or lower). These master clocks may lose
synchronization to their primary time source, if this occurs; the clock class is
downgraded from class 6 to class 7 and continues synchronization against its
internal clock.

When it is important to have the capability of synchronizing against a primary
master, the Use Accurate Master setting can be enabled in the settings sheet.

A Use Accurate Master option
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When there is a clock class 7 or lower master, Perception will continue to work
as before, no difference will be noticed. However when a higher clock class
(less accurate) is detected a number of things will occur in the system when
using GEN series DAQ.

1 A notification will be shown, stating that “ the PTP master clock has no clock
class 7 or better”.

Figure I.7: Mainframe alert notification

2 When a recording is started a marker will be inserted in the recording stating
that the recording was started without an accurate master clock.

Typically all clock classes of 7 and better will be treated as accurate masters.
Also if a master downgrades from class 6 to 7, this is typically not recorded by
Perception, nor is it notified. The clock class will be updated in Perception, it
can be found in the settings sheet mainframe – general advanced settings.

I.3.3 Advanced setup 2: PTP tolerance
The PTP source is used to control real clocks in mainframes. This is done
through an adjustment process (PLL) that takes the PTP input, compares it to
real clock and applies slight adjustments based on the difference between the
two clocks.

When there is a difference between the clocks that exceeds acceptable
tolerances, the mainframe reports that is no longer synchronized. It will continue
to adjust to the PTP clock and after a period of time (maybe minutes to hours);
it will have adjusted the real clock enough to reduce the difference below the
given tolerance and will report the mainframe as synchronous to the PTP clock
again.
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Using the PTP tolerance setting, it is possible to adjust the tolerance that is
used and thus control when the system reports it is not synchronized anymore.
This can be used if there are constraints in the overall measurement system
architecture that affect the accuracy of the master or slave clocks, or the
communication between them. It may also be used in case a higher degree of
accuracy is required for the measurement application, and a warning is desired
when this accuracy is exceeded.

WARNING

Setting the tolerance to 0 will result in a system that is never
synchronized. The difference between real clocks is caused by physical
phenomena that cannot be avoided.
Typically 0 will not be accepted or selectable.

Note A thorough understanding of the measurement system, the PTP protocol and
implementation and real clocks is required before changing this value.

I.3.4 Advanced setup 3: Using separate network for data and synchronization
In some cases it might be desired to have a separate network for data traffic
and PTP synchronization traffic. Study has not shown any negative impact on
synchronization accuracy or data throughput of combining both on a single
network.

Note Physical network layout or company (IT) policy might dictate a separation
nonetheless. In case this requirement does exist, it is important to have a GEN
series DAQ apparatus with at least two network ports. If this is available follow
these steps to setup separate network streams.

Tethered systems
1 Make sure the system is connected to the networks correctly.
2 Connect to the system.
3 Open the network sheet.
4 Select “Mainframe Network Setup…” from the “Settings” menu.
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5 Set the network port that should be used to store data as preferred.

Figure I.8: Mainframe Settings - Network Setup dialog

A Preferred port The currently preferred port is indicated with a green
icon.

B Network port Select to show details and make it the preferred port.

C Checkbox for preferred port After selecting the port that should be
preferred, check the box to make it preferred.

Note If a separation of PTP and data network is to be achieved, make sure that
the preferred port is not the same port as used for PTP.

Integrated systems
When using an integrated system, the data is automatically separated from the
PTP traffic as the data is stored through the internal PCI bus. In case the system
is controlled remotely, setting up the network is done through as standard
Windows configuration.
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Note In case the data is stored on an iSCSI network drive the setup might be a
different. Please refer to the section on iSCSI storage in the GEN series
hardware manual for more information.

I.3.5 PTP synchronization lost during recording
It is possible to start a recording when the system is not yet synchronized. In
this case a non-blocking notification will be shown to warn about this
occurrence.

Figure I.9: Not synchronized warning notification

The recording will be created and data storage will commence. Mainframes that
are not synchronized when started will add a marker to the recording that is
visualized in the display.

Figure I.10: Recording started before synchronized.

A Marker A marker is added and the data between two channels of two
mainframes is not synchronized.

Perception

876 A02689_09_E00_00   HBK: UNRESTRICTED



There are several reasons a mainframe is not synchronized when set to PTP.
Please refer to the trouble shooting section in the GEN series hardware manual
for detailed information.

Once the mainframe is synchronized again a new notification is shown, stating
that the synchronization is established again.

Also a marker is added to the recording indicating when the mainframe
resynchronized to PTP.

Figure I.11: Recording - mainframe resynchronized to PTP

A Marker The mainframe is resynchronized to PTP.

Synchronization lost during recording
Another option is that the synchronization is lost during the measurement. This
may happen for example when a power or other hardware failure on the
grandmaster clock occurs, if a network problem between the master clock and
the slave, or another reason. If this happens, PTP will initiate a search for a new
master clock using the BMC algorithm. There are several potential outcomes:
A new master clock will be found. That master was most likely synchronized to
the old master clock (the old clock could even be back online) and will take over
the master clock task. The new clock will typically be close to the old clock, and
the mainframe will resynchronize to the master. The recording will contain two
markers:

1 A marker indicating when the synchronization was lost.
2 A marker indicating when the synchronization was retrieved.
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Note Not all acquisition systems will handle finding a new PTP master the same.
Some may immediately switch to the new time of the PTP, other hardware such
as GEN series mainframes will use a synchronization process to align PTP
Master and internal clocks.The time when the synchronization was retrieved
will always after the new master clock was selected. The time difference
between these occurrences depends on the time difference between the new
and old clock and the time it took to select a new master. This may impact the
time during which the system is not synchronized.

In this case the new clock most likely is not a class 6 or 7 clock, but will be of
a lower clock class, and as such the recording may drift away from the primary
time source. If “Use accurate master” was enabled, another marker will now be
added into the recording to indicate that synchronization from that point on was
not done against an accurate master.

It is also possible that the new clock was not a slave of the old master clock; in
that case its time may be unrelated to the previous clock. The system behaviour
depends heavily on the acquisition hardware used. Some hardware may use
the new time immediately, some hardware may use PLL alike processes to
gradually resynchronize with the new clock and other hardware may not
resynchronize at all. Refer to the hardware manual for more information on how
the specific hardware handles this scenario.

New clock introduced in PTP network
When a new node is introduced into a PTP network, this will invoke a new BMC
cycle. The result of this cycle will normally not change anything. However in
case the new node turns out to be the best clock in the network, it will be made
PTP master clock.

If this occurs during a recording, the master clock will typically be lost first,
including a notification and marker in the recording. After a mainframe is
resynchronized to the new PTP master clock a new notification will be shown
and the event will be stored in the recording with a marker.
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I.4 Using Perception to troubleshoot PTP synchronization

I.4.1 Unable to synchronize to PTP at all

Description:
After connecting to the mainframe and setting up PTP as synchronization
source, the synchronization status never states synchronized.

Check:
l If the PTP enabled port of your hardware is connected to the network.
l If the correct PTP selection is made. PTP 1 in case PTP port 1 is used;

PTP 2 in case PTP port 2 is used.

I.4.2 Synchronization keeps getting lost

Description:
After connecting to the mainframe and setting up PTP as synchronization
source, the synchronization state synchronized is reached, but every now and
then the synchronization state changes to not synchronized.

Check:
l Check if all network equipment is PTP aware.
l Check that PTP is enabled for connections used on PTP aware switches.

This can typically be manipulated through the switches’ configuration
software.

l Check that the PTP Tolerance setting is not set too small. Try restoring
default settings to ensure that the default setting is used.

I.4.3 Unexpected master is found or not all mainframes synchronize to the
same master 

Description:
The mainframe synchronizes when set to PTP; however the PTP-Master MAC
address of one or more mainframes is not the expected address.
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Check:
l Check if the mainframes are not synchronizing to different boundary clocks

which are in turn synchronized to the same grandmaster clock. In this case
it may not be a problem that the Master MAC-addresses differs. This is
only possible if mainframes are part of different subnets.

l Check if any network nodes (switches/routers) are in between the
mainframe(s) and the master clock. If so check that all these network
nodes support PTP, that this support is enabled, and that network
addresses are correctly translated in case of several subnets.

l If the PTP master allows it, open its (web)interface and check if the
mainframe is in the slave list. (see PTP master manual for details).

l Check if the mainframe(s) are physically connected to the correct network.

I.4.4 32 second offset

Description:
Two signals from two mainframes that should be time synchronized show a
difference of approximately 32 to 33 seconds. This difference is typically
caused by use of two different timescales. TAI, short for Temps Atomique
International (or International atomic time), uses a network of atomic clocks to
determine an accurate time, and UTC, Coordinated Universal Time, the bases
for times in different time zones.

There is a slight difference in the time measured through TAI and the rotation
speed of the earth. As time zones are based on UTC and are geographically
fixed, a leap second is introduced every number of years to avoid the UTC time
from slipping.

Check:
l Check that both mainframes are synchronized against the same master

clock. If so, check the manual or contact the vendor of the hardware to
enquire about TAI vs. UTC handling.

l If different physical sources are used. Check to see if all sources output
the same time source (TAI, or UTC).

Note This difference will increase as more leap seconds are introduced. Until 2012,
25 leap seconds were introduced in 41 years; this will increase as time
progresses.

I.4.5 19 second offset

Description:
Same as before (see "32 second offset" on page 880), but now with a 19
second offset.
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Check:
l Same as before (see "32 second offset" on page 880), but now look for

GPS against TAI settings.

Note This difference will not change over time.

I.4.6 13 second offset

Description:
Same as before (see "32 second offset" on page 880), but now with a 13
second offset.

Check:
l Same as before (see "32 second offset" on page 880), but now look for

GPS against UTC settings.

I.4.7 Accuracy not as expected

Description:
Two signals from different mainframes that are both PTP synchronized are not
as closely synchronous as expected.

Check:
l If the PTP Tolerance is set to a very high number (thus being more

inaccurate) there might be a synchronization issue that is not being
reported because it never exceeds the PTP tolerance threshold.

l The clock class of the master clock. If this is a very high clock class, the
master clock might not be very accurate. If the two mainframes respond
differently to an inaccurate clock, their signals might show some drift.
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J Recordings
J.1 Merge Recordings explained

Introduction
If you make a recording using multiple mainframes and multiple storage
locations (for example mainframe SCSI disk or compact flash card and PC),
the end result is a distributed set of recordings that are actually one single
recording.

Perception offers a way to integrate these multiple recording files into a single
recording via the Merge Files command in the Automation menu. Read this
appendix for a better understanding of the Merge Files command and its results.

J.1.1 Basic recording (PNRF) structure
A recording file consists of various parts of information that are all stored in the
Perception Native Recording File (PNRF). A normal recording made on a PC
has the following structure:

Figure J.1: Structure of a recording

J.1.2 Basic recording merge process
A merge of two recordings (for example one mainframe SCSI storage and one
PC storage) created using two mainframes (MF1 and MF2) will look like this:

Perception

882 A02689_09_E00_00   HBK: UNRESTRICTED



Figure J.2: Basic recording merge process

As you may notice the merged recording contains a single start time information
block. This means that all data and trigger information of mainframe 2 is now
viewed relative to the start time of the original mainframe 1 recording. So the
merge process already started when you created the original recordings in the
hardware. The merge process does not check for availability of time
synchronization or valid times. If you need time-synchronous accuracy, you
must add time synchronization options to your hardware such as IRIG/GPS.
This is outside the scope of this document.

A detail to consider is that the merged recording also contains the experiment
information. This is not an arbitrary detail that comes automatically. When
merging multiple recordings, one of the recordings is designated the master
recording. The experiment information of this recording is added to the merged
recording, and also the time information.

Consider the previous recording merge example, now with the SCSI recording
as a master recording. The resulting merged recording will look different:
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Figure J.3: Basic recording merge process with SCSI
recording

Note that the merged
recording's time infor-
mation is now the
mainframe 2 start time
info

 
 

Note that the merged
recording contains
NO more experiment
information

Although merging files from different locations is a powerful feature, you should
consider the mentioned issues to make sure you get the desired results without
undesirable side effects.

Perception

884 A02689_09_E00_00   HBK: UNRESTRICTED



J.2 ASCII Recording Loader

Introduction
This chapter describes the Perception ASCII file loader:

l How to use the ASCII Recording Loader
l Supported file formats

The Perception ASCII file loader is part of the Perception software since version
6.22.

J.2.1 Opening an ASCII file with the Perception ASCII file loader
There are two ways to open an ASCII file containing recorded data:

l Using the “Recordings Navigator” on page 885.
l Using the “File menu” on page 886.

Opening an ASCII file with the Recordings Navigator
ASCII data files which have *.txt or *.asc as their filename extension are
accessible through the Recordings Navigator. This navigator uses a tree view
to display the various items as an indented outline based on their hierarchical
relationship.

Figure J.4 below shows four ASCII files which are stored in the ASCII
Recording Files folder.

Figure J.4: ASCII Recording Files

A ASCII Recording Files

For more information about Recordings navigation, please refer to "Recordings
navigation" on page 94.
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Opening an ASCII file with the File menu

To open an ASCII file from the File menu:

1 Point to File ► Load Recording

Figure J.5: File menu with Load Recording option

A Load Recording
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2 In the Load Recording, dialog select ASCII Recording Files in the Files
of type drop down list.

Figure J.6: Load Recording dialog

A Files of type

B Load recording area

3 In the Load Recording area, select how you want to open the ASCII file:
l As active
l As reference
l Using filename

Note You can also use the formula @ReadAsciiFile() to load an ASCII recording
file. However, the number of channels which can be read is restricted to
only one. For more information, please refer to the Perception Analysis
Option manual.

4 Confirm your selection with the Open button.
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J.2.2 Supported ASCII file formats
The ASCII file loader supports five different file formats. These formats will be
described in this section:

l ASCII file format (I) for Perception export. Refer to "ASCII file format I" on
page 888.

l ASCII file format (II) which supports Catman and ASCII export with channel
information. Refer to "ASCII file format II" on page 891.

l ASCII file format (III) for short header. Refer to "ASCII file format III and IV"
on page 893.

l ASCII file format (IV) for long header. Refer to "ASCII file format III and IV"
on page 893.

l ASCII file format (V) when working with no header. Refer to "ASCII file
format V" on page 896.

ASCII file format I
The first supported file format is used to export a file using the Perception ASCII
export. For more information about export recording, please refer to "Export
Recording..." on page 356.

You should enable at least the following options when you create an ASCII
export file:

l Add x-axis
l Column titles
l File header
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Figure J.7 below shows an example of an ASCII export setup which can be
used to generate an ASCII file that can be read back by the ASCII file loader.

Figure J.7: Perception ASCII export setup

Note The ASCII file must contain a header and a data part.

Header:

Line Description Remark Example
1 The file name Always has to start with

“File:”
File: C:\Export
\AsciiDemo1.txt

2 Creation information Not used (1) Created: Wednesday,
December 21 2011
11:38:47

3 Header time
information

Not used  (1) Header time format:
Absolute

4 Time of the first sample Used (2) Time of first sample:
067
11:44:38.054093300

5 Title Comes back in the
Recording Information.
Comment

Title: This is a demo file

6 Empty line Not Used (1)
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Line Description Remark Example
7 Names of the scaled

units
(x; y1;y2;…yn)

Required Time;Left_Wing;Right
_Wing

8 Units for x and y
(x; y1;y2;…yn)

Required s;V;A

(1) The lines with the remark Not used may be empty.
(2) The information in this line is used to set the time of the first sample. The

line should start with a text followed by a colon ‘:’ and the date and time in
the following format:

  [<Year>] <Day of Year> <Time>
 Where the field Year is optional:

If the field Year is not available, the year of the ASCII file's date/time entry
will be used.

 Examples:
  2011 067 11:44:38.054093300

067 11:44:38
 The time/date is handled as the UTC time/date of the first sample. This

means that the time in the example above can be shown as 12:44:38 in
the Perception display if you are in the Amsterdam time zone +1 UTC.

Data:

The samples of the imported data are interpreted as being equidistant.
The data comes after the header and always starts at line 9.
Each data line contains sample information from one or more different
channels:
 x, y1, y2,…yn

The x (time) value should be the first value in a line, followed by at least one Y
value. The separator between the x and y values can be:
 ● Semicolon ‘;’
 ● TAB ‘\t’
 ● Comma ‘,‘
 ● Space ‘ ‘
   
Example of a data line:
 0.00015;-0.754458;-0.757576
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Example of an ASCII of format type I:

Figure J.8: Example of an ASCII file for Perception export

ASCII file format II
This format supports the Catman ASCII export format with channel information

Note The ASCII file must contain a header and a data part.

Header:

Line Description Remark Example
1 First line Always has to contain

the string:
CATMAN

HBM_CATMAN_DATA
FILE_40

2 Empty line Not used (1)

3 Date Used (2) 1/16/2012

4 Time Used (2) 11:29

5 Number of channels Required CHANNELS: 17
6 Separator Required SEPARATOR: 59
7 Number of data points Required MAXLINES: 103
8 Empty line Not used (1)
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Line Description Remark Example
9 Names of the scaled

units
(x; y1;y2;…yn)

Required Time;Left_Wing;Right_
Wing

10 Units for x and y
(x; y1;y2;…yn)

Required s;V;A

11 Information Not used (1)

12 …. ….
... …. ….
x Empty line Required

(1) The lines with the remark Not used may be empty.
After line 10, there can be an arbitrary number of header lines. The end of
the header lines will be marked by an empty line. After this line, the data
lines will start.

(2) The information in lines 3 and 4 is used to set the time of the first sample.
You may extend the time string with seconds and with a decimal part of a
second.

 Examples:
  11:29
  11:29:38
  11:29:38.054093300
 The date/time is handled as the local date/time.

If the date/time information is not available, the ASCII file's date/time entry
will be used.

Data:

The samples of the imported data are interpreted as being equidistant.
The data comes after the header and always starts after an empty line.
Each data line contains sample information from one or more different
channels:
 x, y1, y2,…yn

The x (time) value should be the first value in a line, followed by at least one Y
value. The separator between the x and y values is defined in the header.
  
Example of a data line:
0.00015;-0.754458;-0.757576
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Example of an ASCII of format type II:

Figure J.9: ASCII file format which supports Catman

Note When the Catman export ASCII file contains multiple sample rates only the
channels recorded at the primary sample rate are read.

ASCII file format III and IV
The third (Short header) and fourth (Long header) supported file formats have
almost the same header. However, the header of the fourth ASCII file is larger
and contains more information.

The format is also described in the Perception Analysis Option manual. For
more information please, refer to @ReadAsciiFile function. The only difference
is that the ASCII recording loader supports multiple channels.

Note The ASCII file must contain a header and a data part.
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ASCII file format III (Short header)

Line Description Remark Example
1 Number of header

rows
Always 5 for a short
header

5

2 Data delimiter (dot,
comma, tab or
semicolon)

Required ;

3 Number of data pairs Optional, if empty the
loader reads until the
last data line

2400

4 Scale factor for x and y
(x; y1;y2;…yn)

Optional, if empty
scale factors of 1 will
be used

1,000E-4;7,570637E-1
;4000

5 Units for x and y
(x; y1;y2;…yn)

Required Recording
Information. Comment

s;V;A

ASCII file format IV (Long header)

Line Description Remark Example
1 Number of header rows Always 12 for a long

header
12

2 Data delimiter (dot,
comma, tab or
semicolon)

Required ;

3 Number of data pairs Optional, if empty the
loader reads until the
last data line

2400

4 Date of data generation Used (2) 17.03.00

5 Time of data
generation

Used (2) 23:59

6 Extra information about
producer of the data

Not used (1) TDG 1.1

7 Comment Comes back in the
Recording Information.
Comment

First example: Test 1;

8 Scale factor for x and y
(x; y1;y2;…yn)

Optional, if empty
scale factors of 1 will
be used

1,000E-4;7,570637E-1
;4000

9 Units for x and y
(x; y1;y2;…yn)

Required Recording
Information. Comment

s;V;A

10 Names of the scaled
units
(x; y1;y2;…yn)

Required Time;Voltage;Current
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Line Description Remark Example
11 Resolution of y-data in

bit
Not used (1) 12

12 Use if dynamic range in
%

Not used (1) 80

(1) The lines with the remark Not used may be empty.
(2) The information for the long header in lines 4 and 5 is used to set the time

of the first sample. You may extend the time string with seconds and with
a decimal part of a second.

 Examples:
  11:29
  11:29:38
  11:29:38.054093300
 The date/time is handled as the local date/time.

If the date/time information is not available, the ASCI file's date/time entry
will be used.

Data

The samples of the imported data are interpreted as being equidistant.
The data comes after the header and always starts at line 6 or 13.
Each data line contains sample information from one or more different
channels:
 x, y1, y2,…yn

The x (time) value should be the first value in a line, followed by at least one Y
value. The separator between the x and y values can be:
 ● Semicolon ‘;’
 ● TAB ‘\t’
 ● Space ‘ ‘
 ● Dot ‘.’
 ● Comma ‘,’
 
Example of a data line:
 0.00015;-0.754458;-0.757576
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Example of an ASCII of format type III:

Figure J.10: ASCII file format (short header)

ASCII file format V
This file format works without a header, it contains only data lines.

Data:

The samples of the imported data are interpreted as being equidistant.
The data starts at the first line of the file, the file should contain at least 10 lines.
Each data line contains sample information of 1 or more different channels:
 x, y1, y2,…yn

The x (time) value should be the first value in a line, followed by at least one Y
value. The separator between the x and y values can be:
 ● Semicolon ‘;’
 ● TAB ‘\t’
 ● Space ‘ ‘
 
Example of a data line:
 0.00015;-0.754458;-0.757576
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Example of an ASCII of format type V:

Figure J.11: ASCII file format (Without header)
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J.3 CSV Recording Loader

Introduction
This chapter describes the Perception CSV file loader:

l How to use the Perception CSV file loader.
l Supported file format

The Perception CSV file loader is part of the Perception software since version
6.22.

J.3.1 Opening a CSV file with the Perception CSV file loader
There are two ways to open a CSV file containing recorded data:

l Using the “Recordings navigator” on page 898.
l Using the “File menu” on page 899.

Opening a CSV file with the Recordings Navigator
CSV data files which have *.csv as their filename extension are accessible
through the Recordings Navigator. This navigator uses a tree view to display
the various items as an indented outline based on their hierarchical relationship.

Figure J.12 below shows four CSV files which are stored in the CSV Recording
Files folder.

Figure J.12: CSV Recording Files

A CSV Recording files

For more information about Recordings navigation, please refer to "Recordings
navigation" on page 94.
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Opening a CSV file with the File menu

To open a CSV file from the File menu:

1 Point to File ► Load Recording

Figure J.13: File menu with Load Recording option

A Load Recording
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2 In the Load Recording dialog, select CSV Recording Files in the Files
of type drop down list.

Figure J.14: Load Recording dialog

A Files of type

B Load recording area

3 In the Load Recording area, select how you want to open the CSV file:
l As active
l As reference
l Using filename

4 Confirm your selection with the Open button.

J.3.2 Supported CSV file format
The Perception CSV loader does not support all possible CSV formats. The
limitations of the format are described in this section.
Although CSV means ‘Comma Separated Variables’, the loader also accepts
other separator characters, such as a semicolon ‘;’ comma ‘,’ or space ‘ ‘.
A dot ‘.’ cannot be used as a separator!
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Note The ASCII file must contain a header and a data part.
The first line of the header should always start with: Recording title

Header:

Line Description Remark Example
1 The file name Always has to start with

“Recording title:”
Recording
title: ;TestCSV;

2 Title Comes back in the
Recording Information.
Comment

Export title: ;This is a
CSV demo file;

3 Header time
information

Not used (1) Header time format
is: ;Absolute;

4 Time of the first sample Used (2) Time of first sample:
067
11:44:38.054093300

5 Names of the scaled
units
(x; y1;y2;…yn)

Required Time;Left_Wing;Right
_Wing

6 Units for x and y
(x; y1;y2;…yn)

Required s;V;A

(1) The lines with the remark Not used may be empty.
(2) The information in this line is used to set the time of the first sample. The

line should start with a text followed by a colon ‘:’ and the date and time in
the following format:

  [<Year>] <Day of Year> <Time>
 Where the field Year is optional:

If the field Year is not available, the year of the ASCII file's date/time entry
will be used.

 Examples:
  2011 067 11:44:38.054093300

067 11:44:38
 The time/date is handled as the UTC time/date of the first sample. This

means that the time in the example above can be shown as 12:44:38 in
the Perception display if you are in the Amsterdam time zone +1 UTC.

Data:

The samples of the imported data are interpreted as being equidistant.
The data comes after the header and always starts at line 7.
Each data line contains sample information from one or more different
channels:
 x, y1, y2,…yn
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The x (time) value should be the first value in a line, followed by at least one Y
value. The separator between the x and y values can be:
 ● Semicolon ‘;’
 ● TAB ‘\t’
 ● Comma ‘,‘
 ● Space ‘ ‘
   
Example of a data line:
 0.00015;-0.754458;-0.757576
   
Example of a CSV format:

Figure J.15: CSV file format
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K File Information
K.1 UFF58 File Format

General information
The Universal File Formats (UFF58) and (UFF58b) are standard in
experimental dynamics. There are several universal file formats. UFF58 and
UFF58b are the most widely used file formats.

One application area which is often used is the modal and structural analysis.

UFF58 Storage mode:

l Header information in ACSII format
l Data information in ASCII format

UFF58b Storage mode of:

l Header information in ACSII format
l Data information in binary format

Ways to import UFF58 and UFF58B files:

l NI Diadem
l NI Sound and Vibration Measurement suite
l Several third-party sound and vibration software packages

K.1.1 Configuration of UFF58 and UFF58b files
UFF58 and UFF58b files are configured in the following way:

l One or more functions
l One or more datasets

The function is:

l Delimited by -1 and contains 12 records

Each record contains:

l One or more fields
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l Records 1 to 11 contain header information
l Record 12 contains the data

If you view an UFF58 or UFF58b file in a text editor:

l The first line is a function delimiter (-1)
l The second line defines whether the file meet the UFF58 or UFF58b

standard.
l The subsequent lines contain records 1 to 12

The UFF58 standard allows any information to be in records 1 to 5 but allows
only specific information to be in records 6 to 12.

Record Description
1 Typically contains the function description
3 Typically contains the time and date information about when the

file was created
6 Contains the degree of freedom identification
7 Contains the data form, including fields that define the ordinate

data type and abscissa spacing
8 Contains the abscissa data characteristics
9 Contains the ordinate or ordinate numerator data characteristics
10 Contains the ordinate denominator characteristics if needed
11 Contains z-axis data characteristics if needed
12 Contains the data
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K.2 File extensions in Perception 6.0 or later
In Perception 6.0 and above various file extensions of Perception-related files
were modified. Refer to the following table for details.

File extension conversion table

Legacy extension New extension Description
LDSesw pEsw Embedded software / firmware
LDSFormulas pFormulas Formula sheet (Analysis option)
LDSReportData pReportData Report saved as compound (Win-

dows) MetaFile
LDSReportLayout pReportLayout Report sheet layout
LDSLinkList pLinkList Link list for advanced Word reporting
LDSInfo pInfo Info sheet data
LDSHPHV pHPHV HPHV sheet information
LDSSequence pSequence Sequencer sheet (BE3200) data
pSet pSet Hardware settings
LDSKey pKey HASP key update file
VWB pVWB Virtual WorkBench information
PNRF pnrf Perception Native Recording File
OfflineConfig pOfflineConfig Offline Configuration file

Various file formats for storage and settings are expanded over the years to
include more information. HBM, however, always strives for backwards
compatibility as much as possible. Therefore reading older files should always
be possible although they may not contain all the latest settings. In these
situations warnings are generated, but you can always use these older files and
save them for upwards compatibility.
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L Product Cycle
L.1 End-of-life products

Product supported by Perception
The following products are no longer supported by Perception:

Product Since
IM1 – Interface Module Perception V7.30
MultiPro Perception V7.00.16336
BE256 Perception V7.00.16336
Liberty Perception V6.70.15224

IM1 – Interface Module
Perception V7.20 is the last version that supports IM1 Interface Modules.

Interface Modules of type IM1 can be recognized by their serial numbers.
Mainframes equipped with the IM1 Interface Module have a serial number
starting with IDJ. This serial number can be found in Perception by navigating
to the Properties page of the mainframe (see Figure L.1).

Figure L.1: Properties window of a mainframe with an IM1.

A IM1 Interface Module serial number

Note The IM1 Interface Module type can also be distinguished from IM2 Interface
Module type in the communication area (see Figure L.2).
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Figure L.2: IM1 Interface Module

Figure L.3: End-of-life warning shown in Perception 7.20
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M Glossary
M.1 Abbreviations

Abbreviations Description
AC Alternating Current
ADC Analog-to-Digital Converter
ALU Arithmetic (and) Logic Unit
BER Bit Error Ratio
BMC Best Master Clock Algorithm
CAN Controller Area Network
CANopen Controller Area Network, a communication protocol and

device profile specification for embedded systems used in
automation and developed by CiA.

CCP CAN Calibration Protocol
CD Compact Disc
CiA CAN in Automation, an international users and manufacturers

organization that develops and supports CAN based higher
layer protocols.

CoE CANopen over EtherCAT®, a CANopen compatible
application protocol layer on top of EtherCAT®.

CSI Custom Software Interface
DC Direct Current
DHCP Dynamic Host Configuration Protocol
DPI Dots per Inch
DTP Desktop Publishing
DVD Digital Versatile Disc
ECU Electronic Control Unit
ETG EtherCAT® Technology Group, an industrial Ethernet user

organization, developing and supporting the EtherCAT®
specifications.

FFT Fast Fourier Transform
FIR Finite Impulse Response
GND Ground
GPS Global Positioning System
HASP Hardware Against Software Piracy
HPHV High Power High Voltage
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Abbreviations Description
IEC International Electrotechnical Commission, a non-profit, non-

governmental international standards organization that
prepares and publishes International Standards for all
electrical, electronic and related technologies.

IP Internet Protocol
IRIG Inter Range Instruments Group
iSCSI Internet Small Computer System Interface
LAN Local Area Network
MAC address Media Access Control address
NZR Non Return to Zero
PC Personal Computer
PCI Peripheral Component Interconnect
PDO Process Data Object, a CANopen specified data object that is

updated cyclically.
PLL Phase Locked Loop
PTP Precision Time Protocol
RAID Redundant Array of Independent Disks
RAM Random Access Memory
ROM Read Only Memory
RPC Remote Procedure Call
RPM Revolutions per Minute
RTC Real-Time Clock
RTD Resistance Temperature Detector
SCSI Small Computer System Interface
SDO Service Data Object, a CANopen specified data object that is

accessible on-demand by means of an SDO request message.
SOAP Simple Object Access Protocol
TAI Temps Atomique International (or International atomic time)
TDC Top Dead Center
TTL Transistor-Transistor Logic
USB Universal Serial Bus
UT Universal Time
UTC Universal Time Coordinated
VWB Virtual Work Bench
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